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Zacatek

ActionScript je Flash skriptovaci jazyk, ktery pouzivdme ke kontrole objektli ve Flash animacich,
pro vytvareni navigacnich a interaktivnich prvk( a pfi vytvareni vysoce interaktivnich animaci
a Web aplikaci.

Co je nového ve Flash 5 ActionScriptu
Flash 5 ActionScript nabizi nové zajimavé vlastnosti ke tvorbé plsobivych, interaktivnich
Web stranek pinych dimysinych her, formulard, prehledd a chatd v redlném case.

Flash 5 ActionScript ma mnoho novych rys( a pravidel syntaxe, které ho délaji velice
podobnym programovacimu jazyku JavaScript. Tento manual vysvétluje zakladni programovaci
koncepty jako jsou funkce, proménné, vyrazy, operatory, podminky a smycky. Kapitola 7 tohoto
manualu ,ActionScript Slovnik“ obsahuje detailni popis kazdého prvku ActionScriptu.

Cilem tohoto manudlu neni dotykat se programovani vSeobecné, na to existuje mnoho
dostupnych zdrojd, které poskytuiji daleko vice informaci o obecnych konceptech programovani
a jazyku JavaScript.

European Computers Manufacturers Association (ECMA) (Asociace Evropskych Vyrobct
Pocitacll) napsala dokument nazvany ECMA-262, ktery byl odvozen z JavaScriptu, aby slouZil
jako mezinarodni standard pro jazyk JavaScript. ActiosScript je zalozeny na specifikaci
ECMA-262, kterd je dostupna na http://www.ecma.ch.

NetscapeDevEdge Online ma JavaScript Developer
(http://developer.netscape.com/tech/javascript/index.html),

ktery obsahuje dokumentaci a ¢ldnky uzite¢né pro pochopeni ActionScript.
NejhodnotnéjSim zdrojem je Core JavaScript Guide, umistény

na http://developer.netscape.com/docs/manuals/js/core/jsguide/index.html.
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Rozdily mezi ActionScript a JavaScript

Nemusite védét, jak se pouziva JavaScript a presto se miZete ucit se ActionScript. Jestlize
znate JavaScript, potom vam bude ActionScript pfipadat znamy. Nékteré rozdily mezi
ActionScript a JavaScript:

ActionScript nepodporuje specifické objekty browseru, jako Document, Window
a Anchor.

ActionScript nepodporuje kompletné vSechny preddefinované objekty JavaScriptu.

ActionScript podporuje konstrukce syntaxe, které nejsou povoleny v JavaScript
(napriklad akce tellTarget a ifFrameLoaded a slash syntax).

ActionSctipt nepodporuje nékteré syntaxe konstrukce JavaScriptu, jako switch,
continue, try, catch, throw, and statement popisky.

ActionScript nepodporuje JavaScript konstruktor Function.
V ActionScriptu akce eval mUze provést pouze odkazy na proménnou.

V JavaScriptu, toString undefinedje undefined. Ve Flash 5, pro kompatibilitu

“ o«

s Flash 4, toString undefinedje “ “.

V JavaScriptu, ohodnocovani unde f ined je numericky kontext jehoz vysledkem
je NaN. Ve Flash 5, pro kompatibilitu s Flash 4, je vysledkem ohodnoceni undefined 0.

ActionScript nepodporuje Unicode; podporuje ISO-8859-1 a nastaveni znaku Shift-JIS.

Editovani textu
Skripty mdlzete vkladat pfimo do panelu Actions v Expert Mode. Také mizZete zvolit
prvky z pop-up menu nebo z Toolbox jako jste to délali ve Flash 4.

Dot syntax

Dot syntax, mlzete pouzit pro ziskani a nastaveni vlastnosti a metod objektu, vcetné
instanci filmovych klipd a proménnych. Mlzete pouZit dot syntax namisto slash syntax
pouzivaném ve Flash 4. Slash syntax jiz neni preferovan, ale je stale podporovan ve Flash
Prehravaci.

Typy dat
Flash 5 ActionScript podporuje nasledujici typy dat: string, number, boolean, object a movie

clip. Nékolik typd dat umozriuje pouzit rdzné typy informaci v ActionScriptu. Napfiklad
mUzZete vytvaret arrays a associative arrays.
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Lokalni proménné

Mdzete deklarovat lokalni proménné, kterym konéi platnost na konci seznamu akci nebo
volani funkce. Toto umoznuje fidit pamét a znovu pouzit jména proménnych. Proménné
Flash 4 byly vSechny permanentni - dokonce doc¢asné proménné jako pocitadla smycek
zlstdvaly v animaci dokud neskondila.

Funkce definované uzivatelem

Mdzete definovat funkce s parametry, které ddvaji hodnoty. Toto umoZznuje znovu pouZit
bloky kddu ve vasich skriptech. Ve Flash 4 jste mohli znovu pouzit kdd pouZitim akce call,
ale nemohli jste propustit parametry nebo obdrzet hodnoty.

Pfeddefinované objekty
Pro dosazeni a manipulaci s uréitymi typy informaci mizete pouzivat preddefinované
objekty. Nékolik preddefinovanych objekt(:

Objekt Math vystupuje jako plny doplnék zabudovani matematickych konstant
a funkci, jako je E (Eulerova konstanta), cos (Cosinus) a atan (Arctangent).

Objekt Dat umoznuje ziskat informaci o datumu a Case, v jakémkoliv systému,
ktery provozuje Flash Prehravac.

Objekt Sound umozriuje pridat a kontrolovat zvuky v animaci, béhem prehravani.
Napriklad mUzete upravit hlasitost (setVolume) nebo rovnovahu (setPan).

Objekt Mouse umozriuje schovat standardni kursor tak, Ze mlZete pouzivat upraveny
kursor.

Objekt MovieClip umozriuje kontrolovat filmové klipy bez pouziti obalové akce,
jako tellTarget. Mizete zavolat metodu jako play, LoadMovie nebo
duplicateMovieClip ze jména instance pouzitim dot syntax (napfiklad,
myMovieClip.play ().

Akce klipt

Pro stanoveni akci pfimo do instanci filmového klipu na Scéné, mizZete pouzit akci
onClipEvent. Akce onClipEvent ma udalosti jako Lload, enterFrame, mouseMove a data,
které vam umoznuji vytvofit nové druhy pokrocilé interaktivity.

Nové akce

Mdzete pouZit nové akce jako do..while a for k vytvareni komplexnich smycek. Dal$i nové
akce jsou implementovany jako metody MovieClip objektu; napfiklad getBounds,
attachMovie, hitTest, swapDepths a globalToLocal.
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Smart klipy

Smart klipy maji vnitini scénare, které vy nebo jiny vyvojar mizete zménit bez pouZiti panelu
Akce. Mlizete propustit hodnoty do Smart klipu pomoci parametr(i klipu, které mizZete definovat
v Knihovné.

Debugger

Debugger umozriuje prohlédnout si a zmeénit proménnou a hodnoty vlastnosti v animaci,
ktera hraje v rezimu Test-movie, samostatném Prehravaci nebo Webovém prohlizeci. Toto
umoznuje jednoduse najit problémy v ActionScriptu.

XML podpora

Preddefinovany XML objekt umozriuje konvertovat ActionScript na XML dokumenty a pouZit
je do aplikaci serveru. Také mizZete pouZit XML objekt pro nataZzeni XML dokumentt do Flash
animace a jejich interpretaci. Pfeddefinovany XML Socket objekt umoZriuje vytvaret plynulé
spojeni se serverem k propousténi XML dat pro aplikace v redlném Case.

Pouziti Flash napovédy pro akce
Flash 5 obsahuje kontextové-citlivou pomoc pro kazdou akci dosazitelnou v panelu Akce.
Kdyz vytvarite scénare, mlzete dostat informace o akcich, které pouzivate.

Jak ziskat napovédu o akcich:
V panelu Actions zvolte akci ze seznamu.

Kliknéte na tlacitko Help na vrcholu panelu.

V prohlize¢i se objevi téma vztahuijici se k akci.

Pochopeni ActionScriptu

ActionScript je Flash skriptovaci jazyk, ktery priddva animacim interaktivitu. Animaci
mUzZete nastavit tak, Ze uzivatelovy udalosti, jako je kliknuti na tladitko a stisknuti klavesy,
spusti skripty, které fikaji animaci, jakou akci ma provést. Naptiklad mlzZete napsat skript,
ktery fika Flashi, aby natdhl rizné animace do Flash Prehrdvace v zavislosti na tom, jaké
navigacni tlacitko uZzivatel zvoli.

Premyslejte o ActionScriptu jako o nastroji, ktery umoznuje vytvareni animaci, chovajicich
se presné podle vasich prani. Abyste mohli zacit skriptovat, nemusite chapat vSechna
mozna pouziti nastrojd, ale jestlize mate jasny cil, mzete zacit tvorit skripty s jednoduchymi
akcemi. MUzZete zabudovavat nové prvky jazyka tak, jak se je naudite.

Tato kapitola vas uvddi do ActionScriptu jako objektové orientovaného skriptovaciho
jazyka a poskytuje prehled termind ActionScriptu. Také uvadi prikladové skripty, abyste
mohli tvorit narocnejsi prace.

Tato kapitola vds také uvadi do Actions panel, kde miZete vytvorit skripty volbou prvkd

ActionSctripu nebo vloZzenim textu do Script window.

Skriptovani v ActionScriptu
MUzZete zacit psani jednoduchych skriptll bez velikych znalosti ActionScriptu. V$e co potrebujete
je zdmér; potom je to pouze zéleZitost vybéru spravnych akci. Nejlepsi zplsob jak se naudit
pouzivat ActionScript, je vytvoreni viastniho skriptu. Nasleduijici kroky pripojuiji skript ke tlacitku,
které méni viditelnost filmového klipu.
Jak zménit viditelnost filmového klipu:
Zvolte Window > Common Libraries > Buttons a potom zvolte Window > Common
Libraries > Movie Clips. Umistéte tlacitko a filmovy klip na Scénu.
Viyberte instanci filmového klipu na Scéné a zvolte Window > Panels > Instance Properties.
Do pole Name vlozZte testMC.
Zvolte tlacitko na Scéné a zvolte Window > Actions, pro otevreni panelu Akce.

V panelu Object Actions kliknéte na kategorii Akce, pro jeji otevreni.

Dvakrat kliknéte na akci setProperty, pro jeji pridani do seznamu Akce.
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Z pop-up menu Property zvolte visible.
Jako parametr Target viozte testMC.
Jako parametr Value vlozte 0.

Kdd by mél vypadat takto:

on (release) {

setProperty ("testMC", visible, false);
}

Zvolte Control > Test Movie a kliknéte na tlacitko, abyste vidéli, jak movie klip zmizi.

ActionScript je objektové orientovany skriptovaci jazyk. To znamend, Ze kdyz se objevi
urCita uddlost, tak akce kontroluji objekty. V tomto skriptu je udalosti uvolnéni mysi,
objekt je instance filmového klipu testMC a akce je setProperty. KdyZ uZivatel klikne
na tlacitko na scéné, udalost release spusti skript, ktery nastavi vliastnost objektu Mc,
_visible na false (nepravda) a zpUsobi tak, Ze objekt se stane neviditelny.

Panel Akci miZete pouzit jako voditko pro nastavovani jednoduchych skriptd. Pro pouziti
pIného vykonu ActionScript je dileZité pochopit jak jazyk funguje: koncepty, prvky a pravidla,
ktera jazyk pouziva pro organizovani informaci a vytvareni interaktivnich animaci.

Tato Cast vysvétluje pribéh ActionScriptu, zakladni koncepty objektové orientovaného
skriptovani, Flash objekty a tok skriptu. Také popisuje, kde jsou ve Flash animaci skripty
umistény.

O planovani a odstranovani zavad skriptu

Kdyz pisete skripty pro celé animace, pocet a riznost skriptd mlze byt znac¢né rozsahla.
Rozhodovani o tom, které akce pouzit, jak efektivné strukturovat skript a kam maiji byt skripty
umistény, vyZaduje peclivé planovani a testovani, obzvlasté pri ristu sloZitosti a narocnosti
celé animace.

Jesté nez zacnete psat skripty, je tfeba si vytycCit a formulovat cil, kterého chceme animaci
dosahnout. Je to stejné dulezité jako sepsdni a postaveni osnovy celého projektu. Zaénéte
nacrtkem toho, co se ma v animaci dit, podle tohoto prikladu:

Chci vytvofit celou svou stranku s pouzitim Flashe.

Navstévnici stranky budou tazani na jméno, které bude znovu pouzivano v odkazech
na strankach.
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Stranka bude mit tazitelny navigacni sloupec s tlacitky, které jsou spojeny s kazdou
casti webu.

Kdyz je kliknuto na tlacitko, nova ¢ast se rozetmi do stfedu Scény.
Jedna scéna bude mit kontaktni formular s jiz vyplnénym uzivatelovym jménem.

Kdyz vite, co chcete, mlzete zadit vytvaret potrebné objekty, a zadit psat skripty pro ovliadani
téchto objektd.

Vypracovani skriptd, které pracuji presné zplsobem jakym jste si to naplanovali trva néjakou
dobu a také dlouho trva testovani a odstrafiovani zavad. Nejlepsi zplsob je zadit
jednoduse a velmi éasto svou praci kontrolovat a testovat. Pokud se dopracujete k jedné
funguijici ¢asti, je nejlepsi ji ulozit — Save As (napfiklad - mojeAnimace.fla), a dat se do prace
na dal$i ¢asti. Takovy postup vam pomuize efektivné identifikovat zédvady a ujisti vds, ze vas

O objektové orientovaném skriptovani

V objektové orientovaném skriptovani organizujete informace jejich aranzovanim do skupin
nazvanych tfidy (classes). Pro pouziti ve skriptech, mlzete vytvorit nékolik instanci trid,
nazyvanych objekty (objects). Mizete pouzit bud preddefinované tridy ActionScriptu
a nebo vytvorit své vlastni.

Pri vytvoreni tfidy, definujete vSechny vlastnosti (properties) a metody (methods) kazdého
vytvoreného objektu. Napriklad, osoba ma viastnosti jako pohlavi vyska a barva vlasti a metody
jako fe¢, chiize. V tomto prikladé je ,osoba“ tfida a kazdd individudini osoba je objekt nebo
instance této tridy.

Objekty v ActionScript mohou obsahovat data, nebo mohou byt graficky reprezentovany
na Scéné jako filmoveé klipy. VSechny filmové klipy jsou instance preddefinovanych tfid
MovieClip. Kazda instance filmového klipu obsahuje vSechny vlastnosti (napfiklad
_height, _rotation, _totalframes a vSechny metody (napfiklad gotoAndPlay,
loadMovie, startDrag) MovieClip tridy.
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Abyste definovali tfidu, vytvorte specidlni funkci nazvanou konstrukéni funkce (constructor
function); preddefinované tfidy maji konstrukéni funkce, které uz jsou definované.
Napriklad, jestlize chcete informaci o cyklistovi ve vasem klipu, mlzete vytvorit konstrukéni
funkci Cyklista, s vlastnostmi cas a vzdalenost a metodou urcit, kterd vam fekne,
jak rychle cyklista jede:
function Cyklista (c, v) {

this.cas = c;

this.vzdalenost = v;
}
function Rychlost () {

return this.cas / this.vzdalenost;
}
Cyklista.prototype.urcit = Rychlost;

Potom miZete vytvorit kopie - to znamend instance - tfidy. Nasledujici kdd vytvari instance
objektu Cyklista nazvané petr a pavel.

petr = new Cyklista (30, 5);

pavel = new Cyklista (40, 5);

Instance také mohou komunikovat mezi sebou. Pro objekt Cyklista mizZete vytvorit
metodu nazvanou streit, kterd umozni jednomu cyklistovi strcit do druhého. (Instance petr
mUze zavolat svou metodu strcit, jestlize se pavel dostane pfili§ blizko). Pro predani
informace do metody pouZzijete parametry (argumenty): napfiklad metoda streit by mohla
mit parametry koho a jakDaleko. V tomto prikladé petr strkd pavla o 10 pixel:
petr.strcit (pavel, 10);

V objektoveé orientovaném skriptovani mohou tfidy obdrzet vlastnosti a metody od sebe
navzajem v uréitém poradi; toto je nazyvano dédiénost (inheritance). Dédi¢nost mizete pouzit
pro rozsifeni nebo redefinovani vliastnosti a metod tfidy. Trida, ktera dédi od jiné tfidy je
nazyvana subtfida (subclass). Trida, ktera definuje vlastnosti a metody jiné tfidé je nazyvana
supertfida (superclass). Tfida mdze byt jak subtfida, tak supertrida.
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O objektu MovieClip

Preddefinované tfidy ActionScriptu jsou nazyvany objekty (objects). Kazdy objekt vam
umozriuje dosahnout urc¢itého typu informace. Napfiklad objekt Date ma metody (napfiklad
getFullYear, getMonth), které vam umozriuji Cist informaci ze systémového Casu.
Objekt Sound ma metody (napfiklad setVolume, setPan), které vam umoznuji kontrolovat
zvuk v animaci. Objekt MovieClip ma metody umozriujici kontrolovat instance filmového
klipu (napfiklad play, stop a getURL) a ziskat a nastavit informaci o jejich vlastnostech
(napfiklad _alpha, framesloaded,_ visible).

MovieClipy jsou nejdleZit&jsimi objekty Flash animaci, protoze maji Casovou osu), ktera bézi
nezavisle na sobé. Napfiklad, jestlize hlavni Casova osa ma pouze jeden snimek a filmovy
klip v tomto snimku ma deset snimkd, tak ¢asova osa v klipu bude neustdle prehravana.
Toto umozniuje instancim hrat jako autonomni objekty, které mohou navzdjem komunikovat.

Kazda instance filmového klipu ma unikatni jméno, takZe ji mGzete cilovat akci. Napriklad,
m0zZete mit nékolik instanci na Scéné (napriklad levyKlip a pravyKlip) a chcete, aby v daném
Case hrdla pouze jedna. Abyste pripajili akci, ktera fika jedné urcité instanci, aby hrala, potrebujete
pouzit jeji jméno. V nasledujicim prikladu je jméno instance filmového klipu levyKlip.
levyKlip.play ()

Jména instanci vam také umozniuji duplikovat, odstrarfiovat a tahnout filmové klipy, zatimco
animace hraje. Nasledujici prfiklad duplikuje instanci kartovaPolozka, pro vyplnéni
nakupni karty Cislem nakupované polozky:
onClipEvent (load) {
do {
duplicateMovieClip ("kartovaPolozka", "kartovaPolozka" + i, i);
i=1i+1;
} while (i <= cisloNakupPolozky) ;
}

Filmové klipy maiji vlastnosti, jejichz hodnoty miiZete s ActionsScriptem dynamicky nastavit
a znovu ziskat. Zména a precteni téchto vlastnosti mize zménit vzhled a identitu filmoveho klipu
a je klicem pro vytvoreni interaktivity. Napfiklad, nasledujici scénar pouziva akci setProperty
pro nastaveni priihlednosti (nastaveni alfa) instance navigacniSloupec na 10:
setProperty ("navigacniSloupec", _alpha, 10);

Vice informaci o dalsich typech objektd viz ,Pouziti preddefinovanych objektd“.
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Jak skripty pracuji

ActionScript vyplyva z logického toku. Flash vykonava pfikazy ActionScriptu tak, ze za¢ne
prvnim piikazem a pokracuje dalSimi skripty podle poradi, dokud nedosahne posledniho
pfikazu nebo pfikazu, ktery ActionScript posila nékam jinam.

Jedny z akci, které posilaji ActionScript nékam jinam nez na dalSi pfikaz jsou pfikazy if,
smyCky do. . .while a akce return.

else

{(podminkovy (poedminkovy
prikaz) piikaz)

WhileLoop

{podminkowy
prikaz)

Pfikaz if je nazyvan také jako podminkovy pfikaz nebo ,logicka vétev®, protoze kontroluje
tok skriptu zalozeného na ohodnoceni urcité podminky. Napfiklad nasledujici kdd kontroluje,
zda je hodnota proménné pocet mensi nebo rovna 10. Jestlize obdrzi true (pravda)
(napriklad hodnota pocet je 5), je nastavena proménna varovani a zobrazi jeji hodnotu
do textového pole:
if ( pocet <= 10 ) {

varovani = "Pocet je mensi neZz nebo roven 10“ ;
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nasledujicim prikladé vidime, ze pokud podminka obdrzi (ma hodnotu) true (pravda)
(napfiklad hodnota pocet je 3), bézi pfikaz mezi prvnim nastavenim slozenych zavorek
a proménnd varovani je nastavena na druhém fadku. Pokud ale podminka obdrzi false
(nepravda) (napfiklad hodnota pocet je 30), prvni blok kddu je pfeskoCen a za pfikazem
if mezi slozenymi zavorkami bézi prikaz else:

if ( pocet <= 10 ) {

varovani = “Pocet je mensi nez nebo roven 10 ;
} else {
varovani = “Pocet je vétsi nez 10

}
Vice informaci viz ,,PouZiti prikaz( “if".

Smycka opakuje akci nékolikrat, nebo dokud neni spinéna urcita podminka. V nasledujicim
prikladé je filmovy klip pétkrat duplikovan:
i=0;
do {
duplicateMovieClip (,mujKlip“, ,novyKlip“ + i, i) ;
noveJmeno = eval (,novyKlip"“ + i) ;
setProperty (novedmeno, _x, getProperty (,mujKlip“, x) + (i * 5)) ;
i=1i+1;
} while (i <= 5) ;

Detailni informace viz ,Opakovani akce"

Kontrola ActionScriptu za béhu

Pfi psani skriptl pouZivéte Action panel, ktery umozniuje pripojit skripty ke snimku na hlavni

Casové ose, nebo ke snimku na Casové ose jakéhokoliv filmového klipu. Samoziejmé

i k tlacitkim a filmovym klipdm umisténym pfimo na scéné.

Flash vykondava akce v riizném ¢ase v zavislosti na tom, k éemu jsou pfipojeny:
Akce pripojené ke snimku, jsou vykonany jakmile je dosazeno tohoto snimku
na Casové ose.

Akce pfipojené k tlacitku, jsou vliozeny do akci ovladace on.

Akce pfipojené k filmovému klipu jsou vloZeny do akci ovladaCe onClipEvent.
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onClipEvent a akce on jsou nazvané ovladace, protoze ,ovladaji“ nebo fidi udalost.
(Uddlost je pfihoda jako pohyb mysi, stisknuti kldvesy nebo natahovani movie klipu). Movie klip
a tlacitkové akce jsou vykonany pfi udalosti specifikované ovladacem. Jestlize pfipojite
k objektu vice nez jeden ovladac¢, akce budou vykondvany pri rliznych udélostech. Vice informaci
viz Kapitola 3, ,Vytvareni Interaktivity v ActionScripu®.

[ zapper.fla:1 _[O]x] ‘
= Scenel s ]
PEYE]l z P 51 Object Actions 2|k
) . . 4+ = Object Actions
(2] Basic Actions onClipEvent Cload) {
HE & || 4] e w e startDrag (this, trusis
(2] actions zap = new ColorCthis)s
7] operatars
Wl Functions onclipEvent (snterFrame) [
J if thittest(this, _root.zapperd) {
1J Properties " Zap.setRGB0D;

@] obiects setProperty (this, v, +5005
setProperty (root.zapper, _alpha, 500%

stopbrag

Telse {

setProperty (_root.zapper, _alpha, 1000;

1
‘% Ling 5: onChpE vent [enterFrame] {
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% EnterFrame ™ Mouseup " Keyup
™ Unload ™ Mouse moue " Data
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Terminologie ActionScriptu

Jako kterykoliv skriptovaci jazyk, také ActionScript pouziva specifickou terminologii vzhledem
ke specifickym pravidIim syntaxe. Nasleduijici seznam poskytuje Uvod do ddlezitych termind
ActionScriptu v abecednim poradi. Tyto fidici terminy a syntaxe, jsou probirdny detailngji
v Kapitole 2, ,Psani Skriptl v ActionScripu.“

Actions (Akce) jsou prikazy, které instruuji animaci, aby néco béhem prehravani vykonala.
Napfiklad gotoAndstop posila hraci hlavu na urcity snimek nebo popisek. V této knize jsou
terminy akce a pfikaz zaménitelné.

Arguments (Argumenty), také nazyvané parametry, jsou schranky umoznujici pfeddvani
a definici hodnot do funkci. Napfiklad, nasledujici funkce, nazvana welcome, pouzivd dvé
hodnoty obdrzené v argumentech firstName a hobby:
function welcome (firstName, hobby) {

welcomeText = “Ahoj,"“ +firstName+ ”Vidim, Ze té bavi” +hobby ;
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Classes (Tridy) jsou typy dat vytvarené, pro definovani nového typu objektu. Tridy objektu
definujeme konstrukéni funkci.

Constants (Konstanty) jsou prvky, které se neméni. Napfiklad konstanta TAB ma vzdy stejny
vyznam. Konstanty jsou uzite¢né pro porovnavani hodnot.

Constructors (Konstruktory) jsou funkce, které pouzivate pro definovani vlastnosti a metod tfidy.
Naprfiklad nasledujici kdd vytvari novou tfidu vytvofenim konstrukéni funkce nazvané Circle:
function Circle(x, y, radius) ({

this.x = x ;

this.y =y

this.radius = radius ;

}

Data types (Typy dat) jsou sady hodnot a operaci, které na nich mohou byt provedeny. String,
number, (Booleovské) hodnoty true a false, object a movie clip jsou typy ActionScript
dat. Vice detaild o téchto prvcich jazyka viz ,O typech dat*.

Events (Udalosti) jsou akce, které se objevuji pfi pfehravani animace. Nékteré priklady
udalosti: animace se natahuje a hraci hlava pfijede na urcity snimek, uzivatel klikne na tlacitko
nebo movie klip, nebo uzivatel pouzije klavesnici atd.

Expressions (Vyrazy) jsou Casti pfikazli produkujici néjakou hodnotu. Napriklad 2+2 je vyraz.

Functions (Funkce) jsou bloky znovu pouzitelného kddu, ktery mlze predavat argumenty
(parametry) a vracet hodnotu. Napfiklad, funkce getProperty, pfedava jméno viastnosti
a jméno instance movie klipu a vraci hodnotu vlastnosti. Funkce getVersion udava verzi
Flash PrehravacCe pravé prehravané animace.

Handlers (Ovladace) jsou specidlni akce, které ,,ovladaji“ nebo fidi udalosti jako mouseDown
nebo load. Napfiklad on (onMouseEvent) a onClipEvent jsou ActionScript ovliadace.

Identifiers (Identifikatory) jsou jména pouzivana pro uréeni proménné, vlastnosti, objektu,
funkce nebo metody. Prvni znak musi byt pismeno, dolni pomi¢ka ( _) nebo znak dolaru
($). Kazdy nasledujici znak musi byt pismeno, €islo, dolni pomli€ka ( _) nebo znak dolaru
($). Napfiklad firstName je jméno proménné.

Instances (Instance) jsou objekty patfici do urcité tfidy. Kazda instance tfidy obsahuje vSechny
vlastnosti a metody této tridy. VSechny movie klipy jsou instancemi s vlastnostmi (napfiklad
_alphaa_visibility) a metodami (napfiklad gotoAndPlay a getURL) MovieClip tfidy.
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Instance names (Jména instanci) jsou jedine¢na jména umoznuijici cilovani instanci movie
klipG ve skriptech. Napriklad symbol v Knihovné by mohl byt nazvan counter a dvé instance
tohoto symbolu v movie klipu by mohly mit jména instanci scorePlayerl a scorePlayer?2.
Nasledujici kdd nastavuje proménnou nazvanou score uvnitf kazdé instance klipu pouzitim
jmen instanci:

_root.scorePlayerl.score += 1

_root.scorePlayer2.score -= 1

Keywords (KliCova slova) jsou rezervovana slova, ktera maji zvlastni vyznam. Napfiklad
var je kliCové slovo pro ur€eni lokdlnich proménnych.

Methods (Metody) jsou funkce pfipojené k objektu. Metodou objektu se stava pouze pfipojena
funkce. Napfiklad v nasledujicim kddu, clear se stdva metodou objektu controller:
function Reset ( ) {

x _pos = 0 ;

y pos = 0 ;
}
controller.clear = Reset ;
contoller.clear ( ) ;

Objects (Objekty) jsou sbirky vlastnosti; kazdy objekt ma své vlastni jméno a hodnotu.
Objekty umoznuji dosahnout urcitého typu informace. Napriklad preddefinovany objekt
Date poskytuje informaci ze systémového Casu.

Operators (Operatory) jsou terminy, které prepocitavaji novou hodnotu nebo vice hodnot.
Napfiklad pripojeni operatoru ( + ) spojuje dvé nebo vice hodnot dohromady pro vytvoreni
nové hodnoty.

Target paths (Cilové cesty) jsou hierarchické adresy jmen movie klip instanci, proménnych
a objektl v animaci. Instanci klipu miZete pojmenovat v panelu Instance. Hlavni Casovd
osa bude mit vzdy jméno _root. Cilova cesta se pouziva k pfimé akci v movie klipu nebo
k ziskani nebo nastaveni hodnoty proménné. Napfiklad nasledujici pfikaz je cilovou cestou
k proménné volume uvnitf movie klipu stereoControl:
_root.stereoControl.volume

Properties (Vlastnosti) jsou atributy definujici objekt. Napfiklad _visibility je vlastnost
movie klipQ, ktera urCuje, zda je movie klip viditelny nebo je schovan.
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Variables (Proménné) jsou identifikatory, které obsahuji hodnoty jakéhokoliv typu dat.
Proménné mohou byt vytvorfeny, zménény a updatovany. Hodnoty, které jsou do nich
ukladany mohou byt znovu ziskdvany pro pouZziti v dalSich skriptech. V nasledujicim pfikladu
jsou proménnymi, identifikatory na levé strané od znaménka rovna se:

x = 5;

jmeno ="Pavel";

zakaznik.adresa ="Nova 25";

c = new Color (mcinstanceJdmeno) ;

Rozbor ukazkového skriptu

V této ukdzkové animaci, kde uzivatel tahne bug (Sténici) do bug zapper (likviddtoru
Sténic), Sténice se otodi, zEernd a spadne do likvidatoru Sténic. Animace je jeden snimek
dlouhd a obsahuje dva objekty, movie klip instanci §ténice a movie klip instanci likvidatoru
Sténic. Kazdy movie klip obsahuje také pouze jeden snimek.

5 zapper.fla:l H[=

o o

00 ] # @ A=A W

V animaci je pouze jeden skript; je pfipojen do instance bug jak je uvedeno dole v panelu
Object Actions:
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Event

[—oncTipEvent Cloadd {
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onclipEvent (enterFrame) {
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Oba objekty musi byt movie klipy, abyste jim mohli pfifadit jméno instance v panelu Instance
a manipulovat s nimi pomoci ActionScriptu. Jméno instance $ténice je bug a jméno
instance likviddtoru Sténic je zapper. Ve skriptu je na bug odkazovano jako na this,
protoze skript je pfipojen k bug a vyhrazené slovo this odkazuje na objekt, ktery ho vola.

Jsou zde dva ovladade onClipEvent se dvéma riznymi udalostmi: load a enterFrame. Akce
v pfikazu onClipEvent(load) se vykonaji pouze jednou a to, kdyz se movie stahne. Akce
v pifkazu onClipEvent(enterFrame) se vykonaji pokazdé, kdyz hraci hlava piijede do snimku.
Dokonce v jedno-snimkovém movie hraci hlava vstupuje opakované do tohoto snimku a skript
je opakované vykonavan. Nasledujici akce se objevi uvnitf kazdého ovladade onClipEvent:
onClipEvend(load) Akce startDrag ucini movie klip bug (Sté€nice) tazZitelny. Instance
objektu Color je vytvofena pomoci operatoru new a Color konstrukéni funkce Color,
a pfipojena k proménné zap:
onClipEvent ( load ) {

startDrag ( this, true ) ;

zap = new Color (this) ;

}

onClipEvent(enterFrame) Podminkovy vyraz if ohodnoti a zkontroluje akci hitTest,
zda se instance bug (this) dotykad instance bug zapper (_root.zapper). Jsou zde dva
mozné vystupy ohodnoceni, true nebo false:
onClipEvent ( enterFrame ) ({
if ( this.hitTest ( _root.zapper )) {
zap.setRGB (0) ;
setProperty ( _target, _y, _y + 50 ) ;
setProperty ( _root.zapper, _alpha, 50 ) ;
stopDrag ( ) ;
} else {
setProperty ( _root.zapper, _alpha, 100 ) ;

}

Jestlize akce hitTest je true, objekt zap vytvoreny udalosti load je pouzit pro nastaveni
barvy bug (Sténice) na ¢ernou. Vlastnost $ténice ( _y ) je nastavena na ni samotnou plus 50,
takZe bug (8ténice) spadne. Prlihlednost likvidatoru Sténic (zapper)(_alpha ) je nastavena
na 50, takZe je matny. Akce stopDrag zastavi taZzeni $ténice.

Jestlize akce hitTest je false, béZi v akci nasledujici pfikaz else, ve kterém je hodnota
_alpha likviddtoru Sténic (zapper) nastavena na 100. Toto zpUsobi, Ze likvidator $ténic se bude
blyskat, protoZe hodnota _alpha jde z plvodniho stavu (100) na pfepnuty stav (50) a zpét na
plvodni stav. Akce hitTest je false a pfikaz else se vykonaji poté, co bug (Sténice) byla
prepnuta a spadla.

Chcete-li animaci vidét hrat, podivejte se na Flash Help.

Pouzivani panelu Akce

Panel Akci umozZnuje vytvaret a editovat akce pro objekty nebo snimeky, za pouziti dvou
riznych rezim( editace. Akce mizete zvolit jiz predepsané ze seznamu Toolbox list,
taZzenim a pusténim je vkladat, nebo pouzivat tlaCitka pro jejich ruSeni a zménu. V Normal
Mode miiZete psat akce pouzitim poli parametrd (argumentd), které vas nasméruiji ke spravnym
argumentim. V Expert Mode mUiZete psat a editovat akce pfimo do textového boxu,
podobné jako psani skriptl v textovém editoru.

Zobrazeni panelu Akce:
Zvolte Window >Actions.

Zvoleni instance tlacitka nebo movie klipu ucini panel Akce aktivni. Nazev panelu Akce se zmeéni
na Object Actions, jestlize je zvoleno tladitko nebo movie klip a na panel Frame Actions,
jestlize je zvolen snimek.

Zvoleni editovaciho rezimu:
Se zobrazenym panelem Akce kliknéte na Sipku v pravém hornim rohu panelu pro zobrazeni
pop-up menu.

Zvolte Normal Mode nebo Expert Mode z pop-up menu.

Kazdy skript ma svij vlastni rezim. Skriptovat mizete napfiklad jednu instanci tladitka
v Normalnim Rezimu a jinou v Expert Rezimu. Pfepindni mezi zvolenym tlaCitkem prepina
také rezim panelu.

Normalni Rezim

V Normadlnim Rezimu mUzZete vytvéret akce zvolenim akci ze seznamu nazvaného Toolbox
list, umisténého na levé strané panelu,. Tento seznam obsahuje Basic Actions, Actions,
Operators, Functions, Properties a Objects. Kategorie Basic Actions obsahuje nej-
jednodussi Flash akce a je dostupnd pouze v Normalnim Rezimu. Zvolené akce jsou zap-
sdny na pravé strané panelu v seznamu Akci. Poradi piikazl akci mizete zrusit zménit,
nebo akce pridat; také muzete viozit parametry (argumenty) pro akce do pole parametrd
na spodni ¢asti panelu.

V Normalnim ReZimu, miZete pouZivat pro zruseni nebo zménu poradi prikazll v seznamu,
také kontrolu v panelu Akce. Kontroly jsou zvlasté uzite¢né pro ovladani akci snimku
a tlacitkovych akci, které se zkladaji z nékolika prikazd.
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2Zvoleni akce:
Kliknéte na kategorii Akce v Toolbox listu, pro zobrazeni akci v této kategorii.

Dvakrat kliknéte na akci nebo ji prfetahnéte do okna Skript.

Pouziti poli Parametru:
Pro zobrazeni poli, kliknéte na tlacitko Parameters v pravém spodnim rohu panelu Akce.

Zvolte akci a viozte nové hodnoty do poli Parameters, pro zménu parametrd existujicich akci.
Vlozeni cilové cesty movie klipu:

Kliknéte na tlac¢itko Target Path v pravém spodnim rohu panelu Akci, pro zobrazeni dialog

boxu Target Path.

Zvolte movie klip ze zobrazeného seznamu.

Pohyb pfikazu nahoru a dolli v seznamu:
Zvolte prikaz v seznamu Akci.

Kliknéte na sméroveé Sipky v pravém hornim rohu - Up nebo Down.

ZruSeni akce:
Zvolte prikaz v seznamu Akci.

Kliknéte na tlaCitko Delete (-).

Zména parametri existujicich akci:
Zvolte prikaz v seznamu Akci.

VloZte nové hodnoty do poli Parameters.
Pro zménu velikosti Toolbox listu, nebo seznamu Akci, udélejte jedno z nasledujicich:
Pretahnéte vertikdlni rozdélovaci sloupec, ktery se objevi mezi Toolbox listem

a seznamem AKci.

Dvakrét kliknéte na rozdélovaci sloupec pro schovani Toolbox listu; dvakrat kliknéte
opét na sloupec pro jeho znovuzobrazeni.

Kliknéte na Sipku sméfuijici vlevo, nebo vpravo, umisténou ve stfedu rozdélovaciho
sloupce, pro schovani, nebo znovuzobrazeni Toolbox listu.

Jestlize je Toolbox list schovédn, mizZete stale pouzivat jeho polozky pouZitim Add (+)
tlacitko vlevo nahore v panelu Akci.
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Expert Rezim

V Expert Rezimu vytvafite akce vkladanim ActionScriptu do textového boxu na praveé strané
panelu, nebo zvolenim akci z Toolbox listu. Akce mlzete editovat, vkladat jejich parametry,
nebo zrusit akce pfimo v textovém boxu, podobné jako vytvarite skripty v textovém editoru.

Expert Rezim umozriuje pokrocilym uZivateldm ActionScriptu editovat své skripty pomoci
textového editoru, jako by tvofili JavaScript nebo VBScript. Expert Rezim se li§i od Normainiho
Rezimu v téchto parametrech:

Zvoleni polozky pouzitim tlacitka Add (+) nebo v Toolbox listu viozi polozku do oblasti

textové editace.

Neobjevi se zadné pole parametrd.

V tlaCitkovém panelu funguje pouze tlacitko Add (+).

Sipky Up a Down na presouvani akci zCstavaji neaktivni.

+ Obiject Actions

@] Aetions nCT ipEvent Coad) {
@l Operators " Zap = naw Ccicr!tEE ;H
@] Functions nCl fpEuent Centerframed {
: if ChittestCthis, _root.zapperd) {
7] Properties zap.setRGE(DjC;h_
o zetPraperty CHhis, v, _y+
2] ojects setProperty (_root.zapper,
stopDrag 3 s
1=

=
setFroperty (root.zapper, _alpha, 1000%

5003
alpha, oy

e

< BT
Line 2 of 15, Cal 1
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Pfepinani mezi editovacimi rezimy
Zména editovacich rezim0 pfi tvorbé skriptu, mize zménit jeho formatovani. Z tohoto diivodu
je nejlepsi pouzivat jeden editovaci rezim na kazdy skript.

Kdyz prepinate z Normalniho na Expert Rezim, odsazeni a formatovani je zachovano.
Ackoliv skripty z Normalniho rezimu mdzete konvertovat i s chybami do Expert Rezimu,
nemUzete skripty s chybami exportovat.

Prepinani z Expert Rezimu do Normalniho Rezimu je trochu komplikované:
Kdyz pfepindte na Normalni Rezim, Flash preformatuje skript a rozebere jakékoliv
bilé misto a odsazeni, které jste pridali.

Jestlize prepindte na Normalni Rezim a potom zpatky na Expert Rezim, Flash
preformatuje skript podle jeho vzhledu v Normalnim Rezimu.

Skripty z Expert Rezimu obsahuijici chyby nemohou byt exportovany nebo konvertovany
na Normalni Rezim; jestlize se skript snazite konvertovat, obdrzite hlaSeni o chybe.

Piepinani editovacich rezimi:
Zvolte Normalni Rezim nebo Expert Rezim z pop-up menu vpravo nahofe panelu Akce.
Kontrolni znacka indikuje zvoleny rezim.

Nastaveni preferenci editovaciho rezimu:
Zvolte Edit > Preferences.

Zvolte General tab

V Casti Actions Panel zvolte Normalni Rezim nebo Expert Rezim z pop-up menu.
Pouzivani externiho editoru
Ackoliv Expert Rezim panelu Akci vam ddva dostatek moznosti pfi editaci ActionScriptu,
mUzete si také zvolit editaci skriptu mimo Flash. Pro pridani skriptd do Flashe, napsanych

v externim editoru, pouzijte akci include.

Napriklad nasleduijici pfikaz importuje soubor se skriptem:
#include "externisoubor.txt"

Text souboru se skriptem nahradi akci include. Pfi exportu movie, musi byt ale textovy
soubor pfitomen.
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Pfidani scénaii napsanych v externim editoru do scénafe uvnitf Flash:
Pretahnéte akci include z Toolbox listu do okna Skript.

Vlozte cestu k externimu souboru do boxu Path.

Cesta by méla byt relativni k FLA souboru. Napriklad jestlize myMovie.fla a externisoubor.txt
jsou ve stejné slozce, cesta by byla externisoubor.txt. Jestlize je externisoubor.txt v podslozce
nazvané Skripty, cesta by byla skripty/externisoubor.txt.

Vybér variant v panelu Akci

Panel Akci vam umoziiuje pracovat se scénari (skripty) riznymi zpGsoby. MiZete zménit
velikost fontu v okné Skript, miZete importovat textovy soubor obsahujici ActionScript
do panelu Akci a exportovat akce jako textovy soubor, mizZete hledat a nahrazovat text

chyb. Panel Akci zobrazuje zvyraznéni chyb syntaxe a nekompatibility verze Flash Prehravace.
Také zvyraznuje deprecated (neschvalené) nebo jiz nepreferované prvky ActionScript.

Tyto volby panelu Akci jsou dostupné jak v rezimu Normalnim, tak v Expert Rezimu, pokud
neni uvedeno jinak.

Zména velikosti fontu v okné Skript:
Z pop-up menu panelu Akci, vpravo nahore, zvolte Font Size.

Zvolte Small, Normal nebo Large.

Import textového souboru obsahujiciho ActionScript:
Z pop-up menu panelu Akci, vpravo nahore, zvolte Import from File.

Zvolte textovy soubor obsahuijici ActionScript a kliknéte na Open (Otevrit).

Poznamka: Skripty s chybami v syntaxi mohou byt importovany pouze v Expert Rezimu.
V Normalnim Rezimu obdrzite zpravu o chybe.

Export akci jako textového souboru:
Z pop-up menu panelu Akci, vpravo nahore, zvolte Export as File.

Zvolte umisténi, kde bude soubor ulozen a kliknéte na Save.
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Tisk akci:
Z pop-up menu panelu Akci, vpravo nahore, zvolte Print. Objevi se dialog box Print.

Zvolte Options a kliknéte na Print.
Poznamka: Vytisknuty soubor nebude zahrnovat informaci o plvodnim Flash souboru.
Je dobré zahrnout tuto informaci do comment akce ve skriptu.
Hledani textu ve skriptu, vybér volby z panelu Akci:
Zvolte Goto Line, pro prechod na urcity radek ve skriptu.

Zvolte Find pro nalezeni textu.
Zvolte Find Again pro opétovné hledani textu.
Zvolte Replace pro nalezeni a nahrazeni textu.

V Rezimu Expert, Replace prozkouma cely obsah skriptu. V Normalnim Rezimu, Replace
hleda a nahrazuje pouze text v poli parametru kazdé akce. Napfiklad v Normalnim Rezimu
nemUzete nahradit véechny akce gotoAndPlay akci gotoAndStop.

Poznamka: Pro hledani v aktudlnim seznamu Akci, pouZijte pfikazy Find nebo Replace.
Pro hledani textu v kazdém skriptu v celém movie pouzijte Movie Explorer. Vice informaci
viz Using Flash.

Zvyraznéni a kontrola syntaxe
Zvyraznéni syntaxe identifikuje urcité prvky ActionScriptu urcitymi barvami. Toto pomaha
pfi prevenci chyb syntaxe jako je chybné psani kliCovych slov.

Barevnostni rozli$eni syntaxe:
Keywords (Kli¢ova slova) a preddefinované identifikatory (napfiklad gotoAndStop,
play a stop) jsou modré.

Properties (Vlastnosti) jsou zelené.
Comments (Komentare) jsou fialové.

Strings (Retézce) obklopené dvéma uvozovkami jsou $edé.
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Zapnuti a vypnuti zvyraznéni syntaxe:
Zvolte Colored Syntax z pop-up menu vpravo nahofe v panelu Akci. Kontrolni znacka
indikuje, Ze je volba zapnuta. VSechny skripty ve vaSem movie budou barevné zvyraznény.

Je dobré zkontrolovat syntaxi pred exportovdnim movie. Chyby jsou uvedeny v okné
Output. Mlzete exportovat i movie, kiteré obsahuje chybné skripty, nicméné budete
varovani, ze skripty obsahujici chyby nebyly exportovany.

Kontrola aktudlni syntaxe skriptu:
Zvolte Check Syntax z pop-up menu vpravo nahore v panelu Akci.

O zvyrazhovani chybu

V Normalnim Rezimu jsou vSechny chyby syntaxe zndzornény ervenym pozadim v okné Skript.
Toto usnadriuje nalezeni problém0. Jestlize pohnete ukazatelem mysi na akci s nespravnou
syntaxi, tooltip zobrazi zprdvu o chybé spojenou s touto akci. KdyZ zvolite akci, chybové
hldseni je také zobrazeno v titulu panelu oblasti parametrd.

V Normadlnim ReZimu jsou vSechny export nekompatibility zndzornény Zlutym pozadim v okné
Skript. Napfiklad, jestlize export verze Flash Pfehrdvace je nastavena na Flash 4, ActionSctipt,
ktery je podporovan pouze Flash 5 Pfehrdvacem je zndzornén Zluté. Export verze je uréena
v dialog boxu Publish Settings.

Vsechny deprecated (neschvdlené) akce jsou zndzornény zelenym pozadim v Toolbox listu.
Neschvalené akce jsou zndzornény pouze tehdy, kdyz exportujete do Flash5 prehravace.

Nastaveni verze Flash Pfehravace pro export:
Zvolte File > Publish Settings.

Kliknéte na zdlozku Flash.
Zvolte export verzi z pop-up menu Version.
Poznamka: NemUzZete vypnout zndzornéni syntaxe chyb.

Ukdazani znazornéni neschvalené syntaxe:
Zvolte Show Deprecated Syntax z pop-up menu v panelu Akci.

Kompletni seznam vSech zprdv o chybdch viz Dodatek C, ,Hlaseni o Chybdch.“
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PFipojovani akci k objektum

Akce muzete pripojit, kdyz uZivatel klikne na tlacitko, nebo pres néj prejede ukazatelem,
nebo kdyz se stahuje movie klip nebo hraci hlava dosdhne urcitého snimku, akci mizete
pfipojit take k tlacitku nebo movie klipu. Pfipojite-li akci k instanci tlacitka nebo movie klipu;
dalSi instance symbolu nejsou ovlivnény. (Pfipojeni akce ke snimku, viz ,Pfipojovani akci
ke snimkdm®)

Kdyz pfipojujete akci k tlacitku, musite ji viozit dovnitf ovladace on (mouse event) a specifikovat
udalosti mysi nebo klavesnice, které akci spoustéji. Kdyz pfipojujete akci k tlacitku v Normalnim
ReZimu, ovladaC on (mouse event) je vlozen automaticky.

Kdyz pfipojujete akci k movie klipu (v expert rezimu), musite ji vlozit dovniti ovladace
onClipEvent a specifikovat v klipu udalosti, které akci spoustéji. Kdyz pfipojujete akci k movie
klipu v Normalnim Rezimu, ovlada¢ onClipEvent je vloZzen automaticky.

Nasledujici instrukce popisuiji jak pripojit akce k objektdim pouZitim panelu Akci v Normalnim
Rezimu.

Kdyz jste pfipojili akci, pro testovani zda funguije, pouzijte pfikaz Control > Test Movie.
VeétSina akci nebude fungovat v Editovacim Rezimu.

Pripojeni akce k tlacitku nebo movie klipu:
Zvolte tlacitko nebo movie klip instanci a zvolte Window > Action.

Jestlize volbou neni tla¢itko, movie klip instance nebo snimek, nebo jestlize volba
zahrnuje vice objektl, panel Akce je matny.

Zvolte Normalni Rezim z pop-up menu vpravo nahore v panelu Akce Objektu.

Pro pfipojeni akce udélejte jedno z nasleduijicich:
Kliknéte na slozku Action v Toolbox listu na levé strané panelu Akci. Dvakrat kliknéte
na akci pro jeji pfidani do seznamu akci na praveé strané panelu.

Pretahnéte akci z Toolbox listu do seznamu akeci.

Kliknéte na tlacitko Add (+) a zvolte akci z pop-up menu.

Pouzijte klavesové zkratky zapsané vedle kazdé akce v pop-up menu.

@ Play b
@
@
@

| Stop
| Toggle High Guality

I Stop All Sounds =

Mo action selected.

Mo Parameters.

V polich Parametry ve spodni ¢asti panelu zvolte potfebné parametry pro akci.

Parametry se liSi v zavislosti na akci, kterou zvolite. Detailni informace o pozadovanych
parametrech pro kaZzdou akci viz Kapitola 7, ,,ActionScript Slovnik“. Pro vlioZeni Cilové cesty
pro movie klip do pole Parametr kliknéte na tlacitko Target Path v dolnim pravém rohu panelu
Akce. Vice informaci viz Kapitola 4, ,Prace s Movie Klipy.*

Opakujte kroky 3 a 4 pro pfipojeni potfebnych dodate¢nych akci.

Testovani akce objektu:
Zvolte Control > Test Movie.

24 ACTION SCRIPT - FLASH 5

KAPITOLA 1 25



PFipojovani akci ke snimkum

Abyste pfiméli movie udélat néco, kdyz dosahne kli¢ového snimku, pfipojite akci snimku
do kli¢ového snimku. Napfiklad pro vytvoreni smycéky v Casové ose mezi snimky 10 a 20,
byste pfipojili ndsledujici akci snimku do snimku 20:

gotoAndPlay ( 10 ) ;

Je dobré umistit akce simku do oddélené vrstvy. Snimky s akcemi zobrazi malé a v Casové ose.

Po pripojeni akce, zvolte Control > Test Movie pro testovani funkénosti. Vétsina akci nefunguje
v Editovacim Rezimu.

Ndsleduijici instrukce popisuji, jak pfipojit akce snimku pomoci pouZiti panelu Akci v Normdlinim
Rezimu. (Informace o pfipojovani akci k tlacitku nebo movie klipu viz ,Pfipojovani akce

nebo metody*.)

Pripojeni akce ke klicovému snimku:
Zvolte kliovy snimek v Casové ose a zvolte Window > Action.

Jestlize zvoleny snimek neni kli¢ovy, akce je pripojena k predchozimu klicovému snimku. Jestlize
volbou neni snimek, nebo jestlize volba zahrnuje vice klicovych snimkd, panel Akce je matny.

Zvolte Normalni Rezim z pop-up menu vpravo nahore v panelu Akce Snimku.
Pro pfipojeni akce udélejte jedno z nasledujicich:
Kliknéte na slozku Action v Toolbox listu na levé strané panelu Akci. Dvakrat kliknéte
na akci pro jeji pfidani do seznamu akci na pravé strané panelu.
Pretahnéte akci z Toolbox listu do seznamu akci.
Kliknéte na tla¢itko Add (+) a zvolte akci z pop-up menu.
Pouzijte kldvesové zkratky zapsané vedle kazdé akce z pop-up menu.
V polich Parametry v horni ¢asti panelu zvolte potfebné parametry pro akci.
Pro pfipojeni dodateénych akci zvolte dalsi klic¢ovy snimek a opakujte krok3.

Testovani akce snimku:
Zvolte Control > Test Movie.
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Tvorba Skripta v ActionScriptu

Pri tvorbé skriptd mizete zvolit rliznou Uroven sloZitosti a pouziti detailu. Pro jednoduché akce
pouzivejte panel Akci v Normdlnim Rezimu a tak vlastné vytvareijte skripty vybérem z moznosti
obsaZenych v menu a seznamech akci. Nicméné, jestlize chcete pouzit ActionScript pro tvorbu
Podobneé jako jiné skriptovaci jazyky, je ActionSctipt tvoren komponenty, jako jsou preddefinované
objekty a funkce a také umoznuje vytvaret vlastni objekty a funkce. ActionScript dodrzuje
sva vlastni pravidla syntaxe, rezervuje si klicova slova, poskytuje operatory a umoznuje
pouzivat proménné pro ukladdni a znovu ziskani informaci.

Syntaxe a styl ActionSctiptu se velice podobaji Java Scriptu. Flash 5 konvertuje ActionScripty
napsané v jakékoliv pfedchozi verzi Flash.

Pouziti syntaxe ActionScriptu

ActionScript ma pravidla gramatiky a interpunkce, urcujici pouzivani znakd a slov k tvorbé skript(
a poradi v jakém mohou byt napsany. Napriklad v anglic¢tiné tecka konci vétu. V ActionSctiptu
konéi vétu strednik.

Nasleduji véeobecnd pravidla, kterd se uplatriuji v celém ActionScriptu. Vétsina termind
ActionScriptu md také své vlastni individualni pozadavky; pokud se tyCe pravidel pro specifické
terminy, podivejte se na né v Kapitole 7, ,ActionScript Slovnik.“

Dot syntaxe (TeCkova syntaxe)

V ActionScriptu je tecka (.) pouzivana k uréeni vlastnosti nebo metod, vztahuijicich se k objektu
nebo movie klipu. Je také pouzivana pro identifikaci cilové cesty k movie klipu nebo proménné.
Vyraz dot syntaxe zacina jménem objektu nebo movie klipu nasledovanych teckou a konci
vlastnosti, metodou, nebo proménnou, kterou chcete specifikovat.

Napriklad vlastnost _x movie klipu indikuje pozici movie klipu po ose x na Scéné. Vyraz
ballMC._x referuje o vlastnosti _x movie klip instance ballMcC.

Dal$im prikladem je vlastnost submi t, kterd je nastavena v movie klipu form, ktery je uhnizdén
uvnitf movie klipu shoppingCart.

Vyraz shoppingCart.form.submit = true nastavuje proménnou submit, instance
form, na true.
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Znazornéni vyrazu a metody objektu nebo movie klipu je naprosto shodné. Napriklad
metoda play instance bal1lMc posune hraci hlavu v Casové ose ballMc jako v ndsledujicim
piikazu:

ballMC.play() ;

Dot syntaxe také pouziva dva specidini aliasy, _root a _parent. Alias _root odkazuje
na hlavni Casovou osu. Alias _root se pouZiva k vytvofeni absolutni cilové cesty. Napfiklad
nasledujici pfikaz volda funkci buildGameBoard v movie klipu functions na hlavni
Casové ose:

_root.functions.buildGameBoard () ;

Alias _parent se pouziva jako odkaz na movie klip, ve kterém je uhnizdén aktudini movie klip.
Také se _parent pouZiva k vytvofeni relativni cilové cesty. Napfiklad, jestlize movie klip dog
je uhnizdén uvniti movie klipu animal, nasledujici pfikaz instance dog fika rodiCovskému
klipu animal, aby zastavil:

_parent.stop() ;

Viz Kapitola 4, ,Prace s Movie Klipy.“

Slash syntaxe

Slash syntaxe byla pouzivana ve Flash 3 a 4 pro urovani cilové cesty k movie klipu nebo
proménné. Tato syntaxe je sice stdle podporovana Pfehrava¢em Flash 5, ale jeji pouzivani neni
doporucovano. Ve slash syntaxi jsou pro urceni cesty k movie klipu nebo proménné, misto
tecek pouzivdna slashes (lomitka). Pri ur¢eni proménné predchdzi proménnou dvojtecka:
myMovieClip/childMovieClip:myVariable

Stejna cilova cestu napsana v dot syntaxi:
myMovieClip.childMovieClip.myVariable

Slash syntaxe byla nej¢astéji pouzivdna s akci tellTarget, jejiz pouZiti jiz také neni
doporucovano.

Poznamka: Akce with je nyni preferovana pred akci tellTarget, protoZe je kompatibilngjsi
s dot syntaxi. Vice informaci viz Kapitola 7, ,ActionScript Slovnik.“

Slozené zavorky
Prikazy ActionScriptu jsou seskupeny do blok( sloZzenymi zavorkami (}), jako v nasleduijicim skriptu:
on (release) {

myDate = new Date();

currentMonth = myDate.getMonth() ;

Viz ,Pouziti akci“.
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Stfedniky

Prikaz ActionScriptu je ukoncCen stfednikem, ale pokud stfednik zapomeneme zapsat,
Flash bude stéle uspésné se skriptem pracovat. Napfiklad nasleduijici vyrazy jsou zakonceny
stfedniky:

column = passedDate.getDay() ;

row = 0;

Stejné prikazy by mohly byt napsany bez zakon&eni stfedniky:
column = passedDate.getDay ()
row = 0

Zavorky
Kdyz definujete funkci, umistéte jakékoliv argumenty do zavorek:
function myFunction (name,age,reader) {

Kdyz volate funkci, vioZte vSechny argumenty k ni pfifazené do zavorek:
myFunction ("Steve",10,true);

Zéavorky také mUzete pouzit pro predepsani priorit prfednosti, nebo pro usnadnéni ¢teni
ActionScript vyrazd. Viz ,Priority operator(“.

V dot syntaxi se také pouzivaji pro ochodnoceni vyrazu na levé strané od teCky. Napriklad
v ndsledujicim prikazu zavorky zpUsobi, Ze new Color (this) bude ohodnocen a vznikne
objekt s novou barvou:
onClipEvent (enterFrame) {

(new Color (this)) .setRGB (0xffffff)) ;

Kdybyste nepouzili zavorky a kéd byl ohodnocen shodné, museli byste do néj pridat
néjaké prikazy:
onClipEvent (enterFrame) {

myColor = new Color(this);

myColor.setRGB (Oxffff£ff) ;
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Mala a velka pismena

V ActionScriptu jsou case citliva (citliva na mald a velka pismena) pouze klicova slova;
ve zbytku ActionScriptu mizete pouZzivat mald i velka pismena, podle vlastniho uvazeni.
Napriklad nasledujici vyrazy jsou ekvivalentni:

cat.hilite = true;

CAT.hilite = true;

Nicméné, je dobrym zvykem pro usnadnéni identifikace jmen funkci a proménnych pfi ¢teni
a orientaci v kédu ActionScriptu, dodrzovat odpovidajici konvence psani velkych a malych
pismen, pouzivané v této knize,.

Jestlize nepouzivate spravné psani velkych a malych pismen u kli¢ovych slov, vas scénar
bude obsahovat chyby. Kdyz je zapnuta Barevna Syntaxe v panelu Akci, klicova slova napsana
spravnymi pismeny jsou modra. Vice informaci viz ,Klicova slova“ a ,Zvyraznéni a kontrola
syntaxe®.

Komentare
Pro popis a sledovani priibéhu akci a pro pridavani poznamek ke snimkové nebo tlacitkové
akci v panelu Akce, pouzijte vyraz comment.

Jestlize pracujete v kolektivu, nebo nékomu poskytujete ukazky skriptu, jsou komentare
také uzite¢né pro poskytovani informaci dal$im vyvojaraim.

Kdyz zvolite akci comment, jsou do skriptu vlozeny znaky //. Dokonce i jednoduché
skripty jsou s pozndmkami o jejich tvorbé snadnéji pochopitelné:

on (release) {
// vytvofit novy objekt Datum
myDate = new Date() ;
currentMonth = myDate.getMonth() ;
// konvertovat &islo mésice na jméno mésice
monthName = calcMonth (currentMonth) ;
year = myDate.getFullYear();
currentDate = myDate.getDat ()
}

Komentare se v okné Skript objevi riizové znazornény. Mohou mit jakoukoliv délku bez ovlivnéni
velikosti exportovaného souboru a nemusi dodrzovat pravidla syntyxe ActionScriptu,
nebo klicova slova.
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Klicova slova

ActionScript rezervuje slova pro specifické pouziti uvnitf jazyka, takZe je nemUZete pouzit
jako proménné, funkce nebo popisy jmen. V nasledujici tabulce je seznam vSech
ActionScript kliCovych slov:

Vice informaci o specialnich kli¢ovych slovech viz Kapitola 7, ,ActionScript Slovnik.*

break for new var

continue function return void

delete if this while

else in typeof with
Konstanty

Konstanta je vlastnost, jejiz hodnota se nikdy neméni. Konstanty jsou zapsany v Actions
toolbox a v Kapitole 7, ,ActionScript Slovnik,” vSechny velkymi pismeny.

Napfiklad konstanty BACKSPACE, ENTER, QUOTE, RETURN, SPACE a TAB jsou vlastnosti
objektu Key a odkazuji na klavesy klavesnice. Pro testovani, zda uzivatel tiskne klavesu
Enter, pouzijte nasledujici prikaz:
if (keycode () == Key.ENTER) {

alert = "Are you ready to play?"

controlMC.gotoAndStop (5) ;

O typech dat

Typ dat popisuje druh informace, kterou miZe obsahovat proménnd nebo prvek. Existuji
dva typy dat: primitivni a odkazujici. Primitivni typy dat — string, number a Boolean - maji
konstantni hodnotu a proto mohou obsahovat aktudlni hodnotu prvku, ktery reprezentuiji.
Odkazujici typy dat - movie klip a objekt - maji hodnotu, ktera se mize ménit a proto
obsahuji odkazy na aktudlni hodnotu prvku. Proménné obsahuijici primitivni typy dat se
chovaji odlisné v uritych situacich nez ty, které obsahuji odkazujici typy. Viz ,Pouziti
proménnych ve skriptu®.

Kazdy typ dat ma sva vlastni pravidla a jejich seznam je zde. Odkazy jsou zahrnuty pro typy
dat, které jsou rozebrany detailnéji.
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String (Retézec)

Retézec je sekvence znak( jako jsou pismena, &isla a interpunkéni znaménka. Retézce
vlozite do ActionScript vyrazu jejich vnorenim do jednoduché nebo dvojité citace (uvozovek).
S fetézci se zachazi jako se znaky, ne jako s proménnymi. Napfiklad nasledujici vyraz ,L7¢
je fetézec:

favoriteBand = "L7";

Pro slouceni nebo spojeni dvou fetézcl mizete pouzit operator Add (+). ActionScript
zachdzi s mezerami na zaCatku nebo konci fetézce jako s Casti fetézce. Nasledujici vyraz
zahrnuje mezeru za ¢arkou:

greeting = "Welcome," + firstName;

Ackoliv ActionScript nerozliSuje mezi velkymi a malymi pismeny v odkazech na proménné,
jména instanci a popisy snimkd, pismenné znaky jsou case citlivé. Napriklad, nasledujici dva
vyrazy umistuiji rlzny text do uré¢enych textovych poli proménnych, protoze ,Hello“ a ,HELLO®
jsou pismenné fetézce.

"Hello";
invoice.display = "HELLO";

invoice.display

Pokud vkladate do fetézce uvozovky, uvedte je zpétnym lomitkem (\ ). Toto je nazvano
~escaping” znak. Jsou zde i dalSi znaky, které mohou byt prezentovany v ActionScriptu
pouze ve specidlnich escape sekvencich. Nasledujici tabulka poskytuje unikové znaky
ActionSctipt:

Escape sekvence Predstavovany znak

\b Backspace (ASCII 8)

\f Form-feed (ASCII 12) (posuv stranky)

\n Line-feed (ASCII 10) (novy tadek)

\r Carriage return (ASCII 13) (navrat kurzoru)
\t Tab (ASCII 9) (tabulator)

" Dvojity znak citace

" Jednoduchy znak citace

\\ Backslash (zpétné lomitko)

\000 - \377 Byte specifikovany v octal

\x00 - \xFF Byte specifikovanid v hexadecimal

\u0000 - \uFFFF 16-ti bit Unicode znak specifikovany v hexadecimal

Number (Cisla)

Cisla jsou data bud celodiselna, nebo s pohyblivou &arkou. S &isly mlizete manipulovat
pomoci aritmetickych operator scitani (+), odéitani (-), nasobeni (*), déleni (/), procento (%),
inkrement (++) a dekrement (--). Pro praci s Cisly mizete také pouZit metody preddefinovaného
objektu Math. Nasledujici pfiklad pouzivd metodu sqrt (Ctvercovy kofen) pro navrat
Ctvercového korene na &islo 100:

Math.sqrt(100) ;

Viz ,Numerické operatory“.

Boolean (Booleovské)
Booleovska hodnota je takova hodnota, kterd je bud true nebo false. ActionScript také,
pokud je to vhodné konvertuje hodnoty true a false, na 1 a 0. Booleovské hodnoty jsou
nejCasteji pouzivany s logickymi operatory v téch pfikazech ActionScriptu, které délaji
srovnani pro kontrolu toku skriptu. Napfiklad v nasledujicim scénafi movie hraje, jestlize
proménna password je true:
onClipEvent (enterFrame) {
if ((userName == true) && (password == true)) {
play();

}
Viz ,Pouziti pfikazl ,if“ a ,Logické operatory“.

Object (Objekt)

Obijekt je soubor vlastnosti, znichz kazda ma jméno a hodnotu. Hodnota vlastnosti mize
byt jakykoliv typ dat. To umoznuje upravovat objekty uvnitf sebe a nebo je ,uhnizdit” jeden
do druhého. Pro specifikaci objekt( a jejich vlastnosti pouZivejte operator dot (. ). Napriklad
v nasledujicim kddu je hoursWorked vlastnosti weeklyStats, kterd je vlastnosti employee:
employee.weeklyStats.hoursWorked

Pro dosazeni a manipulaci se specifickymi druhy informaci, mdzete pouzit ActionScriptem
preddefinované objekty. Napriklad objekt Math ma metody vykondvajici matematické operace
s Cisly, ktera jste v nich definovali. Teto priklad pouziva metodu sqrt:

squareRoot = Math.sqrt(100) ;

Objekt ActionScriptu MovieClip, ma metody umoznuijici kontrolu instanci movie klip symbolu
na Scéne. Tento priklad pouzivd metody play a nextFrame:
mcInstanceName.play () ;

mc2InstanceName.nextFrame () ;
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Pro lepsi organizaci informaci v animaci si mizZete vytvorit vlastni objekty. Pri pridavani
interaktivity do animace, je tfeba spousta rliznych druhd informaci: napriklad jméno uzivatele,
rychlost miCe, jména poloZek v nakupni karté, pocet nataZzenych snimkd, uzivatelGv zip kod
a napf. skuteCnost, ktera klavesa byla naposledy stisknuta. Vytvoreni specidlnich objektd
umozriuje organizovat tyto informace do skupin, usnadnit tvorbu a znovupouZiti skriptd.
Vice informaci viz ,PouZiti specidlnich objektd*“.

Movie clip (Movie klip)

Movie klipy jsou symboly, které mohou hrat svou animaci v dal§i Flash animaci. Jsou to pouze
typy dat odkazujici na graficky prvek. Typy dat movie klipu umozriuiji kontrolu symbold
movie klipu pouzivajicich metody MovieClip objektu. Metody miZete volat pouZitim operatoru
dot (.):

myClip.startDrag(true) ;
parentClip.childClip.getURL(,http://www.macromedia.com/support/“+product) ;

O proménnych

Variable (Proménna) je schranka, ktera obsahuje informaci. Samotna schranka je stdle stejna,
av$ak jeji obsah se miZze ménit. Zménou hodnoty proménné v priibéhu animace mizete
nahrat a ulozit informace o tom, co uzivatel udélal, nahrat hodnoty, které se zménily béhem
pfehravani animace, nebo ohodnotit zda je néjaka podminka pravdiva nebo ne.

Je dobré vzdy pripojit proménné hodnotu hned pfi jeji prvni definici. Toto nazyvame zavedeni
(deklarace) proménné a je Casto provadéno v prvnim snimku animace. Zavedeni proménné,
usnadriuje v prlibéhu animace sledovani a porovnavani hodnoty proménné.

Proménné mohou obsahovat jakékoliv typy dat: Cislo, fetézec, Booleanské, objekt nebo
movie klip. Typy dat, které proménna obsahuje ovliviiuji, jak se méni hodnota proménné,
pfi jejim zavedeni do skriptu.

Typy dat a informaci, které mlzete ukladat do proménné jsou napriklad: URL, jméno uZivatele,
vysledek matematické operace, pocet, kolikrat se objevila néjaka udalost nebo zda bylo
kliknuto na tlacitko. Kazdé movie a movie klip instance ma své vlastni nastaveni proménnych,
s tim, Ze kazdd proménna ma svoji vlastni hodnotu nezavislou na proménnych v jinych
movies nebo movie klipech.
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Pojmenovavani proménnych
Jméno proménné musi dodrzovat tato pravidla:
Musi to byt identifikator.

Nemlze to byt klicové slovo nebo Booleovské funkce (true nebo false).
Musi byt unikatni ve svém rozsahu. (Viz ,Rozsah proménné“)

Zapis proménné

Ve Flashi nemusite vyslovné (explicitn€) definovat proménnou tak, Zze obsahuje bud &islo,
fetézec nebo jiny typ dat. Flash urCuje typ data proménné az kdyz je proménna pfipojena:
x = 3;

Ve vyrazu x = 3, Flash ohodnoti prvek na pravé strané operatoru a urci, zda je to typ Cisla.
Pozdéji se typ x miZe zménit; napfiklad x = ,ahoj“ zméni typ x na fetézec. Proménna,
které nebyla pfifazena Zadna hodnota ma typ undefined (nedefinovana).

ActionScript convertuje typy dat automaticky, pokud to vyraz vyZaduje. Napfiklad, kdyZ viozite
hodnotu do akce trace, trace automaticky konvertuje hodnotu na fetézec a posila ji do okna
Output. Ve vyrazech s operatory konvertuje ActionScript typy dat podle potfeby; napfiklad
jestlize je pouzit fetézec, operator + oCekava, ze dalSim operandem bude fetézec:
,Dalsi v radé, je ¢&islo“+7

ActionScript konvertuje Cislo 7 na fetézec ,7“ a pfida ho nakonec prvniho fetézce:
,Dalsi v radé, je éislo 7%

Pri odstrarfiovani zavad ve skriptech, je uzite¢né urcit typy dat ve vyrazu nebo proménné
k pochopeni, pro¢ se skript chova ur¢itym zplsobem. MizZete to udélat pomoci operdtoru
typeof:

trace (typeof (variableName)) ;

Pro konvertovani fetézce na numerickou hodnotu pouzijte funkci Number. Pro konvertovani
numerické hodnoty na fetézec pouzijte funkci String. Viz Kapitola 7, ,,ActionScript Slovnik®.
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Rozsah proménné

,Ro0zsah“ proménné odkazuje na oblast, ve které proménna existuje a mize na ni byt
odkazovano. Proménné v ActionScriptu mohou byt bud globalni nebo lokalni. Globalni
proménna je sdilena véemi Casovymi osami; lokalni proménnd je dostupnd pouze uvnit?
svého vlastniho bloku kddu (mezi slozenymi zavorkami).

Pro deklarovani lokalni proménné uvnitf skriptu, miZete pouzit pfikaz var. Napfiklad
proménné i a j jsou Casto pouzivany jako pocitadla smycek. V nasledujicim pfikladé je i pouzito
jako lokalni proménna; existuje pouze uvnitf funkce makeDays:
function makeDays () {

var i

for(i = 0; i < monthArray [month]; i++) {

_root.Days.attachMovie ("DayDisplay", i, i + 2000);

_root.Days [i].num = i + 1;
_root.Days [i]._x = column *_root.Days [i]._width;
_root.Days [i]._y = row *_root.Days [i]._height;

column = column + 1;
if (column == 7) {

column = 0O;
row = row + 1;

Lokalni proménné také mohou pomoci pfi prevenci proti kolizim jmen (shodé jmen),
které mohou zpUsobit chyby ve v animaci. Napriklad, jestlize pouzivate name jako lokalni
proménnou, mUzete ji pouzit pro uloZeni jména uzivatele v jednom kontextu a jméno movie
klip instance v jiném kontextu; protoze tyto proménné pobézi v oddélenych prostorech,
nedojde zde k zadna kolizi.

V praxi je dobré pouzivat lokalni proménné v téle funkce tak, aby funkce mohla fungovat
jako nezavisla ¢ast kodu. Lokalni proménnou Ize zménit pouze uvnitf jejiho bloku kddu.
Jestlize vyraz ve funkci pouziva globdlni proménnou, pfikaz zvendi funkce mize zménit
jeho hodnotu a ta zmeéni celou funkci.
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Deklarace (zavadéni) proménné
Pro deklaraci globalnich proménnych pouzijte akci setVariable nebo operator (=).
Obéma metodami dosahnete stejnych vysledkd.

Pro deklaraci lokalnich proménnych pouzijte pfikaz var uvnitf téla funkce. Lokalni proménné
jsou seskupeny do bloku a jejich ucinnost konéi na konci bloku. Lokalnim proménnym
nedeklarovanym uvnitf bloku kon¢i ucinnost na konci jejich skriptu.

Poznamka: Akce call také vytvari novou lokalni proménnou, deklarovanou do volaného
skriptu. Jestlize volany skript skonci, deklarovana lokalni proménnd zmizi. Nicméné, tato akce
neni doporucovana, protoze akce call byla nahrazena akci with, kterd je kompatibilnéjsi
s dot syntaxi.

Pro testovani hodnoty proménné pouzijte akci trace, ktera posila hodnoty do okna
Output. Napriklad, trace (hoursWorked) posle v testovacim rezimu hodnotu proménné
hoursWorked do okna Output. Kontrolovat a nastavit hodnoty proménné v testovacim
rezimu miZete také v Debuggeru (Odstrariovaci zavad). Vice informaci viz Kapitola 6,
»Odstrafiovani zavad ActionScriptu.”

Pouziti proménnych ve skriptu

Proménnou musite ve skriptu deklarovat jesté pred jejim pouzitim ve vyrazu. Jestlize
pouzijete nedeklarovanou proménnou, jako v nasledujicim prikladé, hodnota proménné
bude undefined (nedefinovana) a skript vygeneruje chybu:

getURL (myWebSite) ;

myWebSite = "http://www.shrimpmeat.net";

Vyraz deklarujici proménnou myWebsSite musi byt prvni, aby proménna v akci getURL
mohla byt nahrazena jeji hodnotou.

Hodnotu proménné mizete ve skriptech zménit nékolikrat. Datové typy které proménna
obsahuije, ovliviuji, jak a kdy se proménna zméni. Zakladni typy dat (fetézce a Cisla) jsou
nahrazeny hodnotou. To znamena, ze aktualni obsah proménné je pfifazen k proménné.

V nasledujicim prikladé je x nastaveno na 15 a hodnota je zkopirovdna do y. Kdyz je x
zménéno na 30, hodnota y zlstava 15, protoze y nehleda hodnotu x , ale obsahuje jiz dfive
pfifazenou hodnotu x.

var x = 15;

var y = X;

var x = 30;
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V dal$im prikladé, proménna in ma plvodni hodnotu 9, aktudlni hodnota je vioZzena do funkce
sqrt a nove ziskana hodnota je 3:
function sqrt(x){

return x * x;

var in = 9;
var out = sqrt (in);

Hodnota proménné in se nezméni.

Datovy typ objekt m(iZze obsahovat tak velké mnozZstvi mnohdy slozitych informaci, Ze proménna
tohoto typu v sobé neuchovava samotnou proménnou, ale pouze odkaz na ni. Tato reference
je néco jako alias, ktery se odkazuje na obsah proménné. Kdyz proménna potfebuje znat
svou hodnotu, vyZzada si odkaz pfislusny obsah a vrati odpovéd, aniz by se hodnota presunula
do proménné.

Nasleduje priklad odkazu na obsah:
var myArray = ["tom","dick"];
var newArray = myArray;
myArray [1l] == "jack";

trace (newArray) ;

Predchozi kéd vytvari objekt Array nazvany myArray, se dvéma prvky. Deklarovana proménna
newArray ma hodnotu myArray. KdyzZ je druhy prvek myArray zménén, ovlivni to kazdou

proménnou s odkazem na nej. Akce trace by posilala [, tom"“, ,jack"“] do okna Output.

V dal$im prikladé obsahuje myArray objekt Array, takze je poslan funkci zeroArray.
Funkce zeroArray zméni obsah pole v myArray.

function zeroArray (array) {

var 1i;
for (i = 0; i < array.length; i++){
array [i] == O;
}
}
var myArray = new Array();
myArray [0] == 1;
myArray [l] == 2;
myArray [2] == 3;

var out = zeroArray (myArray)
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Funkce zeroArray pfijme objekt Array jako argument a nastavi vSechny prvky tohoto
pole na 0. MiZe pole zménit, protoZe pole obsahuje referenci.

Odkazy odvolavajici se na jiné objekty nez jsou klipy animace, se nazyvaji hard references
(tvrdé odkazy), protoze pokud na objekt existuje odkaz, neni mozno jej smazat. Odkaz na klip
animace je zvlastni druh odkazu a nazyva se soft references (mékky odkaz). Mékké odkazy
nevyzaduji, aby dany objekt existoval. Pokud je klip animace zruSen akci jako je napfiklad
removeMovieClip, nebudou veskeré odkazy na néj odkazané fungovat.

Pouziti operatoru pro manipulaci s hodnotami ve vyrazech
Expression (Vyraz) je jakykoliv pfikaz, ktery Flash ohodnoti a pfidéli mu hodnotu. Vyraz
mUZete vytvorit kombinaci operatord a hodnot, nebo volanim funkce. Pfi psani vyrazu v panelu
Akce v Normalnim RezZimu se ujistéte, Ze box Expression je v panelu Parametrd zaskrtnuty,
jinak bude pole misto vyrazu obsahovat pismennou hodnotu fetézce.

G
| Ling 1: losdhovie [curentKite + ", 0); Expression
AL [ourserine o |J:‘, [—— box
Losuion: [Lewl =] [0 =
Naiiastoz: [Oont send |
& oo

Operatory jsou znaky, které urluji, jak kombinovat, srovnavat nebo upravovat hodnoty
vyrazu. Prvky, mezi kterymi operator lezi a se kterymi manipuluje se nazvyvaji operandy.
Napriklad v nasledujicim vyrazu operator + pfidavd numerickou hodnotu k hodnoté
proménné foo; foo a 3 jsou operandy:

foo + 3

o kazdém operatoru stejné tak jako o specialnich operatorech nespadajicich do téchto
kategorii, viz Kapitola 7, ,ActionScript Slovnik.*
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Priorita operatoru

Pfi pouziti dvou nebo vice operdtord v jednom vyrazu, maji nékteré operatory prednost
pfed jinymi. ActionScript dodrzuje presnou hierarchii k ur¢ovani priority operatord.
Napfiklad, ndsobeni je vzdy provedeno pred scitanim, ale polozky v zavorkach maiji pfednost
pred nasobenim. Bez zavorek ActionScript provadi nasobeni jako prvni:

celkem = 2 + 4 * 3 ;

Vysledek je 14.

Kdyz zavorky obsahuji operaci scitani, ActionScript vykona nejprve scitani:
celkem = (2 + 4 ) * 3 ;

Vysledek je 18.

Tabulka vSech operatorll a jejich prednosti viz Dodatek A, ,Priorita Operator( a Poradi
vyhodnocovani.”

PoFadi vyhodnocovani operatoru

Jestlize maji dva nebo vice operatorl stejnou prioritu, poradi ve kterém budou vykondny
uréuje jejich poradi vyhodnocovani, které mlze byt bud L - zleva doprava nebo R - zprava
doleva. Napfriklad operator nasobeni ma poradi vyhodnocovani L - zleva doprava, proto
nasledujici dva vyrazy jsou ekvivalentni:

celkem 2 * 3 * 4;

celkem = (2 * 3) * 4;

Tabulka vSech operatorl a jejich poradi vyhodnocovani viz Dodatek A, ,Priorita Operator(
a Poradi vyhodnocovani.”

Aritmetické (numerické) operatory

Aritmetické (numerické) operatory scitaji, odcitaji, nasobi, déli a provadi dalsi aritmetické
operace. Zavorky a znak minus jsou také aritmetické operatory. Nasleduje tabulka numerickych
operatorl ActionScriptu:

Operator Vykonana operace

+ S&itani

* Nasobeni

/ Déleni

% Procento

- odéitani

++ Inkrement (zvysSeni)
-= Dekrement (sniZeni)

Srovnavaci (relacni) operatory
Srovndvaci operatory porovnavaji hodnoty vyraz(l a ddvaji Booldnskou hodnotu (true nebo
false). Tyto operatory jsou nejbéznéji pouzivany ve smyckdach a v podminkovych vyrazech.
V nasledujicim prfikladé, jestlize proménna skore je 100, natdhne se urcity .swf soubor,
jinak se natahne jiny .swf soubor:
if (skore == 100){

loadMovie ("vitez.swf",5) ;
lelse {

loadMovie (“porazeny.swf",5) ;

}

Nasleduje tabulka srovndvacich (relacnich) operator:

Operator Vykonana operace
< MensSi nez
> Vétsi nez
<= Mens$i nebo rovno
>= Vétsi nebo rovno

Retézcové operatory

Operator +, v fetézcich spojuje dva fetézcové operandy. Napfiklad, nasledujici piikaz pridava:
"Congratulations," to "Donna!":

"Congratulations," + "Donna!"

Vysledek je "Congratulations, Donna!". JestliZze je pouze jeden operand operatoru
+ fetézec, Flash konvertuje dal$i operand také na retézec.

Srovnavaci operatory >, >=, < a <= maji pfi operacich v fetézcich specialni ur€eni. Tyto
operatory porovnavaji dva fetézce a urcuiji, ktery je prvni v abecednim poradi. Srovndvaci
operatory porovnavaji fetézce pouze tehdy, jestlize oba operandy jsou retézce. Jestlize je pouze
jeden z operand fetézec, ActionScript konvertuje oba operandy na ¢isla a vykona numerické
srovnani.

Poznamka: Psani dat ActionScriptu ve Flash 5 umozriuje pouzit stejné operatory pro riizné
druhy dat. Pfi exportu animace jako Flash 4 soubor, neni nutné pouzivat Flash 4 fetézcové
operatory (napfiklad, eq, ge, a 1t).
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Logické operatory
Logické operatory porovnavaji Boolednské (true a false) hodnoty a davaiji treti Boolednskou
hodnotu. Napfiklad, jestlize dva operandy maji hodnotu true, logicky operator AND ( && )
da true. Jestlize jeden nebo oba operandy maji hodnotu true, logicky operator OR ( | | )
da false. Logické operatory jsou Casto pouzivany ve spojeni se srovnavacimi operatory
pro ureni podminky akce if. Napfiklad v nasledujicim scénafi, jestlize jsou oba vyrazy
true, akce if bude provedena:
if ((i > 10) && (_framesloaded > 50)){

play();

Nasleduje tabulka logickych operator(:

Operator Vykonana operace
&& Logické AND
11 Logické OR
! Logické NOT

Bitové operatory

Prestoze v Actionscriptu jsou vSechna &isla s pohyblivou ¢arkou, bitové operatory vyzaduiji
Ciselné operandy s celoCiselnou hodnotou. Operuiji s témito celociselnymi operandy za pouziti
32-bitovych celych Cisel, se kterymi se snadnéji pracuje. Pfesnost vykonané bitové operace
zavisi na operatoru, avSak vSechny bitové operace ohodnocuji kaZzdou &islici s pohyblivou
¢arkou oddélené pro pocitani nové hodnoty.

Nasleduje tabulka bitovych operator ActionScriptu:

Operator Vykonana operace

& Bitové And

| Bitové Or

~ Bitové Xor

~ Bitové Not
<< Posuv vlevo
>> Posuv vpravo se znaménkem
>>> Posuv vpravo s doplnénim nulou
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Tyto operatory jsou pouzivany pro nizkourovriovou manipulaci s dvojkovymi €isly a nejsou
pfi programovani bézné pouzivany. Pro lepsi pochopeni je vhodné se obeznamit s dvojkovymi
(binarnimi) Cisly a binarni reprezentaci desitkovych celych Cisel.

Srovnavaci a pFiFazovaci operatory

K urCovani, zda jsou hodnoty nebo identity dvou operand( sobé rovny, pouZivejte operator
rovnost ( ==). Toto srovnani dava Booleovskou (true nebo £alse) hodnotu. Jestlize jsou
operandy fetézce, Cisla nebo Booleovské hodnoty, jsou porovnavany hodnotou. Jestlize
jsou operandy objekty nebo pole, jsou porovnavany odkazem.

Stanoveni hodnoty proménné pomoci operatoru pfifazeni ( = ):
password = “Sk8tEr“;

Tento operator Ize také pouzit pro stanoveni nékolika proménnych ve stejném vyrazu.
V nasledujicim vyrazu hodnota b je pfifazena hodnotam c a d:
a=b=c=4d;

Pro kombinovani operaci pouzivejte slozené pfifazovaci operatory. SloZzené operatory
se vykonaji na obou operandech a potom ur¢i novou hodnotu prvniho operandu.
Napriklad nasledujici vyrazy jsou ekvivalentni:

x += 15;

x = x + 15;

Nasleduje tabulka srovnavacich a pfifazovacich operator(:

Operator Vykonana operace

= Rovnost

1= Nerovnost

= Ptifazeni

+= P¥idani a p¥ifazeni

-= Odecteni a pifirazeni

*= Nasobeni a p¥ifazeni

%= Procento a p¥ifazeni

/= Déleni a p¥ifazeni

<<= Bitovy posun vlevo a pfifazeni

>>= Bitovy posuv vpravo a pififazeni

>>>= Bitovy posuv vpravo s doplnénim nulou a pfifazeni

= Bitové Xor a pfifazeni

|= Bitové Or a pfifazeni

&= Bitové And a pififazeni
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Operatory tecka a pristupové pole
Operator teCka ( . ) a operator pfistupové pole ( 1) Ize pouzivat pro dosazeni jakychkoliv
preddefinovanych nebo specidlnich viastnosti objektu ActionScriptu, v€etné viastnosti movie klipu.

Operator tecka pouziva jméno objektu na levé strané a jméno vlastnosti nebo proménné
na pravé strané. Jméno vlastnosti nebo proménné nem(ize byt fetézec nebo proménnag,
ktera je ohodnocovana jako fetézec; musi to byt identifikator. Nasledujici pfiklady pouzivaji
teCkovy operator:

year.month = "June";

year.month.day = 9;

Operator teCka a operator pfistupové pole vykonavaji stejnou roli, ale operator teCka bere
identifikator jako jeho vlastnost a operator pristupoveé pole ohodnocuje jeho obsahy na jméno
a potom urcéuje hodnoty této pojmenované vlastnosti. Napriklad nasledujici dva radky kodd
pfisuzuji stejnou proménnou velocity v movie klipu rocket:

rocket.velocity;

rocket [,velocity"“];

Operator pristupové pole mizete pouzit pro dynamické nastaveni a ziskdni jmen instanci
a promeénnych. Napiiklad v ndsledujicim kddu je vyraz uvnitf operatoru []ohodnocen a vysledek
ohodnoceni je pouzit jako jméno proménné, ktera bude ziskana z movie klipu name:
name [ ,mc“ + i ]

Jestlize ovladate slash syntaxi (Flash 4), miZete udélat stejnou véc pouZzitim funkce eval:
eval (,mc“& i) ;

Operétor pfistupové pole mize byt také pouzit na levé strané urcujiciho prikazu. Toto vam
umozriuje dynamicky nastavit jména instanci, proménnych a objekt(:

name [index] = ,Gary"“;

Opét je to ekvivalentni k nasleduijici slash syntaxi (Flash 4):
Set Variable : “name:“ & index = ,Gary"

Operétor pristupové pole mize také vkladat sam sebe pfi simulaci vicerozmérnych poli.
chessboard [row] [column]

Toto je ekvivalentni k nasledujici slash syntaxi:
eval (,chessboard/“ & row & “:“ & column)

Poznamka: Jestlize chcete psat skripty které jsou kompatibilni s Flash 4 Prehravacem,
mUzete pouZit akci eval s operatorem add.

Pouzivani akci

Akce jsou prikazy nebo povely ActionScriptu. Nékolik akci uréenych pro stejny snimek
nebo objekt vytvaii skript. Akce mohou hrat nezavisle na sobé, jako v nasledujicich prikazech:
swapDepths (,,mcl", “mc2") ;

gotoAndPlay (15);

Také mlizete ,uhnizdit* akce pouzitim jedné akce uvnitf jiné; toto umozriuje akcim navzdjem
se ovliviiovat. V nasledujicim prikladé akce if, fikd akci gotoAndPlay kdy se ma vykonat:
if (i > 25){

gotoAndPlay (10) ;
}

Akce mohou posunovat hraci hlavu po Casové ose (gotoAndPlay), kontrolovat tok skriptu
vytvarenim smycek (do..while), nebo logickych podminek (i£), nebo vytvofit nové funkce
a proménné(function, setVariable). Ndsleduje tabulka vSech ActionScript akci:

Action Action

break onClipEvent
call play

comment playFrame
continue prevScene
delete print
do..while printAsBitmap
duplicateMovieClip removeMovieClip
else return

else if setVariable
evalute setProperty
for startDrag
for..in stop
fsCommand stopAllSounds
function stopDrag
getURL swapDepths
gotoAndPlay, gotoAndStop tellTarget

if toggleHighQuality
ifFrameLoaded stopDrag
include trace
loadMovie unloadMovie
loadVariables var

nextFrame, nextScene while

on
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Syntaxe a pouziti prikladd kazdé akce viz Kapitola 7, ,ActionScript Slovnik.“

Poznamka: V této knize je termin ActionScriptu action (akce) synonymum s JavaScript
terminem statement (prikaz).

Zapis cilové cesty

Pri pouziti akce, ktera kontroluje movie klip nebo natazenou animaci, musite specifikovat
jeho jméno a jeho adresu nazvanou target path (cilova cesta). Nasledujici akce maji jednu
nebo vice cilovych cest jako argumenty:

loadMovie duplicateMovieClip
loadVariables removeMovieClip
unloadMovie print

setProperty printAsBitmap
startDrag tellTarget

Napfiklad akce 1loadMovie ma argumenty URL, Location a Variables. URL je umisténi
animace, kterou chcete natahnout. Umisténi je cilova cesta, do které bude animace natazena.

loadMovie (URL ,Location ,Variables)

Poznamka: Argument Proménné neni v tomto prikladé pozadovan.

Nasledujici pfikaz natahuje URL http://www.mySite.com/myMovie.swf do instance bar na
hlavni Casové ose ( _root); _root.bar je cilova cesta;

loadMovie ("http://www.mySite.com/myMovie.swf", root.bar) ;

V ActionScriptu identifikujete movie klip jménem jeho instance. Napfiklad v nasledujicim

vyrazu vlastnost _alpha movie klipu pojmenovaného star je nastavena na 50% viditelnost:
star._alpha = 50;
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Pojmenovani movie klipu jménem instance:
Vyberte movie klip na Scéné.

Zvolte Window > Panels > Instance.
Vlozte jméno instance v poli Name.

Identifikace natazené animace:
PouZijte _levelX, kde X je Cislo Urovné urCené v akci loadMovie, kterd animaci natahuije.

Napfiklad animace natazena do urovné 5 ma jméno instance _level5. V nasledujicim
pfikladu je animace natazena do urovné 5 a jeho viditelnost je nastavena na false:

onClipEvent (load) {
loadMovie ("myMovie.swf",5) ;

}

onClipEvent (enterFrame) {
_level5. visible = false;

Vlozeni cilové cesty klipu:
Kliknéte na tlacitko Insert Target Path v panelu Akci a ze seznamu, ktery se objevi zvolte
movie klip.

Vice informaci o psani cilovych cest viz Kapitola 4, ,Prace s Movie Klipy.*
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Kontrola toku ve skriptech
ActionScript pouziva akce if, for, while, do..while a for..in pro vykonani akci
v zavislosti na skutecnosti, zda existuje podminka.

Pouziti pfikazu “if”

Prikazy, které kontroluji, zda je podminka true nebo £alse zacinaji terminem if. Jestlize
podminka existuje, ActionScript vykona pfikaz ktery nasleduje. Jestlize podminka
neexistuje, ActionScript sko¢i na dalsi pfikaz mimo bloku kddu.

Pro optimalizaci kddu zkontrolujte nejprve podminky.

Nasledujici priklad testuje nékolik podminek. Termin else if specifikuje alternativni varianty
provedeni, jestlize jsou pfedchozi podminky false.

if ((password == null) || (email == null)) {
gotoAndStop ("reject") ;
} else {

gotoAndPlay (“startMovie ”);

Opakovani akce
ActionScript mize opakovat akci nékolikrat, nebo zatimco existuje urcitd podminka.
Pro vytvoreni smycCek pouzijte akce while, do.while, for a for...in.

Opakovani akce, zatimco existuje podminka:
Pouzijte pfikaz while.

SmycCka while ohodnocuje vyraz a vykonava kdd v téle smycky, jestlize je vyraz true.
Pokazdé, kdyz je v télé pfikaz vykonadn, vyraz je ohodnocen znovu. V nasledujicim priklade
se smycCka vykonava Ctyrikrat:
i=4
while (i > 0){

myMC.duplicateMovieClip ("newMC" + i, i);

i--;
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Prikaz do..while mUzete pouzit k vytvoreni stejného druhu smycky jako je smycka while.
Ve smycce do..while je vyraz ohodnocen na spodku bloku kddu, takze smycka vzdy bézi
minimalné jednou:
i=4
do {

myMC.duplicateMovieClip ("newMC" + i, i);

i--;
} while (i > 0);

Opakovani akce pomoci pouziti zabudovaného poéitadla:
Pouzijte pfikaz for.

VétSina smycCek pouziva pro kontrolu kolikrat uz smycka bézela, néjaky typ pocitadla.
Mdzete deklarovat proménnou a napsat piikaz, ktery zvySuje nebo snizuje proménnou
pokazdé, kdyz se smycCka vykond. V akci for jsou pocitadlo a prikaz, ktery zvySuje pocitadlo,
soucasti akce:
for (i = 4; i > 0; i--) {

myMC.duplicateMovieClip ("newMC" + i, i +10);

Pro vytvoreni smycky prostfednictvim ditéte movie klipu nebo objektu:
Pouzijte pfikaz for. .in.

Dité zahrnuje dalsi movie klipy, funkce, objekty a proménné. Nasledujici priklad pouzivd
akci trace pro tisk vysledk( do okna Output:
myObject ={name:'Joe',age:25,city:'San Francisco'};
for (propertyName in myObject) {
trace ("myObject has the property:"+propertyName +",with
the value:"+myObject [propertyName]) ;
}

Tento priklad posila vysledky do okna Vystup:

myObject has the property: name,with the value: Joe

myObject has the property: age,with the value: 25

myObject has the property: city,with the value: San Francisco
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MoZna budete chtit, aby vas skript provadél iteraci na urcitém typu ditéte - napf. jen na détech
klipd animace. To mlzete provést pomoci for. . .in ve spojeni s operdtorem typeof.

for (name in myMovieClip) ({

if (typeof (myMovieClip [name]) == "movieclip") {
trace ("Mam détsky movie klip nazvany" + name);

}
Poznamka: Prikaz for. . .in iteruje vlastnosti objektl v prototypu fetézce iterovaného
objektu. Pokud je prototyp détského objektu rodi¢, bude for. . .in iterovat takeé vlastnosti

rodice.

Vice informaci o kazdé akci viz Kapitola 7, ,,ActionScript Slovnik.”

Pouzivani preddefinovanych funkci

Funkce je blok kddu ActionScriptu, ktery miZe byt znovu pouzit kdekoliv v animaci. Jestlize
vlozite do funkce urcité hodnoty (argumenty), funkce bude operovat a pracovat s témito
hodnotami. Funkce mize také hodnoty vrétit. Flash ma preddefinované funkce, které umoznuiji
dosahnout urcitych informaci a vykonat urcité ukoly, jako je detekce kolizi (hitTest ), ziskani
hodnoty naposledy stisknuté klavesy ( keycode ) a ziskani Cisla verze Flash Prehravace
hosticiho animaci ( getVersion ).

Volani funkce

Funkce méZete volat v jakékoliv Casové ose z jakékoliv Casové osy, véetné natazené animace.
Kazda funkce ma své vlastni charakteristiky a nékteré po vas pozaduiji vlozit urcité hodnoty.
Jestlize vlozite vice argumentd neZ funkce poZaduje, hodnoty navic jsou ignorovany.
Jestlize naopak nevlozite pozadovany argument, prazdné argumenty jsou uréeny typem
dat undefined (nedefinovano), ktery mize zpUsobit chyby pfi exportu skriptu. Pfi volani
funkce musi byt funkce ve snimku dosazeném hraci hlavou.

Nasleduje seznam Flash preddefinovanych funkci:
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Boolean localToGlobal
escape maxscroll
eval newline
false number
getProperty parseFloat
getTimer parselnt
getVersion random
globalToLocal scroll
hitTest String

int targetPath
isFinite true

isNaN unescape
keycode

Poznamka: Retézcové funkce nejsou doporuéovany a proto nejsou zapsané ve vyse

uvedené tabulce.

Volani funkce v Expert Rezimu:
Pouzijte jméno funkce a zadejte poZadované argumenty dovnitf zavorek. Nasleduijici priklad

vola funkci initialize, kterd nepozaduje zadné argumenty:

initialize ();

KAPITOLA 2




Volani funkce v Normalnim Rezimu:
Pouzijte funkci evalute. VioZte jméno funkce a pozadované argumenty do pole Expression.
Frarme s B

51 Frame Actions 2 |»

+ - Frame Actions

@ dowhile -

(@ duplicatehovieClip

far

| forin
FECommand
| function

) getlRL

@@

Line 1: initialize();

Expression |imlial\ze[]

Pro volani funkce na jiné Casové ose pouzijte cilovou cestu. Napiiklad, pro volani funkce
calculateTax, kterd byla deklarovana v instanci functionsMovieClip, pouzijte
nasledujici cestu:

_root.functionsMovieClip.calculateTax (total) ;

Poznamka: Uvniti zavorek zaddveijte jakékoliv argumenty.

Vice informaci o kazdé funkci, v€etné nedoporucenych retézcovych funkci viz Kapitola 7,
»ActionScript Slovnik.*

Vytvareni specialnich funkci

Mdzete definovat funkce, aby na prifazenych hodnotach vykonavaly sérii pfikazl. Vase
funkce také mohou vracet hodnoty. Jakmile je funkce definovana, mdze byt volana z jakékoliv
Casové osy, véetné Casové osy nahrané animace.

Funkci si mlzete predstavit jako "¢ernou skrinku". Kdyz je funkce voldna, je ji pfifazen vstup
(argumenty). Vykona nékolik operaci a pak generuje output (vracenou hodnotu). Dobre
napsané funkce ma vhodné umisténé komentare o svém vstupu, vystupu a Ucelu. Tak nemusi
uzivatel funkce presné rozumét tomu, jak funkce funguije.

Definovani funkce
Funkce, podobné jako proménné, jsou pripojeny k movie klipu, ktery je definuje. Kdyz je funkce
redefinovdna, nova definice nahradi starou.

Pro definovani funkce pouzijte akci function, nasledovanou jménem funkce a zvolenymi
argumenty, které maji byt do funkce vlozeny, a pfikazy ActionScriptu, které indikuji co funkce
dela.

Nasleduje funkce pojmenovand Circle s argumentem radius:
function Circle (radius) {

this.radius = radius;

this.area = Math.PI * radius * radius;

Poznamka: Kli¢ové slovo this pouzité v téle funkce, je odkaz na movie klip, ke kterému
funkce patfi.

Funkci mlzete také definovat vytvorenim function literal (doslovné funkce). Doslovna
funkce je nepojmenovana funkce, ktera je deklarovdna ve vyrazu misto v pfikazu.
Doslovnou funkci miZete pouzit pro definovani funkce, ziskani jeji hodnoty a jeji pfipojeni
k proménng, v jednom vyrazu:

area. (function() {return Math.PI * radius * radius;}) (5);

Vkladani argumentu do funkce
Argumenty jsou prvky, na kterych funkce provadi svij kdd. (V této knize jsou zaménitelné pojmy
argument a parametr.) Napfiklad nasledujici funkce ma argumenty initials a finalScore:
function fillOutScorecard(initials, finalScore) {

scorecard.display = initials;

scorecard.score = finalScore;

Pri volani funkce musi byt pozadované argumenty do funkce vliozeny. Funkce nahradi
zadanymi hodnotami argumenty v definici funkce. V tomto prikladé je scorecard jméno
instance movie klipu; display a score jsou inputova textova pole v instanci. Nasleduijici
volani funkce urCuje proménné display hodnotu ,JEB™ a proménné score hodnotu 45000:
fillOutScorecard(, JEB"“,45000) ;

Argument initials ve funkci £il1l0utScorecard je podobny lokalni proménné; existuje,
zatimco je funkce voldna a prestava existovat, kdyz funkce kon¢i. Jestlize zapomenete
na argumenty v prdbéhu volani funkce, jsou tyto zapomenuté argumenty vkladany jako
undefined (nedefinované). Jestlize poskytnete argumenty navic, které nejsou pfi volani
funkce pozadovany v deklaraci funkce, jsou tyto argumenty ignorovany.
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Pouziti lokalnich proménnych ve funkci

Lokalni proménné jsou cennymi nastroji pro organizovani kddu a usnadnéni porozumeni.
Kdyz funkce pouZiva lokalni proménné, mize své proménné ukryt pfed vSemi ostatnimi
skripty v animaci; lokalni proménné jsou platné pro télo funkce a jsou znieny, kdyz funkce
konci. Jakékoliv argumenty pfifazené k funkci budou také povazovany za lokalni proménné.

Poznamka: Jestlize upravujete globdlni proménné ve funkci, pouZijte pro dokumentaci
téchto Uprav skriptové komentare.

Vraceni hodnot z funkce
Pro vraceni hodnot funkci miZete pouzit akci return. Tato akce zastavi funkce a nahradi
ji hodnotou akce return. Pokud Flash nenarazi na akci return pfed koncem funkce,
je vracen prazdny fetézec. Napriklad nasledujici funkce vraci mocninu argumentu x.
function sqgr(x) {

return x * x;

}

Nékteré funkce vykondvaiji série Ukoll bez vraceni hodnoty. Naptiklad, ndsledujici funkce
inicializuje sérii globalnich proménnych:
function initialize (){

boat_x= root.boat._x;

boat_y=_ root.boat._y;

car_x= root.car._x;

car_y= root.car._y;

}

Volani funkce

Pro volani funkce pomoci panelu Akci v Normalnim Rezimu pouzijte akci evaluate.
Zadejte pozadované argumenty uvniti zavorek. Funkci mliZete volat na jakékoliv Casové
ose z jakékoliv Casové osy, véetné natazené animace. Napiiklad nasledujici pfikaz vold
funkce sqr v movie klipu MathLib na hlavni Casové ose, vkladd argument 3 a ukladd
vysledek v proménné temp:

var temp = _root.MathLib.sqr(3);

Ve Flash 4 m(zete napsat skript pro volani funkce do snimk{ az za konec animace a volat
ji jménem snimku pomoci akce call. Napfiklad, snimek nazvany initialize a obsahujici
skript, byste mohli volat nasledovné:

call(,initialize");

Tento typ skriptu neni skute¢na funkce, protoZze nemiZe vkladat argumenty a nemUzZe zaddvat
hodnotu. Ackoliv akce call je stadle funkéni, ve Flash 5 jeji pouziti neni doporucovano.
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Pouzivani preddefinovanych objektu

Pro dosazeni a ziskani urcitych druhd informaci, mizete pouZit pfeddefinované objekty.
Vétsina preddefinovanych objektd ma methods (metody) (funkce prfipojené k objektu),
které zadavate pro obdrzeni hodnoty nebo k provedeni akce. Napfiklad objekt Date poskytuje
informaci ze systému hodin a objekt Sound umozriuje kontrolovat zvukoveé prvky v animaci.

Nékteré preddefinované objekty maji vlastnosti, jejichz hodnoty mizZete Cist. Napfiklad
objekt Key, ma konstantni hodnoty reprezentuijici klavesy na klavesnici. Kazdy objekt ma své
vlastni charakteristiky a schopnosti vyuzitelné v animacich. Nasleduje seznam preddefinovanych
objekt(:

Array Number
Boolean Object
Color Selection
Date Sound

Key String
Math XML
MovieClip XMLSocket

Instance movie klipd jsou v ActionScriptu prezentovany jako objekty. Metody preddefinovanych
movie klipl mlzete volat stejné, jako byste volali metody jakéhokoliv jiného ActionScript
objektu.

Detailni informace o kazdém objektu viz Kapitola 7, ,ActionScript Slovnik.*
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Vytvareni objektu

Existuji dva zplsoby pro vytvoreni objektu: operdtor new a inicializacni operétor objektu
({}). Operator new mUlzete pouzit pro vytvoreni objektu z preddefinované tridy objektu
nebo z uzpUlsobené tfidy objekt. Inicializacni operator objektu ({}) mdlzete pouzit pro
vytvoreni objektu obecného typu Obijekt.

Pfi tvorbé objektu s pouzitim operatoru new, musi byt pouzita konstrukéni funkce.
(Konstrukéni funkce je jednoduse funkce, specifikujici typ objektu, ktery ma byt vytvoren.)
Preddefinované objekty ActionScriptu jsou v zdsadé prepsané konstrukéni funkce. Novy
objekt konkretizuje nebo vytvari kopii objektu a pridava ji vSechny vlastnosti a metody
tohoto objektu. Toto je podobné jako pretaZzeni movie klipu z Knihovny na Scénu. Napfriklad
nasledujici vyrazy konkretizuji objekt Date:

currentDate = new Date();

Metody nékterych preddefinovanych objektl Ize volat i bez jejich konkretizaci. Naptiklad
nasledujici vyraz vola Math objekt, metodu random:

Math.random () ;

Kazdy objekt pozadujici konstrukéni funkci ma odpovidajici prvek v panelu nastroji Akci;
napfiklad new Color, new Date, new String atd.

Vytvofeni objektu pomoci operatoru new v Normalnim Rezimu:
Zvolte setVariable

Vlozte identifikdtor do pole Name.

VloZte new Object, new Color atd. do pole Value.
VloZte argumenty pozadované konstrukéni funkci v zavorkach.

Zatrhnéte box Expression pole Value.
Jestlize nezatrhnete box Expression, celd hodnota bude pismenny fetézec.

V nasledujicim kdédu je objekt ¢ vytvoren z konstruktoru Color:
¢ = new Color (this) ;

Poznamka: Jméno objektu je proménnd s typem dat pfipojenych k ni.
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Dosazeni metody v Normalnim Rezimu:
Zvolte akci evaluate.

Vlozte jméno objektu do pole Expression.
Vlozte vlastnost objektu do pole Expression.
Pouziti operatoru inicializator objektu ({}) v Normalnim Rezimu:
Zvolte akci setVariable.
Vlozte jméno do pole Proménng; toto je jméno nového objektu.

Vlozte jméno, vlastnosti a pary hodnot oddélené dvojteCkami uvnitf operatoru inicializator
objektu ({}).

Napfiklad v tomto pfikazu jsou jména vlastnosti radius a area, jejich hodnoty jsou 5
a hodnota vyrazu:
myCircle = {radius:5, area: (PI * radius * radius)};

Vyraz v zdvorkdch bude ohodnocen a obdrZzena hodnota je hodnota proménné area.

Pole a inicializatory objektu mdzete ,uhnizdit, jako v tomto vyrazu:
new Object = {name:“John Smith“, projects:[,Flash"“,“Dreamweaver“]};

Detailni informace o kazdém objektu viz Kapitola 7, ,ActionScript Slovnik.*

Pfipojeni vliastnosti objektu

Pro pripojeni hodnoty vlastnosti v objektu pouZzijte operator teCka ( . ). Jméno objektu je na levé
strané teCky a jméno vlastnosti na prave strané. Napriklad v nasledujicim skriptu je myObject
objektem a name je vlastnosti:

myObject.name

Pro pfipojeni hodnoty k vlastnosti v Normalnim Rezimu pouzijte akci setVariable:
myObject.name = ,Allen“;

Pro zménu hodnoty vlastnosti pfipojte novou hodnotu:
myObject.name = ,Homer"“;

K pfipojeni vlastnosti objektu mliZzete pouzit i operator pfistupové pole ( [1 ). Viz ,TeCkové
operatory a operatory pfistupoveé pole*.
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Volani metody objektu

Metodu objektu miZete volat s pouzitim operatoru tecka, ndsledovaného metodou.
Napriklad nasleduijici pfiklad vola metodu setVolume objekiu Sound:

s = new Sound(this);

s.setVolume (50) ;

Pro volani metody preddefinovaného objektu v Normalnim rezimu pouzijte akci evaluate.

Pouziti objektu MovieClip

Ke kontrole instanci movie klipu symbolu na Scéné, mlzete pouZit metody preddefinovaného
objektu MovieClip,. Nasledujici pfiklad spousti pfehravani instance dateCounter:
dateCounter.play ()

Detailni informace o objektu MovieClip viz Kapitola 7, ,ActionScript
Slovnik."“

Pouziti objektu Array

Objekt Array (Pole) je bézné pouzivany preddefinovany ActionScript objekt, ktery uchovava,
nebo obsahuje Cislovana data. Kazdy Cislovany udaj se nazyva prvek pole a &islo pfifazené
prvku se nazyva index. To je uzitetné pro ukladani a znovuziskani urcitych typl informaci,
jako jsou seznamy nebo sekvence pohybu ve hre.

Prvky objektu Array mizete pfipojit stejné, jako byste pripojovali viastnost jakéhokoliv objektu:
move[0] ==,a2a4d“;

move[l] == ,h7h5"%;
move[2] == ,blc3";
move[1l00] ==,e3ed™;

Pfi volani druhého prvku pole pouzijte vyraz move [1].

Objekt Array ma preddefinovanou vlastnost 1ength, coz je hodnota poétu prvkl v poli.
Kdyz je prvek objektu Array pfipojen a index prvku je pozitivni celé &islo jako index >= length,
length je automaticky aktualizovan na index + 1.
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Pouziti specialnich objektu

Pro organizaci informaci ve skriptech, pro jejich snadnéjsi skladovani a pfistup k nim,
mUZete vytvorit specidlni objekty pomoci definovani viastnosti a metod objektu. Poté, co vytvorite
hlavni objekt nebo ,tfidu”, miZete pouZit nebo ,konkretizovat“ kopie (tzn. Instance) tohoto
objektu. Toto vdm umozni znovu pouzit kdd a neménit velikost souboru.

Objekt je komplexni typ dat obsahujici Zadnou nebo vice vlastnosti. Kazda vlastnost, jako
proménna, ma jméno a hodnotu. Vlastnosti jsou pfipojeny k objektu a obsahuji hodnoty,
které mohou byt ménény a znovu ziskavany. Tyto hodnoty mohou byt jakéhokoliv typu dat:
fetézec, Cislo, Booleanské, objekt, movie klip nebo nedefinované. Nasledujici vlastnosti
jsou rdizné typy dat:

customer.name = "Jane Doe";
customer.age = 30;
customer .member = true;

customer.account.currentRecord = 000609;
customer.mcInstanceName._ visible = true;

Vlastnost objektu mliZe byt také objekt. Ve 4. Radku predchoziho piikladu je account
vlastnost objekiu customer a currentRecord je vlastnost objektu account. Typ dat vlastnosti
currentRecord je Cislo.

Vytvareni objektu

Pro vytvoreni objektu z konstrukéni funkce, mlzete pouzit operator new. Konstrukéni funkci
je vzdy davano stejné jméno jako je typ objektu, ktery vytvari. Napfiklad konstruktor, ktery vytvari
objekt account by byl nazvan Account. Nasledujici vyraz vytvafi novy objekt z funkce
nazvané MyConstructorFunction:

new MyConstructorFunction (argumentl,argument2,...argumentN) ;

KdyzZ je volana MyConstructorFunction, Flash propusti schovany argument this,
ktery je odkazem na objekt vytvarejici MyConstructorFunction. Pfi definici konstruktoru,
this umozni odkazovat na objekty, které konstruktor vytvori. Napriklad nasleduijici je konstrukéni
funkce, ktera vytvari kruh:
function Circle (radius) {

this. radius = radius;

this.area = Math.PI * radius * radius;

}
Konstruktory funkci jsou bézné pouzivany jako zadani metody objektu.

function Area() {
this.circleArea = Math.PI * radius * radius;
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Objekt pouzity ve skriptu musi byt pfipojen k proménné. Pro vytvoreni objektu novy kruh
s polomérem 5 pouzijte operator new a pfipojte ho k lokdlni proménné myCircle:
var myCircle = new Circle(5);

Poznamka: Objekty maji stejné umisténi jako proménné, ke kterym jsou pripojeny.
Viz ,Umistovani proménné“.

Vytvareni dédi¢nosti

VSechny funkce maiji vlastnost prototype, ktera je vytvorena automaticky pfi definovani
funkce. Jestlize pouzivate konstrukéni funkci pro vytvoreni nového objektu, vSechny viastnosti
a metody konstrukéni vlastnosti prototype se stavaji vlastnostmi a metodami viastnosti
_proto_ nového objektu. Vlastnost prototype indikuje nastavené hodnoty vlastnosti pro
objekty vytvofené touto funkci. Pfedédvani hodnot pouZitim vlastnosti _proto_ a prototype
je nazvano dédi¢nost.

Dédicnost postupuje podle definitivni hierarchie. Kdyz volate vlastnost nebo metodu objektu,
ActionScript hledd v objektu, zda takovy prvek existuje. Jestlize neexistuje, ActionScript
hleda ve viastnosti objektu _proto_informaci(ocbject. proto_). JestliZe volana vlastnost
neni vlastnosti objektu _proto_, ActionScript hledéd v object._proto_. proto_.

Je bézné pripojovat metody k objektu jejich ur¢enim do vlastnosti objektu prototype.
Nasledujici kroky popisuji, jak definici provést:
Definujte konstrukéni funkci Circle:
function Circle(radius) {
this. radius = radius;

}

Definujte metodu area objektu Circle. Metoda area bude pocitat obsah kruhu.
Pro definovani metody area mizete pouZit doslovnou funkci a nastavit vlastnost oblasti
objektu prototypu kruhu nasledovne:
Circle.prototype.area = function() {

return Math.PI * this.radius * this.radius;

}

Vytvorte instanci objektu Circle:
var myCircle = new Circle(4);

Volejte metodu area nového objektu myCircle:
var myCircleArea = myCircle.area ()
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ActionScript hleda objekt myCircle, metodu area. Protoze objekt nema metodu area,
v jeho prototypu objektu Circle.prototype je hledana metoda area. ActionScript ji najde
avola ji.

Metodu také mlzete pripojit k objektu jejim pripojenim ke kazdé jednotlivé instanci objektu:
function Circle(radius) {
this.radius = radius;
this.area = function() {
return Math.PI * this.radius * this.radius;

}

Tato technika ale neni doporu€ovana. Pouziti objektu prototype je Ucinnéjsi, protoze
je nezbytna pouze jedna definice area a tato definice je automaticky kopirovana do vSech
instanci vytvorenych funkci Circle.

Vlastnost prototype je podporovana verzi Flash Pfehrdvac 5 a novéjsi. Vice informaci
viz Kapitola 7, ,ActionScript Slovnik.*

Otevirani Flash 4 souboru

ActionScript se znacné zménil od uverejnéni Flash 5. Nyni je to objektové orientovany jazyk
s nékolika typy dat a dot syntaxi. Flash 4 ActionScript mél pouze jeden typ dat: fetézec.
Pouzival rlzné typy operatord ve vyrazech pro indikaci, zda by s hodnotou mélo byt
zachazeno jako s fetézcem nebo jako s Cislem. Ve Flash 5 miZete pouzit jednu sadu
operatorll na vSechny typy dat.

Kdyz pouzivate Flash 5 pro otevirdni souboru, ktery byl vytvoren ve Flash 4, Flash automaticky
konvertuje ActonScript vyrazy tak, aby je ucinil kompatibilni s novou syntaxi Flash 5.
Nasledujici konverze typl dat a operator( vidite ve vasem ActionScript kddu:
Operator = ve Flash 4 byl pouzivan pro numerickou rovnost. Ve Flash 5 je ==
operator rovnosti a = je operator urceni. Jakékoliv operatory = ve Flash 4 souborech
jsou automaticky konvertovany na ==.

Flash automaticky provadi konverze pro ujisténi, Ze se operatory chovaji korektné.
Kvdli zavedeni mnoha typ( dat maji nasledujici operatory nové vyznamy:
+, ==, 1=, <>, <, >, >=, <=

Ve Flash 4 byly tyto operatory vzdy numerickymi operatory. Ve Flash 5 se chovaji
rlizné v zavislosti na typu dat operandd. Aby se zabranilo sémantickym odliSnostem
v importovanych souborech, funkce Number je vioZzena do vSech operand( k témto
operatorim. (Konstantni ¢isla jsou vzdy jasna, proto nejsou vklddana do Number).
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Ve Flash 4 unikova sekvence \n generovana carriage return znakem (ASCII 13).
Ve Flash 5 pro shodu se standardem ECMA-262, \n generuije line-feed znak (ASCII 10).
Sekvence \n ve Flash 4 FLA souborech je automaticky konvertovana na \r.

Operator & ve Flash 4 byl pouzivan pro pfidani fetézce. Ve Flash 5 je & bitovy AND
operator. Operator pfidani fetézce je nyni nazvan add. Jakékoliv operatory & ve Flash 4
souborech jsou automaticky konvertovany na operatory add.

Mnoho funkci ve Flash 4 nepozaduje zavreni zavorek, napfiklad Get Timer,
Set Variable, Stop a Play. Ve Flash 5 funkce getTimer a vSechny ostatni
funkce nyni zavfené zavorky pozaduiji. Tyto zavorky jsou automaticky pfidavany
béhem konverze.

Kdyz je ve Flash 5 funkce getProperty vykondna na movie klipu ktery neexistuje,
vraci hodnotu undefined, ne 0. Ve Flash 5 ActionScriptu undefined ==0 je false.
Flash fixuje tento problém pfi konverzi na Flash 4 soubory, zavedenim funkci Number
v rovnicovych srovnanich. V nasledujicim pfikladu Number pfinuti undefined
aby bylo konvertovano na 0, aby bylo tak dosazeno srovnani:

getProperty ("clip", _width) ==

Number (getProperty ("clip", _width)) == Number (0)

Poznamka: Jestlize jste pouzili ve skriptu napsaném ve Flash 4 jakdkoliv klicova slova
rezervovana Flashem 5 jako jména proménnych, syntaxe ve Flash 5 nahldsi chybu. Toto
odstranite pfejmenovanim vSech takovych proménnych ve skriptu. Viz ,KliCova slova“.

Pouziti Flash 5 k vytvoreni obsahu pro Flash 4

Jestlize pouzivate Flash 5 k vytvoreni obsahu pro Flash 4 Prehravac (exportovanim jako
Flash 4), nebudete moci vyuzit vSechny nové vlastnosti Flash 5 ActionScriptu. Nicméné,
mnoho jich z0stava stdle dostupnych. Flash 4 ActionScript ma pouze jeden zakladni typ
dat, ktery je pouzivan pro Ciselnou i fetézcovou manipulaci. Kdyz autorizujete movie pro
Flash 4 PfehrdavaC, musite pouzit nezadouci fetézcové operatory umisténé v kategorii
String Operators v boxu nastrojd.

Nasleduijici rysy Flash 5 mlzete pouzit pfi exportu do .swf souboru formatu Flash:
Operator pole a pfistupové pole ( []).

TeCkovy operator (.).

Logické operatory, urCovaci operatory a pred-zvySovaci a po-zvySovaci/snizovaci
operatory.

Modulo operator ( % ), vSechny metody a vlastnosti objektu Math. Tyto operatory
a funkce nejsou plvodné podporovany Flash 4 Pfehravacem. Flash 5 je musi
exportovat jako série pfibliznych hodnot. To znamena, Ze vysledky jsou pouze pfiblizné.
Navic, vzhledem k zapocteni sérii pfibliznosti do SWF souboru, tyto funkce zabiraji
vice prostoru ve Flash 4 SWF souborech nez ve Flash 5 SWF souborech.

Akce for, while, do.while, break a continue.
Akce print a printAsBitmap.

Nasleduijici rysy Flash 5 nem0zete pouzit pfi exportu do . swf souboru formatu Flash:
Specidlni funkce
XML podpora
Lokalni proménné
Preddefinované objekty (kromé Math)
Movie clip akce
Typy dat Multiple
eval s dot syntaxi (napriklad, eval ("_root.movieclip.variable"))
return
new
delete
typeof
for..in
keycode
targetPath
escape
globalToLocal a localToGlobal
hitTest
isFinite a inNaN
parseFloat a parselInt
unescape

_Xmouse a _Yymouse

_quality
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KAPITOLA 3

Vytvareni Interakce s ActionScriptem

Interaktivni animace uZivatele zahrnuje do déje a také s nimi pocita. Pouzitim kldvesnice,
mysi nebo obojiho mohou uZivatelé skakat do rliznych ¢asti animace, hybat objekty, vkladat
informace (data, Udaje), klikat na tladitka a provddét mnoho dalSich interaktivnich operaci.
Interaktivni animace vytvarite nastavenim skriptd, které bézi, kdyz se objevi urcité udalosti.
Udalosti mohou spustit skript pokud hraci hlava dosdhne urcitého snimku, nebo kdyZz se natahne
nebo stahne ze scény movie klip, nebo kdyz uZivatel klikne na tlacitko nebo stlaéi kldvesy
na klavesnici. ActionScript Ize pouzit k vytvareni skriptd, které fikaji jaka akce se ma po dané
uddlosti spustit.

Nasledujicimi zplsoby mUzZe uzivatel interaktivné ovladat animaci:
Hrani a zastavovani animace

Upravovani kvality zobrazeni animace
Zastaveni vSech zvukd

Skok na snimek nebo scénu

Skok na jinou URL

Kontrola, zda je snimek natazen

Natazeni a stazeni dodate¢nych animaci (movies)

Detailni informace o téchto akcich, viz Using Flash.

Vytvareni specialniho kursoru
Ziskani pozice mysi

Ovladnuti stiskd klaves

Vytvareni rolujiciho textového pole
Nastaveni hodnot barev

Vytvareni kontrol zvuku

Detekce kolizi
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Vytvareni specialniho kursoru

Schovdni standardniho kursoru (prezentace ukazatele mysi na obrazovce) provedete
metodou hide preddefinovaného objektu Mouse. Pri pouziti movie klipu jako specidlniho
kursoru pouzijete akci startDrag.

1 Object A 2 [r

.‘ + = Object Actions v
+ (@] Bssic actions -
. fg) actions

@ break. -

Line 3: startDrag [this", tue);

Target |xms [~ Enpression
[ Constrain to rectangle

L
¥ Lockmousetocenter T

Vytvoreni specialniho kursoru:
Vytvorte movie klip, ktery pouzijete jako specidlni kursor.

Zvolte movie klip instanci na Scéné.
Zvolte Window > Action pro otevieni panelu Object Actions.

V seznamu Toolbox list zvolte Objects, potom zvolte Mouse a pretahnéte hide do okna
Scénar.
Kdéd by mél vypadat takto:
onClipEvent (load) {
Mouse.hide() ;

V seznamu Toolbox list zvolte Actions; potom pretdhnéte startbDrag do okna Scénar.

Zvolte LockMouse to center a zatrhnéte Expressions.
Kdéd by mél vypadat takto:
onClipEvent (load) {
Mouse.hide ()
startDrag(this, true);
}

Zvolte Control > Test Movie pro zkousku pouZiti specidlniho kursoru.

Tlac¢itka budou stdle funkéni i pokud pouzijete specidlni kursor. Je dobré dét specidlni
kursor do vrchni vrstvy Casové osy, aby se my$ pohybovala nad tladitky a dal$imi objekty.
Vice informaci o zplsobech objektu Mys viz Kapitola 7, ,ActionScript Slovnik.*
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Ziskani pozice mysi
Vlastnosti _xmouse a _ymouse miZete pouZzit k nalezeni umisténi ukazatele mysi (kursoru)
v animaci. Kazdd Casové osa md vlastnost _xmouse a _ymouse, kterd udévd umisténi
mysi uvniti systému souradnic.

"\Uﬂ xmouse, ymouse (origins for different timelines)

main fmeline dimensions 550x400

xmouse 377.2
yrmouse 198,

mavie clip timeline dimensions 250%250

Nasleduijici piikaz by mohl byt umistén na jakékoliv Casové ose animace, na urovni
_levelo, pro ziskani _xmouse pozice uvnitf hlavni Casové osy:
X _pos = _root._xmouse ;

Pro uréeni pozice mysi uvnitf movie klipu Ize pouzit jméno instance movie klipu. Napfiklad
nasledujici prikaz by mohl byt umistén na jakékoliv Casové ose animace, v Urovni
_levelo, pro ziskdni _ymouse pozice v instanci myMovieClip:

y_pos = _root.myMovieClip._ ymouse

Pozici mysi uvnitf movie klipu, mlizete také urdit pouzitim vlastnosti _xmouse a _ymouse
v klip akci:
onClipEvent (enterFrame) {

xmousePosition = _xmouse;

ymousePosition = _ymouse;

}

Proménné x_pos ay_pos jsou pouZity jako schranky obsahujici hodnoty pozici mysi.
Tyto proménné miiZete pouzit v jakémkoliv skriptu v animaci. V nasleduijicim prikladé se hodnoty
x pos ay_pos updatuji pokazdé, kdyZ uZivatel pohne s mysi.

onClipEvent (mouseMove) {

X pos = _root._xmouse;
y_pos = _root._ymouse;

Vice informaci o vlastnostech _xmouse a _ymouse viz Kapitola Z, ,ActionScript slovnik.*
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Oviadnuti stisku klaves

Metody preddefinovaného objektu Key, miZete pouzit pro urceni posledni klavesy, kterou
uzivatel stiskl. Objekt Key nepozaduje konstrukéni funkci; pro pouziti téchto metod jednoduse
volate samotny objekt:

Key.getCode() ;

MdUzete ziskat jak virtudlni kody kldves, tak ASCII hodnoty stisknuti kldves:
Pro ziskani virtudlniho kddu klavesy, ktera byla naposledy stisknuta pouzijte metodu
getCode.

Pro ziskani ASCII hodnoty naposledy stisknuté klavesy pouzijte metodu getAscii.

Virtudlni kdéd klavesy je stanoven pro kazdou fyzickou klavesu na klavesnici. Napfiklad
klavesa leva Sipka ma virtualni kod 37. Pouzitim virtudlniho kddu klavesy zajistite, Ze vami
uréena klavesa bude na klavesnici, bez ohledu na jazyk nebo platformu, opravdu ta kterou
jste urdili.

ASCII (American Standard Code for Information Interchange) hodnoty jsou uréeny k prvnim
127 znaklm v kaZdé sadé znakl. ASCII hodnoty poskytuji informaci o znaku na obrazovce.
Napriklad pismeno ,A“ a pismeno ,a“ maji riizné ASCIl hodnoty.

Bézné misto pro pouziti Key . getCode je ovladaC onClipEvent. VloZzeni keyDown jako
parametru, instruuje ovladag, aby zkontroloval hodnotu naposledy stisknuté klavesy pouze
tehdy, je-li kldvesa momentdiné stisknuta. Tento priklad pouziva Key.getCode v pfikazu
if, pro vytvorfeni navigacnich kontrol pro kosmickou lod.

Use the ammow keys to move the spacesnip
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Vytvoreni kldvesovych ovladaéi v animaci:

Rozhodnéte se, které klavesy pouzijete a urcete jejich virtualni klavesové kddy pouzitim

jednim z téchto postup:

Podivejte se do seznamu kddu klaves v Dodatku B, ,Klavesy na Klavesnici a Hodnoty

Kodud Klaves.“

Pouzijte konstantu Key object. (V seznamu Toolbox list zvolte Objects, potom zvolte

Key. Konstanty jsou zapsany velkymi pismeny.)

Zadejte nasledujici akci klipu, potom zvolte Control > Test Movie a stisknéte

poZadovanou klavesu:
onClipEvent (keyDown) {
trace (Key.getCode()) ;
Zvolte movie klip na Scéné.
Zvolte Window > Action.
Dvakrét stisknéte akci onClipEvent v kategorii Actions, v boxu néstroj.
Zvolte udalost keyDown v panelu parametry.

Dvakrat kliknéte na akci if v kategorii Actions, v boxu nastroji.

Kliknéte na parametr Condition, zvolte Objects; potom zvolte Key a getCode.

Dvakrat kliknéte na operator rovnosti (==) v kategorii Operatory, v boxu néstrojd.

VloZte virtualni kdd klavesy na pravou stranu operatoru rovnosti.

Vas kdd by mél vypadat takto:
onClipEvent (keyDown) {

if (Key.getCode ()==32) {
}
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Zvolte akci, ktera ma byt provedena po stisknuti spravné klavesy.

Napfiklad nasledujici akce zplisobi, Ze hlavni Casové osa plijde na dalsi snimek, pokud
je stisknut Mezernik (32):
onClipEvent (keyDown) {
if (Key.getCode() == 32){
nextFrame () ;

Vice informaci o zpUsobech objektu Klavesa viz Kapitola 7, ,ActionScript Slovnik.“

Vytvareni rolujiciho textového pole
Pro vytvoreni rolujiciho textového pole pouzijte vlastnosti scroll a maxscroll.

Proinde cum venabere, licebir, aucte
Ridebis, ef licel rideas. Fgoille quen
lam undique silvae et selitudo ipsum
Proinde cum venabere, licebir, auete
Tidebis, ef icel ndeas. Fgo ille quen
lam undique silvac et selitudo ipsum @

Proinde cum venabere, licebir, aucte
Ridebis. et licel rideas. Eeoille guen

V panelu Text Options zadejte jméno proménné v jakémkoliv nastaveni textového pole - Input
Text nebo Dynamic Text. Textové pole se bude chovat jako okno zobrazujici hodnotu této
proménné.

Kazda proménnd spojend s textovym polem ma vlastnost scroll a maxscroll. Tyto
vlastnosti mlzete vyuZit pfi rolovani textu v textovém poli. Vlastnost scroll uddva éislo
nejvySe viditelného fédku v textovém poli; tuto viastnost mizZete nastavit a znovu ziskat.
Vlastnost maxscroll uddva nejvyse viditelny fadek v textovém poli, kdyz je vidét spodni
fadek textu; tuto vlastnost mlzete Gist, ale ne nastavit.

Napfiklad predpokladejme, Ze mate textové pole dlouhé Ctyri radky. Jestlize obsahuje
proménnou speech, kierd by zaplnila devét fadkl textového pole, tak zobrazena najednou
(identifikovana pevnym boxem) miiZze byt pouze ¢ast proménné speech:

— Scroll property

- Visible text ficlc
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Ziskat tyto vlastnosti miZete dot syntaxe:
textFieldVariable.scroll

myMovieClip. textFieldVariable.scroll
textFieldVariable.maxscroll
myMovieClip. textFieldVariable.maxscroll

Vytvofreni rolujiciho textového pole:
Pretahnéte textové pole na Scénu.

Zvolte Window > Panels > Text Options.
Zvolte Input Text z pop-up menu.
Vlozte jméno textové proménné do pole Variable.

Tahnéte pravy dolni roh textového pole pro zménu velikosti textového pole.

| g

Zvolte Window > Action.

Zvolte snimek 1 na hlavni Casové ose a uréete akci setVariable, kiterd nastavuje
hodnotu textu.

V poli se Zadny text neobjevi dokud neni nastavena proménna. Proto, ackoliv mlzete tuto akci
pfipoijit k jakémukoliv snimku, tlacitku nebo movie klipu, je dobré ji pfifadit k snimku 1 na hlavni
Casové ose:

s ovie Explorer [ FrameActions] E

+ = Frame Actions

text = "These are the words that fill the editahlel

Line 1: text = "These are the words that fill the editable text field wit

Wariable: |text

Walue: |These are the words that fill the editable text field with the
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Zvolte Window > Common Libraries > Buttons, a pretahnéte tlacitko na Scénu.
Stisknéte Alt (Windows) nebo Option (Macintosh) a tahnéte tlacitko pro vytvoreni kopie.
Zvolte vrchni tladitko a zvolte Window > Action.

Pretahnéte akci setVariable z boxu nastroji do okna Skript v panelu Akci.

Vlozte text.scroll do boxu Variable.

Vlozte text.scroll -1 do boxu Value a zatrhnéte Expression.

Zvolte tlagitko Sipka Doll a urdete nasledujici akci setVariable:
text.scroll = text.scroll + 1;

Zvolte Control > Test Movie pro otestovani rolovani textového pole.

Vice informaci o vlastnostech scroll a maxscroll viz Kapitola 7, ,ActionScript Slovnik.”

Nastaveni hodnot barev

Metody preddefinovaného objektu Color, miZete pouzit pro upraveni barvy movie klipu.
Metoda setRGB ur€uje objektu hexadecimalni RGB (red-Cervena, green-zelena, blue-modra)
hodnoty a metoda setTransform nastavuje procento a vyrovnavaci hodnoty pro ¢ervenou,
zelenou, modrou a prihledné (alfa) komponenty barvy. Ndsledujici priklad pouzivd setRGB
pro zménu barvy objektu zalozenou na vkladu uZivatele.

x|
<3y Mavie Explorer] 5] Object Astions| Bl
v .

=+ = Object Actions

© = new Color(shirt);
c.setRGE (parseTnt (input,16 J;

H

Line 2. c = new Colarfshirt);

Enter a hex valus Expression: |c = new Colar(shirt)

Pro pouziti objektu Color musite vytvorit instanci objektu a pouzit ji na movie klip.
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Nastaveni hodnoty barvy movie klipu:
Zvolte movie klip na Scéné a zvolte Window > Panels > Instance.

Vlozte jméno instance colorTarget do boxu Name.
Pretahnéte textové pole na Scénu.
Zvolte Window > Panels > Text Option a urcete jméno proménné input.
Pretahnéte tlaCitko na Scénu a oznacte (zvolte) ho.
Zvolte Window > Actions.
Pretahnéte akci setVariable z boxu nastroji do okna Skript.
Do boxu Variable viozte c.
V boxu nastrojll zvolte Objects, potom Color a pretahnéte new Color do boxu Value.
Zatrhnéte Expression.
Kliknéte na tlacitko Target Path a zvolte colorTarget. Kliknéte OK.
Kdd v okné Scénar by mél vypadat takto:
on (release) {
c = new Color (colorTarget) ;
Pretahnéte akci evaluate z boxu ndstroji do okna Skript.
VloZte ¢ do boxu Expression.

V kategorii Objects seznamu Toolbox list zvolte Color; potom pretdhnéte setRGB do boxu
Expression.

Zvolte Functions a pretahnéte parselnt do boxu Expression.

Kdd by mél vypadat takto:

on(release) {
c = new Color (colorTarget) ;
c.setRGB (parselInt(string, radix));
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Pro retézcovy argument parseInt vlioZte input.
Retézec, ktery md byt analyzovén je hodnota vioZena do editovatelného textového pole.
Pro radix argument parseInt viozte 16.

Radix je zaklad Ciselného systému, ktery ma byt analyzovan. V tomto pripadé, je 16 zakladem
hexadecimalniho systému, ktery pouziva objekt Color. Kéd by mél vypadat takto:
on (release) {

c = new Color (colorTarget) ;

c.setRGB (parselnt (input, 16));

Zvolte Control > Test Movie pro zménu barvy movie klipu.

Vice informaci o zplsobech objektu Color viz Kapitola 7, ,ActionScript Slovnik.“

Vytvareni oviadaéa zvuku

Pro kontrolu a ovladani zvuk{ v animaci pouzivate preddefinovany objekt Sound. Pro pouZiti
metod objektu Sound musite nejprve vytvorit novy objekt Sound. Potom mizete, zatimco
animace bézi, pouzit pro vlozeni zvuku z knihovny metodu attachSound. Metoda setVolume
kontroluje hlasitost a setPan upravuje pravou a levou rovnovahu zvuku.

volume balance

¢ —

x|
<2y Mouie Explorer| 5] Object Actions| 2 [r

+ — | Dbjsct Actions v A

onCTipEvent (Toad) {
top = _v;

Teft = ey

right =

bottom = _y+100;

onClipEvent (enterfrane) {
if (dragaing — trued [
_root.s. se tValume (L00- (y-top)) §
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Pfipojeni zvuku k Casové ose: Vytvofeni posuvného ovladace hlasitosti:

Zvolte File > Import pro importovani zvuku. Tahnéte tlaCitko na Scénu.
Zvolte zvuk v knihovné a zvolte Linkage z menu Options. Zvolte tlacitko a zvolte Insert > Convert to Symbol. Zvolte behavior movie clip.
Zvolte Export This Symbol a dejte mu identifikator mySound. Toto vytvofi movie klip s tlaCitkem na jeho prvnim snimku.
Zvolte snimek 1 na hlavni Casové ose a zvolte Window > Actions. Zvolte movie klip a zvolte Edit > Edit Symbol.
Pretahnéte akci setVariable z boxu nastroji do okna Skript. Zvolte tlacitko a Window > Action.
Vlozte s do boxu Value. Vlozte nasledujici akce:
on (press){
V seznamu Toolbox list zvolte Objects, potom zvolte Sound a pretahnéte new Sound startDrag ("", false, left, top, right, bottom);
do boxu Value. dragging = true;
}
Kéd by mél vypadat takto: on (release, releaseOutside) {
s = new Sound (); stopDrag ()
dragging = false;
Dvakrat kliknéte na akci evaluate v boxu nastrojl. }
Vlozte s do boxu Expression. Parametry startDrag - levy, horni, pravy a spodni jsou proménné nastavené v akci klipu.
V kategorii Objects seznamu Toolbox list zvolte Sound, potom pretahnéte attachSound Zvolte Edit > Edit Movie pro névrat na hlavni Casovou osu.

do boxu Expression.

Zvolte movie klip na Scéné.
Vlozte ,mySound” do ID argumentu attachSound.

Vlozte nasledujici akce:

Dvakrat kliknéte na akci evaluate v boxu nastrojl. onClipEvent (load) {
top = _y:
VloZte s do boxu Expression. left = _x;
right = _x;
V kategorii Objects zvolte Sound, potom pretahnéte start do boxu Expression. bottom = _y + 100;
}
Kdd by mél vypadat takto: onClipEvent (enterFrame) {
s = new Sound() ; if (dragging == true) {
s.attachSound ("mySound") ; _root.s.setVolume (100 - (_y - top));
s.start () ; }

}
Zvolte Control > Test Movie, abyste slySeli pfehrat zvuk.

Zvolte Control > Test Movie pro pouziti ovladace hlasitosti.
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Vytvoreni pohyblivého ovladace vyrovnavani:
Pretahnéte tlacitko na Scénu.

Zvolte tladitko a zvolte Insert > Convert to Symbol. Zvolte viastnost movie klipu.
Zvolte movie klip a zvolte Edit > Edit Symbol.
Zvolte tla¢itko a Window > Actions.

VloZte nasledujici akce:
on (press) {
startDrag ("", false, left, top, right, bottom);
dragging = true;
}
on (release, releaseOutside) {
stopDrag ()
dragging = false;

Parametry startDrag - levy, horni, pravy a spodni jsou proménné nastavené v akci klipu.
Zvolte Edit > Edit Movie pro ndvrat na hlavni Casovou osu.
Zvolte movie klip na Scéné.

Vlozte nasledujici akce:
onClipEvent (load) {
top = _y;
bottom = _y;
left = _x - 50;
right = _x + 50;
center = _x;
}
onClipEvent (enterFrame) {
if (dragging == true) {
_root.s.setPan((_x - center) * 2);

Zvolte Control > Test Movie pro pouziti pohyblivého vyrovnavace.

Vice informaci o metodach objektu Sound viz Kapitola 7, ,ActionScript Slovnik.*

Detekce kolizi

Metodu hitTest objektu MovieClip, miZete pouZit pro detekci kolizi v animaci. Metoda
hitTest kontroluje, zda objekt koliduje s movie klipem a ddvd Boolednskou hodnotu
(true nebo false). Parametry metody hitTest mizZete pouZit pro specifikovani souradnic
X a y oblasti na Scéné, nebo pouzit cilovou cestu jiného movie klipu jako hit (zasahované) oblasti.
Kazdy movie klip v animaci je instance MovieClip objektu. Toto umozriuje volat metody
objektu z jakékoliv instance:

myMovieClip.hitTest (target) ;

Metodu hitTest miZete pouzit pro testovani kolize v movie klipu a jednotlivého bodu.

Také miZete metodu hitTest pouZit pro testovani kolize mezi dvéma movie klipy.

Provedeni detekce kolize mezi movie klipem a bodem na Scéné:
Zvolte movie klip na Scéné.

Zvolte Window > Actions pro otevieni panelu Objekt Akce.
Dvakrat kliknéte na trace v kategorii Actions, v boxu nastrojd.

Zatrhnéte Expression a vlozte nasledujici Vyraz:
trace (this.hitTest(_root._xmouse, _root._ymouse, true);

Tento pfiklad pouZiva vlastnosti _xmouse a _ymouse jako soufadnice x a y pro hit
(zasahovanou) oblast a posild vysledky do okna Output v Rezimu Test-Movie. Pro zobrazeni
vysledk( také mdlzZete nastavit textové pole na Scéné, nebo pouZit vysledky v prikazu if.

Zvolte Control > Test Movie a posurite my$ na movie klip pro testovani kolize.
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Provedeni detekce kolize na dvou movie klipech:
Pretahnéte dva movie klipy na Scénu a dejte jim jména instanci mcHitArea a mcDrag.

Vytvorte textové pole na Scéné a vlozte status do Variable v boxu Text Options.
Zvolte mcHitArea a Window > Actions.
Dvakrat kliknéte na evaluate v boxu nastrojd.

VloZte nasledujici kdd do boxu Expression vybranim polozek z boxu néstrojl:
_root.status = this.hitTest(_root.mcDragq) ;

Zvolte akci onClipEvent v okné Skript a zvolte enterFrame jako uddlost.
Zvolte meDrag a Window > Actions.

Dvakrat kliknéte na startDrag v boxu ndstrojd.

Zvolte Lock Mouse to Center.

Zvolte akci onClipEvent v okné Skript a zvolte uddlost Mouse down.
Dvakrat kliknéte na stopDrag v boxu nastrojd.

Zvolte akci onClipEvent Vv okné Skript a zvolte uddlost Mouse up.

Zvolte Control > Test Movie a tahnéte movie klip pro testovani detekce kolize.

Vice informaci o metodach hitTest viz Kapitola 7, ,ActionScript Slovnik.“

KAPITOLA 4

Prace s Movie Klipy

Movie klip je mini animace, kterd ma svoji vlastni Casovou osu a vlastnosti. Symbol movie
klip umistény v Knihovné, mdlze byt v animaci pouZit nékolikrat; kazdé pouZiti je nazvéano
instance movie klipu. Movie klipy mohou byt umistény uvniti' sebe navzdjem. Pro odliSeni
instanci pouzivejte pro kazdou instanci jedine¢né jméno.

Na Casové ose movie klipu méiZze byt umistén jakykoliv objekt, v&etné jinych movie klipd.
Animace, které jsou nataZzeny do Flash Prehrdvace pomoci loadMovie jsou také mini
Flash animace. Kazdy movie klip, natazend animace a hlavni Casové osa v animaci jsou
objekty s vlastnostmi a metodami, se kterymi miZe byt manipulovano pomoci ActionScriptu
k vytvdreni komplexni, nelinedrni a interaktivni animace.

Movie klipy kontrolujete pomoci akci a metod MovieClip objektl. V movie klipu jsou akce
a metody pfipojeny bud, ke snimkdm nebo k tlacitkim (akce snimkl a tlacitek), nebo ke
specifické movie klip instanci (akce klipu). Akce v movie klipu mohou kontrolovat jakoukoliv
Casovou osu v animaci. Casovou osu méiZete ovlddat pomoci pouZiti cilové cesty (target
path). Cilova cesta udava umisténi Casové osy v animaci.

Z movie klipu mizete vytvorit ,smart” klip; movie klip s ActionScriptem, ktery mze byt
preprogramovan bez pouziti panelu Akci. Smart klipy ¢ini jednodussi komunikaci mezi
programatorem a navrharem.
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O nékolika Gasovych osach

KaZda Flash animace ma ve Flash Piehravaci hlavni Casovou osu umisténou v trovni O (level0).
Pro natazeni dalSich Flash animaci (.swf soubor(l) do Flash Prehravace na jakoukoliv
uroven vyssi nez 0 (napfiklad drovenii, Uroven 2, droven 15), mizZete pouzit akci loadMovie.
Kazdd animace natazend do néjaké trovné ma svou Casovou osu.

Flash animace na jakékoliv trovni, mohou mit na svych Casovych osach instance movie
klipu. Kazd4 instance movie klipu ma také Casovou osu a miize obsahovat dal$i movie klipy,
které maji také svoje Casové osy. Casové osy movie klipll a irovné ve Flash Prehravadi
jsou hierarchicky organizovany tak, Ze objekty v animaci m(zete organizovat a kontrolovat
velmi snadno.

Child MC  Child MC2

Flash Player

Ve Flash je tato hierarchie Urovni a movie klipd nazvéna display list (seznam zobrazeni) a je
dispozici k nahlédnuti a Upravam v Movie Exploreru. Do seznamu zobrazeni mlzete nahlédnout
také v Debuggeru, pokud si prehrajete animaci v Rezimu Test-Movie, samostatném Flash
Prehravaci nebo na Webovém browseru.

orer =]
Explorer| 51 Object Actions 2 [»

show A M (@ D (P i
Find

+ B Seene

= 24 symbol Defintion(s)
=[] WestCoas, (westoast)
= E]  cal (calitormia)

2] San Fransisoo, (sanfrancisea)

Biakersfizld, [bakersfield)
n)
Portland, [portland)
2] Ashland, (ashiand)
= H]  warshingtun, {washington)
2 ouiotmeiz)
%]  Ellensburg, [ellensburg)

Seene 1-» Layer 1-» frame 15 West Coast - Layer -5 frame 1-> Orygun
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Casové osy Flash animaci jsou objekty a vechny maji charakteristiky (vlastnosti) a moznosti
(metody) preddefinovaného MovieClip objektu. Casové osy maji specificky vztah k sobé
navzajem v zdvislosti na umisténi v seznamu zobrazeni. Casové osy, které jsou umistény
uvnitf dal$ich Casovych os a jsou ovliviiovany zménami, ke kterym dojde na Casové ose
ve které se nachazeji. Napriklad, jestlize je portland dit€ oregonu a vy zménite vlastnost
_xscale oregonu, portland se zméni také.

Casové osy si mohou navzajem posilat zpravy. Napriklad akce na poslednim snimku jednoho
movie klipu mlze spustit pfehravani dalsiho movie klipu.

O hierarchickém vztahu €asovych os

Jestlize umistite movie klip instanci na Casovou osu jiného movie klipu, tak viastné jeden
symbol movie klipu obsahuje instanci jiného movie klipu - prvni movie klip je dité a druhy
movie Klip je rodié. Hlavni Casova osa Flash animace je rodié (parent) véech movie klip(i
na této urovni.

Vztahy rodi¢-dité movie klip jsou hierarchické. Pro pochopeni této hierarchie si predstavte
hierarchii pocitace: hard disk ma zakladni adresar (nebo slozku) a podadresare. Zakladni
adresér je shodny s hlavni Casovou osou v animaci: je to rodié véeho ostatniho. Podadresére
jsou analogické movie kliplim. Podadresare mlzete pouZzit, pro organizaci pribuznych obsahd.

Jakakoliv zména v rodi¢ovském movie klipu je provedena také na jeho ditéti.

Napriklad byste mohli vytvorit animaci, ve které jede auto pres Plochu. Mohli byste pouzit
movie klip symbol, ktery reprezentuje auto a nastavit jeho pohyb pres Plochu.

ER 2 a1 || 8] ElE ® ] o reomes 0es 4
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Na auto je pohlizeno z boku, kde ma dvé viditelna kola. Pfi pohybu auta chcete, aby kola
rotovala. Takze udéldte movie klip pro kolo auta a vytvofite dvé instance tohoto movie klipu,
pojmenované frontWheel a backWheel. Potom umistite kola na Casovou osu movie
klipu car - ne na hlavni Casovou osu. Jako déti car jsou frontWheel a backWheel
ovlivnény zménami, které nastanou u auta. To znamena, ze se pfi pohybu auta pfes plochu
budou pohybovat s autem.

£ Scene car

HE  [|4] alo] =l 1 eoms | oes o

wheel graphic

E2e Tl LH

4] whes!
Bevssior [odeTtp =]

Mame: |backWheel

S| 55 A

Rotuijici kola vytvofite nastavenim motion tween na rotaci symbolu kola, a zéroven také na
rotaci obou instanci. Dokonce poté, co zménite frontWheel a backWheel, interpolace
jejich rodicovského movie klipu car budou nadale ovlivnény; kola se budou tocit, ale budou
se také pohybovat s rodi¢ovskym klipem car pres Plochu.

BB =i | ERREIRE I N
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Posilani zprav mezi Casovymi osami

Zpravy mizete posilat z jedné Casové osy do druhé. Jedna Casova osa obsahuje akci,
nazvanou controller a druhd, kterd obdrz akci nazvanou target. Akce mizete pridélit v Casové
ose ke snimku, tlacitku, nebo movie klipu.

Pro cilovani Casovych os mlizete pouzit akce z kategorie Action, nebo miiZete pouzit
metody MovieClip objektu z kategorie Objects v panelu Akci. Napriklad pfi pfehravani animace
mUzete pouzit akci duplicateMovieClip pro urcity klip-cil a vytvorit tak kopie instanci
movie klipu.

Fre ions x|
sy Movie Explorer| 5 Frame Actions 2|r
+ = Fiame Actions
(2] Basic Actions [ cuelicated
&) Astions

@ bresk

call —
comment
continue
delete

@
@
@
@
(@ dowhile
=3
]
@
@

evaluate

sy Mawie Explorer[ ] Frame Actions 20w

+ = Frame Actions

;_J Objects -
1] Array
1] Eoolean
1] Calar
1] Date
1] Key )
@] Math 4
'E_J PavieClip
@ attachlovie

@ getBounds

@ getBytesLasded Duplicates this movie clip
@ getBytesTatal - 4 | | 3

Line 1: mybd ovieClip. duplicatetd ovieClip[ newh ame, depth |;

Pfi provddéni nékolika akci ve stejném cili pouzijte akci with. Podobné jako u JavaScript
piikazu with, akce ActionScriptu wi th je obal, ktery umozriuje adresovat cilovou Casovou
osu pouze jednou a potom vykonat série akci v tomto klipu; nemusite adresovat cilovou
Casovou osu v kazdé akci.
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K provedeni nékolika akcich ve stejném cili také miZete pouzit akci tellTarget.

Pro komunikaci mezi Casovymi osami musite udélat nasledujic:
Vlozte jméno instance cilového movie klipu.

Pro pojmenovani movie klip instance pouzijte Panel Instance (Window > Panels > Instance).
Casové osy natazené do Urovni pouzivaji sva Cisla urovni jako jména instanci, napfiklad
level6.

VloZte cilovou cestu do jména instance v Panelu Akce.

Cilovou cestu mdizete viozit ru¢né nebo Ize pouzit dialog box Insert Target Path. Viz ,,Specifikace
cilovych cest"”.

Poznamka: Aby mohla byt cilovana Casovéd osa movie klipu, musi byt béhem prehravani
na Scéné.

O absolutnich a relativnich cilovych cestach
Cilova cesta je adresa Casoveé osy, ktera je cilovana. Seznam zobrazeni Casovych os ve Flashi
je podobny hierarchii soubor( a slozek na Web serveru.

.";_'I" 3y Movie Explorer| 2] Object Astiong| 2 |
show: A (@ D P i
@ ) Find:
# 2 Scenet
= 2 symbol Defintian(s)
@ lard = [E] westCoast westCassy
k;:: = ] cahieslifomia)
Z] sanFranciseo, [sanfranciseo)
| Bakerstisld, (bakersfield)
Pomland, (poniand)
@ San Francisco #]  ashiand, (askland)
= ] warshingtun, fwashingtan)
] outclmpia)
%] Enensburg, (sllensburg)
O ersiield
Soene 1-> Layer 15 frame 1-> West Coast -> Lager 1> frame 1-> Orygun

Stejné jako na Web serveru, kazdd Casova osa ve Flashi miiZe byt adresovana dvéma zptisoby:
absolutni cestou nebo relativni cestou. Absolutni cesta instance je vzdy stejnd, bez ohledu
na to, jakou Casovou osu akce vold; napiiklad absolutni cesta k instanci california je vzdy
_levelOwestCoast.california. Relativni cesta je riiznd, protoZe byva voldna z riiznych
umisténi; napriklad relativni cesta do california ze sanfrancisco je _parent, ale z portland
je _parent._ parent.california.
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Poznamka: Vice informaci o Movie Explorer viz Using Flash.

Absolutni cesta zac¢ina jménem Urovné, do které je animace natazena a pokracuje pres
seznam zobrazeni az dosahne cilové instance.

(Pro potreby této knihy chapeijte animace jako .swf soubory)

Prvni animace, ktera ma byt oteviena ve Flash Prehravaci je natazena na uroven 0. Ke kazdé
dodate¢né natazené animaci musite pfipojit Cislo trovné. Cilové jméno pro uroveri je _levelX,
kde X je Cislo urovné, do které je animace natazena. Napfiklad prvni animace otevrena ve Flash
Pfehravadi je nazvana _level0, animace natazend do urovné 3 je nazvdna _level3.

V nasledujicim pfikladé byly dvé animace natazeny do pfehravaCe, TargetPaths. swf
do urovné 0 a EastCoast.sw£ do Urovné 5. Urovné jsou indikovany v Debuggeru, s urovni
0 indikovanou jako _root.

TargetPaths ger =]
7L Debugger] 2 [r

Test Movie:

_lewels k

[ ] - ] _tevelseastCoast

= ] _levels.eastCoast fAorida

B

+

2] _levelbeastCoastgeorgia

%] _levelSeastCoastzouthCaroling

] _rocttarget

#] _rootuwestCoastealiomia

i

il = T _rootwesiCoast
+
+ ] _rootwestCoastportiand
+

] _rootuwestCoastuashington

Instance ma vzdy néjakou absolutni cestu, at je volana z akce v instanci na stejné urovni
nebo z akce na jiné Urovni. Napfiklad instance bakers£field na urovni 0, ma v dot syntaxi
vzdy nasledujici absolutni cestu v dot syntaxi:

_levelO.california.bakersfield

Ve slash syntaxi jsou tecky v absolutni cesté nahrazeny lomitky:
_levelO/california/bakersfield

Pro komunikaci mezi animacemi na rliznych drovnich musite pouzit jméno drovné v cilové
cesté. Napriklad instance portland by adresovala instanci atlanta nasledovneé:
_level5.georgia.atlanta
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V dot syntaxi mizete pouZit alias _root pro odkaz na hlavni Casovou osu aktudlni trovné.
Pro hlavni Casovou osu, nebo _ level0, alias _root reprezentuje _levelO, kdy? je
cilovén klipem také na _level0. Pro animaci natazenou do _level5, je _root roven
_levels, pokud je cilovana movie klipem také na urovni 1. Napfiklad akce voland z
instance southcarolina by mohla pouzit nasledujici absolutni cestu pro cilovani
instance florida:

_root.eastCoast.florida

Ve slash syntaxi mGzZete pouzit / pro odkaz na hlavni Casovou osu aktudini Grovné:
/eastCoast/florida

V dot syntaxi, v Absolutnim i v Relativnim Rezimu, mdlzete pouZit stejna pravidla cilovani
pro identifikaci proménné na Casové ose, nebo viastnosti objektu. Napfiklad nésleduijici
pfikaz nastavujte jméno proménné ve formé instance k hodnoté ,Gilbert":
_root.form.name = ,Gilbert";

Ve slash syntaxi, v Absolutnim i v Relativnim ReZimu, miZete identifikovat proménnou na Casové
ose tak, Zze jméno proménné predchazi dvojtecka ():
/form:name = ,Gilbert“;

Relativni cesta je zavisla na vztahu mezi kontrolorem Casové osy a cilovou Casovou osou.
Relativni cestu mUizete vyuzit pro znovupouziti akci, protozZe stejnd akce mlze byt cilovana
do réiznych Casovych os v zavislosti na umisténi akce. Relativni cesty mohou adresovat cile
pouze uvnitf své vlastni Urovné Flash Prehravace; nemohou adresovat animace natazené
do jinych drovni. Napfiklad nem(izete pouZit relativni cestu v akci na _levelo, kterd ciluje
Casovou osu na _levelS.

V dot syntaxi, v relativni cilové cest&, pro odkaz na aktudini Casovou osu mézZete pouzit
klidové slovo this. V relativni cilové cesté, pro indikovéni rodidovské Casové osy aktudini
Casové osy, mlizete pouzit alias _parent. Alias _parent mize byt pouzit opakované pro skok
o jednu uroven vys$ v movie klip hierarchii, uvnitf stejné urovné Flash Prehravace. Napfiklad
_ parent._parent kontroluje movie klip o dvé drovné vys$ v hierarchii.
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V nasledujicim prikladu je kazdé mésto (charleston, atlanta a staugustine) ditétem
instance stat a kazdy stdt (southcarolina, georgia a florida) je dité instance
eastCoast.

2 Seenel (£ southEast

B Laper 1

oE) & |41l ey e A B D] ) =
Flnd:,i

¥ Z

Seene |
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Atlanta . + .

2
2% symbol Definticn(s)
=[] souEas (eastCoast
= ] flarida, (orida)
%] st Augustine, [staugustine)

= ] Georgia, [georgia)
] atlants, [atlanta)

+ =] southCaralina, [southearaling]

] charleston, jcharleston)

-+

Akce na Casové ose instance charleston, by mohla pouzit nasledujici cilovou cestu
pro cilovani instance southcarolina:
_parent

Pro cilovani instance eastCoast z akce v charleston, byste mohli pouzit nasledujici relativni
cestu:
_parent._ parent

Ve slash syntaxi mlzete pouzit dvé teCky ( . . ), abyste se dostali o Uroveri vy$ v hierarchii.
Pro cilovani eastCoast z akce v charleston byste mohli pouZit ndsledujici cestu:

AR

V dot syntaxi, pro cilovani instance atlanta z akce na Casové ose charlestonu, byste
mohli pouzit nasleduijici relativni cestu:
_parent. parent.georgia.atlanta

Relativni cesty jsou uzite¢né pro znovupouziti scénarll. Napiiklad byste monhli skript pripojit k

movie klipu, ktery jej zvétSuje o 150%:

onClipEvent (load) {
_parent._ xscale
_parent._yscale

150;
150;
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Potom byste tento skript mohli znovu pouzit jeho umisténim do Casové osy jakéhokoliv
jiného movie klipu.

Vice informaci o adresovani a dot syntaxi viz ,Psani Scénari s ActionScript“.
Vice informaci o Dot syntaxi a Slash syntaxi viz ,Pouziti ActionScript syntaxe®.
Specifikovani cilovych cest
Ke kontrole movie klipu nebo nataZzené animace musite k ur€eni cile pouzit cilovou cestu.
Aby mohl byt movie klip cilovéan, musi mit jméno instance. Cil mdzete urcit nékolika rdznymi
zplsoby:
Vlozte cilovou cestu pomoci pouziti tlacitka Insert Target Path a dialog boxu v panelu
Akci.

Vlozte cilovou cestu movie klipu ve skriptu ru¢né.

Vytvorte vyraz pouzitim odkazu na movie klip, nebo pouzitim pfeddefinovanych
funkci targetPath a eval.

VlozZeni cilové cesty pomoci pouziti dialog boxu Insert Target Path:
Zvolte movie klip, snimek nebo instanci tlacitka, ke kterému chcete pfipojit akci.

To bude kontrolor Casové osy.
Zvolte Window > Actions pro zobrazeni panelu Akci.

V seznamu Toolbox list zvolte akci, nebo metodu z kategorie MovieClip uvnitf slozky
Objects.

Kliknéte na pole Target, nebo umisténi ve skriptu pro vioZeni cilové cesty.

Kliknéte na tlacitko Insert Target Path v pravém dolnim rohu panelu Akci, pro zobrazeni
dialog boxu Insert Target Path.
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s Movie Explorer] 5 Frame Actions| kML
+ = Frame Actions
[#] Basic Actions ] duplicateMovieClip ", "", <no
2] astions

@ break _

@ cal

comment

continue

@ delete

@ dowhie

duplicateMovieClip

Line 1: duplicateMavieClip [, ", MilEasu=s); (D epth: An expression is required. |

Taiget, ‘| [ Expression
Lew Mame: ‘ [™ Espression

Diepth: ‘
s

V dialog boxu Insert target Path zvolte syntaxi: Dots (nastaveno) nebo Slashes.

= ok |
Cancel

Netalior: & Dots Mode: & Aelaive Mo |

" Slashes O Absolute

Target: (atlanta

Zvolte Absolutni nebo Relativni pro rezim cilové cesty.
Viz ,,0 absolutni a relativnich cilovych cestach*.

Urcete vas cil jednim z ndsledujicich zplsobu:
Zvolte movie klip v seznamu zobrazeni Insert Target Path.

Vlozte cil ruéné do pole Target pomoci pouziti absolutni nebo relativni cesty a dot
syntaxe.

Kliknéte OK.
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Vlozeni cilové cesty ru¢né:
Provedte kroky 1-4 nahofe a vlozte absolutni nebo relativni cestu do panelu Akce.

Pouziti vyrazu jako cilové cesty:
Provedte kroky 1-4 nahore.

Udélejte jedno z nasleduijicich:

Rucné vlozte odkaz na cilovou cestu. Odkaz pro urceni cilové cesty je ohodnocen.
Odkaz mizete pouzit jako parametr pro akci with. V nasledujicim prikladé je
proménna index ohodnocena a vynasobena 2. Vysledna hodnota je pouzita jako
jméno movie klipu uvnitf instance Block, které je feCeno, aby hrala:
with (Board.Block [index*2]) {

play ();

V kategorii Functions seznamu Toolbox list zvolte funkci targetPath. Tato funkce
konvertuje odkaz na movie klip do fetézce, ktery miize byt pouzity akcemi jako
tellTarget.

V nasledujicim pfikladé funkce targetPath konvertuje odkaz Board.Blok
[index*2+1] na fetézec:
tellTarget (targetPath (Board.Blok[index*2+1])) {

play ()

Predchozi priklad je ekvivalentni nasledujici Slash syntaxi:
tellTarget ("Board/Block:"+index*2+1)) {
play();

V kategorii Functions, v seznamu Toolbox list zvolte funkci eval.

Funkce eval konvertuje fetézec na odkaz na movie klip, ktery mize byt pouzit
jako cilova cesta akcemi jako with.

Nasledujici scénar ohodnocuje proménnou i, pfiddva ji k fetézci ,,cat™ a pfipojuje
vyslednou hodnotu k proménné x. Proménna x je nyni odkaz na movie klip instanci
a mdze volat metody MovieClip objektu:

x = eval (,cat™+i);

x.play();

Funkci eval mizete také pouzit pro pfimé volani metod:
eval (,cat“+i).play();

Pouzivani akci a metod pro kontrolu €asovych os

Pro cilovani, nebo pro provedeni Ukoll v movie klipu nebo natazené trovni, mizZete pouZit
urcité akce a metody MovieClip objektu. Napriklad akce setProperty nastavuje viastnost
(jako je _width) Casové osy na néjakou hodnotu (napf. 100). Nékteré metody MovieClip
objektu duplikuji funkci vSech akci, pouzivanych k cilovani Casové osy. Existuji také
dodatkoveé metody, jako je hitTest a swapDepth. Kdyz pouZijete akci nebo metodu a chcete
ji zarover volat, musi byt cilovd Casovd osa natazena do Flash Prehravade.

Nasledujici akce mohou cilovat movie klipy: loadMovie, unloadMovie, setProperty,
startDrag, duplicateMovieClip a removeMovieClip. Pri pouziti téchto akci musite
vlozit cilovou cestu, do parametru akce Target zadat pfijemce akce. Nékteré z téchto akci
mohou cilovat movie klipy nebo urovné a jiné mohou cilovat pouze movie klipy.

Nasledujici metody objektu MovieClip mohou kontrolovat movie klipy nebo natazené
urovné a nemaji ekvivalentni akce: attachMovie, getBounds, getBytesLoaded,
getBytesTotal, globalToLocal, lokalToGlobal, hitTest a swapDepth.

Pokud akce a metoda nabizi podobné funkce, miZete zvolit pro kontrolu movie klipd
kterykoliv z nich. Volba je zavisla pouze na vasich schopnostech a znalostech skriptovani.

Vice informaci o metoddach MovieClip objektu a informace o kazdé akci viz Kapitola 7,
»ActionScript Slovnik".

Metody versus akce

Metody volavate pouzitim cilové cesty ke jménu instance, nasledovaném teCkou a potom
jménem metody a argumentu, jako v nasledujicich prikazech:

myMovieClip.play() ;

parentClip.childClip.gotoAndPlay (3) ;

V prvnim piikazu metoda play zpUsobi, Ze instance myMovieClip bude hrat. Ve druhém
pfikazu metoda gotoAndPlay posila hraci hlavu na childClip (ktery je ditétem instance
parentClip) na snimek 3 a hraje.

Akce, které kontroluji Casovou osu maji parametr Target, uréujici cilovou cestu. Napfiklad
v nasledujicim scénafi akce startDrag ciluje instanci customCursor a &ini jej tazitelny:
on (press) {

startDrag ("customCursor") ;
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Kdyz pouzijete metodu, volate ji az na konci cilové cesty. Napfiklad nasledujici pfiklad
provani stejnou funkci startDrag:
customCursor.startDrag() ;

Vv

akci tellTarget. Od pouziti akce tellTarget je odrazovdno, protoZe neni kompatibilni
s ECMA-262 standardem. Napriklad ke spusténi prehrdvéni movie klipu myMovieClip
pomoci metod objektu MovieClip, byste pouZzili ndsledujici kéd:

myMovieClip.play() ;

Nasledujici kdd dava stejny vysledek, ale s pouzitim akce tellTarget:
tellTarget (,myMovieClip"“) {

play();
}

Pouziti nékolika metod nebo akci pro cilovani Casové osy

Akci with sta¢i pouzit pro cilovani movie klipu jen jednou, potom mdzete vykondvat sérii
akci na tomto klipu. Akce with funguje ve vSech objektech ActionScriptu (napfiklad Array,
Color a Sound, ne pouze movie klipech. Akce tellTarget je podobnd akci with,
nicméné neni preferovana, protoze nefunguje se vSemi objekty ActionScriptu a nevyhovuje
ECMA-262.

Akce with bere objekt jako parametr. Objekt, ktery urcite je pfipojen na konec aktudlni
cilové cesty. VSechny akce vlozené do akce with, jsou vykonany uvniti nové cilové cesty
nebo pole plisobnosti. Napfiklad v nasledujicim skriptu na hlavni Casové ose je akce with
pfifazena objektu donut.hole, aby zménila viastnosti hole:

with (donut.hole) {

_alpha = 20;
_xscale = 150;
_yscale = 150;

}

Je to, jako kdyby pfikazy uvnitf akce with byly voldny z Casové osy instance hole.

V nasledujicim pfikladu si vSimnéte hospodarnosti pouziti akce with a metod MovieClip
objektu pro stanoveni nékolika instrukci:
with (myMovieClip) {
_x -= 10;
_y += 10;
gotoAndPlay (3) ;
}

Vice informaci o akci tellTarget viz Using Flash.
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Pfipojeni akce nebo metody
Akce a metody mohou byt pripojeny k tladitku, nebo snimku na Casové ose, nebo k instanci
movie klipu.

Pro pripojeni akce nebo metody k instanci movie klipu musite pouzit ovlada¢ onClipEvent.
VSechny akce pfipojené k instanci jsou viozeny do ovladace onClipEvent a jsou vykonany
ihned po jejich spusténi. Akce onClipEvent je spousténa bud uddlostmi Casové osy
(jako je natazeni animace) nebo udalostmi uzivatele (jako je kliknuti mySi nebo stisknuti
kldvesy). Napriklad onClipEvent (mouseMove) spousti akci pokazdé, kdyz uZivatel pohne
s mysi.

(] southEast e .
| DH 5 10 |[E Mowie Explarer] 71 Chject Actians 2|
. .
I B
@ IosdMovie onclipEvent (load) {
o || ¢]aldl
i
@ .
. emaveMovieCip
@ retun
3 cpt wariahl =4

Lire 1: onClipEvent load) {

Event: (% Load ™ Mouse down " Keydown
" EnterFrame " Mouse up  Keyup
" Unlozd ™ Mouss moue " Data

Natazeni a stazeni externich animaci

Akci nebo metodu loadMovie miZete pouzit k nataZzeni a prehrani externich animaci,
nebo k vypnuti animaci bez natahovani dal§i HTML stranky. Tuto akci nebo metodu Ize také
pouzit pro poslani proménnych do CGl skriptu, ktery generuje SWF soubor jako jeho CGlI
vystup. Pfi natahovéni animace, mlzete urcit Groveri nebo cilovy movie klip, do kterého
bude animace natazena.

Akce a metoda unloadMovie odstranuje dfive natazenou animaci pomoci loadMovie.
Explicitni staZzeni animace pomoci unloadMovie zajiStuje hladky prfechod mezi animacemi
a mlze také odleh¢it paméti poZzadované Flash Prehrdvacem. Akci loadMovie pouZijte
pro vytvoreni nékterého z nasledujicich pfiklad(:
Prehravéni sekvence reklamnich baner(i (SWF soubord), umisténim akce loadMovie
na konec kazdého SWF souboru, pro natazeni dalsi animace

Vyvitite rozvétvené rozhrani, které uzivateli umozni vybrat si mezi nékolika rdznymi
SWF soubory.

Na drovni 0 vytvorte naviga¢ni rozhrani s navigaénimi ovladadi, které nahraji ostatni
urovne.
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Zmeéna pozice a vzhledu movie klipu

Pro zménu vlastnosti movie klipu pfi jejich prehravani mlzete pouzit akci setProperty
nebo napsat pfikaz, ktery uréujte hodnotu proménné. Jestlize natahujete animaci do cile,
natazend animace zdédi vlastnosti cilovaného movie klipu. Pokud uz je animace natazena,
mUzete tyto vlastnosti zménit.

Neékteré vlastnosti, nazvané pouze pro ¢teni, maji hodnoty, které mdZete Cist, ale ne nastavit.
Z toho vyplyva, ze psat prikazy pro nastaveni vlastnosti Ize pouze pro ty, které nejsou urceny
pouze pro Cteni. Nésledujici pfikaz nastavuje vlastnost _alpha instanci movie klipu wheel,
kterd je ditétem instance car:
car.wheel. alpha = 50;

Navic, mizZete psat prikazy, které ziskavaji hodnotu vlastnosti movie klipu. Napriklad,
nésledujici pfikaz dostavé hodnotu vlastnosti _xmouse na hlavni Casové ose a nastavujte
na tuto hodnotu vlastnost _x instance customCursor:
onClipEvent (enterFrame) {

customCursor._x = _root._xmouse;

Ziskani vlastnosti movie klipu také zajisti pouziti funkce getProperty.

Vlastnosti_x, y, rotation, xscale,_yscale, height, width, alphaa_visible
jsou ovliviiovany transformacemi na rodicovském movie klipu a tim transformuiji také movie klip
jakéhokoliv ditéte. Vlastnosti _focusrect, _highquality, _qualitya_sounbuftime
jsou globdlni; patii pouze k trovni 0 Casové osy. Véechny ostatni viastnosti patti ke kazdému
movie klipu nebo natazené urovni. V tabulce dole je seznam vSech movie klip vlastnosti:

Vlastnost
_alpha _target
_currentframe _totalframes
_droptarget _url
_focusrect _visible
_framesloaded _width
_height _x
_highquality _xmouse
_name _xscale
_quality _y
_rotation _ymouse
_soundbuftime _yscale
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Tazeni movie klipQ

Akce nebo metoda startDrag, ucini pfi pfehravani animace movie klip tazitelny. Tazeni
movie klipu ma vyuziti ve hrach, ve funkcich tahni a pust, specialnim rozhrani, v rolujicich
sloupcich a diapozitivech. Movie klip zUstava taZitelny, dokud neni explicitné zastaven
pomoci stopDrag, nebo dokud neni jiny klip cilovan pomoci startDrag. V jednom Case
mUze byt taZitelny pouze jeden klip.

Pfi tvorbé komplikovanéjsich chovani tahni a pust mlzete ohodnocovat tazeny movie klip
vlastnosti _droptarget. Tuto vlastnost miizete vyzkouset pfi tazeni klipu na specificky klip
(napf.movie klip ,trash can®) a po uvolnéni klipu spustit dal$i akci. Viz ,Pouziti vyrazl ,if“ a
»Pouziti operator(l pro manipulaci s hodnotami ve vyrazech®.

Duplikovani a odstrahovani movie klipt

Instanci movie klipu mUZete vytvorit nebo odstranit pfi pfehravani animace, pomoci pouZziti
duplicateMovieClip, nebo removeMovieClip. Akce a metoda duplicateMovieClip
dynamicky vytvari novou instanci movie klipu, pfipojuje ji nové jméno instance a dava ji hloubku.
Duplikovany movie klip vzdy zac¢ina na snimku 1, i kdyz plvodni movie klip byl v okamZiku
duplikovani na jiném snimku, a je stale na vrcholu vSech preddefinovanych movie klipQ
umisténych na Casové ose. Do duplikovaného movie klipu nejsou kopirovany proménné.

Pro odstranéni movie klipu, ktery jste vytvofili pomoci duplicateMovieClip, pouzijte
removeMovieClip. KdyZ je odstranén rodiCovsky movie klip, duplikované movie klipy
jsou odstraneny take.

PFipojeni movie klipa

Kopii movie klipu mlzete ziskat z knihovny a prehravat ji jako ¢ast animace Ize pomoci

metody attachMovie. Tato metoda béhem hrani animace natdhne jiny movie klip do vaseho
movie klipu a pfehrava jej.

Pfi pouziti metody attachMovie musi byt pfipojovany movie klip pojmenovan jedineénym
jménem v dialog boxu Symbol Linkage Properties.

Pojmenovani movie klipu pro sdileni:
V Knihovné animace zvolte movie klip, ktery chcete pfipojit.

V okné Knihovna zvolte Linkage z menu Options.
Pro Linkage zvolte Export This Symbol.

Do dialog boxu Symbol Linkage Properties, vioZzte jméno movie klipu do okna pro
Identifier. Jméno se musi lisit od jmen symbold v knihovné.

Kliknéte OK.
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Pfipojeni movie klipu k dal$imu movie klipu:
V panelu Akce urcete cil, ke kterému chcete pfipojit movie klip.

V seznamu Toolbox list zvolte objekt MovieClip a potom vyberte metodu attachMovie.

Nastavte nasledujici argumenty:
Pro idName specifikujte jméno, které jste vlozili do dialog boxu Symbol Linkage
Properties, do pole Identifier.

Pro newName vloZte jméno instance pro pfipojovany klip tak, abyste ho mohli cilovat.

Pro depth vlozte uroven, na kterou ma byt k movie klipu pfipojen duplikovany klip.
Pfipojené movie klipy jsou vzdy na vrcholu pdvodniho movie klipu.

Napriklad:
myMovieClip.attachMovie(,calif", ,california“,10);

Vytvareni ,smart“ klipa
»omart“ klip je movie klip s definovanymi parametry, které mohou byt ménény. Tyto parametry
jsou vkladany do akci ménicich jeho chovani.

Pfi vytvafeni smart klipu urcite jeho parametry v Knihovng, v symbolu movie klipu. Do smart
klipu mizZete napsat piikazy ActionScriptu, které operujici s jeho parametry, podobné jako
pouzivate argumenty v definici funkci. Mlzete zvolit instanci smart klipu na Scéné a zménit
hodnoty jejich parametr(l v panelu Klip Parametry. BEéhem prehravani, jsou hodnoty
nastavené v panelu posilany do smart klipu, pfed jakymikoliv akcemi vykonavanymi v animaci.

Smart klipy jsou uzite¢né pro preddvani komplikovanych prvkd od programétora k navrhari.
Programétor miiZze do smart klipu napsat akce s proménnymi, které kontroluiji klip a animaci.
Navrhar potom mdze zménit hodnoty téchto proménnych v panelu Klip Parametry aniz by
oteviral panel Akci.

Smart klipy miZete pouZit pro vytvareni prvk( rozhrani - jako jsou radiova tlacitka, pop-up
menu, uzivatelské tipy, prizkumy, hry a variantni faze trvalé entity. Jakykoliv klip animace,
ktery chcete pozdéji jinak pouzit bez zmény skriptd bude dobrym smart klipem.

Dale mlzete vytvaret prizplsobené rozhrani ve Flashi pro panel Klip Parametry, abyste
usnadnili praci designérdm, ktefi klip upravuiji.
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Definovani parametra klipu

Parametry klipu jsou Casti dat, které jsou vkladany do movie klipu, pfi jeho natahovani
do animace. Parametry klipu mlzete definovat uz pfi jeho tvorbé. Béhem prehravani animace
pomoci parametrd mizete ménit vzhled a chovani smart klipu. Movie klip s definovanymi
parametry indikuje v Knihovné Specidlni ikona.

Library - clipParameters.fla
One item in ibrary Options

B8 Symbol

Smart Clipicon
maa | » F‘

Definovani parametrt pro movie klip:
Zvolte symbol movie klip v knihovné a udélejte jednu z nasleduijicich véci pro zobrazeni
dialog boxu Clip Parameters:
Kliknéte vpravo (Windows) nebo na Control (Macintosh) a zvolte Define Clip
Parameters z kontext menu.

Zvolte Define Clip Parameters z menu Options v vpravo nahore v okné Knihovna.

Library - clipParameters. fla
One item in library

Mew Symbal

New Folder

MNew Fort

Rename

Move to New Folder. .
Duplicate.

Delete

Edit

Properties...
Linkage.

Detine Clip Parameters...

MName

i Symbal Select Unused ltems

Flay

Shared Library Properties.

Keep Use Counts Updated
Update Use Counts Nove
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Pouzijte kontroly v dialog boxu Clip Parameters nasledovné:
Kliknéte na tlacitko Add (+) pro pfidani nové dvojice name/value (jméno/hodnota),
nebo dodatec¢nych parametrll pro vybrany par jméno/hodnota.
Kliknéte na tlacitko Minus (-) pro zruseni dvojice jméno/hodnota.
Pouzijte tlacitka Sipek pro zménu poradi parametrli v seznamu.
Zvolte pole tak, ze na néj dvakrat kliknete, a potom vlozte hodnotu.

Do Name vlozte unikatni identifikator parametru.

Do Type zvolte z pop-up menu druh dat, které bude parametr obsahovat:
Zvolte Default pro pouziti fretézcové nebo Ciselné hodnoty.

Zvolte Arrow pro dynamicky seznam polozZek, které mohou rlist nebo se zmensovat.

Zvolte Object pro deklarovani nékolika vztahuijicich se prvkd se jmény a hodnotami,
jako je objekt Point s prvky x a y.

Zvolte List pro omezeni vybéru na nékolik voleb jako je true nebo false nebo Red,
Green nebo Blue

Pro Value zvolte z pop-up menu nastavenou hodnotu, kterou bude parametr obsahovat.
Pokud chcete pouzit upravené prostredi pro panel Klip Parametry, provedte jedno
z nasledujicich:

Zadejte relativni cestu do SWF soubor s upravenym rozhranim v poli Link to Custom Ul

(Odkazat na upravené Ul).

Kliknéte na slozku Link to Custom Ul a zobrazte SWF s upravenym rozhranim.

Viz ,Vytvareni specialniho rozhrani®.

Pro Description vlozte poznamky, které se objevi v panelu Klip Parametry a které popisuiji,
co kazdy parametr déla.

Do Popisu mUzete zahrnout jakoukoliv informaci podle které se miiZze nékdo dalsi
v klipu orientovat. Napfiklad vysvétleni metod, které jste definovali atd.
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Zvolte Lock in Instance, abyste zabranili uzivatelim v prejmenovani parametri v panelu
Klip Parametry.
Je doporucovano, abyste nechali jména parametrl zamknuta.

Kliknéte OK.

Nastaveni parametru klipu
Do smart klipu mizZete psat akce, které pouzivaji definované parametry, abyste zménili
chovani chytrého klipu. JednoduSe, pokud definujete parametr klipu pojmenovany Frame,
mUzete do chytrého klipu, ktery pouZiva parametr Frame, zapsat nasledujici skript:
onClipEvent (load) {

gotoAndStop (Frame) ;
}

Potom mUzete vybrat Smart Klip na Scéné a nastavit hodnotu parametru Frame v panelu
Klip Parametry pro zménu aktudlné prehravaného snimku.

[ & o || ] el B e 1 e

Clip Parameters

] Clip Parameters

Tlame [ walue
Frame

Nastaveni parametri smart klipu:
Zvolte instanci smart klipu na Scéné.

Smart klipy jsou movie klipy, takZe v autorském rezimu je zobrazen pouze prvni snimek.

Zvolte Window > Panels > Clip Parameters, pro zobrazeni panelu Klip Parametry.
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V panelu Klip Parametry udélejte jedno z nasleduijicich:
Dvakrat kliknéte na pole Value pro jeho vybrani a viozte hodnotu pro vSechny parametry.

Jestlize byl parametr definovan jako List, objevi se pop-up menu.
Jestlize bylo definovano specidlni rozhrani, pouzijte poskytnuté prvky rozhrani.
Zvolte Control > Test Movie, abyste vidéli zménu chovani smart klipu.
Vytvareni specialniho rozhrani

Custom interface (Specidlni rozhrani) je Flash animace, kterd umoznuje viozit hodnoty do smart
klipu. Specialni rozhrani nahrazuje rozhrani panelu Klip Parametry.
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Jakékoliv hodnoty, které zadate s pouzitim specidlniho rozhrani, jsou poslény z panelu Klip
Parametry klipu smart klipu pfes zprostfedkuijici, neboli vyménny, klip animace ve specidlnim
rozhrani. Vyménny klip animace musi mit ndzev instance xch. Pokud je v dialogovém okné
Define Clip Parameters oznaceno specialni rozhrani, posle instance smart klipu definované
parametry do klipu animace xch a jakékoliv noveé zadané hodnoty ve specidlnim prostredi
jsou zkopirovany do xch a poslany zpét smart klipu.

Klip xch musite umistit na hlavni Casovou osu animace rozhrani a také xch musi byt stéle
natazen. Movie klip xch by mél obsahovat pouze hodnoty, které maji byt vkladany do Smart
Klipu. Nemél by obsahovat jakoukoliv grafiku, jiné movie klipy nebo pfikazy ActionScriptu;
xch je pouze schranka, pres kterou jsou posilany hodnoty. Neméli byste ale predavat Arrays
nebo Objects.

Vytvoreni specidlniho rozhrani pro Smart klip:
Zvolte File > New pro vytvoreni nového Flash movie.

Zvolte Insert > New Symbol pro vytvoreni vyménného movie klipu.
Vytvorte novou vrstvu nazvanou ,Exchange Clip“.

S vybranou vrstvou ,,Exchange Clip“ tahnéte vyménny movie klip z okna Knihovna na Scénu
ve snimku 1.

Zvolte vyménny movie klip na Scéné, zvolte Window > Panels > Instance a vlozte jméno
xch.

Vytvorte prvky rozhrani, se kterymi bude autor interaktivovat s nastavenim klip parametrd.
Napriklad pop-up menu, radio tlacitka nebo polozky menu téhni a pust.

Pouzijte akci set variable pro kopirovani proménné a hodnot objektu do instance xch.

Napfiklad, jestlize je tlacitko pouzito jako prvek rozhrani, tla¢itko by mohlo mit akci,
kterd nastavuje hodnotu proménné vertical a propousti ji do xch:
on (release) {

_root.xch.vertical = true;
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Exportujte movie jako SWF soubor.

Abyste mohli pouzit SWF se specidlnim rozhranim se Smart Klipem, potfebujete je spoijit
v dialogovém okné Define Clip Parameters v knihovng, které obsahuje Smart Kilip.
Doporucuje se ulozit si SWF soubor do stejného adresare jako FLA obsahujiciho Smart
Klip. Pokud Smart Klip pouzijete v jiném souboru nebo jej poslete jinému vyvojafi, musi
Smart Klip a SWF se specidlnim rozhranim zstat ve stejnych relativnich umisténich.
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Integrace Flash s Web Aplikacemi

Flash animace mohou posilat informace do a natahovat informace ze vzdélenych soubord.
Pro posilani a natahovani proménnych pouzivate akci loadvariables, nebo getURL.
Pro natazeni animace (SWF souboru) ze vzddleného umisténi pouzivate akci loadMovie.
Pro posildni a natahovani XML dat pouzivdte objekt XML nebo XML Socket. XML data
mUzete strukturovat pomoci metod preddefinovanych XML objektd.

Mdzete také vytvaret formy Flashe skladajici se z prizptsobenych prvkl rozhrani, jako jsou
textova pole a pop-up menu, abyste sbirali data, kterd budou odesldna aplikaci na strané
serveru.

Abyste Flash rozsifili tak, Zze by odesilal vzkazy a také je pfijimal z prostfedi animace
hostitele - napfiklad Prehravace Flashe nebo funkce JavaScript v internetovém prohlize¢i
- mizete pouzit £scommand a metody Prehravace Flashe.

Posilani a natahovani proménnych do a ze vzdaleného souboru
Flash animace je vlastné okno pro ziskdvani a zobrazovani informaci, podobné jako HTML
stranka. Flash animace, na rozdil od HTML strdnek, mohou zUstat nataZzeny v prohlizeci
a nepretrzité aktualizovat informace. Pro posildni informaci do a obdrzeni informace
ze serverovych skriptd, textovych soubord a XML soubor(, mizete pouzit akce a metody
Flash objektl. Serverové skripty mohou pozadovat specifickou informaci z databéze a predavat
ji zpét a vpred mezi databazi a Flash animaci. Serverové skripty mohou byt napsany v riznych

Vv vavw

jazycich: nejbéznéjsi jsou Perl, ASP (Microsoft Active Server Pages) a PHP.

Ukladani informaci v databdzi a jejich ziskdvani umoznuje vytvaret dynamické animace.
Napriklad mGzete vytvorit tabuli zprav, persondlini profily pro uzivatele nebo nakupni kartu,
ktera si pamatuje co uzivatel koupil, takze mize urcit preference uZivatele.

Kazdd akce a metoda, kterd prendsi informace z a do animace pouzivd pro prenos informaci
protokol. Kazda také pozaduje urcity zplsob formatovani informace.

Nésledujici akce pouzivaji HTTP nebo HTTPS protokol pro posilani informace v URL
zakédovaném formatu: getURL, loadVariables, loadMovie.

Nésledujici metody pouzivaji HTTP nebo HTTPS protokol pro poslani informace jako XML:
XML.send, XML.load, XML.sendAndLoad.

Ndsledujici metody vytvareji a pouzivaji TCP/IP socket spojeni pro poslani informace jako
XML: XMLSocket.connect, XMLSocket.send.
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O bezpecnosti

Kdyz prehravate Flash animaci ve webovém prohlize¢i, miiZzete do animace nahrat data
pouze ze souboru, ktery je na serveru ve stejné subdoméme. To zabrani tomu, aby byly
animace ve Flashi schopny stahovat informace ze server( jinych lidi.

Abyste ur€ili subdoménu URL skladajiciho se z jedné nebo dvou slozek, pouzijte celou

doménu:

Doména

Subdoména

http://macromedia

macromedia

http://macromedia.com

macromedia.com

Pro uréeni subdomény URL sestavajici z vice nez dvou komponent odstrarte posledni uroven:

Doména

Subdoména

http://x.y.macromedia.com

y.macromedia.com

http://x.y.macromedia.com

macromedia.com

Nasledujici graf ukazuje, jak Flash Prehravac urcuje, zda pfipustit nebo nepfipustit HTTP
poZadavek:
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Kdyz pouzivate XML Socket objekt pro vytvoreni socket spojeni se serverem, musite pouzit
port Cislo 1024 nebo vyssi. (Porty s nizsim Cislem jsou bézné pouzivany pro Telnet, FTP,
World Wide Web nebo Finger.)

Flash se spoléha na bezpecnostni rysy standardniho browseru, HTTP a HTTPS. V podstate
Flash nabizi stejnou bezpecnost, ktera je dosazitelnd u standardniho HTML. Méli byste
dodrzovat stejna pravidla, ktera pouzivate pfi zabezpeCovani HTML stranek. Napfiklad
pro zajisténi bezpecného hesla ve Flashi potfebujete nastavit autentikaci hesla s zadosti
na web server.

Pro vytvoreni hesla pouzijte textové pole, které bude heslo od uzivatele pozadovat.
Predlozte ho serveru v akci loadvVariables nebo v metodé XML . sendAndLoad, pomoci
pouziti HTTPS URL s metodou POST. Web server mize potom verifikovat, zda je heslo
platné. Timto zptsobem nebude heslo nikdy dostupné v SWF souboru.

Kontrola natazenych dat
Kazda akce a metoda, kterd natahuje data do animace (kromé XMLSocket. send) je
asynchronni; vysledky akce jsou obdrzeny v neuréeném case.

Drive nez budete moci natazena data v animaci pouzit, musite provést kontolu, zda byla
data natazena. Napfiklad natdhnout proménné a manipulovat s hodnotami téchto promén-
nych miZete v jednom skriptu. V nasledujicim skriptu nemlZete pouZit proménnou
lastFrameVisited, dokud si nejste jisti, Ze byla natazena ze souboru myData. txt:
loadvVariables (,myData.txt“,0);

gotoAndPlay (lastFrameVisited)

Kazda akce a metoda ma ur€itou techniku, kterou Ize pouzit pro kontrolu natazenych dat.
Jestlize pouzijete akce loadvariables nebo loadMovie, mizZete natdhnout informaci
do cile movie klipu a pro vykonani skriptu pouzit uddlost data, akce onClipEvent. Jestlize
pouzijete akci loadvariables pro natazeni dat, akce onClipEvent (data)se vykond
aZ kdyZ je natazena posledni proménna. Jestlize pouZijete akci loadMovie pro natazeni
dat, akce onClipEvent(data) se vykona i kdyz je natazena pouze ¢dst animace.

Nasledujici akce tlaCitka, natdhne proménné ze souboru myData.txt do movie klipu
loadTargetMC:
on (release) {

loadVariables (,myData.txt™, _root.loadTargetMC) ;

Akce pfipojena k instanci LoadTarge tMC pouziva proménnou lastFrameVisited, kterd
je nataZzena ze souboru myData. txt. Nasledujici akce se vykona poté, co jsou vSechny
proménng, véetné lastFrameVisited, natazeny:
onClipEvent (data) {

gotoAndPlay (lastFrameVisited) ;
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Jestlize pouzijete metody XML.load a XMLSocket.connect, mizZete nadefinovat
ovlada¢, ktery postoupi data ihned po jejich obdrzeni. Ovlada¢ je vlastnost XML nebo
XMLSocket objektu, ke kterému pfipojite nadefinovanou funkci. Ovladace jsou volany auto-
maticky pfi obdrzeni informace. Pro XML objekt pouZijte XML.onLoad. Pro XMLSocket
objekt pouzijte XMLSocket .onConnect.

Vice informaci viz ,Pouziti objektu XML“ a ,Pouziti objektu XMLSocket".

Pouziti loadVariables, getURL a loadMovie
V8echny akce loadVariables, getURL a loadMovie komunikuji se serverovymi skripty
pomoci HTTP protokolu. KaZda akce posild véechny proménné z Casové osy, ke které
je tato akce pfipojena; akce reaguji nasledovné:

getURL ddva jakoukoliv informaci do okna browseru, nebo do Flash Prehravace.

loadVariables natahuje proménné do uréené Casové osy ve Flash Prehrdvadi.
loadMovie natahuje animaci do ur¢ené urovné ve Flash Prehravadi.
Kdyz pouZivate akce loadVariables, getURL nebo loadMovie, mizZete zadat nékolik
argumentu:
URL je soubor obsahujici vzdalené proménné.
Location je uroven, nebo cil v animaci ktera proménné obdrzi.
Vice informaci o trovnich a cilech viz ,O nékolika Casovych oséch®.

Poznamka: Akce getURL argument this nepotrebuje.

Variables nastavuje HTTP zpUsob, bud GET nebo POST, kterym budou proménné
poslany.

Napriklad, jestlize chcete sledovat nejvy$si skdre ve hre, méli byste ukladat skdére na
serveru a pouzit akci loadvariables pro jejich natazeni do animace pfi kazdém spusténi
hryy. Akce by mohla vypadat takto:

loadVariables (,http://www.mojeStranka.cz/skripty/vysoke skore.php"“,
_root.skoreKlip,GET) ;
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Toto natahne proménné z PHP skriptu nazvaného vysoke_skore.php do instance movie
klipu skoreKlip pomoci HTTP zplsobu GET.

Jakékoliv proménné natazené pomoci akce loadVariables musi byt ve standardni
MIME format aplikaci/x-www-urlformencoded (standardni format pouzivany CGl skripty).
Aby Flash mohl soubor Cist, musi byt soubor ktery urCujete v URL argumentu akce
loadVariables zapsan dvojici proménnd a hodnota, v tomto formatu.

Soubor mlze urcit jakykoliv pocet proménnych; dvojice proménnd a hodnota musi byt
oddéleny znaménkem ( & ) a slova uvnitf hodnoty musi byt oddélena znaménkem plus ( + ).
Napriklad tato fraze definuje nékolik proménnych:
vysokeSkorel=54000&hracJdmenol=rockin+dobry&vysokeSkore2=53455¢&hrac
Jmeno2=bonehelmeté&vysokeSkore3=42885&hracdmeno3=soda+pop

Vice informaci o loadvVariables, getURL a loadMovie viz Kapitola 7, ,ActionScript
Slovnik.”

O XML

XML (Extensible Markup Language) se stdva standardem pro vyménu strukturovanych
dat v Internetovych aplikacich. Data ve Flashi mizZete integrovat se servery, které pouzivaj
XML technologii pro vytvareni sofistikovanych aplikaci, jako je chat systém nebo maklérsky
systém atd.

V XML, tak jako v HTML, pouZivate tagy pro markup (oznaceni), nebo urceni téla textu. V HTML
pouzivate prfeddefinované tagy pro indikaci, jak by mél text vypadat v prohlizeci (napriklad
tag <b> indikuje, Ze text by mél byt tuény). V XML definujete tagy, které identifikuji typ ¢asti dat
(napfiklad <heslo>VelmiTajné</heslo>). XML oddéluje strukturu informace od zplsobu,
jakym je zobrazena. Toto umozniuje, aby byl stejny XML dokument pouzity a znovu pouzity
v rlznych prostredich.

Kazdy XML tag je nazvan node nebo prvek. Kazdy node ma typ (1-XML prvek nebo 3-text
node) a také prvky mohou mit atributy. Node ,uhnizdény“ v node je nazvan child (dité)
nebo childNode (détskyNode). Takovato hierarchicka stromova struktura nodd je nazvana
XML DOM (Document Object Model) - podobné jako DOM JavaScriptu, ktery je strukturou
prvkl ve Webovém prohlizeci.
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V nasledujicim prikladu, je <PORTFOLIO> rodiCovsky node; nema zadné atributy a obsahuje
détskyNode <HOLDING>, ktery ma atributy SYMBOL, QTY, CENA a HODNOTA:
<PORTFOLIO>
<HOLDING SYMBOL=,BOHATY"
QTY=,75"
CENA=,,245.50"
HODNOTA=,,18412.50%“/>
</PORTFOLIO>

Pouziti objektu XML

Metody ActionScript objektu XML mUzete pouzit (napfiklad appendChild, removeNode
a insertBefore), pro strukturovani XML dat ve Flashi, pro poslani stazenych XML dat na
server, manipulaci s nimi a jejich interpretaci.

Nasledujici metody objektu XML mdzete pouZit pro poslani a natazeni XML dat na server
pres HTTP zplsob POST:
load natdhne XML z URL a umisti ho do ActionScript XML objektu.

send preda XML objekt do URL. Jakakoliv vracena informace je poslana do dalsiho
okna browseru.

sendAndLoad posle XML objekt do URL. Jakakoliv vracena informace je umisténa
do ActionScript XML objektu.

Napriklad byste mohli vytvofit maklérsky systém pro obchodovani s cennymi papiry, ktery
uklada véechny informace (jména uzivateld, hesla, ID zasedani, portfolio holdingy a informace
o transakcich) do databaze.

Serverovy skript, ktery pfedava informaci mezi Flash a databazi, ¢te a piSe data v XML formatu.
ActionScript mlzete pouzit, pro konverzi informace ziskané ve Flash animaci (napfiklad
username a password) na XML objekt a potom data poslat do serverového skriptu jako
XML dokument. Také mUzZete pouzit ActionScript pro natazeni XML dokumentu, ktery serv-
er vraci do XML objektu, pro pouziti v animaci.

Server-side script Database

Flash Player mowvie

Validace heslem pro maklérsky systém pozaduje dva skripty: funkci definovanou na snimku
1 a skript, ktery vytvafi a posila XML objekty pfipojené k tlacitku Submit ve formulari.

Kdyz uzivatelé vlozi svou informaci do textovych poli ve Flash animaci s proménnymi
username a password, musi byt proménné konvertovany na XML dfive nez budou
pfedany na server. Prvni ¢ast skriptu natdhne proménné do nové vytvoreného XML objektu
nazvaného loginXML. Kdyz uZivatel stiskne tlacitko Submit, je objekt 1oginXML konvertovan
na fetézec XML a poslan na server.

Nasledujici skript je pfipojen k tladitku Submit. Pro pochopeni skriptu ¢téte komentare
indikované znaky //:
on (release) {
// A.Konstrukce XML dokumentu a prvkem LOGIN
loginXML = new XML() ;
loginElement = loginXML.createElement ("LOGIN") ;
loginElement.attributes.username = username;
loginElement.attributes.password = password;
loginXML.appendChild (loginElement) ;

// B.Konstrukce XML objektu pro obdrZeni odpovédi serveru
loginReplyXML = new XML() ;
loginReplyXML.onLoad = onLoginReply;

// C.Posléani prvku LOGIN do serveru, umisténi odpovédi do loginReplyXML
loginXML.sendAndLoad ("https://www.imexstocks.com/main.cgi",
loginReplyXML) ;

}

Prvni ¢ast skriptu generuje nasledujici XML pfi uzivatelove stisku tlacitka SUBMIT:
<LOGIN USERNAME="JeanSmith"PASSWORD="VelmiTajné&"/>

Server obdrzi XML, generuje XML odpoved a posild ji zpét do Flash animace. Jestlize je heslo
akceptovano, server odpovi nasledujicim zplsobem:
<LOGINREPLY STATUS="OK"SESSION="rnr6f7vkj2oeldm7jkkycilb"/>

Tento XML zahrnuje atribut SESSION, ktery obsahuje unikatni, ndhodné generované session
ID, které bude pouzito ve vSech komunikacich mezi klientem a serverem po cely zbytek
spojeni. Jestlize je heslo odmitnuto, server odpovi nasledujici zpravou:

<LOGINREPLY STATUS="FAILED"/>

XML node LOGINREPLY se musi natdhnout do prazdného XML objektu ve Flash animaci.
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Nasledujici pfikaz vytvari XML objekt loginreplyXML pro obdrzeni XML node:
//B. Konstrukce XML objektu pro obdrZeni odpovédi serveru
loginReplyXML = new XML() ;

loginReplyXML.onLoad = onLoginReply;

Druhy pfikaz prfipojuje funkci onLoginReply k ovladaci loginreplyXML. onLoad.

XML prvek LOGINREPLY pfichdzi asynchronné, podobné jako data z akce 1loadvariables,
a natahuje se do objektu loginReplyXML. Kdyz data pfijdou, je volana metoda onLoad
objektu loginReplyXML. Musite definovat funkci onloginReply a pfipoijit ji k ovladaci
loginReplyXML.onLoad tak, aby mohla pfeddvat prvek LOGINREPLY. Funkce onloginReply
je pfipojena ke snimku, ktery obsahuje tlacitko SUBMIT.
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Funkce onloginReply je definovdna v prvnim snimku animace. Pro pochopeni skriptu
Ctéte komentare, které jsou oznaceny znaky //:
function onLoginReply () {
// Ziskat prvni XML prvek
var e = this.firstChild;
// JestliZe je prvni XML prvek prvek LOGINODPOVED se
// stavem OK, jdi na obrazovku portfolio. Jinak,
// jdi na obrazovku login neuspésné a nech to uZivatele zkusit znovu.
if (e.nodeName == "LOGINREPLY" && e.attributes.status == "OK") {
// UloZeni ID session pro budouci komunikaci se serverem
sessionID = e.attributes.session;
// Jdi na obrazovku prohliZeni portfolia
gotoAndStop ("portfolioView") ;
lelse {
// Login neuspésné! Jdi na obrazovku neuspé&sné login.
gotoAndStop ("loginFailed") ;
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Prvni radek této funkce, var e=this. firstChild, pouziva klic¢ové slovo this pro odkaz
na XML objekt loginReplyXML, ktery byl pravé natazen s XML ze serveru. MizZete pouZit
this, protoZze onloginReply bylo volano jako 1loginReplyXML . onLoad, takzZe i kdyz se zda,
Ze onloginReply vypada jako jednoducha funkce, ve skuteCnosti se chova jako metoda
loginReplyXML.

Pro poslani username a password jako XML do serveru a natazeni XML odpovéedi zpét do
Flash animace, mizete pouzit metodu sendAndLoad:

//C. Poslat prvek LOGIN do serveru, umistit odpovéd do loginReplyXML
loginXML.sendAndLoad ("https://www.imexstocks.com/main.cgi",
loginReplyXML) ;

Vice informaci o XML metoddch viz Kapitola 7, ,ActionScript Slovnik.*

Poznamka: Tento navrh je pouze priklad a neklade Zadné pozadavky na uUroven bezpecnosti.
Jestlize implementujete bezpecnostni systém chranény heslem, ujistéte se, Ze jste dobre
pochopili bezpec€nost sité.

Pouziti objektu XMLSocket

ActionScript nabizi prfeddefinovany XMLSocket objekt, ktery umoznuje otevfit nepretrzité
spojeni se serverem. Socket spojeni umozriuje serveru predavat informace ke klientovi, jakmile
je informace dostupna. Bez nepretrzitého spojeni musi server ¢ekat na pozadavek HTTP.
Toto oteviené spojeni odstrariuje latentni problémy a je bézné pouzivano pro aplikace v rediném
Case, jako jsou chaty. Data jsou posilana pres socket spojeni jako jeden fetézec a méla by byt
v XML formaétu. Pro strukturovani dat mlzete pouzit XML objekt.

Pri tvorbé socket spojeni musite vytvorit serverovou aplikaci, kterd bude ¢ekat na pozadavek
socket spojeni a posilat odpovéd do Flash animace. Tento typ serverové aplikace mize byt
napsan v programovacim jazyce Java.

Metody objektu XMLSocket connect a send, miizete pouzit pro transfer XML do a ze serveru
pfes socket spojeni. Metoda connect zfizuje socket spojeni s portem Web serveru.
Metoda send posila XML objekt na server specifikovany v socket spojeni.

Jestlize volavate metodu connect, Flash Pfehravac otevie TCP/IP spojeni se serverem a udrzuje
spojeni oteviené, dokud se nestane nasleduijici:

Je voldna metoda close objektu XMLSocket.
Neexistuji uz zddné odkazy na objekt XMLSocket.
Je ukoncena aplikace Flash Prehrdvace.

Je preruseno spojeni (napfiklad nespojeni nebo odpojeni modemu).
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Nasledujici pfiklad vytvafi XML socket spojeni a posila data z XML objektu myXML. Pro
pochopeni skriptu ¢téte komentare indikované znaky//:

//vytvofit novy XMLSocket objekt
sock = new XMLSocket() ;
//volat jeho metodu connect ke z¥izeni spojeni s portem 1024 serveru na URL
sock.connect ("http://www.myserver.com",1024) ;
//definovat funkci pro p¥ipojeni sock objektu, ktery ¥idi odpovéd serveru.
//Jestlize je spojeni uspésné, poslat myXML objekt.
//JestliZe Uspésné neni, poskytnout chybovou zpravu v textovém poli.
function onSockConnect (success) {
if (success) {
sock. send (myXML) ;
lelse {
msg = "Je zde chybné spojeni se" + jménoServeru;

}
//ptipojit funkci onSockConnect k vlastnosti onConnect
sock.onConnect = onSockConnect;

Vice informaci viz Kapitola 7, ,ActionScript Slovnik.”

Vytvareni formulara

Formulare poskytuji pokrocily typ interaktivity - kombinace tlacitek, animaci a textovych poli,
které umoznuji pfedavani informaci do jiné aplikace na lokalnim nebo vzdaleném serveru.
Vsechny bézné prvky formuldrll (jako jsou radio tlacitka, drop-down seznamy a check boxy)
mohou byt vytvoreny jako movie klipy nebo tlacitka, ktera zapadnou do struktury vasich stranek,
dle vaSeho grafického citéni, nebo podle designu vasi Web stranky. NejbéznéjSim prvkem
formulare je vstupni (input) textové pole.

Bézné typy formular(, které pouzivaji prvky rozhrani, zahrnuji chat rozhrani, objedndvkové
formuldre a prohledavaci rozhrani. Formuldf mdlze napfiklad sbirat informace o adresdch
a posilat je do jiné aplikace, ktera kompiluje informace do e-mail zpravy nebo databazoveého
souboru. Dokonce i jednoduché textové pole je povazovano za formular a mize byt pouzito
pro sbirani vstupl uzivatele a zobrazeni vysledkd.

Formulare pozaduiji dvé hlavni komponenty: prvky Flash rozhrani, které vytvareji formular a bud
serverovou aplikaci nebo klientsky skript pro predavani informace vlozené uzivatelem.
Nasledujici kroky ukazuji vSeobecny postup pro vytvareni formulare ve Flash.
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Vytvoieni formulare:
Umistéte prvky rozhrani do animace, do uréené vstvy.

Mdzete pouzit prvky rozhrani z bézné knihovny Buttons-Advanded, nebo vytvorit svoje
vlastni.

V panelu Volby Textu nastavte textova pole na Input a kazdému pfipojte unikatni jméno
proménné.

Vice informaci o vytvareni editovatelnych textovych poli viz Using Flash.

Pripojte akci, ktera bud posild, natahuje nebo posila a natahuje data.
Vytvareni prohledavaciho formulare
Priklad jednoduchého formulare je prohledavaci pole s tlacitkem Submit. Jako tvod do vytvareni
formularl poskytuje nasledujici priklad instrukce pro vytvareni prohleddvaciho rozhrani
pomoci pouziti akce getURL. VloZzenim pozadované informace mohou uzivatelé poslat

klicové slovo do prohledavaciho stroje na vzdaleném Web serveru.

Vytvoieni jednoduchého prohledavaciho formulare:
Vytvorte tlacitko pro predani vioZzenych dat.

Vytvorte popisek, prazdné textové pole a instanci tlacitka na Scéné.

VaSe obrazovka by méla vypadat takto:

KEYWORD Peanuts‘ SUBMIT

Zvolte textové pole a zvolte Window > Panels > Text Option.

V panelu Volby Textu nastavte nasleduijici volby:
Zvolte Input Text z pop-up menu.
Zatrhnéte Border/Bg.

UrCete jméno proménné.

Poznamka: Jednotlivé prohledavaci stroje mohou pozadovat specifické jméno proménné.
Detaily jsou uvedené ve Web site prohleddvaci stroje.
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Na Scéneé zvolte tlacitko a zvolte Window > Action.

Objevi se panel Objekt Akce.

Poznamka: Kontrolka vedle Akce v menu Window indikuje, Ze je panel otevieny.
Pretahnéte akci getURL z boxu nastroji do okna Skriptu.

V panelu Parametry nastavte nasledujici volby:
Pro URL vlozte URL prohleddvaciho stroje.

Pro Window zvolte _blank. Toto otevfe nové okno, které zobrazi vysledky

prohleddvani.
Pro Variable zvolte Send using GET.
Pro testovani formulare zvolte File > Publish Preview > HTML.

Pouziti proménnych ve formularich

Proménné ve formuldfich mizete pouzit pro uloZeni vstupu uzivatele. Pro posilani promén-
nych pouzijte editovatelnd textova pole nebo v prvcich rozhrani pfipojte akce k tlacitkéim.
Napriklad kazda polozka v pop-up menu je tla¢itko s akci, kterd nastavuje proménnou pro
indikovani vybrané polozky. Mlzete pfipojit jméno proménné do vstupu textového pole.
Textové pole se pak chova jako okno, které zobrazuje hodnotu této proménné.

Kdyz posilate informaci do a ze serverového skriptu, musi proménné ve Flash animaci
souhlasit s proménnymi ve skriptu. Napfiklad, jestlize skript oekdva proménnou nazvanou
password, textové pole, do kterého budou uzivatelé vkladat heslo, by mélo mit proménnou
jménem password.

Neékteré skripty pozaduiji schované (hidden) proménné, coz jsou proménné, které uzivatel nikdy
neuvidi. Pro vytvoreni schovanych proménnych ve Flashi miZete nastavit proménnou na snimku
v movie klipu, ktery obsahuje prvky jiného formulare. Schované proménné jsou poslany
do serverového skriptu spolu s ostatnimi proménnymi nastavenymi na Casové ose obsahuijici
akci, ktera predklada formular.
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Verifikace viozenych dat
Ve formuldfi, ktery propousti proménné do aplikace na Webovém serveru budete chtit
verifikovat, Ze uzivatelé vkladaji spravnou informaci. Napfiklad nechcete, aby uzivatelé
vkladali text do pole telefonni Cislo. Pouzijte sérii akci set variable ve spojenis for a if,
pro ohodnoceni viozenych dat.

Nasledujici ukazkova akce kontroluje, zda je vlozené Cislo a ze Cislo je ve formatu ###-
###-###+#. Jestlize jsou data platna, je zobrazena zprava ,Toto je platné telefonni Cislo!“.
Jestlize data nejsou platna, je zobrazena zprava ,Toto telefonni &islo je neplatné!*.

Pro pouziti tohoto skriptu v animaci vytvorte dvé textova pole na Scéné a pro kazdé zvolte
Input v panelu Volby Textu. Pfipojte proménnou phoneNumber k jednomu textovému poli
a ke druhému pfipojte proménnou message. Pfipojte nasledujici akci k tlaCitku na Scéné
vedle textovych poli:
on (release) {

valid = validPhoneNumber (phoneNumber) ;

if (wvalid) {

message = "Toto je platné telefonni ¢&islo!";
lelse {
message ="Toto telefonni ¢éislo je neplatné!";
}
function isdigit(ch) {
return ch.length == 1 && ch >= '0' && ch <= '9';
}
function validPhoneNumber (phoneNumber) {
if (phoneNumber.length != 12) {
return false;
}
for (var index = 0; index < 12; index++) {
var ch = phoneNumber.charAt (index) ;
if (index == | |lindex == 7) {
if (ch '= "-"){
return false;
}
}else if (!isdigit(ch)){
return false;
}
}
return true;
}
}
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Pro poslani dat vytvorte tlacitko, které ma akci podobnou nasledujici:
(Nahradte argumenty ge tURL argumenty, které odpovidaji vasi animaci.)
on (release) {
if (valid){
getURL ("http://www.webserver.com", "_self", "GET");

Vice informaci o téchto ActionScript pfikazech viz set, for a i £ v Kapitole 7, ,ActionScript
Slovnik®.

Posilani zprav do a z Flash Prehravace

Pro posilani zprav z animace do jejiho hostitelského prostfedi (napfiklad Webového
browseru, Director movie nebo samostatného Flash Prehravace) mizZete pouZit akci
fscommand. To umozni rozsifit animaci o pouziti schopnosti hostitele. Napfiklad byste
mohli poslat akci £scommand do funkce JavaScript na HTML strance, ktera otevird okno
browseru s urcitymi vlastnostmi.

Pro ovladani animace ve Flash Prehravaci ze skriptovacich jazykd prohlizece jako
JavaScript, VBScript a Microsoft Jscript mizete pouzit metody Flash Prehravace -- funkce,
které posilaji zpravy z hostitelského prostredi do Flash animace. Napfriklad byste mohli mit
fadek na HTML strance, ktery posila vasi Flash animaci na urcity snimek.

Pouziti fscommand
Pouzijte akci £scommand pro poslani zpravy do jakéhokoliv programu, ktery hosti Flash
Prehravac. Akce £scommand ma dva parametry: command (pfikaz) a argumets (argumenty).
Pfi posilani zpravy do samostatné verze Flash Pfehravace musite pouzit pfeddefinované
pfikazy a argumenty. Napfiklad nasledujici akce nastavuje samostatny prehravac pro rozsifeni
animace na velikost celé obrazovky, kdyz je uvolnéno tlacitko:
on (release) {

fscommand ("fullscreen", "true");

Nasledujici tabulka ukazuje hodnoty, které mizete zadat do parametr( prikaz a argumenty
akce £scommand, pro kontrolu animace hrajici v samostatném prehravaci (véetné projektord):

Command Arguments Ugel

quit Z&dné Zaviré projektor.

Specifikace true nastavuje Flash Prehravac
na rezim celé obrazovky.

Specifikace false nechava prehravac¢ v normainim
rezimu zobrazeni.

Specifikace false nastavuje prehravac tak,

Ze animace je stale prehrévana ve své plvodni

fullscreen true / false

allowscale true / false

velikosti a neni nikdy pfizplsobovana.
Specifikace true pfizplsobi animaci na 100%
prehravace.

Specifikace true umozni pIné nastaveni
poloZek kontext menu. Specifikace false
zastini vSechny polozky kontext menu kromé
O Flash Prehravadi.

Vykona aplikaci z uvnitf projektoru.

showmenu true / false

exec Cesta do aplikace

Pfi pouziti £scommand k posilani zpravy do skriptovaciho jazyka jako JavaScript ve Web
browseru, mlzete preddvat jakékoliv dva argumenty v parametrech command a arguments.
Tyto argumenty mohou byt fetézce nebo vyrazy a budou pouzity v JavaScript funkci,
ktera ,chyta“ nebo fidi akci £scommand.

Akce fscommand vold na HTML strance JavaScript funkci moviename DoFSCommand,
ktera vklada Flash animaci, kde moviename je jméno Flash Pfehravace, které je ur¢eno
atributem NAME tagu EMBED, nebo atributem ID tagu OBJECT. Jestlize je Flash Prehravac
uren jménem myMovie, voland JavaScript funkce je myMovie DoFSCommand.

Pouziti akce fscommand, pro otevieni boxu zprav z Flash animace na HTML strance
pfes JavaScript:
Na HTML stranku, kterd vklada Flash animaci pfipojte nasledujici JavaScript kod:
function theMovie_DoFSCommand (command, args) {
if (command == "messagebox") {
alert (args) ;

Jestlize publikujete animaci pomoci Flashe se Sablonou FSCommand v HTML Nastaveni
Publikace, je tento kod vlozen automaticky. Atributy movie NAME a ID budou jména
soubor(l. Napriklad pro soubor myMovie.fla by byly atributy nastaveny na myMovie.
Vice informaci od publikovani viz Using Flash.
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Ve Flash animaci pridejte akci £scommand k tlagitku:
fscommand (“messagebox“,“Toto je box zprav volavanych z Flash.“)

Také mUzete pouZit vyrazy pro akci £scommand a argumenty:
fscommand (“messagebox™, “Ahoj,“& name &“, vitej na nasSi Web site!")

Zvolte File > Publiblish Preview > HTML, pro otestovani movie.

Akce £scommand miZe do Macromedia Directoru poslat zpravy, které jsou interpretovany
pomoci Lingo jako fetézce, udalosti nebo proveditelny Lingo kdd. Jestlize je zprava fetézec
nebo udalost, musite napsat Lingo kdd pro jeji obdrzeni z akce £scommand a vykonat akci
v Directoru. Vice informaci viz Director Support Center na http://www.macromedia.com/
support/director.

Ve Visual Basic, Visual C++ a dalSich programech, které mohou hostit ActiveX kontroly,
posila £scommand VB uddlost se dvéma fetézci, které mohou byt ovladany v prostredi
programovaciho jazyka. Pro vice informaci pouZijte klicova slova Flash method pro hledani
Flash Support Center na http://www.macromedia.com/support/flash.

O metodach Flash Prehravace

Metody Flash Prehravate mizete pouzit pro ovladani animace ve Flash Prehravaci ze
skriptovacich jazyk( Web prohlizece, jako jsou JavaScript a VBScript. Metody lIze také pouzit
pro posilani volani do Flash Prehravace z jinych skriptovacich prostfedi nez je ActionScript.
Kazda metoda ma jméno a vétSina metod také argumenty. Argument specifikuje hodnotu,
na které metoda operuje. Kalkulace provedena nékterymi metodami dava hodnotu, ktera
mUze byt pouzita skriptovacim prostredim.

Existuji dvé rdizné technologie umoznuijici komunikaci mezi prohlizeCem a Flash Prehravacem:
LiveConnect (Netscape Navigator 3.0 nebo pozdéji na Windows 95/98/2000/NT nebo
Power Macintosh) a ActiveX (Microsoft Internet Explorer 3.0 a pozdé&ji na Windows
95/98/2000/NT). Ackoliv techniky skriptovani jsou podobné pro vSechny prohlizeCe a jazyky,
jsou zde dodatecné vlastnosti a udalosti dostupné pro pouziti s kontrolami ActiveX.

Pro ziskani vice informaci, véetné kompletniho seznamu skriptovacich zpUsobl Flash
Prehravace pouzijte kliCova slova Flash method pro vyhledani Flash Support Center
na http://www.macromedia.com/support/flash.
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Odstranovani chyb v ActionScriptu

Uroven sofistikovanosti (Uroveri sloZitosti) nékterych akci, zvlasté v kombinaci s dalsimi,
mUZe vytvaret vysokou obtiznost skriptl ve Flash animacich. Stejné jako u jinych programovacich
jazyk(, mOzete napsat nespravny skript, ktery zplsobuje chyby v animaci. Pouziti spravnych
autorskych technik usnadnuje odstranovani zdvad v animaci, pokud se néco chova
neocekdvané.

Flash ma nékolik nastrojli pro testovani animace v ReZimu Test-Movie nebo ve Web
browseru. Debugger (Odstrariova¢ zavad) ukazuje hierarchicky seznam zobrazeni movie
klipd aktualné natazenych do Flash Prehravace. Umozriuje také zobrazit a upravovat hodnoty
proménné, béhem prehravani animace. V Rezimu Test-Movie, okno Output zobrazuje chybové
zprdvy, seznamy proménnych a objekt(. Také mizete ve skriptech pouzit akci trace, pro
poslani programovacich poznamek a hodnot vyrazt do okna Output.

Autorské smérnice a smérnice pro odstrafiovani zavad

Jestlize pouzivéte spravné autorské praktiky pfi psani skriptd, budou vase animace mit malo
chyb (programovacich chyb). Snazte se dodrZovat nasledujici zasady, které vam pomohou
zabranit vzniku problém(, a v pripadé jejich vyskytu je i rychle nalézt.

Pouziti spravnych autorskych praktik

Je dobré béhem prace uklddat nékolik verzi animace. Zvolte File > Save As pro ulozeni
verze s jinym jménem kazdé pll hodiny. Odpovéd na otazku kde zacal problém naleznete
sledovanim historie ukladani jednotlivych verzi tim, Ze naleznete posledni soubor, ve kterém
jesté problém nebyl. Pfi pouZiti tohoto postupu mate stéle funkéni verzi, dokonce i kdyz je jeden
soubor Spatny.

Dalsi dllezitou autorskou praktikou je testovat vcas, testovat Casto a testovat na vSech
cilovych platformdch, abyste nalezli problémy hned po jejich vyskytu. Zvolte Control > Test
Movie, pro prehrani animace v rezimu test-movie, kdykoliv udélate vétsi zménu nebo pred
uloZenim verze. V rezimu test-movie bézi animace ve verzi samostatného prehravace.

Pokud je vase animace uréena pro Web, je duleZité ji testovat také v prohlizeci. V uréitych
situacich (napriklad jestlize vyvijite pro intranet) mozna budete znat typ prohlizece a platformu
uzivatele. Jestlize vyvijite pro Web, testujte animaci ve vSech prohlize¢ich na vSech
potenciondlnich platformach.
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Je dobré pouzivat tyto autorské praktiky:
PouZivejte akci trace pro posilani komentard do okna Output. Viz ,PouZziti stopa“.

Pouzivejte akci comment pro zahrnuti instruktaznich poznamek, které se objevi
pouze v panelu Akce. Viz ,Komentare“.

Pouzivejte odpovidajici konvence pojmenovavani pro identifikaci prvkd ve skriptu.
Napriklad je dobré vyhnout se mezeram ve jménech. Zacinejte jména proménnych
a funkci malym pismenem a pouzivejte velké pismeno pro kazdé nové slovo
(mojePromennadmeno, mojeFunkcedmeno). Zacinejte jména konstrukeni
funkce velkym pismenem (MojeKonstrukcniFunkce). NejdUlezitéjsi je zvolit styl,
ktery vam ddva smysl| a dlsledné ho pouZivat.

Pouzivejte jména proménnych, kterd maji vyznam odrazejici druh informace, kterou
proménna obsahuje. Napfiklad proménna obsahuijici informaci a naposledy stisknutém
tla¢itku by mohla byt pojmenovana posledniStisknuteTlacitko. Jméno jako foo
by téZko pfipomenul ¢eho se proménna tyka.

PouZivejte editovatelna textova pole ve vodicich (guide) vrstvach pro sledovani hodnot
proménnych jako alternativu k pouziti Debuggeru.

Pouzivejte Movie Explorer v Rezimu Edit-Movie pro prohlizeni seznamu zobrazeni
a prohlizeni vSech akci v animaci. Viz Flash Help.

Pouzivejte akci £or...in, pro smyc¢kovani napfi¢ vlastnostmi movie klipd, véetné
détskych movie klipd. Akci for...in s akci trace miZete pouzit pro poslani seznamu
vlastnosti do okna Output. Viz ,Opakovani akce*”.

Pouziti kontrolnich seznamu odstranovani zavad

Stejné jako u kazdého skriptovaciho prostredi i zde tvirci skriptd bézné délaji urcité chyby.

Nasledujici seznam je dobry pro zacatek préce pfi odstrariovani problém( v animaci:
Ujistéte se, Ze jste v reZimu test-movie.

V autorském prostredi budou fungovat pouze jednoducha tlacitka a akce snimku
(napriklad gotoAndPlay a stop). Zvolte Control > Enable Simple Frame Actions
nebo zvolte Control > Enable Simple Buttons, pro umoznéni téchto akci.

Ujistéte se, Zze nemate akce snimku na nékolika vrstvach, které jsou mezi sebou
V rozporu.

Jestlize pracujete s panelem Akce v Normalnim Rezimu, ujistéte se, Ze vas pfikaz
(statement) je nastaven na vyraz (expression).
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Jestlize zaddvate vyraz v akci a nebyl zvolen box Expression, hodnota bude predana
jako retézec. Viz ,Pouziti operator( pro manipulaci s hodnotami ve vyrazech®.

Ujistéte se, Zze zadné prvky ActionScriptu nemaji stejné jméno.

Je dobré dat kazdé proménné, objektu a vlastnosti unikatni jméno. Lokalni proménné
jsou vyjimky: musi byt unikatni pouze ve svém prostoru a jsou ¢asto pouzivané znovu
jako pocitadla. Viz “Rozsah proménné“.

Vice tipll o odstrarnovani problém( ve Flash movie viz Flash Support Center
na http://www.macromedia.com/support/flash.

Pouziti Odstranovace zavad (Debugger)

Odstraniova¢ zavad umozriuje najit chyby v animaci pfi jejim béhu ve Flash Prehravagi. Pro
uréovani spravnych hodnot si miZete prohlizet seznam zobrazeni movie klipti, natazené
externi animace a zmény hodnot proménnych a vlastnosti. MZete se pak vrétit do skriptu
a editovat je tak, aby ddvaly pozadované spravné vysledky. Pfi pouziti OdstrarfiovaCe zavad
musite spustit Flash Debug Pfehravag, specialni verzi Flash Pfehravace.

Flash Debug Prehrava¢ (Player) je automaticky instalovan s autorskou aplikaci Flash 5.
Umozriuje stdhnout seznam zobrazeni, jméno proménné a dvojice hodnot, jméno vlastnosti

a dvojice hodnot do Odstrariovace zavad ve Flash autorské aplikaci.

Zobrazeni Odstranovace zavad:
Zvolte Window > Debugger (Odstrariova¢ zdvad).

Toto otevie Odstrafiova¢ zdvad v neaktivnim stavu. V seznamu zobrazeni se neobjevi
z4dnd informace, dokud neni vydan prikaz z Flash Prehravace.

Aktivace Odstranovace zavad v rezimu test-movie:
Zvolte Control > Debug Movie.

Toto otevre Odstrariovac zavad v aktivnim stavu.

/e Debugas 2]

Test [ Status bar

I Display list

— WWatch list

[— Wariabl
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Umoznéni odstranovani zavad v animaci

Pokud exportujete animaci, miZete zvolit moZnost odstrariovani zavad a vytvorit heslo pro
odstranovani zavad. Jestlize neumoznite odstrariovani zavad, Odstranovac zavad se nebude
aktivovat.

Stejné jako v JavaScriptu nebo HTML, jakékoliv klientské proménné mohou byt potencionalné
prohlizeny uzivatelem. Abyste proménné bezpecné ulozili, musite je poslat do serverové
aplikace namisto jejich ukladani do animace.

Nicméné, jako vyvojar Flash, mizZete mit svoje obchodni tajemstvi, napfiklad struktury
movie klipl apod., které nechcete prozradit. Abyste zajistili, Ze pouze vami vybrani dGvéryhodni
uzivatelé si mohou vase animace prohlizet s Flash Debug Prehravac¢em, miZete vasi animaci

publikovat s heslem Odstrafiovace zavad.

Umoznéni odstranovani zavad a vytvoreni hesla:
Zvolte File > Publish Settings.

Kliknéte na tabulku Flash.
Zvolte Debugging Permitted.
Pro nastaveni hesla vlozte heslo do boxu Password.

Bez tohoto hesla nem(zete stahnout informaci do Odstrariovac¢e zavad. Jestlize nechate
pole hesla prazdné, neni pozadovano heslo zadné.

Aktivace Odstranovace zavad ve Web browseru:
Kliknéte vpravo (Windows) nebo na Control (Macintosh) pro otevieni kontext menu
Flash Debug Player.
Zvolte Debugger.

Poznamka: Odstrariovac zavad mUlzete pouzit pro monitorovani pouze jedné animace
v jednom Case. Pro pouziti Odstrafiovace zdvad musi byt otevieny Flash.

Zoom In

Guality 3

Frint

About Macromedia Flash Player 5...
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O sloupci stavu
Kdyz je aktivovan, Debugger status bar zobrazuje URL nebo lokalni soubor cesty k animaci.
Flash Prehravac je implementovan v riznych forméch v zavislosti na prostredi prehravani.
Sloupec stavu Odstrafiovace zavad zobrazuje typ Flash Prehravace, na kterém animace
bézi:

Rezim test-movie

Samostatny prehravac
Netscape plug-in

Netscape plug-in je pouzivan s Netscape Navigator na Windows a Macintosh a v Microsoft
Internet Explorer na Macintosh.

ActiveX kontrola
ActiveX kontrola je pouzivana s Internet Explorer ve Windows.

O seznamu zobrazeni

Pokud je Odstraniovac zavad aktivni, ukazuje zivy nahled na seznam zobrazeni (display list)
movie klipl. Abyste vidéli vSechny movie klipy aktualné na Scéné, mlzete rozsitit a zUzit
vétve. Jestlizee jsou movie klipy pfipojeny k nebo odstranény z animace, seznam zobrazeni
ukazuje zmény okamzité. Pohybem horizontalniho rozdélovace nebo tazeni ze spodniho
pravého rohu, mizete zménit velikost seznamu zobrazeni.

Zobrazeni a modifikovani proménnych

Tabulka Variable v Odstrafiovaci zavad zobrazuje jména a hodnoty vSech proménnych v
animaci. Jestlize zménite hodnotu proménné v tabulce Variable, mizete tuto zménu vidét
ihned pfi béhu animace.

Zobrazeni proménné:
Zvolte movie klip obsahujici proménnou ze seznamu zobrazeni.

Kliknéte na tabulku Variable.
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Seznam proménnych se automaticky aktualizuje béhem pfehravani animace. Jestlize
je na urcitém snimku movie klip odstranén z animace, je odstranén také ze seznamu
zobrazeni v Odstrafiovaci zavad; toto odstrani jméno proménné a takeé jeji hodnotu.

£ Debugger L

Test Movie:

|[Properties] Variables wateh ]

_root.myMovieClip

Name [Value
chiis lungfish

jetf tarpon
labRiats [
mytreay

noah bowfin

Modifikace hodnoty proménné:
Zvolte hodnotu a viozte novou hodnotu.

Hodnota musi byt konstantni hodnota (napfiklad “Aho3j"“, 3523, nebo , http://www.macro-
media.com"), ne vyraz (napfiklad x+2, nebo eval (,jméno:“+i)). Hodnota mizZe byt
fetézec (jakakoliv hodnota obklopena citacnimi znaménky (*“), €islo nebo Booleanska
(true nebo false).

Proménné Object a Aray jsou zobrazeny v tabulce Variables. Kliknéte na tlacitko Add (+),
abyste vidéli jejich vlastnosti a hodnoty. Nicméné, vlozit hodnoty Objektu nebo Pole
(napriklad {jmeno:“Jsem objekt“} nebo [1,2,3]) do hodnot poli nemizete.

Poznamka: Pro vystup hodnoty vyrazu v reZimu test-movie pouzijte akci trace (stopa). Viz
~Pouziti stopy“.
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Pouziti seznamu Watch (Sledovat)

Pro monitorovani nastaveni kritickych hodnot mlzete oznacit proménné, které se maji
objevit v seznamu Watch. Seznam Watch zobrazuje absolutni cestu k proménné a hodnoteé.
Také zde mizete vlozit novou hodnotu proménné.

Do seznamu Watch mohou byt pfidany pouze proménné, ne vlastnosti a funkce.

Debugger =]
[ O] [ | Bz IOl 1
Test Movie: Test Movie
] _root
=~ o
[ Properties|variatie=] wateh] | [Properties [ariabies] wateh]| 3|
_ oot mptd ovieClip hame [¥alue

imyhavieClip:chris| lungfish
imylavieClip:zippy| bonefish
imyhdauieClipiab...| &

Name [¥alue
chiis lungfish
jeif tarpon
labRats 4
mynrray
noah bowfin

B8 zippy [

Pro pfidani proménnych do seznamu Watch udélejte jedno z nasleduijicich:
V tabulce Variable kliknéte vpravo (Windows) nebo na Control (Macintosh) na
vybranou proménnou a zvolte Watch z kontext menu. Vedle proménné se objevi
modra tecka.

V tabulce Watch kliknéte vpravo (Windows) nebo na Control (Macintosh) a zvolte
Add z kontext menu. Vlozte jméno proménné a hodnotu do textovych poli.

Odstranéni proménnych ze seznamu Sledovat:
V tabulce Watch kliknéte vpravo (Windows) nebo na Control (Macintosh) a zvolte Remove
z kontext menu.
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Zobrazeni vlastnosti animace a zména editovatelnych viastnosti

Tabulka Debugger Properties zobrazi vSechny hodnoty vlastnosti jakéhokoliv movie klipu
na Scéné. Zménit hodnotu vlastnosti a sledovat zménu mUiZzete hned pfi prehravani animace.
Nékteré vlastnosti movie klip jsou pouze pro ¢teni a nemohou byt ménény.

Zobrazeni vlastnosti movie klipu:
Zvolte movie klip ze seznamu zobrazeni.

Kliknéte na tabulku Properties.

& 590 j 5 10 = o
- [/ 31 Frame Actians] 2 [v]

+ Frame Actions

function onlogirReply O [ -
BE oo T ST RSO ## Get the first L element =
war & = this.firstchild;

/7 TF the first 3ML element 15 a LOGINREPLY element with

#¢ status DK, go to the portfolio scresn. Otheewise,

/7 9o to the login failure scresn and Tet the user try again.
Online Trading Unlimited if (e.nodeName = "LOGTMREFLY' & e.attributes.status = "0K") {
J 77 save the session ID for future communications with server
sessionID = e.attributes.sessions

/¢ o to the portfolio viewing screen

gotofndStop (portfol ioliem) ;
/¢ Login failed! Go to the Togin failure zcreen.

password[ | Setosmtion QoginFailed s _
1

R -
[susmiT | ® -
M ey

Modifikovani hodnoty viastnosti:
Zvolte hodnotu a viozte novou hodnotu.

Hodnota musi byt konstanta (napfiklad 50 nebo ,&istavoda“) radéji nez vyraz (napfiklad
x+50). Hodnota m{ze byt rfetézec (jakakoliv hodnota obklopena citacnimi znaménky (“*),
¢islo nebo Booleovska hodnota (true nebo false). V Odstrariovadi zdvad nemizete
vlozit hodnoty objektu nebo pole (napfiklad {id: “gauner“} nebo [1,2,3]).

Vice informaci viz ,Retézec* a ,Pouziti operatord pro manipulaci s hodnotami ve vyrazech®.

Poznamka: Pro vystup hodnot vyrazu v rezimu test-movie zvolte akci stopa. Viz ,,Pouziti stopy*.
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Pouziti okna Vystup (Output)

V rezimu test-movie zobrazuje okno Output informaci, kterd pomaha odstrariovat problémy
v animaci. Nékteré informace, jako napriklad chyby syntaxe, jsou zobrazovany automaticky.
Pomoci prikaz( List Objects (Seznam Objektd) a List Variables (Seznam Proménnych) si mlzete
nechat zobrazit dal$i informace. Viz ,Pouziti Seznamu Objekt(“ a ,Pouziti Seznamu
Proménnych®.

Jestlize ve skriptech pouzivate akci trace, mizete poslat béhem prehrdvani animace
urcité informace do okna Output. Tyto by mohly zahrnovat poznamky o stavu animace,
nebo hodnotu vyrazu. Viz ,Pouziti stopy“.

Zobrazeni okna Vystup:
Jestlize animace nebézi v rezimu test-movie, zvolte Control > Test Movie.

Zvolte Window > Output.
Objevi se okno Vystup.
Poznamka: Pokud jsou ve skriptu chyby syntaxe, okno Vystup se zobrazi automaticky.
Pro praci s obsahem okna Output pouzijte menu Options:
Zvolte Options > Copy, pro zkopirovani obsahu okna Vystup do schranky (Clipboard).
Zvolte Options > Clear, pro vycisténi obsahu okna.
Zvolte Options > Save to File, pro ulozeni obsahu okna do textového souboru.

Zvolte Options > Print, pro tisk obsahu okna.
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Pouziti Seznamu Objekta

V reZzimu test-movie zobrazuje prikaz List Objects (Seznam Objekt() Uroven, snimek, typ
objektu (tvar, movie klip nebo tlacitko) a cilovou cestu movie klip instance v hierarchickém
seznamu. Toto je zvlasté uziteCné pro hledani spravné cilové cesty a jména instance.
Narozdil od Odstrariovace zdvad, seznam se v pribéhu animace automaticky neaktualizuje;
pokud chcete poslat informaci do okna Vystup, pokazdé musite zvolit pfikaz List Objects.

Zobrazeni seznamu objektl v animaci:
Pokud animace nebézi v rezimu test-movie, zvolte Control > Test Movie.

Zvolte Debug > List Objects.
Seznam vSech objekt(, které jsou aktualné na Scéné, je zobrazen v okné Vystup, jako v prikladé:

Layer #0:Frame=3
Movie Clip:Frame=1 Target=_root.MC

Shape:
Movie Clip:Frame=1 Target=_ root.instance3
Shape:
Button:
Movie Clip:Frame=1 Target=_root.instance3.instance2
Shape:

Poznamka: Prikaz Seznam Objektl nezapisuje vSechna data objektd ActionScriptu.
V tomto kontextu je objekt povazovan za tvar nebo symbol na Scéne.

Pouziti Seznamu Proménnych

V rezimu test-movie pfikaz List Variables (Seznam Proménnych) zobrazi seznam vSech
proménnych, které jsou aktudlné v animaci. Toto je zvlasté uzitecné pro hledani spravné cilové
cesty k proménné a jména proménné. Narozdil od Odstrariovace zdvad, seznam se v priibéhu
animace automaticky neaktualizuje; pokud chcete poslat informaci do okna Vystup,
pokazdé musite zvolit pfikaz List Variables.
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Zobrazeni seznamu proménnych v movie:

Pokud animace nebézi v rezimu test-movie, zvolte Control > Test Movie.
Zvolte Debug > List Variables.

Seznam vsech proménnych, které jsou aktudlné v animaci je zobrazen v okné Vystup,
jako v prikladé:
Level #0:
Variable _root.country ="Sweden"
Variable _root.city ="San Francisco"
Movie Clip:Target=""
Variable _root.instancel.firstName ="Rick"

Pouziti stopy
KdyZ pouzivéte akci trace (stopa) ve skriptu, mizete poslat informaci do okna Output.
Napriklad, zatimco testujete animaci nebo scénu, nebo pokud je stisknuto tlacitko, nebo je hran
urcity snimek, mlzete poslat programovaci poznamky do okna Vystup. Akce trace je podobna
vyrazu JavaScriptu alert.
Kdyz pouzivate akci stopa ve skriptu, méizete pouzit vyrazy jako argumenty. Hodnota vyrazu
je zobrazena v okné Vystup, jako v pfikladu:
onClipEvent (enterFrame) {

trace ("onClipEvent enterFrame" +enterFrame++)

Output x]

Options «

onClipEwvent enterFrame event =
onClipEvent enterFrame svent

onClipEvent enterFrame event
onClipEwent enterFrame event
onClipEvent enterFrame event
onClipEwvent enterFrame svent
onClipEvent enterFrame event
onClipEvent enterFrame event
onClipEwent enterFrame event
onClipEvent enterFrame event
onClipEv rrem [x]

onClipEw = =

onClipEw

onClipEv 4 Object Actions

onClipEw

L R R N

14 mFer onC1ipEvent (enterFrams) {
j trace ("onClipEvent enterFrame event " + enterFrame++);

o
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KAPITOLA 7

ActionScript Slovnik

Tato ¢ast Odkazového Priivodce ActionScriptu popisuje syntaxi a pouZiti prvkd ActionScriptu
ve Flash 5 a noveéjsich verzich. Hesla v tomto prlivodci jsou stejnd, jako v ActionScript
Dictionary Help. Pro pouziti pfiklad( ve skriptech si zkopirujte ukdzkovy text z ActionScript
Slovniku a vioZte jej do panelu Akci v Rezimu Expert.

Ve slovniku jsou zapsany vSechny prvky ActionScriptu - operatory, kliCova slova, vyrazy,
akce, vlastnosti, funkce, objekty a metody. Prehled o vSech heslech ve slovniku najdete
v Obsahu slovniku; tabulky v této ¢dsti jsou dobrym startovnim bodem pro hledani
symbolickych operatord nebo metod, jejichz tfidy objektu neznate.

ActionScript pouzivda ECMA-262 standard (specifikace napsand Asociaci Evropskych
Vyrobcl Pocitacd - European Computer Manufacturers Association), pokud neni uvedeno
jinak.

V tomto slovniku jsou dva typy hesel:
Individudini hesla pro operatory, kli¢ova slova, funkce, proménné, vlastnosti, metody
a vyrazy

Hesla objektu, kterd poskytuji vSeobecné detaily o preddefinovanych objektech

Pouzijte informace v ukdzkovych heslech pro interpretaci struktury a konvenci pouzitych
v téchto dvou typech hesel.

Ukazkové heslo pro vétsinu prvku ActionScriptu
Ndsledujici ukdzkovy skript vysvétluje obecné zdsady pouzité pro vSechny ActionScript
prvky, které nejsou objekty.

Nazev hesla
VSechna hesla jsou zapsdna podle abecedy. Abecedni porddek ignoruje velka pismena,
dolni pomic¢ky, apod.

Syntaxe

Cast ,Syntaxe” poskytuje spravné pouziti syntaxe ActionScript prvku v kédu. Cést syntaxe kédu
je v code fontu a argumenty, které musite poskytnout jsou v italicized code fontu.
Zavorky indikuji volitelné argumenty.

Argumenty
Tato ¢ast popisuje jakékoliv argumenty zapsané v syntaxi.
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Popis
Tato €ast urCuje prvek (napfiklad jako operator, metodu, funkci nebo jiny prvek) a potom
popisuje, jak je prvek pouzivan.

Pfehravac¢

Tato cast rika, ktera verze PrehravacCe prvek podporuje. Toto neni stejné jako verze Flashe
pouzitd pfi vytvareni obsahu. Napfiklad, jestlize vytvafite obsah pro Flash 4 Prehravac
pomoci pouziti autorskych ndstroji Flash 5, nemlzete pouzit ty prvky ActionScriptu, které
jsou dostupné pouze pro Flash 5 Pfehravac. Se zavedenim Flash 5 ActionScript byly nékteré

Flash 4 (a drivéjsi) ActionScript prvky zamitnuty. Ackoliv zamitnuté prvky jsou stdle podporovany
Flash 5 Prehrdvacem, je doporucovano, abyste pouzivali nové prvky Flash 5.

Navic, funkénost operatoru ve Flash 5 byla zna¢né rozsifena. Nejenom, Ze bylo zavedeno
mnoho novych matematickych operator(, ale nékteré starsi operatory jsou nyni schopné
ovladat dodatec¢né typy dat. Pro udrzeni typové konzistence dat jsou Flash 4 soubory
automaticky modifikovany pfi importu do autorského prostredi Flash 5, ale tyto modifikace
neovlivriuji funkénost plvodniho skriptu. Vice informaci viz hesla pro + (pfidani), < (mensi nez),
> (vetsinez), <= (mensi nebo rovno), >= (vetsi nebo rovno), !'= (nerovnost) a = (rovnost).

Priklad
Tato ¢ast poskytuje priklad kddu demonstrujici pouziti prvku.

Viz také
V této Casti jsou zapsana souviseejici hesla v ActionScriptu.

Ukazkové heslo pro objekty

Nasledujici ukazkoveé heslo slovniku vysvétluje obecné zasady pouzité pro preddefinované
ActionScript objekty. Objekty jsou zapsany podle abecedniho pofadku se vSemi dalSimi
prvky ve slovniku.

Nazev hesla

Nazev hesla poskytuje jméno objektu. Za jménem objektu nadsleduje odstavec, obsahujici
vSeobecné informace o objektu.

Shrnujici tabulky metod a viastnosti

Kazdé heslo objektu obsahuje tabulku, ve které jsou zapsany vsechny metody spojené
s objektem. Jestlize ma objekt vlastnosti (Casto konstanty), tyto prvky jsou shrnuty v dodate¢né
tabulce. VSechny metody a vlastnosti zapsané v téchto tabulkdch maiji také sva vlastni
hesla ve slovniku, které nasleduji heslo objektu.

KAPITOLA 7-1 131



Konstruktor

Jestlize po vas objekt vyZzaduje pouziti konstruktoru pro dosazeni jeho metod a vlastnosti,
je konstruktor popsan na konci hesla objektu. Tento popis obsahuje vSechny standardni
prvky (popis syntaxe atd.) dalSich hesel slovniku.

Zapsani metody a viastnosti do seznamu
Vlastnosti a metody objektu jsou zapsany abecedné za heslem objekt.

Obsahy slovniku

VSechna hesla slovniku jsou zapsdna podle abecedy. Nicméné, nékteré operatory jsou
symboly a jsou prezentovany v ASCII poradi. Navic, metody, které jsou spojeny s objektem
jsou zapsany u jména objektu - napfiklad, metoda abs objektu Math je zapsana jako
Math.abs.

Nasledujici dvé tabulky vam pomohou lokalizovat tyto prvky. V prvni tabulce jsou zapsany
symbolické operatory v poradi, ve kterém se objevi ve slovniku. Ve druhé tabulce jsou zapsany

vSechny dalsi ActionScript prvky.

Poznamka: Prednost a spojovani operatord viz Dodatek A.

Symbolické operatory

decrement)

++ increment)

logical NOT)

inequality)

modulo)

modulo assignment)

bitwise AND)

short-circuit AND)

bitwise AND assignment)

parentheses)

minus)

multiplication)

multiplication assignment)

comma)

dot)

conditional)

division)

~ |~ =~ a A aAalalaaalalalalalalala |l

// comment delimiter)
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Symbolické operatory

~ (bitwise XOR)

A= (bitwise XOR assignment)

{} (object initializer)

| (bitwise OR)

1 (logical OR)

|= (bitwise OR assignment)

~ (bitwise NOT)

+ (addition)

+= (addition assignment)

< (less than)

<< (bitwise left shift)

<<= (bitwise left shift and assignment)
<= (less than or equal to)

<> (inequality)

= (assignment)

-= (negation assignment)

= (equality)

> (greater than)

>= (greater than or equal to)

>> (bitwise right shift)

>>= (bitwise right shift and assignment)
>>> (bitwise unsignet right shift)
>>>= (bitwise unsigned right shift and assignment)
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Prvek Actionscriptu

Viz heslo

Date Date (object)

delete delete

DELETEKEY Key .DELETEKEY

docTypeDecl XML .docTypeDecl

do...while do...while

DOWN Key .DOWN

_DROPTARGET _droptarget
DUPLICATEMOVIECLIP duplicateMovieClip, MovieClip.duplicateMovieClip
E Math.E

else else

END Key .END

ENTER Key .ENTER

eq eq (equal-string specific)

escape (function)

escape (function)

Prvek Actionscriptu Viz heslo

abs Math.abs

acos Math.acos

add add

and and

_alpha _alpha

appendChild XML . appendChild

Array Array (object)

asin Math.asin

atan Math.atan

atan2 Math.atan2
attachMovie MovieClip.attachMovie
attachSound Sound. attachSound
attributes XML.attributes
BACKSPACE Key .BACKSPACE

Boolean Boolean (function, object)
break break

call call

CAPSLOCK Key.CAPSLOCK

ceil Math.ceil

charAt String.charAT
charCodeAt String.charCodeAt
childNodes XML .childNodes

chr chr

cloneNode XML . cloneNode

close XMLSocket.close

Color Color (object)

concat Array.concat,String.concat
connect XMLSocket.Connect

P T i
continue continue

CONTROL Key .CONTROL

cos Math.cos
createElement XML.createElement
createTextNode XML. createTextNode
_currentframe currentframe

ESCAPE (constant) Key.ESCAPE

eval eval

evaluate evaluate

exp Match.exp

firstChild XML. firstChild

floor Math.floor

_focusrect _focusrect

for for

for...in for...in

_framesloaded _framesloaded
fromCharCode String.fromCharCode
fscommand fsconnand

function function

ge ge (greater than or equal to-string specific)
getAscii Key.getAscii
getBeginIndex Selection.getBinIndex
getBounds MovieClip.getBounds
getBytesLoaded MovieClip.getBytesLoaded
getBytesTotal MovieClip.getBytesTotal
getCaretIndex Selection.getCaretIndex
getCode Key.getCode
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Prvek Actionscriptu

Viz heslo

Prvek Actionscriptu

Viz heslo

hide Mouse.hide

_highquality _highquality

hitTest MovieClip.hitTest

HOME Key . HOME

if if

ifFramelLoaded ifFrameLoaded

#include #include

indexOf String.indexOf

Infinity Infinity

INSERT Key.INSERT

insertBefore XML. insertBefore

int int

isDown Key.isDown

isFinite isFinite

isNan isNan

isToggled Key.isToggled

join Array.join

Key Key (object)

lastChild XML.lastChild

lastIndexOf StringlastIndexOf

le le (less than or equal to-string specific)
LEFT Key.LEFT

length length, Array.length, String.length
LN2 Math.LN2

LN10 Math.LN10

load XML. load

loaded XML. loaded

loadMovie loadMovie, MovieClip.loadMovie
loadVeriables loadVeriables, MovieClip.loadVeriables
localToGlobal MovieClip.localToGlobal

log Math.log

LOG2E Math.LOG2E

LOG10E Math.LOG10E

1t 1t (less than or equal to-string specific)

getDate Date.getDate

getDay Date.getDay

getEndIndex Selection.getEndIndex

getFocus Selection.getFocus

getFullZear Date.getFullYear

getHours Date.getHours

getMilliseconds Date.getMilliseconds

getMinutes Date.getMinutes

getMonth Date.getMonth

getPan Sound.getPan

getProperty getProperty

getRGB Color.getRGB

getSeconds Date.getSeconds

getTime Date.getTime

getTimer getTimer

getTimezoneOfset Date.getTimezoneOfset
getTransform Color.getTransform, Sound.getTransform
getURL getURL, MovieClip.getURL
getUTCDate Date.getUTCDate

getUTCDay Date.getUTCDay

getUTCFullYear Date.getUTCFullYear

getUTCHours Date.getUTCHours
getUTCMilliceconds Date.getUTCMilliceconds
getUTCMinutes Date.getUTCMinutes

getUTCMonth Date.getUTCMonth

getUTCSeconds Date.getUTCSeconds

getVersion getVersion

getVolume Sound.getVolume

getYear Date.getYear

globalToLocal MovieClip.globalToLocal
gotoAndPlay gotoAndPlay, MovieClip.gotoAndPlay
gotoAndStop gotoAndStop, MovieClip.gotoAndStop
gt gt (greater than-string specific)
hasChildNodes XML .hasChildNodes

_height _height
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Prvek Actionscriptu

Viz heslo

Math Math (object)

max Math.max
maxscroll maxscroll
MAX_VALUE Number .MAX_VALUE
mbchr mbchr

mblength mblength

mbord mbord

mbsubstring mbsubstring

min Math.min

MIN VALUE Number .MIN VALUE
Mouse Mouse (object)
MovieClip MovieClip (object)
_name _name

NaN NaN, Number.NaN
ne ne (not equal-string specific)

NEGATIVE_INFINITY

Number .NEGATIVE INFINITY

new (operator)

new (operator)

newline newline

nextFrame nextFrame, MovieClip.nextFrame
nextScene nextScene

nextSibling XML .nextSibling

nodeName XML .nodeName

nodeType XML .nodeType

nodeValue XML .nodeValue

not not

null null

Number Number (function, object)
Object Object (object)

On On (mouseEvent)
onClipEvent onClipEvent

onClose XMLSocket.onClose
onConnect XMLSocket.onConnect
OnLoad XML.OnLoad

onXML XMLSocket.onXML

or (logical OR)

or (logical OR)
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Prvek Actionscriptu Viz heslo

ord ord

_parent _parent

parentNode XML .parentNode
parseFloat parseFloat

parselnt parselnt

parseXML XML .parseXML

PGDN Key . PGDN

PGUP Key .PGUP

PI Math.PI

play play, MovieClip.play
pop Array.pop
POSITIVE_INFINITY Number .POSITIVE INFINITY
pow Math.pow

prevframe prevframe, MovieClip.prevframe
previousSibiling XML.previousSibiling
prevScene prevScene

print print

printAsBitmap printAsBitmap

push Array.push

_quality _quality

radom radom, Math.radom
removeMovieClip removeMovieClip, MovieClip.removeMovieClip
removeNode XML . removeNode

return return

reverse Array.reverse

RIGHT Key.RIGHT

_root _root

_rotation _rotation

round Math.round

scroll scroll

Selection Selection (object)

send XML.send, XMLSocket.send
sendAndLoad XML . sendAndLoad

set set

setDate Date.setDate
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Prvek Actionscriptu

Viz heslo

setFocus Selection.setFocus
setFullYear Date.setFullYear
setHours Date.setHours
setMilliseconds Date.setMilliseconds
setMinutes Date.setMinutes
setMonth Date.setMonth

setPan Sound.setPan
setPropety setPropety

setRGB Color.setRGB
setSeconds Date.setSeconds
setSelection Selection.setSelection
setTime Date.setTime
setTransform Color.setTransform, Sound.setTransform
setUTCDate Date.setUTCDate
setUTCFullYear Date.setUTCFullYear
setUTCHours Date.setUTCHours
setUTCMilliseconds Date.setUTCMilliseconds
setUTCMinutes Date.setUTCMinutes
setUTCMonth Date.setUTCMonth
setUTCSecodnds Date.setUTCSecodnds
setVolume Sound. setVolume
setYear Date.setYear

Shift (method)

Array.Shift (method)

SHIFT (constant)

Key.SHIFT (constant)

show Mouse. show
sin Math.sin
slice Array.slice, String.slice
sort Array.sort
Sound Sound (object)
_soundbuftime _soundbuftime
SPACE Key.SPACE
splice Array.splice
split String.split
sqgrt Math.sqgrt
SQRT1_2 Math.SQRT1 2

Prvek Actionscriptu Viz heslo

SQRT2 Math.SQRT2

start Sound.start

startDrg startDrg, MovieClip.startDrg

status XML.status

stop stop, MovieClip.stop, Sound.stop

stopAllSounds stopAllSounds

stopDrag stopDrag, MovieClip.stopDrag

String String (function), String (object),"“, (string delimer)

substr String.substr

substring substring, String.substring

swapDepths MovieClip.swapDepths

TAB Key .TAB

tan Math. tan

_tragen _tragen

tragetPath tragetPath

tellTraget tellTraget

this this

toggleHighQuality toggleHighQuality

toLowerCase String.toLowerCase

A g B e TN Dore fosering.
' r

_totalframes totalframes

toUpperCase String.toUpperCase

trace trace

typeof typeof

unescape unescape

unloadMovie unloadMovie, MovieClip.unloadMovie

unshift Array.unshift

upP Key.UP

updateAfterEvent updateAfterEvent

_url _url

UTC Date.UTC

valueOf Boolean.valueOf, Number.valueOf, Object.valueOf

var var

_visible _visible

void void
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Prvek Actionscriptu Viz heslo

while while

_width _width

with with

_X _x

XML XML (object)
xmlDecl xmlDecl (object)
XMLSocket XMLSocket
_xmouse _xmouse

_xscale _xscale

Y Y

-ymouse -ymouse

_yscale _yscale
(decrement)

Syntaxe

--vyraz

vyraz --

Argumenty

vyraz Proménna, ¢&islo, prvek v poli nebo vlastnost objektu.
Popis

Operator; decrement (snizeni) pred a po operatoru, ktery odecitd 1 z vyrazu. Forma
operatoru snizeni pred vyrazem ( --vyraz ), odecitd 1 z vyrazu a dava vysledek.
Forma operatoru snizeni po vyrazu ( vyraz-- ), odecita 1 z vyrazu a dava pavodni
hodnotu vyrazu (vysledek pred odecitanim).

Prfehravaé¢
Flash 4 nebo novéjsi.

Priklad

Forma operdtoru sniZzeni pred, snizuje x na 2 ( x-1=2) a dava vysledek jako y:
x = 3;

y = --x

Forma operdtoru snizeni po, snizuje x na 2 ( x-1=2 ) a déva plvodni hodnotu ( x=3)
jako vysledek y:
Jestlize x = 3;

y = x--

++

(increment)
Syntaxe
++vyraz
vyraz++

Argumenty
vyraz Proménng, Cislo, prvek v poli nebo vlastnost objektu.

Popis

Operator; increment (zvy$eni) pred a po pfiddva 1 k vyrazu. Forma operdtoru pred
vyrazem ( ++vyraz ), pridava 1 k vyrazu a dava vysledek. Forma operatoru po vyrazu
(vyraz++ ), pridava 1 k vyrazu a dava pQvodni hodnotu vyrazu (vysledek pred
pfidanim).

Forma operatoru zvySeni pfed, zvySuje x na 2 ( x+1=2 ) a dava vysledek jako y:
x =1;
y = ++x

Forma operatoru zvyseni po, zvysuje x na 2 ( x+1=2 ) a dava plvodni hodnotu ( x=1)
jako vysledek y:

x =1;

X = X++;

Prfehravac¢
Flash 4 a novéjsi.

Priklad

Nasledujici pfiklad pouziva ++ jako operator zvySeni pred s pfikazem while.
i=0

while ( i++ < 5 ){

//tato &ast se vykonad pétkrat

}

Nasledujici pfiklad pouziva ++ operator zvyseni pred:
var a = [ 1;
var i = 0;
while ( i<10 ){
a.push( ++i );
}
trace (a.join());
Tento skript tiskne nasleduijici:
1,2,3,4,5,6,7,8,9
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Nasledujici pfiklad pouziva ++ jako operator zvyseni pred:
var a = [];

var i = 0;

while ( i<10 ){
a.push ( i++ );

}

trace (a.join());

Tento scénar tiskne nasledujici:
0,1,2,3,4,5,6,7,8,9

(logical NOT)
Syntaxe
lvyraz

Argumenty
vyraz Proménna nebo ohodnoceny vyraz.

Popis

Operator (logicky); prevraci Booleovskou hodnotu proménné nebo vyraz. Jestlize
je vyrazem proménnd s absolutni nebo konvertovanou hodnotou true, !proménna
hodnota !vyrazu je false. Jestlize se vyraz x && y ohodnocuje na false, vyraz
' (x && y) se ohodnoti na true. Tento operator je identicky k operatoru not,
ktery byl pouzit ve Flash 4.

Prfehravac¢
Flash 4 a novéjsi.

Priklad

V nasledujicim prikladu je proménnd stastny nastavena na false, podminka
if ohodnocuje podminku !stastny a jestlize je podminka true, trace posle
fetézec do okna Output.

stastny = false;

if ( !stastny ) {

trace (,nedélej si starosti, bud Stastny"“);

}

Nasledujici ilustruje vysledky ! operatoru:
'true ddvd false
'false ddvd true

(inequality)

Syntaxe
vyraz1l != vyraz2

Argumenty

vyrazi, vyraz2 Cisla, fetézce, Boolednské, proménné, objekty, pole nebo
funkce.

Popis

Operétor (equality); testuje presny opak operatoru ==. Jestlize vyraz1 je roven vyrazu2,
vysledek je false. Jako u operatoru == zavisi definice rovnosti na typu dat, ktera jsou
srovnavana.

Cisla, fetézce a Booleovské hodnoty jsou porovnavany hodnotou.
Proménné, objekty, pole a funkce jsou porovnavany odkazem.

Pfehravac
Flash 5 a novéjsi.

Priklad

Nasledujici pfiklad ilustruje vysledky operatoru !'=
5 !'= 8 ddva true

5 1= 5ddva false

Nasledujici pfiklad ilustruje pouziti operatoru !'= v pfikazu if:
a = ,David"“

b = ,blazen“

if (a '= b ){

trace (,David neni blazen");

}

Viz také
== (equality)
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%

(modulo)
Syntaxe
vyrazl % vyraz2

Argumenty
vyrazi, vyraz2 Cisla, cela Cisla, plynouci ¢isla nebo retézce, které se konvertuji
na numerickou hodnotu.

Popis
Operator (aritmeticky); vypocitava zbytek vyrazu1 déleny vyrazem2. Jestlize je jeden
z argumenttl vyrazu nenumericky, modulo operator pristupuije k jejich konverzi na Cisla.

Pfehravac

Flash 4 nebo novéjsi.

V souborech Flash 4 je operator % rozsifen v SWF souboru jako x-int (x/y) *y
a nemUze byt tak rychly nebo presny jako implementace Flash 5 Prehravace.

Priklad

Ndsledujici pfiklad je numericky priklad pouziti operatoru %:
12 $ 5 dava 2

4.3 % 2.1 dava 0.1

(modulo assignment)

Syntaxe
vyrazl %= vyraz2

Argumenty
vyrazi,vyraz2 Celd Cisla a proménné.

Popis
Operator (assignment); prifazuje vyrazu1 hodnotu vyraz1 % vyraz2.

Pfehravac¢
Flash 4 nebo novéjsi.

Priklad
Nasledujici ilustruje pouziti operatoru $= s proménnymi a Cisly:
x %= yjestenéjakox = x % y

Jestlizex = 14ay = 5,potom x %= 5 dava 4

Viz také
% (modulo)

(bitwise AND)
Syntaxe
vyraz1 & vyraz2

Argumenty
vyrazi,vyraz2 Jakékoliv ¢islo.

Popis

Operator (bitwise — Bit po bitu). Oznaceni operatoru, ktery zpracovava danou operaci
mezi dvéma Ci vice operandy bit po bitu, tj. nejdrive prvni bit prvniho operandu s prvnim
bitem druhého operandu atd.); konvertuje vyraz1 a vyraz2 na 32-bitova neoznacena
cela Cisla a provadi Booleovskou ( AND ) operaci na kazdém bitu argument( celého
Cisla. Vysledkem je nové 32-bitové neoznacené celé Cislo.

Pfehravac¢

Flash 5 a novéjsi. Ve Flash 4 byl operédtor & pouZzivan pro spojovani fetézcl. Ve Flash 5
je operator & bitwise AND a operatory add a + spojuji fetézce. Soubory Flash 4,
které pouzivaji operator & jsou automaticky konvertovany na operator add, pokud
jsou preneseny do autorského prostredi Flash 5.
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&&

(short-circuit AND)
Syntaxe
vyrazl && vyraz2

Argumenty
vyrazi,vyraz2 Cisla, fetézce, proménné nebo funkce.

Popis

Operator (logicky); vykonava Booleovskou operaci na hodnotach jednoho nebo obou
vyrazl. Zplsobuje, Ze Flash interpret ohodnoti vyraz1 (levy vyraz) a dava false,
jestlize je vyraz ohodnocen jako false. Jestlize se vyraz1 ohodnoti jako true, vyraz2
(pravy) je ohodnocen. Jestlize se vyraz2 ohodnoti jako true, kone¢ny vysledek

je true; jinak je false.

Pfehravac
Flash 4 a novéjsi.

Priklad

Tento priklad uréuje hodnoty ohodnocenych vyrazi na proménné vitez a porazeny

v poradi, jak je provadén test:

()

(bitwise AND assignment)
Syntaxe
vyrazl &= vyraz2

Argumenty
vyrazi,vyraz2 Celd Cisla a proménné.

Popis

Operétor (bitwise assignment); uréuje vyrazu1 hodnotu vyraz1 & vyraz2.

Pfehravac
Flash 5 a novéjsi.

Priklad
Nasledujici ilustruje pouziti operatoru &= s proménnymi a Cisly:
x &= yjestenéjakox = x & y

Jestlize x = 15a y = 9 potom x &= 9dava 9

Viz také
& (bitwise AND)

(parentheses)

Syntaxe

(vyrazi,vyraz2);

function (functionCall1, ..... ,functionCalIN);

Argumenty
vyrazi,vyraz2 Cisla, fetézce, proménné nebo text.

function Funkce, ktera ma byt provedena na obsahu v zavorkach.

functionCallf, ..... ,functionCalIN

Série funkci, které se maji provést pred tim, nez je vysledek

poslan do funkce mimo zavorky.

vitez = ( cokoladovaVejce >= 10 ) && (zeleFazole >= 25);
porazeny = ( cokoladovaVejce <= 1 ) && ( zeleFazole <= 5 );
if ( vitez ) {

varovat = ,Vyhral jsi lov!%;

if ( porazeny ) {

varovat = ,Nyni je to nesStastny lov!";

}
lelse{

varovat = ,VSichni Jjsme vitézové!";
}
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Popis

Operator (obecny); vykonadva skupinovou operaci na jednom nebo vice argumentech
nebo obklopuije jeden nebo vice argumentt a posild vysledky jako parametr do funkce
mimo zavorky.

Pouziti 1: Vykonava skupinovou operaci na jednom nebo vice vyrazech pro kontrolu
poradi vykonani operatorl ve vyrazu. Tento operator prepisuje automaticky poradek
a zpUsobuije, Ze vyrazy uvnitf zavorek jsou ohodnoceny jako prvni. Jestlize jsou dalsi
vloZzeny zavorky, Flash ohodnoti obsah nejvnitfnéjSich zavorek a potom obsahy
vnéjsich zavorek.

Pouziti 2: Obklopuji jeden nebo vice argumentt a vkladaji je jako parametry do funkce
mimo zavorky.

Pfehravac
Flash 4 a novéjsi.

Priklad

(Pouziti 1) Nasledujici vyrazy ilustruji pouZiti zavorek k fizeni poradi vykonani vyrazd.
(Vysledek je pod kazdym vyrazem.)

(2+43) * (4+5)

45

2+ (3% (4+5))

29

2+ (3*4)+5

19

(Pouziti 2) Nasleduijici priklad ilustruje pouziti zavorek u funkce:
getDate() ;
invoice (item, amount);

Viz také
with

(minus)

Syntaxe

(Negace) - vyraz
(Od¢itani) vyraz1 - vyraz2

Argumenty
vyrazi,vyraz2 Jakékoliv ¢islo.

Popis

Operator (aritmeticky); pouzivan pro negaci nebo od¢itani. Pokud je pouZit pro negaci,
obraci znaménko numerického vyrazu. Pokud je pouzit pro od¢itani, vykondva
aritmetické od¢itani na dvou numerickych vyrazech, odecitd vyraz2 od vyrazui.
Jestlize jsou oba vyrazy cela Cisla, rozdil je celé Cislo. Jestlize je jeden nebo oba
vyrazy ,Cislo s plovouci fadkovou ¢arkou®, rozdil je také ,Cislo s plovouci fadkovou
carkou”.

Pfehravac
Flash 4 a novéjsi.

Priklad

(Negace) Tento vyraz obraci znaménko vyrazu 2+3:
-(2+43)

Vysledek je -5.

(Odcitani) Tento vyraz odc¢ita celé Cislo 2 od celého ¢&isla 5:
5-2

Vysledek je 3, coz je celé Cislo.
(Odcitani) Tento vyraz odecita ,Cislo s plovouci fadkovou ¢arkou” 1.5 od ,Cisla
s plovouci radkovou ¢arkou® 3.25:

dat 3.25-1.5

Vysledek je 1.75, coz je ,Cislo s plovouci fadkovou ¢arkou®.
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(multiplication)
Syntaxe
vyraz1 * vyraz2

Argumenty
vyrazi,vyraz2 Celd Cisla nebo plynouci Cisla.

Popis

Operétor (aritmeticky); nasobi dva numerické vyrazy. Jestlize jsou oba numerické
vyrazy cela Cisla, vysledkem je celé Cislo. Jestlize je jeden nebo oba vyrazy ,¢islo
s plovouci radkovou ¢arkou®, vysledkem je ,Cislo s plovouci fadkovou ¢arkou*.

Prfehravac¢
Flash 4 a novéjsi.

Priklad
Tento vyraz nasobi celd Cisla 2 a 3:
2 * 3

Vysledek je 6, coz je celé Cislo.

Priklad

Tento vyraz nasobi ,Cisla s plovouci fadkovou ¢arkou” 2.0 a 3.1416:
2.0 * 3.1416

Vysledek je 6.2832, coz je ,Cislo s plovouci fadkovou ¢arkou®.
(multiplication assignment)

Syntaxe

vyrazl *= vyraz2

Argumenty
vyrazi,vyraz2 Celd Cisla, ,Cislo s plovouci fadkovou ¢arkou®, nebo fetézce.

Popis
Operdtor (assignment); uréuje vyrazul hodnotu vyrazi1 * vyraz2.

Prfehravac¢
Flash 4 a novéjsi.

Priklad
Nasledujici ilustruje pouziti operatoru *= s proménnymi a Cisly:
x *= y jestejnéjako x = x * y

JestliZex = 5 a y = 10 potomx *= 10 ddva 50
Viz také

* (multiplication)

(comma)
Syntaxe
vyraz1, vyraz2

Argumenty

vyraz  Jakékoliv &islo, proménnd, rfetézec, prvek pole nebo jind data.

Popis

Operator; instruuje Flash, aby ohodnotil vyraz1, potom vyraz2 a dal hodnotu

vyrazu2. Tento operator je pouzivan predevsim se smyckovym prikazem for.

Prehravac¢
Flash 4 a novéjsi.

Priklad
Nasledujici ukazkovy koéd pouziva operator ¢arka:

var x =1, b =2, ¢ = 3;

Toto je ekvivalentni s nasledujicim:
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(dot operator)

Syntaxe

objekt.vlastnost_nebo_metoda
jménoinstance.proménna
jménoinstance.détskainstance.proménna

Argumenty

objekt Instance objektu. Nékteré objekty pozaduiji, aby byly instance
vytvoreny pouzitim konstruktoru pro tento objekt. Objekt mize
byt jakykoliv pfeddefinovany ActionScript objekt nebo specialni
objekt. Tento argument je vzdy na levé strané operatoru tecka (.).

vlastnost_nebo_metoda Jméno vlastnosti nebo metody spojené s objektem.
VSechny platné metody a vlastnosti pro preddefinované objekty
jsou zapsany v souhrnnych tabulkach Metody a Vlastnosti pro dany
objekt. Tento argument je vzdy na praveé strané operatoru tecka (.).

jménoinstance Jméno instance movie klipu.
détskainstance Instance movie klipu, ktera je ditétem hlavniho movie klipu.

proménna Proménna v movie klipu.

Popis

Operator; pouzivany pro navigaci v hierarchii movie klipu, k dosazeni ,,uhnizdénych*
détskych movie klipl, proménnych nebo vlastnosti. TeCkovy operator je také pouzivan
pro testovani nebo nastaveni vlastnosti objektu, vykonani metod objektu nebo
vytvoreni struktury dat.

Pfehravac
Flash 4 a novéjsi.

Viz také
[ 1 (operator pfistup pole)

Priklad
Tento vyraz identifikuje aktualni hodnotu proménné vliasyBarva u movie klipu osoba:
osoba.vlasyBarva

Toto je ekvivalentni k nasledujici Flash 4 syntaxi:
/osoba:vlasyBarva

ACTION SCRIPT - FLASH 5

=

Priklad

Nasleduijici kod ilustruje, jak mize byt teCkovy operator pouZity pro vytvoreni struktury
pole:

ucet.jmeno = “GarySmith"“;

ucet.adresa = ,123 HlavniTf#ida“;

ucet.mesto = “Jakékoliv Mésto“;

ucet.stat = ,CAY;

ucet.zip = ,12345"%;

(conditional)
Syntaxe
vyraz1 ? vyraz2 : vyraz3

Argumenty
vyrazl Vyraz, ktery ohodnocuje na Boolednskou hodnotu, obvykle srovndvaci vyraz.

vyraz2, vyraz3 Hodnoty jakéhokoliv typu.

Popis
Operétor (podminkovy); instruuje Flash, aby ohodnotil vyraz1 a dal hodnotu vyrazu2,
jestlize je vyraz1 true; jinak da hodnotu vyraz3.

Pfehravac¢
Flash 4 a novéjsi.

(division)
Syntaxe
vyraz1 / vyraz2

Argumenty
vyraz Jakékoliv Cislo.

Popis
Operétor (aritmeticky); déli vyraz1 vyrazem2. S argumenty vyrazu a vysledky operace

¢arkou“.

Prfehravac¢
Flash 4 a novéjsi.
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I

Priklad

Tento vyraz déli ,&islo s plovouci fadkovou Carkou“ 22.0 cCislem 7.0 a potom
zobrazi vysledek v okné Vystup:

trace (22.0 / 7.0);

Vysledek je 3.1429, coz je ,Cislo s plovouci fadkovou ¢arkou®.

(comment delimiter)
Syntaxe
/| komentar

Argumenty
komentar Text, ktery neni ¢dsti kédu a mél by byt interpretem ignorovan.
Popis

Komentar; indikuje zacatek skriptového komentare. Jakykoliv text, ktery se objevi
mezi znaCkami // a poslednim znakem fadku je interpretovan jako komentar a je
ignorovan interpretem ActionScriptu.

Prfehravac¢
Flash 1 a novéjsi.

Priklad

Tento skript pouziva znacky komentare pro identifikovani prvniho, tfetiho, patého
a sedmeého rfadku jako komentare:

//nastavit X pozici midového movie klipu
mic = getProperty (mic._x);

//nastavit Y pozici mi&ového movie klipu
mic = getProperty (mic._y);

//nastavit X pozici movie klipu drak
drak = getProperty (drak._x);

//nastavit pozici Y movie klipu drak
drak_y = getProperty (drak._y);

Viz také
/* (comment delimiter)

/*

(comment delimiter)
Syntaxe
/*komentar*/

/*
*komentar
*komentar
*/

Argumenty
komentar Jakykoliv text

Popis

Komentar; indikuje jeden nebo vice radkl skriptového komentare. Jakykoliv text,
ktery se objevi mezi otevirajici znackou komentére /* a zavirajici znaCkou*/,
je interpretovan jako komentar a je ignorovan ActionScript interpretem. Prvni syntaxi
pouzivejte pro identifikaci jednoradkovych komentart a druhou syntaxi pro identifikaci
komentare na vice po sobé jdoucich radcich. Vynechani zaviraci znacky */ zpUsobi,
ze ActionScript nahlasi chybovou zpravu.

Pfehravac¢
Flash 5 a novéjsi.

Viz také
// (comment delimiter)

(division assignment)
Syntaxe
vyraz1l /= vyraz2

Argumenty
vyrazi,vyraz2 Celd Cisla, plynouci Cisla nebo retézce.

Popis
Operator (assignment); urCuje vyrazul hodnotu vyraz1 / vyraz2.

Pfehravac
Flash 4 a novéjsi.
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Priklad
Nasleduijici ilustruje pouziti operatoru /= s proménnymi a Cisly:
x /=y je stejné jako x = x / y

x = 10;
y = 2;
x /=y;

// x nyni obsahuje hodnotu 5

[1] (array access operator)
Syntaxe
myArray [“a0“,“a1,...“aN“];
objekt [hodnota1,hodnota2,...hodnotaN];

Argumenty
myArray Jméno pole.
a0,al,...aN Prvky v poli.

hodnota1,2,...N Jména vlastnosti.

Popis
Operator; vytvari novy objekt inicializaci vlastnosti ur€enych v argumentech nebo
inicializuje nové pole s prvky ( a0 ) uréenymi v argumentech.

Vytvoreny objekt ma genericky objekt Object jako svlj prototyp. Pouziti tohoto
operatoru je stejné jako volani new Object a pouziti viastnosti pomoci operatoru
urCeni. Pouziti tohoto operatoru je alternativni k pouZiti operatoru new, ktery umoznuje
rychlé a vhodné vytvoreni objektd.

Pfehravac¢
Flash 4 a novéjsi.

Priklad
Nasledujici prikladové kédy jsou dva riizné zplsoby vytvoreni nového prazdného
objektu Array:

myArray

[ 1;

myArray = new Array();
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Nasledujici je pfikladem jednoduchého pole:

myArray = [“red"“, ,yellow"“, ,green“, ,blue"“, ,purple"]
myArray[0]="red"

myArray[l]="“yellow"

myArray[2]=“green"

myArray[3]="blue"“

myArray[4]="purple"

~ (bitwise XOR)
Syntaxe
vyrazl ~ vyraz2

Argumenty
vyrazi,vyraz2 Jakékoliv ¢islo.

Popis

Operator (bitwise); konvertuje vyraz1 a vyraz2 na 32-bitové neoznacené celé Cislo
a ddva 1 do kazdé pozice, kde korespondujici bity bud ve vyrazu1 nebo vyrazu2,
avSak ne v obou jsou 1.

Pfehravac
Flash 5 a novéjsi.

Priklad
15 ~ 9 dava 6
(1111 ~ 1001 == 0110)

= (bitwise XOR assignment)
Syntaxe
vyrazl ~ = vyraz2

Argumenty
vyrazi,vyraz2 Celd Cisla a proménné.

Popis
Operétor (slozené urceni); uréuje vyrazul hodnotu vyrazi ~ vyraz2.

Pfehravac
Flash 5 a novéjsi.
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{}

Priklad

Nasledujici je pfikladem operace *= :

// 15 decimalné = 1111 binaricky
x = 15;

// 9 decimalné = 1001 binaricky
x *=vy;

dava

x ~ y (0110 binaricky)

Nasledujici ilustruje pouziti operatoru 2= s proménnymi a Cisly:
x *= y je stejné jako x = x * y
Jestlize x = 15 a y = 9 potom

15 ~= 9 dava 6

Viz také
~ (bitwise XOR)

(object initializer)

Syntaxe

objekt {jméno1: hodnotal ,
jméno1: hodnota 2,

jménoN: hodnotaN};

Argumenty
objekt Objekt pro vytvoreni.

jméno 1,2,... N Jméno vlastnosti.
hodnota 1,2,...N Korespondujici hodnota kazdé vlastnosti jméno.

Popis

Operator; vytvari novy objekt a inicializuje ho s danou dvojici vlastnosti jméno
a hodnota. Vytvoreny objekt ma genericky objekt Object, jako svlj prototyp.
Pouziti tohoto operatoru je stejné jako volani new Object a urCeni dvojic vlastnosti
pomoci pouZiti operatoru assignment. Pouziti tohoto operatoru je alternativou k pouZiti
operatoru new, ktery umoznuje rychlé a vhodné vytvoreni objektd.

Pfehravac¢
Flash 5 a noveéjsi.

Priklad

Nasledujici kdd ukazuje, jak mlze byt vytvoren prazdny objekt pomoci pouZiti
operatoru inicializator objektu a pouziti new Object:

objekt = {};

objekt = new Objekt() ;

Nasledujici vytvari objekt ucet inicializujici vlastnosti jmeno, adresa, mesto,
stat, zip abilance:
ucet = { jmeno: “John Smith"“,

adresa: “123 Hlavni T¥ida"“,

mesto: ,Blossomville“,

stat: “California™,

zip: “12345",

bilance: “1000“ };

Nasledujici priklad ukazuje, jak mohou byt inicializatory pole a objektu ,,uhnizdény*
v sobé navzdjem:
osoba = { jmeno: “Peter Piper"“,

deti: [ ,Jack“, ,Jill“, ,Moe™, 1 };

Nasledujici pfiklad je dalsi zplsob pouziti informace v prfedchozim prikladeé,
se stejnymi vysledky:

osoba = new Osoba() ;

osoba.jmeno = “John Smith~;

osoba.deti = new Array ();

osoba.deti [0] = “Jack’;

osoba.deti [1] ‘Jill’;

osoba.deti [2] ‘Moe”’ ;

Viz také

[ 1 (operator ptistup pole)
new

Object (objekt)
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(bitwise OR)
Syntaxe
vyraz1l | vyraz2

Argumenty
vyrazi,vyraz2 Jakékoliv ¢islo.

Popis
Operator (bitwise); konvertuje vyraz1 a vyraz2 na 32-bitovd neoznacend celd Cisla
a ddva 1 do kazdé pozice, kde koresponduijici bity bud’ vyrazu1 nebo vyrazu2 jsou 1.

Pfehravac¢
Flash 5 a novéjsi.

Priklad
Nasledujici je pfiklad operace bitwise OR. VSimnéte si, Ze 15 je binaricky 1111:
// 15 decimalné = 1111 binaricky

x = 15;

// 9 decimalné = 1001 binaricky
y =9;

//x | y = binaricky

z =x | y;

= 15

N

Nasleduijici je dalSim zplsobem vyjadreni predchoziho prikladu:
15 | 9 dava 15
(1111 | 0011 = 1111)
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(OR)
Syntaxe
vyrazil || vyraz2

Argumenty

vyrazl,vyraz2  Booleovskd hodnota nebo vyraz, ktery konvertuje na Boolednskou
hodnotu.

Popis

Operétor (logicky); ohodnocuje vyraz1 a vyraz2. Vysledek je ( true ) jestlize, bud
jeden nebo oba vyrazy jsou ohodnoceny na true; vysledek je ( false ) pouze,
kdyz se oba vyrazy rovnaji false.

U ne-Booleovskych vyraz(, logicky operator OR zplsobuije, Ze Flash ohodnoti vyraz
nalevo; jestlize mlze byt konvertovan na true, vysledek je true.
Jinak ohodnoti vyraz napravo a vysledkem je hodnota tohoto vyrazu.

Prfehravac¢
Flash 4 a novéjsi.

Priklad

Nasledujici pfiklad pouziva operator | | v pfikazu if:
chtit = true;

potrebovat = true;

milovat = false;

if (chtit || potrebovat || milovat) {
trace (,dvé ze 3 nejsou Spatné“);

}
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(bitwise OR assignment)
Syntaxe
vyrazl | = vyraz2

Argumenty
vyrazi,vyraz2 Celd Cisla a proménna.

Popis
Operator (asignment); uruje vyrazul hodnotu vyrazi | vyraz2.

Pfehravac
Flash 5 nebo novéjsi.

Priklad
Nasledujici ilustruje pouziti operatoru | = s proménnymi a Cisly:
X |= y je stejné jako x = x | y

Jestlize x = 15 a y = 9 potom
x |= 9 dava 15

Viz také
| (bitwise OR)

(bitwise NOT)
Syntaxe
~vyraz

Argumenty
vyraz  Jakékoliv &islo.

Popis

Operator (bitwise); konvertuje vyraz na 32-bitové neoznacené celé Cislo, které potom
invertuje (pfevrati) bity. Nebo, jednoduse fec¢eno, zméni znaménko Cisla a odecte 1.
Operace bitwise NOT zméni znaménko Cisla a odecte 1.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici je numerické vysvétleni operace bitwise NOT provedené na proméenné:
~a, dava -1 jestlize a = 0, a dava -2 jestlize a = 1, tedy:

~0=-1 a ~1=-2
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(addition)
Syntaxe
vyrazl + vyraz2

Argumenty
vyrazi,vyraz2  Celd Cisla, Cisla, ,Cislo s plovouci fddkovou ¢arkou” nebo retézce.

Popis
Operator; s¢itd numerické vyrazy nebo spojuje fetézce. Jestlize je jeden vyraz fetézec,
v8echny dalsi vyrazy jsou konvertovany na fetézce a jsou spojeny.

Jestlize jsou oba vyrazy cela Cisla, suma je celé Cislo; jestlize je bud jeden nebo oba
vyrazy plynouci &isla, suma je plynouci Cislo.

Pfehravac¢

Flash4; Flash 5 nebo novéjsi. Ve Flash5 je + numericky operator nebo spojovac
fezézcl v zavislosti na typu dat argumentu. Ve Flash 4 je + pouze numericky operator.
Flash 4 soubory prenesené do autorského prostfedi Flash 5 podstoupi proces
konverze pro zvladnuti integrity typu dat. Prvni priklad dole ilustruje proces konverze.

Priklad

Nasleduijici ilustruje konverzi Flash 4 souboru obsahujiciho numerické srovnani kvality:
Flash 4 soubor:

X +y

Konvertovany Flash 5 soubor:
Number (x) +Number (y)

Tento prikaz scita cela Cisla 2 a 3 a potom zobrazi vysledné celé Cislo 5 do okna Output:
trace (2+3);

Tento vyraz scita ,Cislo s plovouci fadkovou ¢arkou” 2.5 a 3.25 a zobrazi vysledek
5.7500, plynouci Cislo, do okna Output:
trace (2.5+3.25);

Tento vyraz spojuje dva fetézce a zobrazi vysledek ,,dnes mam narozeniny” do okna
Output:

,dnes mam“ + ,narozeniny"

Viz také
add
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(additional assignment)
Syntaxe
vyrazl += vyraz2

Argumenty
vyrazi,vyraz2 Celd Cisla, ,Cislo s plovouci radkovou ¢arkou“ nebo retézce.

Popis
Operdtor (sloZzené urceni); urCuje vyrazu1 hodnotu vyraz1 + vyraz2. Tento operator
také provadi spojovani retézcu.

Pfehravac¢
Fish 4 nebo noveéjsi.

Priklad
Tento nasleduijici pfiklad ilustruje numerické pouziti operatoru +=:
x += yjestejnéjako x = x+y

Jestlizex = 5a y = 10 potom x += 10 ddva 15
Tento pfiklad ilustruje pouziti operatoru += s fetézcovym vyrazem:
x = ,Jmenuji se"“

x += ,Mary"

Vysledek vySe uvedeného kodu je:
,Jmenuji se Mary"“

Viz také
+ (addition)
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(less than)
Syntaxe
vyrazl < vyraz2

Argumenty
vyrazi,vyraz2 Cisla nebo retézce.

Popis

Operator (srovndni); srovndva dva vyrazy a urcuje, zda vyraz1 je mensi nez vyraz2
( true ) nebo zda je vyraz1 vétsi nebo roven vyrazu2 ( false ). Retézcové vyrazy
jsou ohodnoceny a srovndvany na zakladé poctu znak( v fetézci.

Pfehravac¢

Flash 4; Flah 5 nebo noveéjsi. Ve Flash 5 je < srovnavaci operator schopny zachdzet
s rlznymi typy dat. Ve Flash 4 je numerickym operatorem. Flash 4 soubory prenesené
do autorského prostredi Flash 5 podstupuji proces konverze pro zvladnuti integrity
typu dat. Prvni pfiklad dole ilustruje proces konverze.

Priklad
Nasleduijici ilustruje konverzi Flash 4 souboru obsahujictho numerické srovnani kvality.

Flash 4 soubor:
x <y

Konvertovany Flash 5 soubor:
Number (x) < Number (y)

Nasledujici pfiklady ilustruji vysledky true a false pro Cisla a retézce:
3 < 10 nebo ,Al“ < ,Jack" davaji true
10 < 3 nebo ,Jack“ < ,Al“ davaji false
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(bitwise left shift) <<
Syntaxe
vyrazl << vyraz2

Argumenty

vyrazi Cislo, fetézec nebo vyraz, ktery bude posunut vievo.

vyraz2 Cislo, fetézec nebo vyraz, ktery se konvertuje na celé &islo od 0 do 31.
Popis

Operator (bitwise); konvertuje vyraz1 a vyraz2 na 32-bitova celd Cisla a posunuje
vSechny bity ve vyrazu1 vlevo o pocet mist uréenych celym cislem, které je vysledkem
konverze vyrazu2. Bitové pozice jsou prazdné jako vysledek této operace jsou
vyplnény 0. Posunuti hodnoty vlevo o jednu pozici je ekvivalentni nasobeni dvéma.

Pfehravac
Flash 5 nebo novéjsi.

Priklad
Nasledujici priklad posunuje celé ¢islo 1 o deset bitd vlevo:
x =1 << 10

Vysledkem této operace je x = 1024. Toto je proto, Ze decimalni 1 se rovna
1 binaricky, 1 binaricky posunuta vievo o 10 je 10000000000 binaricky a 10000000000
binaricky je 1024 decimalné.

Nasledujici pfiklad posunuje celé ¢islo 7 o osm bitd vlevo: <=
x =7 << 8

Vysledek této operace je x = 1792. Je tomu tak proto, Ze 7 decimalné se rovna
111 binaricky, 111 binaricky posunuté vlevo o 8 bitd je 11100000000 binaricky
a 11100000000 binaricky je 1792 decimalne.

Viz také
>>= (bitwise right shift and assignment)

(bitwise left shift alignment)
Syntaxe
vyrazl <<= vyraz2

Argumenty
vyrazi Cislo, fetézec nebo vyraz, ktery ma byt posunut vlevo.

vyraz2 Cislo, fetézec nebo vyraz, ktery konvertuje na celé &islo od 0 do 31.

Popis
Operator (slozené urceni); tento operator vykonava operaci bitovy posuv vievo a uklada
obsahy jako vysledek ve vyrazui.

Pfehravac
Flash 5 nebo noveéjsi.

Priklad

Nasledujici dva vyrazy jsou ekvivalentni:
A <<= B

A = (A << B)

Viz také
<< (bitwise left shift)
>>= (bitwise right shift and assignment)

(less than or equal to)
Syntaxe
vyrazl <= vyraz2

Argumenty
vyrazi,vyraz2 Cislo nebo retézce.

Popis

Operator (srovndni); srovnava dva vyrazy a uréuje, zda vyraz1 je mensi nebo roven
vyrazu2 ( true ) nebo zda je vyrazi1 vétsi nez vyraz2 ( false ).

Pfehravac¢

Flash4; Flash 5 nebo novéjsi. Ve Flash 5 je <= operator srovnani schopny manipulovat
s rliznymi typy dat. Ve Flash 4 je <= numericky operator. Flash 4 soubory pienesené
do autorského prostredi Flash 5 podstupuji proces konverze pro podporu integrity
typu dat. Prvni pfiklad dole ilustruje proces konverze.
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Priklad
Nasleduijici ilustruje konverzi Flash 4 souboru obsahujictho numerické srovnani kvality.

Flash 4 soubor:
X <=y

Konvertovany Flash 5 soubor:
Number (x) <= Number (y)

Nasledujici pfiklady ilustruji vysledky true a false pro Cisla a retézce:
5 <= 10 nebo ,Al“ <= ,Jack"“ dava true
10 <= 5 nebo ,Jack“ <= ,Al“ dava false

(inequality)
Syntaxe
vyrazl <> vyraz2

Argumenty
vyrazi,vyraz2 Cisla, fetézce, Boolednské, proménné, objekty, pole nebo funkce.

Popis

Operdtor (inequality); testuje presny opak operdtoru ==. Jestlize je vyraz1 roven
vyrazu2, vysledek je false. Stejné jako u operdtoru ==, definice rovnosti zavisi na typu
dat, ktera jsou srovnavana:

Cisla, fetézce a Booleanské hodnoty jsou porovnavany hodnotou.
Proménné, objekty, pole a funkce jsou porovnavany odkazem.

Tento operator byl zavrZzen ve Flash 5 a uZivatelé jsou navadéni pro pouzivani nového
operatoru !=.

Pfehravac
Flash 2 nebo novéjsi.

Viz také
!'= (inequality)
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(assignment)
Syntaxe
vyrazl = vyraz2

Argumenty
vyrazl Proménnd, prvek pole nebo vlastnost objektu.

vyraz2 Hodnota jakéhokoliv typu.

Popis
Operator (uréeni); urCuje typ vyrazu2 (argument vpravo) na promennou, prvek pole
nebo vlastnost ve vyrazui.

Pfehravac¢

Flash 4; Flash 5 nebo novéjsi. Ve Flash 5 je = operator urCeni a operator ==
je pouzivan pro ohodnoceni rovnosti. Ve Flash 4 je = operator numerické rovnosti.
Flash 4 soubory pfenesené do Flash 5 autorského prostredi podstupuiji proces konverze
pro podporu integrity typu dat. Prvni pfiklad dole ilustruje proces konverze.

Priklad
Nasleduijici ilustruje konverzi Flash 4 souboru obsahujictho numerické srovnani kvality.

Flash 4 soubor:
X =y

Konvertovany Flash 5 soubor:
Number (x) == Number (y)

Nasledujici pfiklad pouziva operator assignment pro urceni Ciselného typu dat na
proménnou x:
x =25

Nasledujici priklad pouziva operator assignment pro uréeni fetézcoveého typu dat
na promeénnou x:
x = ,ahoj"
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(negation assignment)
Syntaxe
vyraz1l-= vyraz2

Argumenty
vyrazi,vyraz2 Celd Cisla, ,Cisla s plovouci radkovou ¢arkou“ nebo retézce.

Popis
Operétor (sloZzené urceni); uréuje vyrazul hodnotu vyraz1 - vyraz2.

Pfehravac¢
Flash 4 nebo nové;si.

Priklad
Nasleduijici ilustruje pouziti operatoru -= s proménnymi a Cisly:
x -= y je stejnéjako x = x - y

Jestlizex = 5 a y = 10 potomx -= 10 dava -5

(equality)
Syntaxe
vyrazl == vyraz2

Argumenty
vyrazi,wyraz2  Cisla, fetézce, Boolednské, proménné, objekty, pole nebo funkce.

Popis
Operator (equality); testuje rovnost dvou vyrazd. Vysledek je true, jestlize jsou
si vyrazy rovny.

Definice rovnosti zavisi na typu dat argumentu:

Cisla, fetézce a Boolednské hodnoty jsou porovnavany hodnotou a jsou povazovany
za rovné, jestlize maiji stejnou hodnotu. Napriklad dva fetézce jsou si rovné, jestlize
maji stejny pocet znakd.

Proménné, objekty, pole a funkce jsou porovnavany odkazem. Dvé proménné jsou
si rovny, jestlize odkazuji na stejny objekt, pole nebo funkci. Dvé oddélena pole nejsou
nikdy povaZovana za rovné, dokonce i kdyz maji stejny pocet prvkd.
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Pfehravac
Flash 5 a novéjsi.

Priklad
Nasledujici pfiklad pouziva operator == s pfikazem if:
a = ,David“, b = ,David“;

if (a == b){
trace (,David je David");

}

(greather than)
Syntaxe
vyrazi > vyraz2

Argumenty
vyrazi,vyraz2 Celd Cisla, ,Cisla s plovouci rddkovou ¢arkou“ nebo retézce.

Popis
Operdtor (srovnani); srovnava dva vyrazy a uréuje, zda je vyrazi vétsi nez vyraz2
( true ), nebo zda je vyraz1 mensi nebo roven vyrazu2 ( false ).

Pfehravac¢

Flash 4; Flash 5 nebo novéjsi. Ve Flash 5 je > operator srovnani schopny zachazet
s rlznymi typy dat. Ve Flash 4 je > numericky operator. Flash 4 soubory prenesené
do autorského prostiedi Flash 5 podstupuji proces konverze pro zvladnuti integrity
typl dat. Priklad dole ilustruje proces konverze.

Priklad

Nasleduijici ilustruje konverzi Flash 4souboru obsahujiciho numerické srovnani kvality.
Flash 4 soubor:

X >y

Konvertovany Flash 5 soubor:
Number (x) > Number (y)
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(greather than or equal to)
Syntaxe
vyrazi >= vyraz2

Argumenty
vyrazi,vyraz2  Retézce, cela Cisla nebo ,Cisla s plovouci radkovou ¢arkou*.

Popis
Operdtor (srovndni); porovndva dva vyrazy a uréuje, zda je vyraz1 vetsi nez nebo roven
vyrazu2 ( true ) nebo zda je vyrazl mensi nez vyraz2 ( false).

Pfehravac

Flash 4; Flash 5 nebo novéjsi. Ve Flash 5 je >= operator srovndni schopny
manipulovat s rdznymi typy dat. Ve Flash 4 je >= numericky operator. Flash 4 soubory
prenesené do autorského prostredi Flash 5 podstupuiji proces konverze pro podporu
integrity typu dat. Priklad dole ilustruje proces konverze.

Priklad

Nasleduijici ilustruje konverzi Flash 4 souboru obsahujictho numerické srovnani kvality.
Flash 4 soubor:

X >=y

Konvertovany Flash 5 soubor:
Number (x) > Number (y)

(bitwise right shift)
Syntaxe
vyrazl >> vyraz2

Argumenty

vyraz1 Cislo, fetézec nebo vyraz, ktery ma byt posunut vpravo.

vyraz2 Cislo, fetézec nebo vyraz, ktery konvertuje na celé &islo od 0 do 31.
Popis

Operator (bitwise); konvertuje vyraz1 a vyraz2 na 32-bitovd celd cisla a posunuje
v8echny bity ve vyrazul vpravo o pocet mist uréenych celym ¢&islem, které je
vysledkem konverze vyrazu2. Bity, ze kterych se posunulo vpravo jsou vyrazeny.
Pro zachovani znaku plvodniho vyrazu, jsou bity nalevo vypinény 0, jestlize
nejvyznamnéjsi bit (bit nejvzddlenéjsi nalevo) vyrazui je 0 a jsou vyplnény 1,
jestlize nejvyznamnéjsi bit je 1. Posunuti hodnoty vpravo o jednu pozici je ekvivalentni
déleni dvéma a vyrazeni zbytku.

Pfehravac
Flash 5 nebo noveéjsi.

Priklad

Nasledujici priklad konvertuje 65535 na 32-bitové celé &islo a posunuje ho o 8 bitl
vpravo:

x = 65535 >> 8

Vysledek operace je:
x = 255

Je tomu tak proto, Ze 65535 decimalné se rovnda 1111111111111111 binaricky
(Sestnact 1), 1111111111111111 binaricky posunuté vpravo o 8 bit je 11111111
binaricky a 11111111 binaricky je 255 decimalné. Nejvyznamnéjsi bit je 0, protoze
cela Cisla jsou 32-bitova, takze vyplnény bit je 0.

Nasledujici pfiklad konvertuje -1 na 32-bitové celé Cislo a posunuje ho o jeden bit
vpravo:
x=-1>>1

Vysledek operace je:

x = -1

Je tomu tak proto, Ze -1 decimainé se rovna 11111111111111111111111111111111
binaricky (tficet dva 1), posunuti vpravo o jeden bit zplsobi, Ze nejméné vyznamny
bit (bit nejvice vpravo) bude vyfazen, a nejvyznamngjsi bit bude vyplnén 1.
Vysledek je 11111111111111111111111111111111 binaricky (tficet dva 1), coz
reprezentuje 32-bitové celé Cislo -1.

Viz takeé
>>= (bitwise right shift and assignment)
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(bitwise right shift and assignment)
Syntaxe
vyrazi >>= vyraz2

Argumenty
vyrazi Cislo, fetézec nebo vyraz, ktery ma byt posunut vievo.

vyraz2 Cislo, fetézec nebo vyraz, ktery konvertuje na celé &islo od 0 do 31.

Popis
Operator (slozené urceni); tento operdtor vykonava operaci bitovy posun vpravo
a uklada obsahy jako vysledek ve vyrazui.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici dva vyrazy jsou ekvivalentni:
A >>=B

A= (A>>B)

Nasledujici komentovany kéd pouziva bitwise operator >>=. Je to také pfiklad pouziti
vSech bitwise operatord.

function convertToBinary (number)

{

var result = ““;

for (var i=0; i<32; i++){

//Vyjmout nejméné vyznamny bit pouZitim bitwise AND

var lsb = number & 1;

//Pfidat tento bit do naseho vysledného fetézce

result = (1sb ? “1“: “0%) + result;

//Posunout &islo vpravo o jeden bit, vidét dals$i bit
}number >>= 1;

return result;

}

convertToBinary = (479)

//Dava retézec

00000000000000000000000111011111

//Reté&zec nahofe je binaricka reprezentace decimalniho &isla 479.

Viz také
<< (bitwise left shift)
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>>> (bitwise unsigned right shift)

Syntaxe
vyrazi >>> vyraz2

Argumenty
wyraz1l Cislo, fetézec nebo vyraz, ktery ma byt posunut vpravo.

wraz2 Cislo, fetézec nebo vyraz, ktery konvertuje na celé &islo od 0 do 31.

Popis
Operator (bitwise); stejny jako operadtor bitwise right shift ( >>) kromeé toho,
Ze nezachovava znak plvodniho vyrazu, protoZe bity nalevo jsou vZdy vypinény 0.

Pfehravac
Flash 5 nebo noveéjsi.

Priklad

Nasledujici pfiklad konvertuje -1 na 32-bitové celé Cislo a posunuje ho o jeden bit
vpravo:

x =-1>>>1

Vysledek operace je:
x = 2147483647

Je tomu tak proto, Ze -1 decimalné je binaricky 11111111111111111111111111111111
(tficet dva 1) a kdyz posunete vpravo o jeden bit, nejméné vyznamny bit (nejvice
01111111111111111111111111111111 binaricky, coz reprezentuje 32-bitové celé
Cislo 2147483647.

Viz také
>>= (bitwise right shift and assignment)
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>>>=(bitwise unsigned right shift and assignment)

add

Syntaxe
vyrazi >>>= vyraz2

Argumenty
vyrazi Cislo, fetézec nebo vyraz, ktery ma byt posunuty vievo.

vyraz2 Cislo, fetézec nebo vyraz, ktery konvertuje na celé &islo od 0 do 31.

Popis
Operator (slozené ur€eni); provadi operaci neoznaceny posun vpravo a uklada
obsahy jako vysledek ve vyrazu1l.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici dva vyrazy jsou ekvivalentni:
A >>>=B

A= (A>>>B)

Viz take
>>> (bitwise unsigned right shift)
>>= (bitwise right shift and assignment)

Syntaxe
fetézec1 add retézec2

Argumenty
retézec1,2 Jakykoliv retézec.

Popis

Operator; spojuje dva nebo vice fetézcl. Operator add nahrazuje Flash 4 operator &;
Flash 4 soubory pouzivajici operator & jsou automaticky konvertovany na pouziti
operatoru add, pro spojeni fetézcl, pokud jsou pfeneseny do autorského prostredi
Flash 5. Nicméné, kdyz vytvarite obsah pro Flash 5 prehravac, operator add je zavrzen
ve Flash 5 a je doporu¢ovano pouzivat operator +. Jestlize vytvarite obsah pro Flash 4
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Pfehravac¢
Flash 4 nebo novejsi.

Viz také
+ (addition)

_alpha

Syntaxe
jménoinstance._alpha
jménoinstance._alpha = hodnota;

Argumenty
jménoinstance Jméno movie klip instance.

hodnota Cislo od 0 do 100 uréujici prihlednost al£a.

Popis

Vlastnost; nastavuje nebo ziskava alfa prihlednost ( hodnota ) movie klipu. Platné
hodnoty jsou 0 (UpIné prihledny) do 100 (zcela neprihledny). Objekty v movie klipu
s _alpha nastavenou na 0 jsou aktivni, i kdyZ jsou neviditelné. Napfiklad na tlacitko
v movie klipu s vlastnosti _alpha nastavenou na 0, mlize byt stdle kliknuto.

Pfehravac
Flash 4 nebo novéjsi.

Priklad
Nésledujici vyrazy nastavuiji viastnost _alpha movie klipu pojmenovaného star na 30%,
kdyz je kliknuto na tlacitko:
on (release) {
setProperty(star._alpha = 30);

nebo
on (release) {
star._alpha = 30;
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and

Syntaxe
podminkal and podminka2

Argumenty

podminkal,podminka2 Podminky nebo vyrazy, které se ohodnocuji na true

nebo false.

Popis

Operator; provadi logickou operaci AND ve Flash 4 Prehravaci. Jestlize jsou oba
vyrazy ohodnoceny na true, potom je cely vyraz true.

Prehravac

Flash 4 a novéjsi. Tento operator byl zavrzen pro Flash 5 a uZivatelé jsou podporovani

v pouzivani nového operatoru &&.

Viz také
&& (short-circuit AND)

Array (object)

Objekt Array (Pole) umoznuje ziskat pole a manipulovat s nimi. Pole je objekt, jehoz vlast-
nosti jsou identifikovany Cislem reprezentujicim jeho pozici v poli. Tomuto &islu se nékdy
fika index. VSechna pole maji zaklad nula, coz znamena, ze prvni prvek v poli je [0], druhy

prvek je [1], atd.

cislem.
myArray|[0]

myArray[1]

myArray|[2]

myArray[3]

V nasledujicim prikladé myArray obsahuje mésice roku identifikované

,Leden™“
,Unor"“
,Bfezen™
,Duben™

Pro vytvoreni objektu Pole pouzijte konstruktor new Array. Pro ziskani prvkl pole pouzijte
operator pfistup pole [ ].

Pfehled metod pro objekt Array

Metoda Popis

concat Spojuje argumenty a vraci je jako nové pole.

join Spojuje vSechny prvky pole do retézce.

pop Odstrariuje posledni prvek pole a uda jeho hodnotu.

push Pridévé jeden nebo vice prvk{ na konec pole a uda novou délku pole.
reverse Na misté obrati poradi prvkd v poli.

shift QOdstranuje prvni prvek z pole a udava jeho hodnotu.

slice Oddéli ¢ast pole a vrati ji jako nové pole.

sort Tridi pole v misté.

splice Pridd& a/nebo odstrani prvky z pole.

toString Dava fetézcovou hodnotu reprezentujici prvky v objektu pole.
unshift Pfida jeden nebo vice prvkd na zacatek pole a uda novou délku pole.

Pfehled viastnosti pro objekt Array

Metoda

Popis

length

Udava délku pole.
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Konstruktor pro objekt Array

Syntaxe

new Array();
new Array (length);
new Array (prvekO, prvek1,prvek2,...prvekN);

Argumenty

length Celé Cislo udavaijici pocet prvka v poli. V pripadé nekonec¢nych prvkl délka
ur€uje Cislo indexu posledniho prvku plus 1. Vice informaci viz vlastnost
Array.length.

prvek ()...prvekN Seznam dvou nebo vice libovolnych hodnot. Hodnoty mohou byt
Cisla, jména nebo jiné prvky uréené v poli. Prvni prvek v poli ma vzdy index
nebo pozici 0.

Popis

Konstruktor; umozriuje vam dosahnout a manipulovat s prvky v poli. Pole jsou zalozeny
na nule a prvky jsou indexovany svymi Cisly poradi. Jestlize nespecifikujete zadné
argumenty, je vytvoreno pole s délkou nula.

Prehravac
Flash 5 nebo déle.

Priklad
Nasledujici priklad vytvari objekt new Array s plvodni délkou 0:

myArray = new Array ();

Nasledujici priklad vytvari objekt new Array A-Team, s pUvodni délkou 4:
A-Team = new Array (,Jody"“, ,Mary“, ,Marcelle"“, ,Judy"):;

Pdvodni prvky pole A-tym jsou nasleduijici:

myArray[0] = ,Jody"
myArray[l] = ,Mary"
myArray[2] = ,Marcelle"
myArray[3] = ,Judy"

Viz take

Array.length

Array.concat

Syntaxe
myArray.concat(hodnota0,hodnota1,...hodnotaN);

Argumenty

hodnota0,...hodnotaN  Cisla, prvky nebo fetézce, které maji byt spojeny v nové
pole.

Popis

Metoda; spojuje prvky uréené v argumentech jestlize jsou, a vytvafi a vraci nové
pole. Jestlize argumenty specifikuji pole, jsou spojeny prvky tohoto pole dfive nez
pole samotné.

Pfehravac
Flash 5 nebo noveéjsi.

Priklad

Nasledujici kdd spojuje dvé pole:

alfa = new Array(,a“,“b",“c");
ciselne = new Array(1,2,3);
alfaCiselne = alfa.concat(ciselne)
//vytva¥i pole [,a“,“b"“,“c"“,1,2,3]

Nasledujici kéd spojuije tfi pole:

cislol=[1,3,5];

cislo2=[2,4,6];

cislo3=[7,8,9];

cisla=cislol.concat (cislo2,cislo3)//vytva¥i pole [1,3,5,2,4,6,7,8,9]

182

ACTION SCRIPT - FLASH 5

KAPITOLA 7-2 183



Array.join

Syntaxe
myArray.join();
myArray.join(oddélovac);

Argumenty

oddélovaé (separator) Znak nebo retézec, ktery oddéluje prvky pole v obdrzeném
fetézci. Jestlize na tento argument zapomenete, jako
nastaveny oddélovac je pouzita Carka.

Popis
Metoda; konvertuje prvky v poli na fetézce, spojuje je, vklada specifikovany oddélovac
mezi prvky a dava vysledny fetézec.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici priklad vytvari pole se tfemi prvky. Potom pole tfikrat propoji: pomoci
pouziti nastaveného oddélovace, potom ¢arky a mezery a potom znaménka plus.
a = new Array (,Zemé“, ,Mésic“, ,Slunce")

//uréuje ,Zemé&, Mésic,Slunce“k mojeVarl

mojeVarl = a.join();

//uréuje“Zemé, Mésic,Slunce“ k mojeVar2

mojeVar2 = a.join(“,%);

//uréuje“Zemé+Mésic+Slunce" k moje Var3

mojeVar3 = a.join(“+%);

Array.length

Syntaxe
myArray.length;

Argumenty
Z&dné

Popis

Vlastnost; obsahuje délku pole. Tato vlastnost je automaticky aktualizovana, kdyz
je do pole pfidan novy prvek. Béhem urCovani myArray[index]=hodnota;
jestlize je index &islo a index + 1 je vétsi nez vlastnost 1length, vlastnost length
je aktualizovéna na index + 1.

Pfehravac
Flash 5 nebo noveéjsi.

Priklad

Nasledujici kdad vysvétluje, jak je aktualizovana vlastnost délka:
//pivodni délka je O

myArray = new Array();

//myArray.length je updatovéna na 1

Array.pop

myArray[0] = “a’;

// myArray.length je updatovana na 2
myArray[1l] = 'b";

// myArray.length je updatovédna na 10
myArray[9] = ‘c¢”;

Syntaxe

myArray.pop () ;

Argumenty

Z&adné

Popis

Metoda; odstranuje posledni prvek z pole a udava hodnotu tohoto prvku.

Pfehravac
Flash 5 nebo noveéjsi.

Priklad

Nasledujici kéd vytvari pole myPets obsahuijici Ctyfi prvky, potom odstrani jeho
posledni prvek:

myPets = [,cat“, “dog"“, “bird"“, “fish“];

popped = myPets.pop() ;
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Array.push

Syntaxe
myArray.push(hodnota,...);

Argumenty
hodnota Jedna nebo vice hodnot pro pripojeni k poli.

Popis
Metoda; pridava jeden nebo vice prvki na konec pole a uddva novou délku pole.

Pfehravacé
Flash 5 nebo novéjsi.

Priklad

Nasledujici kdd vytvari pole myPets obsahujici dva prvky, potom do néj pfidava
dva prvky. Poté, co se kéd vykond, pushed obsahuje 4.

myPets = [,cat“, “dog"“];

pushed = myPets (,bird“, “fish"“);

Array.reverse

Syntaxe
myArray.reverse () ;

Argumenty
Z&dné

Popis
Metoda; obrati pole v misté.

Pfehravacé
Flash 5 nebo novéjsi.

Priklad
Nasledujici je pfikladem pouziti metody Array.reverse:
var numbers = [1,2,3,4,5,6];
trace (numbers.join()) ;
numbers.reverse() ;
trace (numbers.join()) ;

Vystup:
112131415161
6,5,4,3,2,1
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Array.shift

Syntaxe
myArray.shift () ;

Argumenty
Z&dné.

Popis

Metoda; odstrariuje prvni prvek z pole a uddva tento prvek.
Prehravac

Flash 5 nebo novéjsi.

Priklad

Nasledujici kdd vytvari pole myPets a potom odstrani prvni prvek z pole:
myPets = [,cat™, “dog"“, “bird"“, “fish"“];

shifted = myPets.shift();

Obdrzend hodnota je cat.
Viz také

Array . pop
Array.unshift

Array.slice

Syntaxe
myArray.slice(start,konec);

Argumenty
start  Cislo uddvajici index zacatecniho bodu pro rozdéleni. Jestlize je start zaporné
¢islo, startujici bod zac¢ina na konci pole, kde je -1 posledni prvek.

konec Cislo uddvajici index posledniho bodu pro rozdéleni. Jestlize na tento
argument zapomenete, rozdéleni zahrne vSechny prvky od zacatku do konce
pole. Jestlize je konec zaporné ¢islo, kone¢ny bod je ur€eny od konce pole,
kde -1 je posledni prvek.

Popis
Metoda; oddéluje Cast nebo podretézec pole a udava ho jako nové pole, bez modifikace
plvodniho pole. Obdrzené pole zahrnuje prvek start a véechny prvky az do prvku konec.

Prfehravac¢
Flash 5 nebo novéjsi.
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Array.sort

Syntaxe
myArray.sort();
myArray.sort(funkceporadi);

Argumenty

funkceporadi  Funkce volitelného srovnani pouzivand pro uréeni poradi tfident.
Dané argumenty A a B ur¢ené funkci poradi by meéli vykonat tfidéni ndsledovné:
-1 jestlize se A objevi pred B ve tfidéné sekvenci

0 jestlize A=B

1 jestlize se A objevi po B ve tfidéné sekvenci

Popis
Metoda; tridi pole v misté, bez délani kopie. Jestlize zapomenete argument
funkceporadi, Flash tfidi prvky v misté pomoci pouZiti operatoru srovnani <.

Pfehravac
Flash 5 nebo novéjsi.

Priklad
Nasledujici pfiklad pouziva Array.sort bez ureni argumentu funkcepofadi:
var ovoce = [,pomerance"“, “jablka"“, “jahody“, ,ananas“, “tfesné"“];

trace (ovoce.join());
ovoce.sort() ;
trace (ovoce.join());

Vystup:

pomerance, jablka, jahody,ananas, tfesné

jablka, tfesné,pomerance,ananas, jahody

Ndsledujici pfiklad pouziva array . sort s uréenou funkci poradi:

var heslo = [
»gary:foo“,
,mike:bar"“,
»john:snafu"“,
»Steve:yuck",
,daniel:1234“

function poradi (a,b) {

//Vstupy, které maji byt tfidény jsou ve formulafi

//jméno:heslo

//T£idit pouZitim pouze &asti jméno

//polozky jako klice.

var jmenol = a.split(’:7)[O0];

var jméno2 = b.split(":7)[0];

if (jmenol < jmeno2) {
return -1;

}else if (jmenol > jmeno2) {
return O;
}

}

for (var i=0; i< heslo.length;

trace (hesla.join());
}
heslo.sort (poradi);

trace (,Tfidéno“);

for (var i=0; i< heslo.length;

trace (heslo.join());

Vystup:
daniel:1234
gary: foo
john:snafu
mike:bar
steve:yuck

i++) {

it++)

{
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Array.splice

Syntaxe
myArray.splice(start,deleteCount,hodnota0,hodnotai...hodnotaN);

Argumenty

start Index prvku v poli, kde vkladani a/nebo ruseni zacina.

deleteCount Pocet prvki, které maji byt zruseny. Tento pocet zahrnuje prvek
ureny v argumentu start. Jestlize neni specifikovana zadna hodnota
pro deleteCount, metoda zrusi vSechny hodnoty od prvku start
do posledniho prvku pole.

hodnota Nula nebo vice hodnot pro vlozeni do pole ve vkladacim bodé
ur€eném v argumentu start. Tento argument je volitelny.

Popis

Metoda; pridava a / nebo odstranuje prvky z pole. Tato metoda upravuje samotné pole,
bez toho, Ze by délal kopii.

Pfehravac
Flash 5 nebo novéjsi.

Array.toString

Syntaxe
myArray.toString();

Argumenty
Z4dné.

Popis

Metoda; ddva hodnotu retézce reprezentujici prvky ve specifikovaném objektu Pole.
Kazdy prvek v poli po¢inaje indexem 0 a konCe indexem myArray. length-1 je
konvertovan na spojeny retézec, oddéleny ¢arkami.

Pfehravac
Flash 5 nebo novéjsi.
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Priklad
Nasledujici pfiklad vytvafi myArray a konvertuje ho na fetézec:
myArray = new Array ()

myArray [0] =

myArray [1] = 2;
myArray [2]

’

myArray [3] =

’

]
s WN R

myArray [4] =

’

trace (myArray.toString())

Vystup:
1,2,3,4,5

Array.unshift

Syntaxe
myArray.unshift(hodnotal,hodnota2,...hodnotaN);

Argumenty
hodnotat,...hodnotaN  Jedno nebo vice &isel, prvkl nebo proménnych, které
maji byt viozeny na zacatek pole.

Popis
Metoda; pridava jeden nebo vice prvkid na zacatek pole a udava novou délku pole.

Pfehravac
Flash 5 nebo noveéjsi.

Boolean (function)

Syntaxe
Boolean(vyraz);

Argumenty
vyraz Proménnag, Cislo nebo retézec, ktery ma byt konvertovdn na Booleovskou.

Popis
Funkce; konvertuje specifikovany argument na Booleovskou a uddva Booleovskou
hodnotu.

Pfehravac
Flash 5 nebo noveéjsi.

KAPITOLA 7-2 191



Boolean (object) Boolean.toString

Booleovsky objekt je jednoduchy obalovy objekt, se stejnou funkénosti jako standardni Syntaxe
JavaScript Boolean objekt. PouZijte Booleovsky objekt, pro ziskani Boolean. toString() ;
prvotniho typu dat nebo rfetézcoveé reprezentace Booleovského objektu.
Argumenty
Pfehled metod Booleovského objektu Zadné.
Metoda Popis Popis
: Udava retézcovou reprezentaci (t: nebo (fal . VA retd i 4 i
toString Bt by (true) (false) Metoda; udava retézcovou reprezentaci, true nebo false Booleovského objektu.
Uddva prvotni typ hodnoty specifikovaného
valueOf A .
Booleovského objektu. Piehravaé

Flash 5 nebo noveéjsi.
Konstruktor pro Booleovsky objekt

Syntaxe
new Boolean() ; Boolean.valueOf
new Boolean (x); Syntaxe
Boolean.valueOf () ;

Argumenty
X Cislo, fetézec, Booleovska, objekt, movie klip nebo jiny vyraz. Tento argument Argumenty

je volitelny. Z&dné.
Popis Popis
Konstruktor; vytvari instanci Boolednského objektu. Jestlize zapomenete na argument Metoda; udava prvotni typ hodnoty specifikovaného Booleovského objektu
x, Booleovsky objekt je inicializovan s hodnotou false. Jestlize urcite x, metoda a konvertuje Booleovsky obalovy objekt na jeho prvotni typ hodnoty.
ohodnoti argument a uda vysledek jako Booleovskou hodnotu podle nasledujicich
pravidel: Pfehravac
Pokud je x Cislo, funkce uda true, jestlize se x nerovna 0, nebo false, pokud je Flash 5 nebo noveéjsi.

x jakékoliv jiné Cislo.

Pokud je x Booleovska, funkce uda x.

Pokud je x objekt nebo movie klip, funkce uda true, jestlize se x nerovna nule;
jinak funkce uda false.

Pokud je x fetézec, funkce uda true, jestlize Number (x) se nerovna 0; jinak funkce
uda false.

Poznamka: Pro zvladnuti kompatibility s Flash 4, neni manipulace retézc Booleanskym
objektem ECMA-262 standard.

Pfehravac
Flash 5 nebo novéjsi.
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break

call

Syntaxe
break;

Argumenty
Z&dné.

Popis

Akce; objevi se uvniti smycky (for, for...in, do...while nebo while).
Akce break instruuje Flash, aby skoCil do zbytku téla smycky, zastavil akci smyckovani
a vykonal pfikaz nasledujici za pfikazem smycka. Akci break pouzijte pro preruseni
série ,uhnizdénych” smycek.

Pfehravac¢
Flash 4 nebo novéjsi.

Priklad
Nasledujici priklad pouziva akci break pro opusténi jinak nekone¢né smycky:
i=2~0;
while (true) {
if (i >= 100) {
break;

i++;

Syntaxe
call (snimek) ;

Argumenty
snimek Jméno nebo ¢islo snimku, ktery se ma volat v kontextu skriptu.

Popis
Akce; prepina kontext z aktudlniho skriptu na skript pfipojeny k volanému snimku.
Pokud je ukon&eno vykonavani skriptu, lokalni proménné prestanou existovat.

Prehravac¢
Flash 4 nebo novéjsi. Tato akce je zavrzena ve Flash 5 a je doporu¢ovano pouzivat
akci function.

Viz takeé
function
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chr
Syntaxe
chr (éislo) ;

Argumenty
cCislo ASCII kdd ¢islo pro konvertovani na znak.

Popis
Retézcova funkce; konvertuje ASCII kdd &isla na znaky.

Pfehravac¢
Flash 4 nebo novéjsi. Tato funkce byla zavrzena ve Flash 5 a je doporu¢ovano
pouzivat metodu String. fromCharCode.

Priklad
Nasledujici pfiklad konvertuje Cislo 65 na pismeno ,A":
chr (65)=,A"

Viz takeé
String.fromCharCode

Color (object)
Objekt Color (Barva) vdam umoznuje nastavit a ziskat hodnotu barvy RGB a zménu barvy
movie klipd. Objekt Color je podporovan Flash 5 a pozdéjsimi verzemi Flash Prehravace.

Musite pouzit konstruktor new Color () pro vytvoreniinstance objektu Color pred tim, nez
volate metody objektu Color.

Pfehled metod objektu Color

Metoda Popis

getRGB Udava numerickou hodnotu RGB nastavenou poslednim voldnim setRGB.
getTransform Udavd informaci o transformaci nastavenou poslednim volanim setTransform.
setRGB Nastavi hexadecimalni reprezentaci RGB hodnoty pro objekt Color.
setTransform Nastavuje transformaci barvy pro objekt Color.
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Konstruktor pro objekt Color Color.getTransform

Syntaxe Syntaxe

new Color(cil); myColor.getTransform() ;

Argumenty Argumenty

cil Jméno movie klipu, na ktery je aplikovana nova barva. Zadné.

Popis Popis

Konstruktor; vytvaii objekt Color pro movie klip ur¢eny argumentem cil. Metoda; uddvé hodnotu transformace nastavenou poslednim voldnim setTransform.
Pfehravac¢ Pfehravac¢

Flash 5 nebo nové;si. Flash 5 nebo novejsi.

Priklad Viz také

Nasleduijici priklad vytvari novy objekt Color nazvany myColor pro animaci mojeMovie: Color.setTransform

myColor = new Color (mojeMovie) ;

Color.setRGB
Color.getRGB Syntaxe
Syntaxe myColor.setRGB (0xRRGGBB) ;
myColor.getRGB () ;
Argumenty
Argumenty 0xRRGGBB Hexadecimalni nebo RGB barva, ktera ma byt nastavena. RR,
Z&dné. GG a BB sestévaji se dvou hexadecimalnich é&islic uréujicich
vyrovnani kazdé barevné komponenty.
Popis
Metoda; udava numerické hodnoty nastavené poslednim volani setRGB. Popis
Metoda; urCuje RGB barvu pro objekt Color. Volani této metody prepisuje jakakoliv
Pfehravac pfedchozi nastaveni metodou setTransform.
Flash 5 nebo nové;si.
Pfehravac
Priklad Flash 5 nebo novejsi.
Nasledujici kdd ziskdvd RGB hodnotu jako hexadecimalni fetézec:
hodnota=(getRGB()) . toString(16) ; Priklad
Nasledujici pfiklad nastavuje hodnotu RGB barvy pro movie klip mojeMovie:
Viz takeé myColor = new Color (mojeMovie) ;
Color.setRGB myColor.setRGB (0x993366) ;
Viz také

Color.setTransform
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Color.setTransform

Syntaxe
myColor. setTransform(colorTransformObject);

Argumenty

colorTransformObject  Objekt vytvofeny konstruktorem generického objektu
Obiject, urCujici hodnoty transformace barvy pro parametry.
Barevneé transformovany objekt musi mit parametry
ra, rb, ga, gb, ba, bb, aa, ab, které jsou
vysvétleny dole.

Popis

Metoda; nastavuje informaci o barevné transformaci pro objekt Color. Argument
colorTransformObject je objekt, ktery vytvarite pouZitim generického objektu Object
s parametry urcujicimi procento a vyrovnani hodnot pro komponenty barvy ¢ervena
(red), zelena (green), modra (blue) a alfa (prdhlednost), viozené ve formatu
0xRRGGBBAA.

Parametry pro barevné transformovany objekt jsou definovany ndsledovné:
ra je procento pro ¢ervenou komponentu (-100 az 100).

rb je vyrovnani pro ¢ervenou komponentu (-255 az 255).

ga je procento pro zelenou komponentu (-100 az 100).

gb je vyrovnani pro zelenou komponentu (-255 az 255).

ba je procento pro modrou komponentu (-100 az 100).

bb je vyrovnani pro modrou komponentu (-255 az 255).

aa je procento pro afla (-100 az 100).

ab je vyrovnani pro alfa (-255 az 255).

Vytvorite barevné transformovany objekt nasledovné:
myColorTransform = new Object() ;
myColorTransform.ra = 50;
myColorTransform.rb = 244;
myColorTransform.ga = 40;
myColorTransform.gb = 112;
myColorTransform.ba = 12;
myColorTransform.bb = 90;
myColorTransform.aa = 40;
myColorTransform.ab = 70;

Mohli byste také pouzit nasledujici syntaxi:
myColorTransform = {ra: 50" ,rb: 244" ,ga: 40" ,gb: 112" ,ba:
“12° ,bb: 90" ,aa: 40" ,ab: 70"}

Pfehravac
Flash 5 nebo noveéjsi.

Priklad

Nasledujici pfiklad ukazuje proces vytvoreni objektu new Color pro cilové movie
vytvorenim barevné transformovaného objektu s parametry definovanymi nahore
pomoci pouziti konstruktoru Object a propusténim barevné transformovaného
objektu do objektu Color pomoci metody setTransform.

//Vytvofit objekt barva nazvany myColor pro cil mojeMovie
myColor = new Color (mojeMovie) ;

//Vytvofit barevné transformovany objekt nazvany myColorTransform
pouzitim

//generického objektu Object

myColorTransform = new Object;

//Nastavit hodnoty pro myColorTransform

myColorTransform = {ra: 50" ,rb:"244° ,ga: 40" ,gb:"112° ,ba:
127 ,bb: 90" ,aa: 40" ,ab: 70"}

//Spojit barevné transformovany objekt s objektem Color vytvofenym
pro mojeMovie

myColor.setTransform (myColorTransform) ;

continue

Syntaxe
continue;

Argumenty
Z4dné.
Popis

Akce; objevi se uvnitf nékolika typ smyckovych prikaz(.

Ve smyCce while, continue zpUsobi, Ze Flash preskoCi zbytek téla smycky a skoci
na vrchol smycky, kde je testovana podminka.

Ve smyCce do..while, continue zpUsobi, Ze Flash preskoéi zbytek téla smycky
a skoCi na spodek smycky, kde je testovana podminka.

198

ACTION SCRIPT - FLASH 5

KAPITOLA 7-2 199



Ve smyéce for, continue zplsobi, Ze Flash pfesko&i zbytek téla smycky a skodi Date (object)

na ohodnoceni vyrazu za smycCkou for. Objekt Date (Datum) vam umoznuje ziskat hodnoty datum a €Cas, relativni k univerzalnimu
Ve smycce for..in, continue zplsobi, Ze Flash preskodi zbytek téla smycky &asu (Grrenwich Stfedozemsky Cas, nyni nazvany Univerzaini Koordinovany Cas) nebo rel-
a skocCi zpét na vrchol smycky, kde je vykonana dalsi hodnota. ativni k operacnimu systému, na kterém bézi Flash Pfehravac. Pro volani metod objektu

Date musite nejprve vytvofit instanci objektu Date pomoci pouziti konstruktoru.
Prfehravacé

Flash 4 nebo nové;si. Objekt Date pozaduje Flash 5 Prehravac.

Viz také Metody objektu Date nejsou statické, avSak aplikujte je pouze na individudini instanci
do..while objektu Date, kterd je ur€ena pfi volani metody.
for
for..in Pfehled metod pro objekt Date
while
Metoda Popis
getDate Udéva den v mésici uréeného objektu Date v souladu s mistnim ¢asem.
_currentframe getDay Udavéa den v mésici pro urcity objekt Date v souladu s mistnim ¢asem.
Syntaxe P " . . e
. getFullYear Udava Ctyiciferny rok specifikovaného objektu Date v souladu s mistnim ¢asem.
jmenoinstance. currentframe
- getHours Udava hodinu specifikovaného objektu Date v souladu s mistnim ¢asem.
Argumenty getMilliseconds Uddva milisekundy specifikovaného objektu Date v souladu s mistnim ¢asem.
jménoinstance Jméno movie klip instance. getMinutes Udava minuty specifikovaného objektu Date v souladu s mistnim Sasem.
getMonth Udéva mésic specifikovaného objektu Date v souladu s mistnim ¢asem.
Popis getSeconds Uddva sekundy specifikovaného objektu Date v souladu s mistnim ¢asem.
Vlastnost (pouze pro Cteni); udéva Cislo snimku, na kterém je aktualné umisténa e Udava poCet milisekund od painoci 1.ledna 1970 univerzalniho Gasu,
hraci hlava v Casové ose. gettime pro specifikovany objekt Date.
getTimezoneOffset | Udévd rozdil v minutdch mezi lokdinim ¢asem pocitace a univerzalnim casem.
. . v Udava den (datum) v mésici specifikovaného objektu Date v souladu
Prehravac getUTCDate s univerzalnim dasem.
Flash 4 nebo nové;si. getUTCDay Udava den v tydnu specifikovaného objektu Date v souladu s univerzalnim ¢asem.
getUTCFullYear Udava ctyrciferny rok specifikovaného objektu Date v souladu s univerzalnim ¢asem.
Priklad o o . getUTCHours Udéva hodinu specifikovaného objektu Date v souladu s univerzalnim casem.
Nasledujici priklad pouzivd _currentframe pro nasmeérovani animace, aby skocila
v P v -, oy . getUTCMilliseconds| Uddva milisekundy uréeného objektu Date v souladu s univerzainim ¢asem.
0 pét snimku dopfedu od snimku obsahuijici akci:
gotoAndStop (_currentframe+5) ; getUTCMinutes Udava minuty specifikovaného objektu Date v souladu s univerzainim ¢asem.
getUTCMonth Uddva mésic specifikovaného objektu Date v souladu s univerzalnim ¢asem.
getUTCSeconds Uddva sekundy specifikovaného objektu Date v souladu s univerzéinim ¢asem.
getYear Uddva rok specifikovaného objektu Date v souladu s mistnim ¢asem.
setDate Udava den v mésici specifikovaného objektu Date v souladu s mistnim ¢asem.
setFullYear Nastavuje cely rok pro objekt Date v souladu s mistnim ¢asem.
setHours Nastavuje hodiny pro objekt Date v souladu s mistnim ¢asem.
setMilliseconds Nastavuje milisekundy pro objekt Date v souladu s mistnim ¢asem.
setMinutes Nastavuje minuty pro objekt Date v souladu s mistnim ¢asem.
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Metoda Popis

setMonth Nastavuje mésic pro objekt Date v souladu s mistnim ¢asem

setSeconds Nastavuje sekundy pro objekt Date v souladu s mistnim ¢asem.

setTime Nastavuje datum pro specifikovany objekt Date v milisekundéch.
setUTCDate Nastavuje datum specifikovaného objektu Date v souladu s univerzalnim ¢asem.
setUTCFullYear Nastavuje rok specifikovaného objektu Date v souladu s univerzalnim ¢asem.
setUTCHours Nastavuje hodinu specifikovaného objektu Date v souladu s univerzalnim ¢asem.
setUTCMilliseconds| Nastavuje milisekundy specifikovaného objektu Date v souladu s univerzainim Gasem.
setUTCMinutes Nastavuje minutu specifikovaného objektu Date v souladu s univerzalnim ¢asem.
setUTCMonth rs\liiti?l\égz lmﬁ]s%:arseepgfzentovany specifikovanym objektem Date v souladu
setUTCSeconds Nastavuje sekundy specifikovaného objektu Date v souladu s univerzalnim ¢asem.
setYear Nastavuje rok pro specifikovany objekt Date v souladu s mistnim ¢asem.
toString \LlJéjévé Fﬁ}fzgoxg% hoqlnlgtu I:r)epg.ezentujl’cf datum a ¢as uloZeny

date.UTC Udava pocet milisekund mezi plinoci 1.ledna 1970 univerzalniho asu

a urcitym ¢asem.

Konstruktor pro objekt Date

Syntaxe
new Date() ;
new Date (rok

[,mésic [,datum [,hodina [,minuta [,sekunda

[,milisekunda ]]11111);

Argumenty
year (rok)

month (mésic)
date (datum)
hour (hodina)
minute (minuta)

second
(sekunda)

millisecond
(milisekunda)

Hodnota od 0 do 99 indikujici 1900 az 1999, jinak musi byt uréeny
v§echny Ctyfi Cislice roku.

Celé ¢islo od 0 (Leden) do 11 (Prosinec). Tento argument je volitelny.

Celé ¢&islo od 1 do 31. Tento argument je volitelny.
Celé &islo od 0 (pllnoc) do 23 (11 hodin vecer).

Celé ¢&islo od 0 do 59. Tento argument je volitelny.

Celé ¢&islo od 0 do 59. Tento argument je volitelny.

Celé ¢&islo od 0 do 999. Tento argument je volitelny.
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Popis
Objekt; konstruuje novy objekt Date udavajici aktualni datum a Cas.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici pfiklad ziskdva aktudini datum a Cas:

nyni = new Date();

Nasledujici pfiklad vytvari novy objekt Date pro Garyho narozeniny 7.srpna 1974:
gary narozeniny = new Date (74,7,7);

Nasledujici pfiklad vytvari novy objekt Date, ktery spojuje ziskané hodnoty metod
objektu Date getMonth, getDate a getFullYear a zobrazuje je v textovém
poli uréeném proménnou datumTextovePole.

myDate = new Date();
datumTextovePole = (myDate.getMonth()+"“/“+myDate.getDate ()+“/"
+ myDate.getFullYear()) ;

Date.getDate

Syntaxe
myDate.getDate () ;

Argumenty

Zadné.

Popis
Metoda; udava den v meésici (celé ¢islo od 1 do 31) specifikovaného objektu Date
v souladu s mistnim ¢asem.

Pfehravac
Flash 5 nebo novéjsi.
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Date.getDay

Syntaxe
myDate .getDay () ;

Argumenty
Z4dné.

Popis

Metoda; udava den v mésici (0 pro nedéli, 1 pro pondéli atd.) specifikovaného
objektu Date v souladu s mistnim ¢asem. Mistni ¢as je ur€en operacnim systémem,
na kterém bézi Flash Prehravac.

Pfehravac
Flash 5 nebo novéjsi.

Date.getFullYear

Syntaxe
myDate.getFullYear () ;

Argumenty
Z4dné.

Popis

Metoda; udava cely rok (Ctyfciferné Cislo, napfiklad 2000) specifikovaného objektu
Date v souladu s mistnim ¢asem. Mistni ¢as je uréen operanim systémem, na kterém
bézi Flash Prehravac.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasleduijici pfiklad pouziva konstruktor pro vytvoreni objektu new Date a posila ziskané
hodnoty metodou getFullYear do okna Vystup:

myDate = new Date();

trace (myDate.getFullYear()) ;
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Date.getHours

Syntaxe
myDate.getHours () ;

Argumenty
Z4dné.

Popis

Metoda; udava hodinu (celé Cislo od 0 do 23) specifikovaného objektu Date v souladu
s mistnim ¢asem. Mistni ¢as je ur¢en operacnim systémem, na kterém bézi Flash
Prehravac.

Pfehravac
Flash 5 nebo novéjsi.

Date.getMilliseconds

Syntaxe
myDate.getMilliseconds () ;

Argumenty
Z4dné.

Popis

Metoda; udava milisekundy (celé Cislo od 0 do 999) specifikovaného objektu Date
v souladu s mistnim ¢asem. Mistni Cas je uréen operacnim systémem, na kterém
bézi Flash Prehravac.

Pfehravac
Flash 5 nebo noveéjsi.
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Date.getMinutes

Syntaxe
myDate.getMinutes () ;

Argumenty
Z4dné.

Popis

Metoda; udava minuty (celé &islo od 0 do 59) specifikovaného objektu Date v souladu
s mistnim ¢asem. Mistni ¢as je ur¢en operacnim systémem, na kterém bézi Flash
Prehravac.

Pfehravac
Flash 5 nebo novéjsi.

Date.getMonth

Syntaxe
myDate.getMonth () ;

Argumenty
Z4dné.

Popis

Metoda; udava meésic (0 pro leden, 1 pro unor atd.) specifikovaného objektu Date
v souladu s mistnim ¢asem. Mistni ¢as je ur€en operacnim systémem, na kterém
bézi Flash Prehravac.

Pfehravac
Flash 5 nebo novéjsi.
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Date.getSeconds

Syntaxe
myDate.getSeconds () ;

Argumenty
Z4dné.

Popis

Metoda; udava sekundy (celé Cislo od 0 do 59) specifického objektu Date v souladu
s mistnim ¢asem. Mistni ¢as je ur¢en operacnim systémem, na kterém bézi Flash
Prehravac.

Pfehravac
Flash 5 nebo novéjsi.

Date.getTime

Syntaxe
myDate.getTime () ;

Argumenty
Z4dné.

Popis

Metoda; udava pocet milisekund (celé &islo od 0 do 999) od plinoci 1.ledna 1970
univerzalniho ¢asu pro specifikovany objekt Date. Pouzijte tuto metodu pro
reprezentaci specifického okamziku v ¢ase, kdyz porovnavéte dva nebo vice ¢asl
definovanych v riznych ¢asovych zénach.

Pfehravac
Flash 5 nebo novéjsi.
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Date.getTimezoneOffset

Syntaxe
myDate.getTimezoneOffset () ;

Argumenty
Z4dné.

Popis
Metoda; udava rozdil v minutach, mezi mistnim ¢asem pocitace a univerzalnim ¢asem.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici pfiklad udava rozdil mezi mistnim dennisvétlo-Setficim ¢asem pro San
Francisco a univerzdlnim ¢asem. Dennisvétlo-Setfici Cas je faktorovan do daného
vysledku, jestlize datum definované v objektu Date je v pribéhu dennisvétlo-Setficino
casu.

new Date () .getTimezoneOffset ()

Vysledek je nasleduijici:
420 (7 hodin * 60 minut / hodina = 420 minut)

Date.getUTCDate

Syntaxe
myDate.getUTCDate () ;

Argumenty

Zadné.

Popis
Metoda; udava den (datum) v mésici ve specifikovaném objektu Date v souladu
s univerzalnim ¢asem.

Pfehravac
Flash 5 nebo novéjsi.
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Date.getUTCDay

Syntaxe
myDate.getUTCDay () ;

Argumenty

Zadné.

Popis
Metoda; udava den v tydnu specifikovaného objektu Date v souladu s univerzalnim
Casem.

Date.getUTCFullYear

Syntaxe
myDate.getUTCFullYear() ;

Argumenty
Z4dné.

Popis
Metoda; udava Ctyrciselny rok specifikovaného objektu Date v souladu s univerzalnim
Casem.

Pfehravac
Flash 5 nebo noveéjsi.

Date.getUTCHours

Syntaxe
myDate.getUTCHours();

Argumenty
Z4dné.
Popis

Metoda; udava hodiny specifického objektu Date v souladu s univerzalnim ¢asem.

Pfehravac
Flash 5 nebo noveéjsi.
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Date.getUTCMilliseconds Date.getUTCSeconds

Syntaxe Syntaxe

myDate.getUTCMilliseconds () ; myDate.getUTCSeconds () ;

Argumenty Argumenty

Z4dné. Z4dné.

Popis Popis

Metoda; udava milisekundy specifikovaného objektu Date v souladu s univerzalnim Metoda; udava sekundy ve specifikovaném objektu Date v souladu s univerzalnim

Casem. Casem.

Pfehravac Pfehravac

Flash 5 nebo novéjsi. Flash 5 nebo noveéjsi.

Date.getUTCMinutes Date.getYear

Syntaxe Syntaxe

myDate . getUTCMinutes () ; myDate.getYear () ;

Argumenty Argumenty

Z4dné. Z4dné.

Popis Popis

Metoda; udava minuty specifikovaného objektu Date v souladu s univerzalnim ¢asem. Metoda; udava rok specifikovaného objektu Date v souladu s mistnim ¢asem. Mistni
Cas je ur€en operacnim systémem, na kterém bézi Flash Prehravag. Rok je cely

Prfehravac¢ rok minus 1900. Napfiklad, rok 2000 je reprezentovan jako 100.

Flash 5 nebo novéjsi.
Pfehravac
Flash 5 nebo noveéjsi.

Date.getUTCMonth
Syntaxe

myDate.getUTCMonth () ;

Argumenty
Z4dné.
Popis

Metoda; udava mésic specifikovaného objektu Date v souladu s univerzalnim ¢asem.

Pfehravac
Flash 5 nebo novéjsi.
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Date.setDate

Syntaxe
myDate.setDate (datum) ;

Argumenty
datum Celé Cislo od 1 do 31.

Popis
Metoda; nastavuje den v mésici pro specifikovany objekt Date v souladu s mistnim
¢asem. Mistni ¢as je ur¢en operacnim systémem, na kterém bézi Flash Prehravac.

Pfehravac
Flash 5 nebo novéjsi.

Date.setFullYear

Syntaxe
myDate . setFullYear (rok [, mésic [, datum ] ] );

Argumenty

rok Ctyrciferné dislo uréuijici rok. Dvouciferna &isla nereprezentuji roky;
napfiklad 99 neni rok 1999, ale rok 99.

mésic Celé &islo od 0 (leden) do 11 (prosinec). Tento argument je volitelny.

datum Cislo od 1 do 31. Tento argument je volitelny.

Popis

Metoda; nastavuje rok specifikovaného objektu Date v souladu s mistnim ¢asem.
Jestlize jsou specifikovany argumenty mésic a datum, jsou nastaveny také na mistni
Cas. Mistni Cas je urCen opera¢nim systémem, na kterém bézi Flash Prehravac.
Vysledky getUTCDay a getDay se mohou zménit vysledkem voldni této metody.

Pfehravac
Flash 5 nebo novéjsi.
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Date.setHours

Syntaxe
myDate. setHours (hodina) ;

Argumenty
hodina Celé ¢islo od 0 (ptlnoc) do 23 (11 hodin vecer).

Popis
Metoda; nastavuje hodiny pro specifikovany objekt Date v souladu s mistnim ¢asem.
Mistni Cas je ur¢en opera¢nim systémem, na kterém bézi Flash Prehrdvac.

Pfehravac
Flash 5 nebo novéjsi.

Date.setMilliseconds

Syntaxe
myDate.setMilliseconds (milisekunda) ;

Argumenty
milisekunda Celé ¢&islo od 0 do 999.

Popis
Metoda; nastavuje milisekundy pro specifikovany objekt Date v souladu s mistnim
C¢asem. Mistni Cas je urCen operacnim systémem, na kterém bézi Flash Prehravac.

Pfehravac
Flash 5 nebo noveéjsi.
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Date.setMinutes

Syntaxe
myDate . setMinutes (minuta) ;

Argumenty
minuta Celé ¢&islo od 0 do 59.

Popis
Metoda; nastavuje minuty pro specifikovany objekt Date v souladu s mistnim ¢asem.
Mistni Cas je urCen opera¢nim systémem, na kterém bézi Flash Prehrdvac.

Pfehravac
Flash 5 nebo novéjsi.

Date.setMonth

Syntaxe
myDate . setMonth (mé&sic [, datum ] );

Argumenty

mésic Celé Cislo od 0 (leden) do 11 (prosinec).

datum Celé &islo od 1 do 31. Tento argument je volitelny.
Popis

Metoda; nastavuje meésic pro specifikovany objekt Date v mistnim Case. Mistni ¢as
je urCen opera¢nim systémem, na kterém bézi Flash Prehravac.

Pfehravac
Flash 5 nebo novéjsi.
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Date.setSeconds

Syntaxe
myDate.setSeconds (sekunda) ;

Argumenty
sekunda Celé ¢&islo od 0 do 59.

Popis
Metoda; nastavuje sekundy pro specifikovany objekt Date v mistnim ¢ase. Mistni
Cas je uren opera¢nim systémem, na kterém bézi Flash Prehravac.

Pfehravac
Flash 5 nebo novéjsi.

Date.setTime

Syntaxe
myDate.setTime(milisekunda);

Argumenty
milisekunda Celé ¢&islo od 0 do 999.

Popis
Metoda; nastavuje Date pro specifikovany objekt datum v milisekundach.

Pfehravac
Flash 5 nebo noveéjsi.
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Date.setUTCDate

Syntaxe
myDate.setUTCDate (datum) ;

Argumenty
datum Celé ¢&islo od 1 do 31.

Popis

Metoda; nastavuje datum pro specifikovany objekt Date v univerzalnim ¢ase. Volani
této metody nemodifikuje ostatni pole specifikovaného objektu Date, ale metody
getUTCDay a getDay mohou uddvat novou hodnotu, jestlize se zméni den v tydnu
jako vysledek volani této metody.

Pfehravac
Flash 5 nebo novéjsi.

Date.setUTCFullYear

Popis

Syntaxe
myDate . setUTCFullYear (rok [,mésic [,datum ]]);

Argumenty
rok Rok urCeny jako Ctyfciferny rok, napfiklad 2000.

mésic Celé ¢islo od 0 (leden) do 11 (prosinec). Tento argument je volitelny.

datum Celé Cislo od 1 do 31. Tento argument je volitelny.

Metoda; nastavuje rok nebo specifikovany objekt Date (myDate) v univerzalnim
Case. VoliteIné mize tato metoda nastavit také mésic a datum reprezentovany
specifikovanym objektem Date. Z4dn4 dalsi pole objektu Date nejsou modifikovana.
Volani setUTCFullYear mize zpUsobit, Ze getUTCDay a getDay budou hlasit
novou hodnotu, pokud se zméni den v tydnu jako vysledek této operace.

Prehravac

Flash 5 nebo novéjsi.

Date.setUTCHours

Syntaxe
myDate.setUTCHours(hodina [,minuta [,sekunda [,milisekunda 11]);

Argumenty

hodina Celé ¢&islo od 0 (pllnoc) do 23 (11 hodin vecer).
minuta Celé ¢&islo od 0 do 59. Tento argument je volitelny.
sekunda Celé &islo od 0 do 59. Tento argument je volitelny.

milisekunda Celé Cislo od 0 do 999. Tento argument je volitelny.

Popis
Metoda; nastavuje hodinu pro specifikovany objekt Date v univerzalnim Case.

Pfehravac
Flash 5 nebo noveéjsi.

Date.setUTCMilliseconds

Syntaxe
myDate . setUTCMilliseconds (milisekunda) ;

Argumenty
milisekunda Celé ¢&islo od 0 do 999.

Popis
Metoda; nastavuje milisekundy pro specifikovany objekt Date v univerzalnim Case.

Pfehravac
Flash 5 nebo noveéjsi.
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Date.setUTCMinutes

Syntaxe
myDate . setUTCMinutes (minuta [,sekunda [,milisekunda ]1]);

Date.setUTCSeconds

Syntaxe
myDate . setUTCSeconds (sekunda [, milisekunda ]);

Argumenty Argumenty
minuta Celé Cislo od 0 do 59. sekunda Celé Cislo od 0 do 59.
sekunda Celé Cislo od 0 do 59. Tento argument je volitelny. milisekunda Celé Cislo od 0 do 999. Tento argument je volitelny.
milisekunda Celé Cislo od 0 do 999. Tento argument je volitelny. Popis

Metoda; nastavuje sekundy pro specifikovany objekt Date v univerzalnim Case.
Popis
Metoda; nastavuje minutu pro specifikovany objekt Date v univerzalnim Case. Pfehravac¢

Flash 5 nebo novéjsi.
Pfehravac¢
Flash 5 nebo novéjsi.

Date.setYear
Syntaxe
Date.setUTCMonth myDate.setYear (rok) ;

Syntaxe
myDate.setUTCMonth (mésic [,datum ]); Argumenty

rok Ctyrciferné &islo, napfiklad 2000.
Argumenty
mésic Celé Cislo od 0 (leden) do 11 (prosinec). Popis

Metoda; nastavuje rok pro specifikovany objekt Date v mistnim ¢ase. Mistni
datum Celé Cislo od 1 do 31. Tento argument je volitelny. Cas je urCen operacnim systémem, na kterém bézi Flash Pfehravac.
Popis Pfehravac¢
Metoda; nastavuje mésic a volitelné den (datum) pro specifikovany objekt Date Flash 5 nebo noveéjsi.

v univerzalnim Case. Voldni této metody nemodifikuje dalSi pole specifikovaného
objektu Date, ale metody getUTCDay a getDay mohou hldsit novou hodnotu,
jestlize se zméni den v tydnu jako vysledek specifikace argumentu datum, pfi volani
setUTCMonth.

Pfehravac
Flash 5 nebo novéjsi.
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Date.toString

Syntaxe
myDate.toString() ;

Argumenty
Z4dné.

Popis
Metoda; uddva rfetézcovou hodnotu pro specifikovany objekt Date ve formatu pro ¢teni.

Prehravac

Flash 5 nebo novéjsi.

Nasledujici pfiklad dava informaci v objektu Date datumNarozeni jako fetézec:
var datumNarozeni = new Date(74,7,7,18,15);
trace (datumNarozeni.toString()):;

Vystup (pro Pacificky Standardni Cas):
Wed (Stfeda) Aug (Srpen) 7 18:15:00 GMT-0700 1974

Date.UTC

Syntaxe
Date.UTC (rok,mésic [,datum [,hodina [,minuta [,sekunda
[, milisekunda ]1]111):

Argumenty 5

rok CtycCciferné Cislo, napfiklad 2000.

mésic Celé Cislo od 0 (leden) do 11 (prosinec).

datum Celé &islo od 1 do 31. Tento argument je volitelny.
hodina Celé ¢&islo od 0 (pllnoc) do 23 (11 hodin vecer).
minuta Celé &islo od 0 do 59.Tento argument je volitelny.
sekunda Celé &islo od 0 do 59. Tento argument je volitelny.

milisekunda Celé Cislo od 0 do 999. Tento argument je volitelny.

ACTION SCRIPT - FLASH 5

Popis

Metoda; udava pocet milisekund mezi pdlnoci 1.ledna 1970 univerzalniho c¢asu
a Gasem uréenym v argumentech. Toto je staticka metoda, ktera je vyvoldna pomoci
konstruktoru objektu Date, ne pomoci specifického objektu Date. Tato metoda
umozniuje vytvorit objekt Date, ktery predpoklada univerzalni ¢as, zatimco konstruktor
Date predpoklada mistni Cas.

Pfehravac
Flash 5 nebo noveéjsi.

Priklad

Nésledujici pfiklad vytvafi objekt new Date gary narozeniny, definovany
v univerzalnim ¢ase. Toto je variace pfikladu univerzalniho ¢asu pouzitého pro
konstrukéni metodu new Date ():

gary narozeniny = new Date(Date.UTC(1974,7,8));

delete

Syntaxe
delete (odkaz);

Argumenty
odkaz Jméno proménné nebo objektu, ktery ma byt eliminovan.

Popis

Operator; rusi objekt nebo proménnou specifikovanou jako odkaz a udava true,
jestlize byl objekt uspésné odstranén; jinak udava false. Tento operator je uziteCny
pro uvolfiovani paméti pouzivané skripty, ackoliv je delete operator, je typicky
pouzivan jako pfikaz:

delete x;

Operétor delete nemusi uspét a mize udat false, jestlize odkaz neexistuje nebo
nemUze byt zrugen. Pfeddefinované objekty a vlastnosti a proménné deklarované
pomoci var nemohou byt zruSeny.

Pfehravac
Flash 5 nebo noveéjsi.
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Priklad

Nasleduijici priklad vytvari objekt, pouZiva ho a potom ho rusi, kdyz uz neni vice potreba:
account = new Object();

account.name = “Jon’;

account.balance = 10000;

delete.account;

Nasledujici pfiklad rusi viastnost objektu:
//vytvofit novy objekt ,account™
account = new Object();

//uré&it vlastnost name k account
account.name = “Jon”;

//zrudit vlastnost

delete account.name;

Ndsledujici je dalSim prikladem zruSeni vlastnosti objektu:

//vytvofit objekt Array s délkou 0

array = new Array();

//Array.length je nyni 1

array[0] = ,abc"“;

//pfidat dalsi prvek do array, Array.length je nyni 2
array[l] = ,def"“;

//ptidat dalsi prvek do array, Array.length je nyni 3
array[2] = ,ghi"“;

// array[2] je zruSeno, ale Array.length se nezméni,
delete arrayl[2];

Ndsledujici priklad ilustruje chovani delete na odkazech na objekty:

/ /vytvoEit novy objekt a pfipojit proménnou ref 1 pro odkaz na objekt
refl = new Object();

refl.jmeno = ,jody"“;

//kopirovat proménnou odkazu do nové proménné a zru$it ref 1
ref2 = refl;

delete refl;

Jestlize by ref1 nebyla zkopirovdna do re£2, objekt by nebyl zruSen, kdyz jsme
zrusili ref1, protoZe by zde na néj nebyly zadné odkazy. Jestlize bychom zrusili
ref2, nebyly by zde uz Zadné odkazy na objekt a ten by byl zruen a pamét, kterou
vyuzival by byla uvolnéna.

Viz také
var
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do...while

Syntaxe

do {

ptikaz;

}while (podminka) ;

Argumenty

podminka Podminka pro ohodnoceni.

pfikaz Prikaz, ktery se ma vykonat, jakmile je podminka ohodnocena
na true.

Popis

Akce; vykonava pfikazy a potom ohodnocuje podminku ve smycce, dokud neni
podminka pravda.

Pfehravac
Flash 4 nebo noveéjsi.

Viz také
break
continue

_droptarget

Syntaxe
tazitelnalnstanceJméno._droptarget

Argument

tazitelnalnstanceJméno Jméno movie klip instance, kterd byla cilem akce
startDrag.

Popis

Vlastnost (pouze pro ¢teni); udava absolutni cestu ve slash (zavorkové) syntaxi
movie klip instance, na kterou byla pusténa tazitelnalnstancedJméno. Viastnost
_droptarget vZdy udava cestu, kterd zacina /. Pro porovnani vlastnosti instance
_droptarget s odkazem poufZijte eval, pro konverzi obdrZzené hodnoty z flash
syntaxe na odkaz.

Pfehravac¢
Flash 4 nebo novejsi.
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Priklad

Nasledujici pfiklad ohodnocuje vlastnost _droptarget movie klip instance smeti
a pouziva eval pro jeji konverzi ze slash syntaxe na odkaz v dot (teckové) syntaxi.
Odkaz smeti je potom porovnavan s odkazem na movie klip instanci odpadky.
Jestlize jsou dva odkazy ekvivalentni, viditelnost smeti je nastavena na false.
Jestlize nejsou ekvivalentni, instance smeti je resetovdna na svoji pivodni pozici.

if (eval (smeti._droptarget) == _root.odpadky) {
smeti. visible = false;

lelse{
smeti. x = x_poz;
smeti. y = y_poz;

}

Proménné x_poz a y_poz jsou nastaveny na snimku 1 movie, s nasledujicim
skriptem:

x_poz = smeti._ x;

y_poz = smeti._y;

Viz takeé
startDrag

duplicateMovieClip

Syntaxe
duplicateMovieClip(cil, novéjméno, hloubka);

Argumenty

target

(cil) Cilova cesta movie klipu, ktery se ma duplikovat.
newname

novéjmeno) Unikatni identifikator pro duplikovany movie klip.

depth (hloubka) Uroven hloubky movie klipu. Uroveni hloubky je poradi navrzeni,
které urCuje, jak se movie klipy a dalsi objekty objevi, pokud
se prekryvaji. Prvni movie klip, ktery vytvofite nebo instance,
kterou tahnete na Scénu, je pfipojen na hloubku urovné 0. Kazdy
nasledny nebo duplikovany movie klip musite pripojit k rlizné
urovni, abyste zabranili nahrazovani movies na obsazenych
urovnich nebo plvodniho movie klipu.

Popis

Akce; vytvari instanci movie klipu, zatimco movie hraje. Duplikované movie klipy
vZdy zacinaji na snimku 1 a nezalezi na tom, na kterém snimku byl plivodni movie
klip. Proménné v rodi¢ovském movie klipu nejsou kopirovany do duplikovaného
movie klipu. Jestlize je rodic¢ovsky movie klip zrusen, duplikovany movie klip je také
zruSen. Pouzijte akci removeMovieClip, nebo metodu, pro zruseni movie klip
instance vytvorené pomoci duplicateMovieClip.

Pfehravacé
Flash 4 nebo noveéjsi.

Priklad
Tento pfikaz duplikuje movie klip instanci kvetina desetkrat. Proménnd i je pouzita
pro vytvoreni nového jména instance a hloubku.
on(release) {
mnozstvi = 10;
while (mnozstvi>0) {
duplicateMovieClip (_root.kvetina, “mc“+i, 1i);
setProperty (,mc“+i, _x,random(275)) ;
setProperty (,mc“+i, _y, random (275));
setProperty (,mc“+i, _alpha, random (275));
setProperty (,mc“+i, _xscale, random (50));
setProperty (,mc“+i, _yscale, random (50));
i=1i+1;

mnozstvi = mnozstvi - 1;
}
}
Viz take
removeMovieClip

MovieClip.removeMovieClip
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else

Syntaxe
else { pfikaz(y) };

Argumenty

pfikaz(y) Alternativni série prikazQ, které maji bézet, jestlize je podminka
specifikovana v pfikazu i£, false.

Popis

Akce; specifikuje akce, véty, argumenty nebo jiné podminky, které maji bézet, jestlize
je pavodni prikaz if, false.

Pfehravac¢

Flash 4 nebo nové;si.
Viz také

if

eq (equal-string specific)

Syntaxe
vyrazl eq vyraz2

Argumenty
vyrazi,vyraz2 Cisla, fetézce nebo proménné.

Popis
Srovnavaci operator; porovndva dva vyrazy, zda jsou si rovny a udava true, jestlize
je vyraz1 roven vyrazu2; jinak uddva false.

Pfehravacé
Flash 1 nebo novéjsi. Tento operator byl zavrzen ve Flash5; je doporu¢eno
pouzivat novy operator rovnosti ==.

Viz také
== (equality)
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escape

Syntaxe

escape(vyraz);

Argumenty

vyraz Vyraz, ktery se ma konvertovat na fetézec a zakddovat
do URL-kédovaciho formatu.

Popis

Funkce; konvertuje argument na fetézec a kdduje ho v URL-kédovacim formatu,
kde jsou vSechny alfanumerické znaky nahrazeny s $ hexadecimalnimi sekvencemi.

Pfehravac
Flash 5 nebo noveéjsi.

Priklad
escape (,Hello{ [World]}"“) ;

Vysledek vyse uvedeného kddu je nasleduijici:
Hello%$7B%$5BWorld%5D%7D

Viz také
unescape
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eval

Syntaxe

eval(vyraz);

Argumenty

vyraz Retézec obsahujici jméno proménné, vlastnosti, objektu nebo
movie klipu, ktery se ma ziskat.

Popis

Funkce; dosahuje proménnych, vlastnosti, objektd nebo movie klipl jménem.
Jestlize je vyraz proménna nebo vlastnost, je ziskdna hodnota proménné nebo
vlastnosti. Jestlize je vyraz objekt nebo movie klip, je ziskan odkaz na objekt nebo
movie klip. Jestlize nemuze byt prvek pojmenovany ve vyrazu nalezen, je ziskano
nedefinovano.

Ve Flash 4 byla funkce eval pouzivana pro simulaci poli. Ve Flash 5 je doporu¢ovano
pouzivat objekt Array, pro vytvoreni poli.

Poznamka: ActionScript akce eval neni stejna jako JavaScript funkce eval a nemdize byt
pouzivana pro ohodnoceni pfikazd.

Pfehravac¢

Flash 5 nebo noveéjsi pro plnou funkénost. Kdyz exportujete do Flash 4 Prehravace
mUzZete pouzit eval, ale musite pouzit slash znacky a mlzete dosahnout pouze
proménnych ne vlastnosti nebo objektd.

Priklad

Nasledujici pfiklad pouzivd eval pro uréeni hodnoty proménné x a nastavuje
ji na hodnotu y:

x = 3;

Yy

eval (,x“);

Nasledujici priklad pouziva eval pro odkaz na movie klip objekt spojeny s movie klip
instanci Mic na Scéné:
eval(,_root.Mic");

Viz také
Array (object)
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evaluate

Syntaxe
ptikaz;

Argumenty
Z4dné.

Popis

Akce; vytvari novy prazdny fadek a vklada; pro vlozeni unikatnich scénarovych
zprav pomoci pouziti pole Vyraz v panelu Akce. Pfikaz evaluate také umoznuje
uzivatelCim, ktefi skriptuji ve Flash 5 Normalnim Rezimu panelu Akce volat funkce.

Pfehravac
Flash 5 nebo novéjsi.

_focusrect

Syntaxe
_focusrect = Booleovska ;

Argumenty
Booleovska true nebo false.

Popis

Vlastnost (vSeobecna); urCuje, zda se objevi zluty obdélnik okolo tlacitka, které
ma aktualni stfed. Nastavena hodnota true (nenula) zobrazi Zluty obdélnik okolo
aktudlné zaméreného tlacitka nebo textového pole, kdyz uzivatel stiskne klavesu
Tab pro navigaci. Specifikujte, aby se zobrazilo £alse pouze pfi stavu tlacitka ,,over*
(jestlize je néjaky definovan), kdyz uzivatelé naviguiji.

Pfehravac¢
Flash 4 nebo novejsi.
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for

Syntaxe

for (init;condition;next) ;{

ptikaz;

}

Argumenty

init Vyraz, ktery se ma ohodnotit dfive, nez zacne smyckova sekvence,
typicky urcuijici vyraz. Pfikaz var je také povolen pro tento argument.

condition

(podminka) Vyraz, ktery se ohodnocuje na true nebo false. Podminka je
ohodnocena pred kazdym opakovanim smycky; smycka existuije,
kdyz je podminka ohodnocena na false.

next (dalsi) Vyraz, ktery se ma ohodnotit po kazdém opakovani smycky; obvykle
uréujici vyraz pouzivajici operatory ++(zvySeni) nebo --(snizeni).

pfikaz Prikaz uvnitf téla smycky, ktery se ma vykonat.

Popis

Akce; smyckova konstrukce, kterd ohodnocuje jednou vyraz init a potom zacina
smyckova sekvence, kterou se, pokud se podminka ohodnoti na true, vykona
pfikaz a je ohodnocen dalsi vyraz.

Neékteré vlastnosti nemohou byt vyjmenovany akcemi for nebo for. . . in. Napfiklad
metody objektu Array (Array.sort a Array.reverse) nejsou zahrnuty ve
vyjmenovanich objektu Array a movie klip vlastnosti, jako _x a _y, nejsou
vyjmenovany.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici priklad pouziva £or pro pfidani prvkld do pole:
for (i=0; i<10; i++){

pole[i] = (i+5)*10;

}

Vysledkem je nasledujici pole:
[50,60,70,80,90,100,110,120,130,140]

Nasledujici je pfikladem pouziti £or pro vykonani stejné akce opakované.

V kddu dole smycka for pfidava ¢isla od 1 do 100:
var sum = 0;
for (var i=1; i<=100; i++){
sum = sum + i;

}

Viz také
++
for..in
var

for...in
Syntaxe
for (proménnaopakovani in objektu) {
ptikaz;

}

Argumenty
proménndopakovani

Jméno proménné, které ma vystupovat jako opakovana,

odkazuijici na kazdou vlastnost objektu nebo prvku v poli.

objekt Jméno objektu, na kterém ma byt opakovano.

pfikaz Prikaz, ktery se ma vykonat pro kazdé opakovani.

Popis

Akce; smyckuje skrz vlastnosti objektu nebo prvku v poli a vykonava prikaz pro

kazdou vlastnost objektu.

Nékteré vlastnosti nemohou byt vyjmenovany akcemi for nebo for. . .in.

Napfiklad zabudované metody objektu Array (Array.sort a Array.reverse)
nejsou zahrnuty ve vyjmenovani objektu Array a movie klip vlastnosti jako _xa_x

nejsou vyjmenovany.

Konstrukce for. . .in se opakuje na vlastnostech objektd v opakovaném fetézu
prototypu objektu. Jestlize je détsky prototyp rodi¢, opakovani na vlastnostech

ditéte s for. . .in se bude také opakovat na viastnostech rodice.
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Pfehravac
Flash 5 nebo novéjsi.

Priklad
Nasleduijici je pfikladem pouziti £or. . . in pro opakovani na vlastnostech objektu:
mujObject= {jmeno: Tara’,vek:27,mesto:San Francisco’};
for (jmeno in mujObject) {
trace (,mujObject. “+jmeno+"“=,+mujObject [jmeno]) ;

Vystup tohoto pfikladu je nasledujici:
mujObject. jmeno=Tara
mujObject.vek=27
mujObject.mesto=San Francisco
Nasledujici je pfikladem pouziti operatoru typeof s for..in pro opakovani na
konkrétnim typu ditéte:
for (jmeno in mujMovieKlip) {
if (typeof (mujMovieKlip [jmeno]) = ,movieklip"“) {
trace (,Mam movie klip dité pojmenované
,+jméno) ;

}

Nasledujici pfiklad vyjmenovava déti movie klipu a posila kazdé do snimku 2
v jejich pfislusnych Casovych osach. Movie klip RadioTlacitkoSkupina je rodic
s nékolika détmi, _CerveneRadioTlacitko_, ZeleneRadioTlacitko_
a _ModreRadioTlacitko.

for (var jmeno in RadioTlacitkoSkupina) {
RadioTlacitkoSkupina [jmeno].gotoAndStop(2) ;
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_framesloaded

Syntaxe
instancejméno._framesloaded

Argumenty
instancejméno Jméno movie klip instance, kterd ma byt ohodnocena.

Popis

Vlastnost (pouze pro ¢teni); pocet snimkd, které byly natazeny z tekouciho movie.
Tato vlastnost je uzite€na pro urceni, zda obsahy uréitého snimku, a vSechny
snimky pred nim, byly nataZzeny a jsou mistné dostupné v uzivatelové browseru.
Tato vlastnost je uzite¢na pro monitorovani procesu stahovani rozsahlych animaci.
Napriklad mdzete chtit zobrazit zpravu pro uZivatele, ktera indikuje natahovani
movie, dokud urcity snimek v animaci nedokoncil natahovani.

Pfehravac¢
Flash 4 nebo novejsi.

Priklad

Nasleduijici je prikladem pouZiti viastnosti _framesloaded pro koordinaci zaC&tku
movie s poCtem nataZenych snimkd:

if (_framesloaded >= _totalframes) {

gotoAndPlay (,Scene 1,“zacatek");

lelse{

setProperty

(,_root.natahovac", _xscale,(_framesloaded/_totalframes)*100);

}
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fscommand

Syntaxe
fscommand (p¥ikaz,argumenty) ;

Argumenty

pfikaz Retézec propustény do hostitelské aplikace pro jakékoliv pouZiti.
argumenty Retézec propustény do hostitelské aplikace pro jakékoliv pouZiti.
Popis

Akce; umoziuje, aby Flash animace komunikovala s programem hosticim
Flash Pfehravac. Ve Web browseru vold f£scommand JavaScript funkci
moviename Dofscommand na HTML stréance obsahujici Flash animaci, kde
moviename je jméno Flash Prehravace, které je ur€eno atributem NAME tagu EMBED
nebo vlastnosti ID tagu OBJECT. Jestlize je Flash Pfehrava¢ uréen jménem Movie,
je voland JavaScript funkce Movie Dofscommand.

Pfehravac
Flash 3 nebo novéjsi.

function

Syntaxe

function funkcejméno ([argumentO,argumentl, ...argumentN]) {
ptikaz(y)

}

function ([argumentO,argumentl, ...argumentN]) {

ptikaz(y)

}

Argumenty
funkcejméno  Jméno nové funkce.

argument Nula nebo vice retézcl, Cisel nebo objektl, které se maiji viozit
do funkce.

pfikazy Nula nebo vice ActionScript zprava, které jste definovali pro télo
funkce.

Popis

Akce; sada prikaz( definovanych pro provedeni uréitych Ukold. MiZete deklarovat
nebo definovat funkci v jedné lokalité a volat nebo vyvolat ji z réiznych skriptd v animaci.
Kdyz definujete funkci, miZete pro ni urcit také argumenty. Argumenty jsou schranky
pro hodnoty, na kterych bude operovat funkce. MlzZete vlozit funkci s rdznymi
argumenty, také zvanymi parametry, pfi kazdém jejim volani.

Aby funkce obdrzela nebo generovala hodnotu, pouzijte ve funkcich pfikaz(y)
akci return.

Pouziti 1: Deklaruje function specifikovanym funkcejméno, argumenty a pfikaz(y).

Kdyz je funkce volana, je vyvolana deklarace funkce. Odkazovani vpred je povoleno;
uvnitr stejného seznamu Akci mdze byt funkce deklarovana poté, co je volana.
Deklarace funkce nahrazuje jakékoliv pfedchozi deklarace stejné funkce. MizZete
pouzit tuto syntaxi, kdekoliv je povolen prikaz.

Pouziti 2: Vytvari anonymni funkci a vraci ji. Tato syntaxe je pouzita ve vyrazech a je zvlasté

uzite€na pro instalovani metod v objektech.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

(Pouziti 1) Nasleduijici priklad definuje funkci sqr, ktera akceptuje jeden argument
a ddva square (x*x) argumentu. VSimnéte si, Ze jestlize je funkce deklarovana
a pouzita ve stejném skriptu, deklarace funkce se mizZe objevit po pouziti funkce.
y = sqr(3);

function sqgr(x) {

return x*x;

}

(Pouziti 2) Nasledujici funkce definuje objekt Circle:
function Circle(radius) {
this.radius = radius;

}

Nasleduijici pfikaz definuje anonymni funkci, kterd pocita rozlohu kruhu a pfipojuje
ho k objektu circle jako metodu:

Circle.prototype.rozloha = function()

{ return Math.PI*this.radius *this.radius }
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ge (greather than or equal to - string specific)

Syntaxe
vyrazl ge vyraz2

Argumenty
vyrazi,vyraz2 Cisla, fetézce nebo proménné.

Popis

Operator (srovnani); porovndva vyrazi s vyrazem2 a uddva true, jestlize je vyrazi

vétsi nez nebo roven vyrazu2; jinak uddva false.

Prehravac

Flash 4 nebo novegjsi. Tento operator byl zavrzen ve Flash 5; je doporu¢ovano

pouzivat novy operator >=.

Viz take
>= (greater than or equal to)

getProperty

Syntaxe
getProperty (instancejméno,vlastnost) ;

Argumenty
instancejméno Jméno instance movie klipu, pro ktery je vlastnost ziskavana.

vlastnost Vlastnost movie klipu, jako ja x nebo y osa.

Popis
Funkce; udava hodnotu specifikované vlastnosti pro movie klip instanci.

Pfehravac¢
Flash 4 nebo nové;si.

Priklad
Nasleduijici pfiklad ziskéava horizontdlni osu ( _x ) pro movie klip mojeMovie:
getProperty (_root.mojeMovie_polozka._ x);
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getTimer
Syntaxe
getTimer() ;

Argumenty
Z4dné.
Popis

Funkce; udava pocet milisekund, které uplynuly od doby, kdy za¢alo movie hrat.

Pfehravac¢
Flash 4 nebo novejsi.

getURL
Syntaxe
getURL (url [, okno [, proménné ]]);

Argumenty

url URL, ze kterého se ma ziskat dokument. URL musi byt ve stejné
subdoméng, jako URL, kde je movie aktudlné umisténo.

window

(okno) Volitelny argument specifikujici okno nebo HTML ram, na ktery

by mél byt dokument natazen. Vlozte jméno urcitého okna nebo
zvolte z nasledujicich rezervovanych jmen cil(:

_self urCuje aktudlni rdm v aktualnim okné.
_blank ur¢uje nové okno.

_parent urCuje rodi¢e aktualniho ramu.
_top urCuje nejvyssi rdm v aktudlnim okné.

proménné Volitelny argument urcujici metodu posilani proménnych. Jestlize
zde nejsou zadné proménné, tento argument vynechte; jinak
specifikujte, zda natahnout proménné pouzitim metody GET
nebo POST. GET pfipoji proménné na konec URL a je pouZzit pro
mala mnozstvi proménnych. POST posila proménné v oddéleném
HTTP a je pouzit pro dlouhé fetézce proménnych.
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Popis

Akce; natahuje dokument z urcitého URL do okna nebo vklada proménné do dalsi
aplikace na definovaném URL. Pro testovani této akce se ujistéte, ze soubory,
které maji byt natazeny, jsou v uréeném umisténi. Pro pouziti absolutniho URL
(napriklad http://www.mujserver.com) potiebujete sitové spojeni.

Pfehravac¢
Flash 2 nebo novejsi. Volby GET a POST jsou dostupné pouze pro Flash 4 a pozdéjsi
verze Prehravace.

Priklad
Tento priklad natahuje nové URL do prazdného okna browseru. Akce getURL ciluje
proménnou prijemAd jako parametr url, takZze miZete zménit natazenou URL bez
editace Flash movie. Hodnota proménné prijemAd je propusténa do Flash dfive
v movie pouzivajici akci loadVariables.
on (release) {

getURL (prijemAd, “_blank");
}

Viz také
loadVariables
XML . send

XML . sendAndLoad
XMLSocket. send

getVersion

Syntaxe
getVersion() ;

Argumenty
Z4dné.

Popis

Funkce; udava fetézec obsahujici verzi Flash Prehravace a informaci o platformé.
Tato funkce nefunguje v rezimu test-movie a udava informaci pouze pro verzi 5
nebo dale Flash Prehravace.
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Priklad
Nasleduijici je prikladem retézce ziskaného funkci getVersion:
WIN 5,0,17,0

Toto indikuje, ze platformou je Windows a Cislo verze Flash Prehravace je hlavni
verze 5, mensi verze 17(5.0r17).

Pfehravac
Flash 5 nebo noveéjsi.

gotoAndPlay

Syntaxe
gotoAndPlay (scéna,snimek) ;

Argumenty

scéna Jméno scény, na kterou je poslana hraci hlava.
snimek Cislo snimku, na ktery je posldna hraci hlava.
Popis

Akce; posild hraci hlavu na urcity snimek ve scéné a hraje od tohoto snimku. Jestlize
neni specifikovana Zadna scéna, hraci hlava jde na urcity snimek v aktudlni scéné.

Pfehravac
Flash 2 nebo noveéjsi.

Priklad
Kdyz uzivatel klikne na tlacitko, ke kterému je pfipojena funkce gotoAndPlay, je hraci
hlava poslana na snimek 16 a zacne hrat.

on (release) {
gotoAndPlay (16) ;
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gotoAndStop

Syntaxe
gotoAndStop(scéna,snimek);

Argumenty

scéna Jméno scény, na kterou je poslana hraci hlava.
snimek Cislo snimku, na ktery je posldna hraci hlava.
Popis

Akce; posild hraci hlavu na specifikovany snimek na scéné a zastavuje ji. Jestlize
neni specifikovana zadna scéné, je hraci hlava posldna na snimek v aktualni scéné.

Pfehravac
Flash 2 nebo novéjsi.

Priklad
Kdyz uzivatel klikne na tlacitko, ke kterému je pfipojena akce gotoAndStop, hraci
hlava je poslana na snimek 5 a animace se zastavi.

on (releaset) {
gotoAndStop (5);

gt (greater than - string specific)

Syntaxe
vyraz1 gt vyraz2

Argumenty
vyrazi,vyraz2 Cisla, fetézce nebo proménné.

Popis
Operdtor (srovnani); porovndvd vyraz1 s vyrazem2 a udava true, jestlize je vyraz1
vetsi nez vyraz2; jinak uddva false.

Pfehravac¢
Flash 4 nebo novéjsi. Tento operator byl ve Flash 5 zavrzen; je doporucovano pouzivat
novy operator >.

Viz také
> (greater than)
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_height

Syntaxe
instancejméno._height
instancejméno._height = hodnota;

Argumenty
instancejméno Jméno instance movie klipu, pro ktery ma byt nastavena
nebo ziskana vlastnost _height.

hodnota Celé Cislo urcujici vysku movie klipu v pixelech.

Popis

Vlastnost; nastavuje a ziskdva vySku prostoru okupovaného obsahem movie.
V pfedchozich verzich Flash, byly vlastnosti _height a _width pouze pro ¢teni;
ve Flash 5 mohou byt tyto vlastnosti nastaveny.

Pfehravac
Flash 4 nebo novéjsi.

Priklad
Nasledujici kdd nastavuje vySku a Sitku movie klipu, kdyz uzivatel klikne na mys:
onClipEvent (mouseDown) {

_width=200;

_height=200;
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_highquality

Syntaxe
_highquality = hodnota ;

Argumenty

hodnota Urovné anti-aliasingu (vyrovnani) aplikovana na animaci. Specifikuj
2 (Best) pro aplikaci vysoke kvality se vzdy hladkymi bitmapami.
Specifikuj 1 (High quality) pro aplikaci anti-aliasing; toto uhladi
bitmapy, pokud animace neobsahuije jejich animaci. Specifikuj 0
(low quality) pro zabranéni anti-aliasingu.

Popis

Vlastnost (vSeobecna); specifikuje uroveri anti-aliasingu aplikovanou na aktualni animaci.

Pfehravac¢
Flash 4 nebo nové;si.

Viz také

_quality

toggleHighQuality

Syntaxe

if (podminka) {

ptikaz;

}

Argumenty

podminka Vyraz, ktery se ohodnocuje na true nebo false. Napfiklad
if (name == ,Erica"“) ohodnoti proménnou name, zda je ,Erica“.

pfikaz Instrukce pro vykonani i £, nebo kdyz se podminka ohodnoti
na true.

Popis

Akce; ohodnocuje podminku pro urceni dalsi akce v animaci. Jestlize je podminka
true, Flash vykonava pfikazy, které nasleduji. Pouzijte 1 £ pro vytvoreni logickych
vétvi ve vasich skriptech.

Pfehravac¢
Flash 4 nebo novejsi.

Viz také
else
for
for..in

ifFramelLoaded

Syntaxe
ifFrameLoaded (scéna,snimek) {
ptikaz;

}

ifFrameLoaded (snimek) {
ptikaz;

}

Argumenty
scéna Scéna, na kterou se ptame.

shimek Cislo snimku nebo popis snimku, ktery se ma natahnout pred
vykonanim dalsiho pfikazu.

Popis

Akce; kontroluje, zda jsou mistné dostupné obsahy ur&itého snimku. Pouzijte
ifFrameLoaded pro zacatek hrani jednoduché animace, zatimco se do mistniho
politaCe natahuje zbytek movie. Rozdil mezi pouZitim _framesloaded
a ifFrameLoaded je ten, Ze _framesloaded vdm umoZzriuje pfidat piikaz if
nebo else, zatimco akce ifFrameLoaded vam umozriuje urit pocet snimkd
v jednom jednoduchém pfikazu.

Pfehravac¢
Flash 3 nebo novéjsi. Akce ifFrameLoaded je ve Flash 5 zavrzena; je doporu¢ovano
pouZivat akci _framesloaded.

Viz také
_framesloaded
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#include

Syntaxe
#include ,souborjméno.as";

Argumenty
souborjméno.as Jméno souboru, ktery ma byt zahrnut; as je doporu¢ovana
pfipona souboru.

Popis

Akce; zahrnuje obsah souboru uréeného v argumentu, kdyz je animace testovana,
publikovana nebo exportovana. Akce #include je volana, kdyz testujete, publikujete
nebo exportujete. Akce #include je kontrolovana, kdyz se objevi kontrola syntaxe.

Prehravac
N/A

Infinity

Syntaxe
Infinity

Argumenty
Z4dné.

Popis
NejvySsi proménnd; pfeddefinovana proménna s ECMA-262 hodnotou
pro nekonec€nost.

Pfehravac
Flash 5 nebo novéjsi.
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Syntaxe
int (hodnota) ;

Argumenty
hodnota Cislo, které ma byt zaokrouhleno na celé &islo.

Popis
Funkce; konvertuje decimalni Cisla na nejbliz§i hodnotu celého Cisla.

Pfehravac¢
Flash 4 nebo novéjsi. Tato funkce byla ve Flash 5 zavrzena; je doporu¢ovano pouzivat
metodu Math. floor.

Viz také
Math. floor

isFinite

Syntaxe
isFinite (vyraz) ;

Argumenty
vyraz Booleovska, proménna nebo jiny vyraz, ktery ma byt ohodnocen.

Popis
Nejvyssi funkce; ohodnocuje argument a udava true, jestlize je Cislo konecné,
a false, jestlize je nekoneCné nebo negativné nekonecné. Pritomnost nekonecného
nebo negativné nekonecného indikuje podminka matematické chyby, jako je déleni
nulou.

Pfehravac
Flash 5 nebo novéjsi.

Priklad
Nasledujici jsou priklady obdrzeni hodnot pro isFinite:
isFinite (56) dava true

isFinite (Number.POSITIVE_INFINITY) udad false

isNaN (Number.POSITIVE INFINITY) udd false
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isNaN Key (object)

Syntaxe Objekt Key (Klavesa) je objekt nejvyssi irovné, ktery mlzete dosdhnout bez pouZiti konstruktoru.
isNaN (vyraz) ; Pro vytvoreni rozhrani, které mlze byt ovladano uZivatelem standardni klavesnici, pouzijte
metody objektu Key. Vlastnosti objektu Key jsou konstanty reprezentujici kldvesy, které jsou
Argumenty nejbéznéji pouzivany napfiklad pro fizeni her. Viz Dodatek B, ,Klavesy Klavesnice a Hodnoty
vyraz Booleovska, proménna nebo jiny vyraz, ktery ma byt ohodnocen. Kddu Klaves®, kde je kompletni seznam hodnot kldvesovych kdd(.
Popis Priklad
Nejvyssi funkce; ohodnocuje argument a udava true, jestlize hodnota neni Cislo onClipEvent (enterFrame) {
(NaN ), indikuje pfitomnost matematickych chyb. if (Key.isDown (Key.RIGHT)) {
setProperty ("", _x, _x+10);

Pfehravac }
Flash 5 nebo novéjsi. }
Priklad nebo
Nasledujici ilustruje ziskanou hodnotu pro isNaN:
isNaN(,Strom") udd true onClipEvent (enterFrame) {

if (Key.isDown (39)) {
isNaN(56) uda false setProperty("", _x, _x+10);

}
isNaN (Number. POSITIVE_INFINITY) uda false }

Pfehled metod objektu Key

Metoda Popis

getAscii; Udava ASCII hodnotu naposledy stisknuté kldvesy.

getCode; Udava virtuaini kldvesovy kdd naposledy stisknuté kldvesy.

isDown; Uddva true, jestlize je kldvesa uréend v argumentu stisknuta.
isToggled; Uddva true, jestlize je aktivovdna kldvesa Num Lock nebo Caps Lock.
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Pfehled viastnosti objektu Key
VSechny vlastnosti objektu Key jsou konstanty.

Metoda Popis
BACKSPACE Konstanta spojena s hodnotou kddu kldvesy pro klavesu Backspace (9).
CAPSLOCK Konstanta spojend s hodnotou kddu kldvesy pro klavesu Caps Lock (20).
CONTROL Konstanta spojend s hodnotou kddu klavesy pro klavesu Control (17).
DELETEKEY Konstanta spojend s hodnotou kédu klavesy pro kldvesu Delete (46).
DOWN Konstanta spojena s hodnotou kddu klavesy pro klavesu SipkaDoldi (40).
END Konstanta spojena s hodnotou kddu kldvesy pro klavesu End (35).
ENTER Konstanta spojend s hodnotou kddu klavesy pro klavesu Enter (13).
ESCAPE Konstanta spojend s hodnotou kddu kldvesy pro klavesu Escape (27).
HOME Konstanta spojend s hodnotou kddu klavesy pro klavesu Home (36).
INSERT Konstanta spojend s hodnotou kédu klavesy pro klavesu Insert (45).
LEFT Konstanta spojend s hodnotou kédu klévesy pro klavesu SipkaVievo (37).
PGDN Konstanta spojend s hodnotou kédu klavesy pro kldvesu Page Down (34).
PGUP Konstanta spojend s hodnotou kddu klavesy pro klavesu Page Up (33).
RIGHT Konstanta spojena s hodnotou kddu klavesy pro klavesu SipkaVpravo (39).
SHIFT Konstanta spojend s hodnotou kddu klavesy pro klavesu Shift (16).
SPACE Konstanta spojend s hodnotou kddu kldvesy pro klavesu Space (32).
TAB Konstanta spojena s hodnotou kddu kldvesy pro klavesu Tab (9).
UP Konstanta spojend s hodnotou kddu klavesy pro klavesu SipkaNahoru (38).
Key.BACKSPACE
Syntaxe

Key . BACKSPACE

Argumenty
Z4dné.

Popis

Vlastnost; konstanta spojena s hodnotou kddu klavesy pro klavesu Backspace (9).

Prehravac

Flash 5 nebo novéjsi.
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Key.CAPSLOCK
Syntaxe
Key .CAPSLOCK

Argumenty
Z4dné.

Popis

Vlastnost; konstanta spojend s hodnotou kédu klavesy pro klavesu Caps Lock (20).

Prehravac¢
Flash 5 nebo novéjsi.

Key.CONTROL

Syntaxe
Key .CONTROL

Argumenty
Z4dné.

Popis

Vlastnost; konstanta spojena s hodnotou kddu kldvesy pro klavesu Control (17).

Pfehravac¢
Flash 5 nebo novéjsi.

Key. DELETEKEY
Syntaxe
Key .DELETEKEY

Argumenty
Z4dné.

Popis

Vlastnost; konstanta spojena s hodnotou kédu klavesy pro klavesu Delete (46).

Pfehravac¢
Flash 5 nebo novéjsi.
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Key.DOWN Key.ESCAPE

Syntaxe Syntaxe
Key . DOWN Key .ESCAPE
Argumenty Argumenty
Z4dné. Z4dné.
Popis Popis
Vlastnost; konstanta spojend s hodnotou kédu kldvesy pro kldvesu Sipka Dol (40). Vlastnost; konstanta spojena s hodnotou kddu kldvesy pro klavesu Escape (27).
Pfehravac¢ Pfehravac¢
Flash 5 nebo novéjsi. Flash 5 nebo noveéjsi.
Key.END Key.getAscii
Syntaxe Syntaxe
Key .END Key.getAscii() ;
Argumenty Argumenty
Z4dné. Z4dné.
Popis Popis
Vlastnost; konstanta spojend s hodnotou kédu klavesy pro klavesu End (35). Metoda; udava ASCII kdd naposledy stisknuté nebo uvolnéné klavesy.
Pfehravac¢ Pfehravac¢
Flash 5 nebo novéjsi. Flash 5 nebo noveéjsi.
Key.ENTER Key.getCode
Syntaxe Syntaxe
Key .ENTER Key.getCode() ;
Argumenty Argumenty
Z4dné. Z4dné.
Popis Popis
Vlastnost; konstanta spojend s hodnotou klavesy pro klavesu Enter (13). Metoda; udava hodnotu klavesového kddu naposledy stisknuté klavesy. Pouzijte
informaci v Dodatku B, ,Klavesy Klavesnice a Hodnoty Kéd( Klaves*, pro porovnani
Pfehravac¢ udaného kddu klavesy s virtudlni kldvesou na standardni klavesnici.

Flash 5 nebo novéjsi.
Pfehravac
Flash 5 nebo novéjsi.
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Key.HOME Key.isDown

Syntaxe Syntaxe

Key . HOME Key.isDown (kédklavesy) ;

Argumenty Argumenty

Z&dné. koédklavesy Hodnota kddu klavesy spojena s urcitou klavesou, nebo vlastnost
objektu Key spojena s urcitou klavesou. V Dodatku B, ,Kldvesy

Popis Klavesnice a Hodnoty Kodd Klaves®, jsou zapsany vSechny kédy

Vlastnost; konstanta spojend s hodnotou kédu klavesy pro klavesu Home (36). klaves spojené s kldvesami na standardni klavesnici.

Pfehravac¢ Popis

Flash 5 nebo nové;si. Metoda; udava true, jestlize je kldvesa uréena v kddklavesy stisknutd. Na Macintosh

jsou hodnoty kddu kldves pro Caps Lock a Num Lock identické.

Key.INSERT Pfehravaé
Syntaxe Flash 5 nebo novéjsi.
Key . INSERT
Argumenty Key.isToggled
Z&dné. Syntaxe
Key.isToggled(kddklavesy)
Popis
Vlastnost; konstanta spojena s hodnotou kddu klavesy pro klavesu Insert (45). Argumenty
kédklavesy Kdéd klavesy pro Caps Lock (20) nebo Num Lock (144).
Pfehravac
Flash 5 nebo novéjsi. Popis
Metoda; uddva true, jestlize je aktivovana (spusténa) kldvesa Caps Lock nebo
Num Lock.

Na Macintosh jsou hodnoty kddU klaves pro tyto kldvesy identické.

Pfehravac
Flash 5 nebo noveéjsi.
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Key.LEFT Key.RIGHT

Syntaxe Syntaxe
Key.LEFT Key .RIGHT
Argumenty Argumenty
Z4dné. Z4dné.
Popis Popis
Vlastnost; konstanta spojena s hodnotou kédu kldvesy pro kldvesu Sipka Vievo (37). Vlastnost; konstanta spojena s hodnotou kddu klavesy pro kldvesu Sipka Vpravo (39).
Pfehravac¢ Pfehravac¢
Flash 5 nebo novéjsi. Flash 5 nebo novéjsi.
Key.PGDN Key.SHIFT
Syntaxe Syntaxe
Key . PGDN Key.SHIFT
Argumenty Argumenty
Z4dné. Z4dné.
Popis Popis
Vlastnost; konstanta spojena s hodnotou kddu klavesy pro kldvesu Page Down (34). Vlastnost; konstanta spojena s hodnotou kddu klavesy pro klavesu Shift (16).
Pfehravac¢ Pfehravac¢
Flash 5 nebo novéjsi. Flash 5 nebo novéjsi.
Key.PGUP Key.SPACE
Syntaxe Syntaxe
Key.PGUP Key.SPACE
Argumenty Argumenty
Z4dné. Z4dné.
Popis Popis
Vlastnost; konstanta spojena s hodnotou kédu kldvesy pro klavesu Page Up (33). Vlastnost; konstanta spojena s hodnotou kddu klavesy pro klavesu Space (32).
Pfehravac¢ Pfehravac¢
Flash 5 nebo novéjsi. Flash 5 nebo novéjsi.
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Key.TAB

Syntaxe
Key.TAB

Argumenty
Z4dné.
Popis

Vlastnost; konstanta spojend s hodnotou kddu klavesy pro klavesu Tab (9).

Pfehravac
Flash 5 nebo novéjsi.

Key.UP

Syntaxe
Key.UP

Argumenty
Z4dné.

Popis

Viastnost; konstanta spojend s hodnotou kédu kldvesy pro kldvesu Sipka Nahoru (38).

Pfehravac
Flash 5 nebo novéjsi.

le (less than or equal to - string specific)

Syntaxe
vyrazl le vyraz2

Argumenty
vyrazi,vyraz2 Cisla, fetézce nebo proménné.

Popis
Operator (srovnani); porovnava vyrazi a vyraz2 a udava true, jestlize je vyrazi
mensi nez nebo roven vyrazu2; jinak uddvd false.

ACTION SCRIPT - FLASH 5

Pfehravac¢
Flash 4 nebo novéjsi. Tento operator byl ve Flash 5 zavrzen; je doporuc¢eno pouzivat
novy operator <=.

Viz také
<= (less than or equal to)

length

Syntaxe
length(vyraz);
length(proménna);

Argumenty
vyraz Jakykoliv fetézec.

proménna Jméno proménné.

Popis
Retézcova funkce; udava délku uréeného fetézce nebo jméno promeénné.

Pfehravac

Flash 4 nebo nové;si. Tato funkce, spolu se vSemi fetézcovymi funkcemi, byla ve Flash 5
zavrzena. Je doporuceno pouzivat metody a vlastnost length objektu String
(Retézec), pro provedeni stejnych operaci.

Priklad
Nasledujici pfiklad udava hodnotu fetézce Ahoj:
length (,Ahoj") ;

Vysledek je 4.
Viz také

“W“ (String delimiter)
String.length
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_level

loadMovie
Syntaxe Syntaxe
_level N; loadMovie (url [, umisténi/cil, proménnél]) ;
Argumenty Argumenty
N Nezaporné celé Cislo urCujici iroveri hloubky. V zékladnim nastaveni url Absolutni nebo relativni URL pro SWF soubor, ktery se ma natdhnout.

je _level nastavena na 0, movie je v zékladu hierarchie.

Popis
Vlastnost; odkaz na korenovou Casovou osu animace levelN. Animaci musite
natahnout pomoci akce loadMovie dfive, nez ji cilujete pouZitim viastnosti _level.

Ve Flash Prehrdvaci jsou animace urceny Cisly podle poradi, v jakém byly natazeny.

Animace, ktera byla natazena prvni, je natazena na nejnizsi Uroven, uroven 0. cil
Animace v Urovni 0 nastavuje miru snimku, barvu pozadi a velikost snimku pro

vS§echny nasledné natazené animace. Ty jsou potom vr§eny do vyssich urovni nad

animaci v trovni 0. Uroveri, ve které je animace umisténa, je nazyvéna také droven

hloubky nebo hloubka (depth).

Pfehravac¢
Flash 4 nebo nové;si.

Priklad
Nasledujici pfiklad zastavuje Casovou osu animace v urovni 0:
_levelO.stop();

Nasledujici pfiklad posila Casovou osu animace v trovni 4 na snimek 5. Animace
v Urovni 4 musi byt pfedtim natazena akci loadMovie:
_leveld.gotoAndStop(5) ; proménné

Viz také
loadMovie
MovieClip.swapDepths
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Relativni cesta musi byt relativni k SWF. URL musi byt ve stejné
subdoméné jako URL, kde animace aktualné umisténa. Pro pouziti
ve Flash Prehravaci, nebo pro testovani v rezimu test-movie
v autorském prostredi Flash, musi byt vSechny SWF soubory
uloZeny ve stejné sloZce a jména souborl nemohou zahrnovat
specifikace slozky nebo disku.

Volitelny argument urcuijici cilovy movie klip, ktery bude nahrazen
natazenou animaci. Natazena animace zdédi vlastnosti pozice,
rotace a velikost cilového movie klipu. Uréeni do cile je stejné jako
uréeni do umisténi (Uroven); neméli byste pouZivat oba zplsoby.

Volitelny argument urcuijici Uroven, do které je animace natazena.
Natazené animace zdédi vlastnosti pozice, rotace a velikost
cilového movie klipu. Pro nataZzeni nové animace k jiz existujicim
animacim ur&ete Uroven, ktera neni obsazena jinou animaci.
Pro nahrazeni existujici animace natazenou animace urcete Uroven,
kterd je aktualné obsazena jinou animaci. Pro nahrazeni plvodniho
animace a stazeni vSech urovni, natdhnéte novou animaci do
urovné 0. Animace v Urovni 0 nastavuje méfitko ramecku, barvu
pozadi a velikost ramecku pro vSechny dalSi natazené animace.

Volitelny argument uréujici zptsob pro posilani proménnych
spojenych s animaci, ktera ma byt natazena. Argument musi byt
fetézec ,GET" nebo ,POST". Jestlize zde nejsou Zadné proménné,
tento argument vynechte; jinak urCete, zda natdhnout proménné
pouZitim zplsobu GET nebo POST. GET prirfadi proménné na
konec URL a je pouzivan pro maly poc¢et promeénnych. POST posle
proménné v oddéleném HTTP a je pouzivan pro dlouhé fetézce
proménnych.
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Popis

Akce; prehrava externi animace bez zavirani Flash Prfehravace. Normalné Flash
Prehravac zobrazi jednu animaci (SWF soubor) a potom se zavie. Akce loadMovie
vas necha zobrazit nékolik animaci najednou, nebo mezi nimi pfepinat bez natahovani
dalsiho HTML dokumentu.

Mdzete také natahnout animace do Urovné, ktera jiz ma natazené SWF soubory.
Jestlize to udélate, nova animace nahradi existujici SWF soubor. Jestlize natahnete
novou animace do Urovné 0, kazda droveri je stazena a Uroveri 0 je nahrazena novym
souborem. PouZzijte akci loadvariables pro udrzeni aktivity animace a aktualizujte
proménné novymi hodnotami.

Pro odstranéni animaci natazenych akci loadMovie pouzijte akci unloadMovie.

Pfehravac
Flash 3 nebo novéjsi.

Priklad
Tento prikaz 1oadMovie, je pfipojen k naviga¢nimu tlacitku oznaGenému Produkty.
Na Scéné je neviditelny movie klip s instanci jménem pustitZona. Akce loadMovie
pouziva tento movie klip jako cilovy parametr pro natazeni produktd v SWF souboru
do spravného umisténi na Scéné:
on (release) {

loadMovie (,produkty.swf™, _root.pustitZona);

}

Viz také
unloadMovie
_level
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loadVariables

Syntaxe
loadVariables(url, umisténi [, proménné]);

Argumenty
url Absolutni nebo relativni URL, kde jsou umistény proménné.
Hostitelem pro URL musi byt stejnd subdoména jako pro animaci.

umisténi Urover nebo cil pro ziskdni proménnych. Ve Flash Pehrdvadi
jsou animace oznaceny Cislem, které se vztahuje k poradi v jakém
byly natazeny. Prvni animace se natahuje do spodni Urovné
(level 0). Uvnitf akce loadMovie musite ur€it ¢islo Urovné
pro kazdou naslednou animaci. Tento argument je volitelny.

proménné Volitelny argument urcujici zplsob pro posilani proménnych.
Jestlize zde nejsou zadné proménné, tento argument vynechte;
jinak urcete, zda natahnout proménné pomoci pouZiti zpUsobu
GET nebo POST. GET pfipoji proménné na konec URL a je
pouzivan pro malé mnozstvi proménnych. POST posila proménné
v oddéleném HTTP a je pouzivan pro dlouhé fetézce proménnych.

Popis

Akce; Cte data z externiho souboru, jako je textovy soubor nebo text generovany
CGl skriptem, Active Server Pages (ASP) nebo Personal Home Page (PHP)
a nastavuje hodnoty proménnych v animaci nebo movie klipu. Tato akce m(ize byt
také pouzita pro updatovani proménnych v aktivni animaci novymi hodnotami.

Text ve specifikované URL musi byt ve standardnim MIME formatu
application/x-www-urlformencoded (standardni format pouzivany CGI skripty).
Animace a promenné, které maji byt natazeny musi sidlit ve stejné subdomeéné.
Mdze byt uréen jakykoliv pocet proménnych. Napriklad véta dole definuje nékolik
proménnych:
spolecnost=Macromedia&adresa=600+Mestoposlat&mesto=
San+Francisco&zip=94

103

Pfehravac
Flash 4 nebo noveéjsi.

KAPITOLA 7-3 262



Priklad
Tento pfiklad natahuje informaci z textového souboru do textového pole v hlavni
Casové ose (level 0). Jména proménnych textového pole musi souhlasit se jmény
proménnych v souboru data.txt.
on (release) {

loadvVariables(,data. txt“, 0);

Viz takeé

getURL
MovieClip.loadMovie
MovieClip.loadVariables

It (less than - string specific)
Syntaxe
vyrazl 1t vyraz2

Argumenty
vyrazi,vyraz2 Cisla, fetézce nebo proménné.

Popis
Operator (srovndni); porovnava vyraz1 s vyrazem2 a uddva true, jestlize je vyrazi
mensi nez vyraz2; jinak udava false.

Pfehravac
Flash 4 nebo novéjsi. Tento operator byl ve Flash 5 zavrzen; doporucuje se pouzivat
novy operator < (less than).

Viz také
< (less than)

Math (object)
Objekt Math je objekt nejvyssi irovné, kterého mizete dosahnout bez pouZiti konstruktoru.

Metody a vlastnosti tohoto objektu pouzijte pro dosazeni a manipulaci s matematickymi
konstantami a funkcemi. VSechny vlastnosti a metody objektu Math jsou statické a musi byt
volany pouzitim syntaxe Math.metoda(argument) nebo Math.konstanta. V
ActionScriptu jsou konstanty definovany s maximalni preciznosti dvoijité pfesnosti IEEE-754
plynoucich Cisel.
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Objekt Math je plné podporovan ve Flash 5 Prehravadi. Ve Flash 4 Prehravaci, metody
objektu Math funguiji, ale jsou napodobeny pouZitim odhadd a nemohou byt presné jako
nenapodobené funkce podporované Flash 5 Pfehravacem.

Nékteré metody objektu Math maji argument radidn Uhlu. MiZete pouzit citaci dole pro
kalkulaci hodnot radian( nebo jednoduse zadat rovnici (vloZeni hodnoty pro stupné) pro
argument radian.

Pro kalkulaci hodnoty radidnu pouzijte tento vzorec:
radian=Math.PI/180*stupné

Nasledujici je pfikladem propusténi vzorce jako argumentu pro vypocet sinu uhlu 45
stupnd:

Math.SIN(Math.PI/180*45) je stejné jako Math.SIN(.7854)

Pfehled metod objektu Math

Metoda Popis

abs Vypoéitd absolutni hodnotu.

acos Vypocdita arc cosinus.

asin Vypodita arc sinus.

atan Vypocitd arc tangent.

atan2 Vypoéitd uhel z osy x do bodu.

ceil Zaokrouhli ¢islo nahoru na nejblizsi celé Cislo.
cos Vypocdita cosinus.

exp Vypocitd exponencidlni hodnotu.

floor Zaokrouhli &islo dolt na nejblizsi celé &islo.
log Vypocdita prirozeny logaritmus.

max Uddva vétsi ze dvou celych cisel.

min Uddava mensi ze dvou celych &isel.

pow Vypoéitd x zvySené na mocninu y.

random Udava pseudo-nahodné ¢islo mezi 0.0 a 1.0.
round Zaokrouhluje na nejblizsi celé Cislo.

sin Vypoditd sinus.

sqrt Vypoéita Etvercovy kofen (odmocninu).

tan Vypocdita tangent.
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Prehled viastnosti pro objekt Math Math.acos
V8echny vlastnosti pro objekt Math jsou konstanty. Syntaxe

_ Math.acos (x) ;
Metoda Popis
E Eulerova konstanta a zaklad prirozeného logaritmu (pfiblizné 2,718). Argumenty
LN2 Pfirozeny logaritmus dvou (pfiblizné 0,693). X Cislo od -1,0 do 1,0.
LOG2E Z&klad 2 logaritmu e (priblizné 1,442).
LN10 Pfirozeny logaritmus 10 (piblizné 2,302). Popis o o . 5 . y
LOGLOE Zéklad 10 logaritmu e (pfiblizné 0.434). Metoda; vypocitava a udava arc cosinus Cisla urceného v argumentu x, v radianech.
PI Pomér obvodu kruhu k jeho prdméru (pfiblizné 3,14159). Prehravaé
SQRT1_2 Reciproéni kofenu Etverce (odmocnina) 1/2 (pfiblizné 0,707). Flash 5 nebo nov&jéi. Ve Flash 4 Pfehrdvadi jsou metody a vlastnosti objektu Math
SQRT2 Kofen &tverce (odmocnina) 2 (pfiblizné 1,414). simulovany pouzitim odhadd a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Pfehravacem.
Math.abs
Syntaxe Math.asin
Math.abs (x) ; Syntaxe
Math.asin (x) ;
Argumenty
X Jakeékoliv E&islo. Argumenty
X Cislo od -1,0 do 1,0.
Popis
Metoda; vypocitava a udava absolutni hodnotu Cisla uréeného argumentem x. Popis
Metoda; vypocitava a udava arc sinus pro Cislo uréené v argumentu X, v radianech.
Pfehravac
Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math Prehravaé
simulovény pouZitim odhadi a nemusi byt pfesné jako nesimulované matematicke Flash 5 nebo novéjsi. Ve Flash 4 Prehravadi jsou metody a vlastnosti objektu Math
funkce podporované Flash 5 Pfehravacem. simulovény pouzitim odhad(l a nemusi byt presné jako nesimulované matematické

funkce podporované Flash 5 Prehravacem.
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Math.atan

Syntaxe
Math.atan (x) ;

Argumenty
X Jakékoliv Cislo.

Popis
Metoda; vypocitdvd a udava arc tangent pro &islo uréené v argumentu x. Obdrzena
hodnota je mezi zapornym pi délenym 2, a kladnym pi délenym 2.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Prehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Prehravacem.

Math.atan2

Syntaxe
Math.atan2 (y, x);

Argumenty

X Cislo uréujici osu x bodu.
y Cislo uréujici osu y bodu.
Popis

Metoda; vypocitdva a uddva arc tangent y/x v radidnech. ObdrZzena hodnota
reprezentuje Uhel naproti protéjSimu Uhlu pravého trojuhelniku, kde x je délka
prilehlé strany a y je délka protilehlé strany.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Prehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadd a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Prehravacem.
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Math.ceil

Syntaxe
Math.ceil (x) ;

Argumenty
X Cislo nebo vyraz.

Popis
Metoda; udava ceiling (horni limit) uréitého Cisla nebo vyrazu. Limitem pro Cislo je
nejblizsi celé Cislo, které je vétsi nebo rovno Cislu.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Pfehravacem.

Math.cos

Syntaxe
Math.cos (x) ;

Argumenty
Uhel méfeny v radidnech.

Popis

Metoda; udava cosinus (hodnota od -1,0 do 1,0) uUhlu uréeného argumentem x.
Uhel x musi byt uréeny v radidnech. Pro vypodet radidnu pouZijte informaci v tvodu
do objektu Math.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadt a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Prehravacem.
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Math.E

Syntaxe
Math.E

Argumenty
Z4dné.

Popis
Konstanta; matematicka konstanta pro zaklad prirozenych logaritmd, vyjadrena
jako e. Pribliznd hodnota e je 2,71828.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Pfehravacem.

Math.exp

Syntaxe
Math.exp (x) ;

Argumenty
X Exponent; €islo nebo vyraz.

Popis
Metoda; udava hodnotu zakladu pfirozeného logaritmu (e) umocnéného exponentem
uréenym argumentem x. Konstanta Math.E mdze poskytnout hodnotu e.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadd a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Prehravacem.

Math.floor

Syntaxe
Math.£floor (x) ;

Argumenty
X Cislo nebo vyraz.

Popis
Metoda; udédva dno &isla nebo vyrazu uréeného v argumentu x. Dno je nejblizsi
celé Cislo mensi nebo rovno ur€enému Eislu nebo vyrazu.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Pfehravacem.

Priklad
Nasledujici uddva hodnotu 12:
Math.floor(12,5);

Math.log

Syntaxe
Math.log (x) ;

Argumenty
X Cislo nebo vyraz s hodnotou vy$&i nez 0.

Popis
Metoda; udava prirozeny logaritmus argumentu x.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Pfehravacem.
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Math.LOG2E

Syntaxe
Math . LOG2E

Argumenty
Z4dné.

Popis
Konstanta; matematicka konstanta pro zaklad-2 logaritmu konstanty e (Math.E),
vyjadfend jako log e 2, s pfibliznou hodnotou 1,442695040888963387.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhad( a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Pfehravacem.

Math.LOG10E

Syntaxe
Math.LOG10E

Argumenty
Z4dné.

Popis
Konstanta; matematicka konstanta pro zéklad-10 logaritmu konstanty e (Math.E),
vyjadrena jako log 10 e, s pfibliznou hodnotou 0,43429448190325181667.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Prehravacem.

Math.LN2

Syntaxe
Math . LN2

Argumenty
Z4dné.

Popis
Konstanta; matematicka konstanta pro prirozeny logaritmus 2, vyjadreny jako 1og e 2,
s pfibliznou hodnotou 0,69314718055994528623.

Pfehravac¢

Flash 5 nebo novejsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt pfesné jako nesimulované matematické
funkce podporované Flash 5 Pfehravacem.

Math.LN10

Syntaxe
Math.LN10

Argumenty
Z4dné.

Popis
Konstanta; matematicka konstanta pro pfirozeny logaritmus 10, vyjadrena jako
log e 10, s pfibliznou hodnotou 2,3025850929940459011.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt pfesné jako nesimulované matematické
funkce podporované Flash 5 Prehravacem.
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Math.max

Syntaxe
Math.max (x, y);

Argumenty

X Cislo nebo vyraz.
y Cislo nebo vyraz.
Popis

Metoda; ohodnocuje x a y a uddva vétsi hodnotu.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadd a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Pfehravacem.

Math.min

Syntaxe
Math.min (x, y);

Argumenty

X Cislo nebo vyraz.
y Cislo nebo vyraz.
Popis

Metoda; ohodnocuje x a y a udava mensi hodnotu.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Prehravacem.

Math.PI

Syntaxe
Math.PI

Argumenty
Z4dné.

Popis
Konstanta; matematicka konstanta pro pomér obvodu kruhu k jeho prdimeéru, vyjadrena
jako pi, s hodnotou 3,14159265358979.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt pfesné jako nesimulované matematické
funkce podporované Flash 5 Prehravacem.

Math.pow

Syntaxe
Math.pow (x, y):

Argumenty

X Cislo, které ma byt zvySeno na mocninu.

y Cislo uréujici mocninu, na kterou se ma x zvysit.
Popis

Metoda; vypocitava a uddava x umocnéné y, xy.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadd a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Prehravacem.
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Math.random

Syntaxe
Math.random () ;

Argumenty
Z4dné.

Popis
Metoda; udava pseudo-nahodné ¢islo mezi 0,0 a 1,0.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Pfehravacem.

Viz také
random

Math.round

Syntaxe
Math. round (x) ;

Argumenty
X Jakékoliv &islo.

Popis
Metoda; zaokrouhluje hodnotu argumentu x nahoru nebo doll na nejblizsi celé Cislo
a udava hodnotu.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Prehravacem.

Math.sin

Syntaxe
Math.sin (x) ;

Argumenty
X Uhel méfeny v radidnech.

Popis
Metoda; vypocitava a udava sinus ur€eného uhlu v radianech. Pro vypocet radianu
pouzijte informaci v ivodu do objektu Math.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt presné jako nesimulované matematické
unkce podporované Flash 5 Prehravacem.

Viz také
Math (object)

Math.sqrt

Syntaxe
Math. sqrt (x) ;

Argumenty
X Jakeékoliv &islo nebo vyraz vétsi nez nebo roven 0.

Popis
Metoda; vypocitava a uddava odmocninu urcitého Cisla.

Pfehravacé

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Prehravacem.
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Math.SQRT1_2

Syntaxe
Math.SQRT1_2

Argumenty
Z4dné.

Popis
Konstanta; matematicka konstanta pro reciprocni odmocniny jedné poloviny (1/2),
s pfibliznou hodnotou 0,707106781186.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Pfehravacem.

Math.SQRT2

Syntaxe
Math.SQRT2

Argumenty
Z4dné.

Popis
Konstanta; matematicka konstanta pro odmocninu 2, s pfibliZnou hodnotou
1,414213562373.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhad( a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Prehravacem.

Math.tan

Syntaxe
Math.tan (x) ;

Argumenty
X Uhel méfeny v radidnech.

Popis
Metoda; vypocitava a udava tangent ur¢eného uhlu. Pouzijte informaci z Uvodu do
objektu Math, pro kalkulaci radianu.

Pfehravac¢

Flash 5 nebo novéjsi. Ve Flash 4 Pfehravaci jsou metody a vlastnosti objektu Math
simulovany pouzitim odhadU a nemusi byt presné jako nesimulované matematické
funkce podporované Flash 5 Pfehravacem.

maxscroll

Syntaxe
proménna_jméno.maxscroll = x

Argumenty

proménna_jméno Jméno proménné spojené s textovym polem

X Cislo fadku, je maximalni hodnota moznad pro vlastnost scroll,
zalozena na vysce textového pole. Toto je hodnota pouze pro Cteni,
nastavena Flashem.

Popis

Vlastnost; vlastnost pouze pro &teni, kterd funguje s vlastnosti scrol1l, pro kontrolu
zobrazeni informace v textovém poli. Tato vlastnost mize byt ziskdna, ale nemize
byt modifikovana.

Pfehravac
Flash 4 nebo noveéjsi.

Viz také
scroll
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mbchr mbord

Syntaxe Syntaxe
mbchr (&islo) ; mbord (znak) ;
Argumenty Argumenty
cislo Cislo, které se ma konvertovat na multibytovy znak. znak Znak, ktery se ma konvertovat na multibytoveé &islo.
Popis Popis
Retézcova funkce; konvertuje &islo v ASCII kédu na multibytovy znak. Retézcova funkce; konvertuje specifikovany znak na multibytové &islo.
Pfehravac¢ Pfehravac¢
Flash 4 nebo novéjsi. Tato funkce byla ve Flash 5 zavrzena; je doporu¢eno pouzivat Flash 4 nebo novéjsi. Tato funkce byla ve Flash 5 zavrzena; je doporu¢eno pouzivat
metodu String. fromCharCode. metodu String.charCodeAt.
Viz také Viz také
String. fromCharCode String. frmCharCode
mblength mbsubstring
Syntaxe Syntaxe
mblength (¥etézec) ; mbsubstring(hodnota, index, pocet);
Argumenty Argumenty
fetézec Retézec. value (hodnota) Multibytovy fetézec, ze kterého se ma vytahnout novy multibytovy
fetézec.
Popis
Retézcova funkce; udava délku fetézce multibytového znaku. index Cislo prvniho znaku, ktery se ma vytahnout.
Pfehravac¢ count (pocet)  Pocet znakl, které maji byt zahrnuty ve vytazeném retézci, bez
Flash 4 nebo novéjsi. Funkce byla ve Flash 5 zavrzena; je doporuceno pouzit objekt znaku index.

String ajeho metody.
Popis
Retézcovéd funkce; vytahuje novy multibytovy znakovy fetézec z multibytového
znakového retézce.

Pfehravac
Flash 4 nebo noveéjsi. Tato funkce byla ve Flash 5 zavrzena; je doporu¢eno pouziti
metody String. substr.

Viz také
String.substr
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Mouse (object) Mouse.show

Pouzijte metody objektu Mouse pro schovavani a ukazani kurzoru v animaci. Ukazatel mysSi Syntaxe
je v nastaveni viditelny, avSak mizete ho schovat a zobrazit specidini kurzor, ktery si vytvorite Mouse.show () ;
pouzitim movie klipu.
Argumenty
Pfehled metod objektu Mouse Z&dné.
Metoda Popis Popis
hide Schové kurzor v movie. Metoda; ucini kurzor v animaci viditelny. Kurzor je v nastaveni viditelny.
show Zobrazi kurzor v movie.
Pfehravac¢
Flash 5 nebo novéjsi.
Mouse.hide

Syntaxe Viz také

Mouse.hide () ; _xmouse
_ymouse

Argumenty Mouse.hide

Zadné.

Popis MovieClip (object)

Metoda; schovava kurzor v animaci. Kurzor je v nastaveni viditelny. Metody pro objekt MovieClip poskytuji stejnou funkCnost jako standardni akce, které ciluji

movie klipy. Jsou zde ale jeSté dodatecné metody poskytujici funkénost nedosazitelnou pfi

Pfehravac¢ pouziti standardnich akci zapsanych v kategorii Akce panelu Akci. Abyste volali metody

Flash 5 nebo nové;si. objektu MovieClip, nemusite pouzivat konstrukéni metody; namisto toho odkazete na movie

klip instance jménem, pfi pouziti nasledujici syntaxe:

Priklad jakykolivMovieClip.play () ;

Nasledujici kdd pripojeny k movie klipu na hlavni Casové ose schova standardni jakykolivMovieClip.gotoAndPlay (3) ;

kurzor a nastavi pozici x a y movie klip instance specialniKurzor na pozice x ay

v hlavni Casové ose: Pfehled metod objektu MovieClip

onClipEvent (enterFrame) {

Mouse.hide () ; Metoda Popis
specialniKurzorMC x = root. xmouse; attachMovie Pripojuje movie klip z knihovny.
specialniKurzorMC_y = _root._ymouse; duplicateMovieClip | Duplikuje specifikovany movie klip.
} getBounds ggﬁy:dmg\ggrlﬂl grgnsatlgrmu.alm souradnice movie klipu x ay ve specifikovaném
, getBytesLoaded Udava pocet byt natazenych pro specifikovany movie klip.
Viz takeé
xmouse getBytesTotal Udava ve‘Iikost mo’vie Blipu v bytevch. - ] _ . _

- Konvertuje bodovy objekt ze soufadnic Scény na lokalni souradnice specifiko

_ymouse getURL vaného movie klipu.

Mouse.show globalTolocal Posila hraci hlavu na specifikovany snimek v movie klipu a hraje animaci.
gotoAndPlay Posila hraci hlravu na specifikovany snimek v movie klipu a zastavuje animaci
gotoAndStop Lthdi\i/én?rui, jﬁs\t,”'iﬁ hr:‘an\il?n;'(ﬁoa(.speciﬁkovaného movie klipu protina
hitTest Natahuje externi animaci do movie klipu.
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Metoda Popis

loadMovie Natahuje externi animaci do movie klipu.

loadVariables Natahuje proménné z URL nebo jiného umisténi do movie klipu.
localToGlobal th%int (Bod) z lokdlnich souradnic movie klipu na globdini
nextFrame Posila hraci hlavu na dal$i snimek movie klipu.

play Hraje specifikovany movie klip.

prevFrame Posila hraci hlavu na predchozi snimek movie klipu.

removelovieCLip | QUStenle LOVE D2 Catoré oo, ol D ol akci nebo metodo
startDrag Specifikuje movie klip jako taZitelny a zagind taZzeni movie klipu.

stop Zastavuje aktualné hrajici animaci.

stopDrag Zastavuje tazeni jakéhokoliv movie klipu, ktery byl tazen.

swapDepths :,I/?l(;r\]lﬁ?mg ljjtr)?(\{/.en hloubky specifikovaného animace s animaci na specifikované
unloadMovie Odstrariuje animaci natazené pomoci loadMovie.

MovieClip.attachMovie

Syntaxe
jakykolivMovieClip.attachMovie(idJméno, novéjméno, hloubka);

Argumenty
iddméno Jméno movie klipu z knihovny, ktery ma byt pfipojen.
Toto je jméno viozené do pole Identifikdtor v dialog boxu Symbol
Linkage Properties.
novéjméno Unikatni jméno instance pro movie klip, ktery ma byt pfipojen.
hloubka Celé ¢islo urcuijici droven hloubky, ve které je umisténa animace.
Popis

Metoda; vytvafi novou instanci movie klipu v knihovné a pfipojuje ji k movie klipu
uréenému v jakykolivMovieKlip. Pro odstranéni movie klipu pfipojeného pomoci
attachMovie, pouzijte akci nebo metodu removeMovieClip, nebo unloadMovie.

Pfehravac
Flash 5 nebo novéjsi.

Viz take

removeMovieClip
unloadMovie
MovieClip.removeMovieClip
MovieClip.unloadMovie

MovieClip.duplicateMovieClip

Syntaxe
jakykolivMovieKlip.duplicateMovieClip(novéjméno, hloubka);

Argumenty

novéjméno Unikatni identifikator pro duplikovani movie klipu.

hloubka Cislo urdujici trover hloubky, ve které je umisténa specifikovana
animace.

Popis

Metoda; vytvari instanci specifikovaného movie klipu, zatimco animace hraje.
Duplikované movie klipy zacinaji vzdy hrat na snimku 1, bez ohledu na kterém
snimku je plvodni movie klip pfi volani metody duplicateMovieClip.
Proménné v rodiCovském movie klipu nejsou kopirovany do duplikovaného movie
klipu. Jestlize je rodiCovsky movie klip zrusen, duplikovany movie klip je také zrusen.
Movie klipy pfidané pomoci duplicateMovieClip mohou byt zruSeny pomoci akce
nebo metody removeMovieClip.

Pfehravac
Flash 5 nebo novéjsi.

Viz take
removeMovieClip
MovieClip.removeMovieClip

MovieClip.getBounds

Syntaxe
jakykolivMovieKlip.ge tBounds(cilSoufadnicovyProstor);

Argumenty
cilSouradnicovyProstor Cilova cesta Casové osy, jejiz souradnicovy prostor
chcete pouzit jako referenéni bod.

Popis

Metoda; uddva minimalni a maximalni hodnoty souradnic x a y Movie Klipu pro cilovy
souradnicnovy prostor uréeny v argumentu. Ziskany objekt bude obsahovat vlastnosti
{xMin, xMax, yMin, xMax}. PouZijte metody objektu MovieClip localToGlobal
a globalToLocal pro konverzi lokdlnich soufadnic movie klipu na souradnice
Scény nebo souradnic Scény na lokalni souradnice.
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Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici pfiklad pouZivd getBounds pro ziskani
mujMovieKlip Vv prostoru soufadnic hlavni animace
mujMovieKlip.getBounds (._root);

Viz take
MovieClip.globalToLocal
MovieClip.localToGlobal

MovieClip.getBytesLoaded
Syntaxe
jakykolivMovieKlip.getBytesLoaded() ;

Argumenty
Z4dné.

Popis

hrani¢niho boxu instance

Metoda; udava pocet natazenych byt pro specifikovany objekt Movie Clip. Protoze

interni movie klipy se natahuji automaticky, obdrzeny

vysledek pro tuto metodu

aMovieClip.getBytesTotal bude stejny, pokud specifikovany objekt Movie Clip
odkazuje na interni movie klip. Tato metoda je urCena pro pouziti v natazenych
animacich, na uréeni toho, jaké procento externi animace bylo natazeno, mdzete
porovnat hodnotu getBytesLoaded s hodnotou getBytesTotal.

Pfehravac
Flash 5 nebo novéjsi.

MovieClip.getBytesTotal

Syntaxe

jakykolivMovieklip.getBytesTotal() ;

Argumenty
Z4dné.

Popis

Metoda; udava velikost specifikovaného objektu Movie klip v bytech. Pro movie klipy,
které jsou externi, (kofen movie nebo movie klip, ktery byl natazen do cile nebo urovné)
je obdrzena hodnota velikost SWF souboru.

Prehravac

Flash 5 nebo novéjsi.

MovieClip.getURL

Syntaxe

jakykolivMovieKlip.getURL( URL [, okno, proménné] );

Argumenty
URL

window (okno)

variables
(proménné)

Url, ze kterého se ziska dokument.

Volitelny argument urcujici jméno, snimek nebo vyraz urcujici
okno nebo HTML ram, do kterého ma byt natazen dokument.
MUZete také pouzit jedno z nasledujicich rezervovanych jmen cil(:
_self specifikuje aktualni ram v aktudlnich okné, _blank
specifikuje nové okno, _parent specifikuje rodice aktualniho
ramu, _top specifikuje rdm nejvy$si Urovné v aktudlnim okné.

Volitelny argument uréujici zplsob pro posilani proménnych
spojenych s movie, které se natahuje. Jestlize zde nejsou zadné
proménngé, tento argument vynechte; jinak urete, zda se maji
proménné natahnout pomoci pouZiti zplsobu GET nebo POST.
GET pfipoji proménné na konec URL a je pouzivan pro malé pocty
proménnych. POST posSle proménné v oddéleném HTTP a je
pouzivan pro dlouhé retézce proménnych.
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Popis
Metoda; natdhne dokument ze specifikovaného URL do
specifikovaného okna. Metoda getURL mdize byt pouZita také
pro propusténi proménnych do jiné aplikace definované v URL
pouzitim zpldsobu GET nebo POST.

Pfehravac

Flash 5 nebo novéjsi.

MovieClip.globalToLocal

Syntaxe
jakykolivMovieKlip.globalToLocal (point) ;

Argumenty

point Jméno nebo identifikator objektu vytvoreny pomoci generického
objektu Object, urCujici soufadnice x a y jako vlastnosti.

Popis

Metoda; konvertuje objekt point ze soufadnic Scény (globalnich soufadnic)
na soufadnice movie klipu (na souradnice lokalni).

Pfehravac
Flash 5 nebo novéjsi.

Priklad
Nasledujici pfiklad konvertuje globalni soufadnice x a y objektu point na lokalni
souradnice movie klipu:
onClipEvent (mouseMove) {
point = new Object();
point.x = _root._xmouse;
point.y = _root._ymouse;
globalTolLocal (point) ;
_root.out = _xmouse + “===" + _ymouse;
_root.out2 = point.x + “===" + point.y;
updateAfterEvent () ;
}

Viz takeé
MovieClip.localToGlobal
MovieClip.getBounds

MovieClip.gotoAndPlay

Syntaxe
jakykolivMovieKlip.gotoAndPlay (snimek) ;

Argumenty

shimek Cislo snimku, na ktery bude poslana hraci hlava.

Popis
Metoda; zacina hrat animaci na specifikovaném snimku.

Pfehravac
Flash 5 nebo noveéjsi.

MovieClip.gotoAndStop

Syntaxe
jakykolivMovieKlip.gotoAndStop (snimek) ;

Argumenty

shimek Cislo snimku, na ktery bude poslana hraci hlava.

Popis
Metoda; zastavuje animaci na specifikovaném snimku.

Pfehravac
Flash 5 nebo noveéjsi.
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MovieClip.hitTest Priklad

Syntaxe Nasleduijici pfiklad pouzivd hitTest s vlastnostmix_mouse ay_mouse pro urceni,
jakykolivMovieKlip.hitTest(x, y, shapeFlag); zda je my$ na hrani¢nim boxu cile:
jakykolivMovieKlip.hitTest (target) ; if ( hitTest(_root._xmouse, _root._ymouse, false));
Argumenty Nasledujici pfiklad pouzivd hitTest pro urceni, zda movie klip mic prekryva
X Souradnice x zasazené oblasti na Scéné. nebo se protind s movie klipem ctverec:
if (_root.mic, hitTest (_root.ctverec)) {
y Souradnice y zasazené oblasti na Scéné. trace(,mi& protina é&tverec");
}
Souradnice x a y jsou definovany v globalnim soufadnicovém prostoru.
Viz také
target (cil) Cilova cesta zasazené oblasti, kterd mize byt protnuta nebo MovieClip.localToGlobal
prekryta instanci ur¢enou v jakykolivMovieKlip. Cil obvykle MovieClip.globalToLocal
reprezentuje tlacitko nebo textové pole. MovieClip.getBounds
shapeFlag Boolednska hodnota urcuijici, zda ohodnotit cely tvar specifikované
instance (true) nebo pouze hraniéniho boxu (false). MovieClip.loadMovie
Tento argument mdze byt specifikovan pouze tehdy, jestlize Syntaxe
je zasaZena oblast identifikovdana pomoci pouziti argumentd jakykolivMovieKlip.loadMovie (url [,promé&nné ]);
soufadnice x a y.
Argumenty
Popis url Absolutni nebo relativni URL pro SWF soubor, ktery ma byt natazen.

Metoda; ohodnocuije instanci specifikovanou v jakykolivMovieKlip, zda se prekryva
nebo protind se zasazenou oblasti identifikovanou v cili nebo argumentech souradnice
xay.

Pouziti 1 srovndva souradnice x a y s tvarem nebo hraniénim boxem specifikované

instance podle nastaveni shapeFlag. JestliZze je shapeFlag nastaven na true,

je ohodnocena pouze oblast aktualné okupovana instanci na Scéné, a jestlize se

X a y prekryvaji na jakémkoliv bodé, je obdrzena hodnota true. Toto je uzite¢né proménné
pro uréovani, zda je movie klip uvnitf specifikované zasazené oblasti.

Pouziti 2 ohodnocuje hrani¢ni boxy cile a specifikované instance a udava true,
jestlize se prekryvaji nebo protinaji v jakémkoliv bodé.

Pfehravac
Flash 5 nebo novéjsi.

Relativni cesta musi byt relativni k SWF. URL musi byt ve stejné
subdoméné jako URL, kde je animace aktualné umisténa. Pro
pouziti ve Flash Pfehravaci, nebo pro testovani v rezimu test
movie v autorském prostfedi Flashe, musi byt vSechny SWF
soubory uloZeny ve stejné sloZzce a jména souboru nemohou
zahrnovat specifikace slozky nebo disku.

Volitelny argument urcujici zplsob posilani proménnych spojenych
s animaci, ktera ma byt nataZzena. Argument musi byt fetézec
,GET“ nebo ,POST". Jestlize zde nejsou zadné proménné, tento
argument vynechte; jinak urCete, zda se maji proménné natahnout
pomoci zplisobu GET nebo POST. GET pripoji proménné na konec
URL a je pouzivan pro mala mnozstvi proménnych. POST posila
proménné v oddéleném HTTP a je pouzivan pro dlouhé fetézce
proménnych.
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Popis

Metoda; prehrava dodate¢né animace bez zavreni Flash Pfehravac¢e. Normalné
Flash Prehravac zobrazi jednu animaci (SWF soubor) a potom se zavie. Metoda
loadMovie vdam umozriuje zobrazit nékolik animaci najednou nebo mezi nimi prepinat
bez natahovani dalSiho HTML dokumentu.

Pro odstranéni animaci natazenych pomoci akce loadMovie, pouzijte akci
unloadMovie.

Pouzijte metodu loadVariables pro udrzeni aktivniho movie a updatujte proménné
novymi hodnotami.

Pfehravac
Flash 5 nebo novéjsi.

Viz take
MovieClip.loadVariables
MovieClip.unloadMovie

MovieClip.loadVariables

Syntaxe
majMovieKlip.loadVariables (url, proménné) ;

Argumenty

url Absolutni nebo relativni URL pro externi soubor. Hostitel pro URL
musi byt ve stejné subdoméné jako movie klip.

proménné ZpUisob pro ziskavani proménnych. GET pripoji proménné na konec

URL a je pouzivan pro mald mnozstvi proménnych. POST posle
proménné v oddéleném HTTP a je pouzivan pro dlouhé fetézce
proménnych.

Popis

Metoda; ¢te data z externiho souboru a nastavuje hodnoty proménnych v animaci
nebo movie klipu. Externi soubor miize byt textovy soubor generovany CGI scénarem,
Active Server Pages (ASP) nebo PHP a mizZe obsahovat jakykoliv pocet
proménnych.

Tato metoda mize byt také pouzita pro updatovani proménnych v aktivni animaci
novymi hodnotami.

Tato metoda pozaduje, aby text v URL byl ve standardnim MIME formatu:
aplikace/x-www-urlformencoded (CGI script format).

Pfehravac
Flash 5 nebo noveéjsi.

Viz takeé
MovieClip.loadMovie

MovieClip.localToGlobal

Syntaxe
jakykolivMovieKlip.localToGlobal (point) ;

Argumenty

point Jméno nebo identifikator objektu vytvofeného pomoci objektu
Object, urcujiciho souradnice x a y jako vlastnosti.

Popis

Metoda; konvertuje objekt point ze souradnic movie klipu (lokdlnich) na soufadnice
Scény (globalini).

Pfehravacé
Flash 5 nebo novéjsi.
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Priklad

Nasleduijici priklad konvertuje souradnice x a y objektu point ze souradnic movie klipu
(lokalnich) na souradnice Scény (globalni). Lokalni souradnice x a y jsou urCeny
pomoci pouziti xmouse a ymouse pro ziskani souradnic x a y pozice mysi.
onClipEvent (mouseMove) {

peoint =
point.x
point.y

new Object() ;
= _xmouse;

= _ymouse;

_root.out3 = point.x + “===" + point.y;

_root.out = _root._ xmouse + “===" + _root._ymouse;
localToGlobal (point);

_root.out2 = point.x + “===" + point.y;
updateAfterEvent() ;

Viz také

MovieClip.globalToLocal

MovieClip.nextFrame

Syntaxe

jakykolivMovieKlip.nextFrame () ;

Argumenty
Z4dné.

Popis

Metoda; posila hraci hlavu na dalSi snimek movie klipu.

Prehravac

Flash 5 nebo novéjsi.
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MovieClip.play

Syntaxe
jakykolivMovieKlip.play() ;

Argumenty
Z4dné.
Popis

Metoda; hraje movie klip.

Pfehravac
Flash 5 nebo noveéjsi.

MovieClip.prevFrame

Syntaxe
jakykolivMovieKlip.prevFrame () ;

Argumenty
Z4dné.

Popis

Metoda; posila hraci hlavu na prfedchozi snimek a zastavuje ji.

Pfehravac
Flash 5 nebo noveéjsi.
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MovieClip.removeMovieClip

Syntaxe
jakykolivMovieKlip.removeMovieClip () ;

Argumenty
Z&dné.

Popis
Metoda; odstrariuje movie Klip instanci vytvofenou pomoci akce duplicateMovieClip
nebo metody objektu MovieClip duplicateMovieClip nebo attachMovie.

Pfehravac
Flash 5 nebo novéjsi.

Viz take
MovieClip.loadMovie
MovieClip.attachMovie

MovieClip.startDrag

Syntaxe
jakykolivMovieKlip.startDrag([lock, left, right, top, bottom]);

Argumenty

lock Booleovska hodnota urcuijici, zda je taZitelny movie klip zamknuty
na stfed pozice mysi (true) nebo je zamknuty na bod, kde uZivatel
poprvé kliknul na movie klip (false). Tento argument je volitelny.

left, top, right, bottom  Hodnoty relativni k soufadnicim rodi¢ovského movie
klipu, které specifikuji omezeni obdélniku pro movie Klip.
Tyto argumenty jsou volitelné.

Popis

Metoda; umozriuje uZivateli tahnout specifikovany movie klip. Movie klip zlstava
tazZitelny, dokud neni explicitné zastaven volanim metody stopDrag nebo dokud
neni uc¢inén taZitelnym jiny movie klip. V jednom ¢ase mUze byt taZitelny pouze
jeden movie klip.

Pfehravac
Flash 5 nebo novéjsi.

Viz také
MovieClip.stopDrag
_droptarget

MovieClip.stop

Syntaxe
jakykolivMovieKlip.stop() ;

Argumenty
Z4dné.
Popis

Metoda; zastavuje movie klip, ktery aktualné hraje.

Pfehravac
Flash 5 nebo noveéjsi.

MovieClip.stopDrag

Syntaxe
jakykolivMovieKlip.stopDrag() ;

Argumenty
Z4dné.

Popis

Metoda; konéi akci taZzeni zavedenou metodou startDrag. Movie klip zUstéva taZitelny,
dokud neni pfidana metoda stopDrag nebo dokud se jiny movie klip nestane
tazitelnym. V jednom ¢ase mlze byt tazitelny pouze jeden movie klip.

Pfehravac
Flash 5 nebo novéjsi.

Viz také
_droptarget
MovieClip.startDrag

296

ACTION SCRIPT - FLASH 5

KAPITOLA 7-3 297



MovieClip.swapDepths MovieClip.unloadMovie

Syntaxe Syntaxe
jakykolivMovieKlip.swapDepths (hloubka) ; jakykolivMovieKlip.unloadMovie () ;
jakykolivMovieKlip. swapDepths (cil);
Argumenty
Argument Z&dné.
cil Instance movie klipu, jejiz hloubka bude vyménéna instanci urenou
v jakykolivMovieKlip. Obé instance musi mit stejny rodi¢ovsky Popis
movie klip. Metoda; odstrariuje movie klip natazeny pomoci metody MovieClipu loadMovie
nebo attachMovie.
hloubka Cislo uréujici drover hloubky, kam ma byt umistén
jakykolivMovieKlip. Pfehravac
Flash 5 nebo novéjsi.
Popis
Metoda; vyménuje navrSeni nebo poradi (Uroven hloubky) specifikované instance Viz také
s movie klipem specifikovanym argumentem cil nebo s movie klipem, ktery je prave MovieClip.loadMovie
na urovni hloubky specifikované v argumentu. Obé animace musi mit stejny MovieClip.attachMovie

rodi¢ovsky movie klip. Vyména urovné hloubky movie klipdl ma efekt v tom, ze
jeden movie klip se posune pfed nebo za jiny. Jestlize je movie klip interpolovan,

pokud je tato metoda volana, interpolovani je zastaveno. _hname
Syntaxe
Pfehravac¢ instancejméno._name
Flash 5 nebo novéjsi. instancejméno._name = hodnota;
Viz také Argumenty
_level instancejméno Jméno instance movie klipu, pro ktery ma byt nastavena nebo
ziskana vlastnost _name.
hodnota Retézec, ktery specifikuje jméno nové instance.
Popis

Vlastnost; ur€uje jméno movie klip instance.

Pfehravac
Flash 4 nebo noveéjsi.
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Syntaxe
NaN

Argumenty
Z4dné.
Popis

Proménng; preddefinovana proménna s hodnotou IEEE-754 pro NaN (Ne Cl'slo).

Pfehravac
Flash 5 nebo novéjsi.

ne (not equal - string specific)

Syntaxe
vyraz1 ne vyraz2

Argumenty
vyraz1,vyraz2 Cisla, fetézce nebo proménné.

Popis

Operator (srovnani); porovndva vyrazi v vyrazem2 a uddva true, jestlize vyraz1
neni roven vyrazu2; jinak uddva false.

Pfehravac¢
Flash 4 nebo noveéjsi. Tento operator byl zavrZzen ve Flash 5; je doporuc¢eno pouzivat
novy operator !'= (neni rovno).

Viz také
!'= (inequality)
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new

Syntaxe
new konstruktor() ;

Argumenty

konstruktor Funkce nasledovana volitelnymi argumenty v zavorkach. Funkce
je obvykle jméno typu objektu (Napfiklad Array, Math, Number,
Object), ktery ma byt konstruovan.

Popis

Operator; vytvari novy, ptivodné anonymni objekt, vola funkci identifikovanou
argumentem konstruktor, vklada volitelné argumenty v zavorkach a expeduje nové
vytvoreny objekt jako hodnotu kliCového slova this. Konstrukéni funkce potom
mUze this pouzit pro konkretizaci nového objektu.

prototyp_vlastnost konstrukéni funkce objektu je kopirovana
do _proto_vlastnosti nového objektu. Vysledkem je to, Ze novy objekt podporuje
vSechny metody a vlastnosti uréené v konstrukéni funkci objektu Prototyp.

Pfehravac
Flash 5 nebo noveéjsi.

Priklad
Nasledujici priklad vytvari objekty kniha1 a kniha2 pomoci pouZiti operatoru new.
function Kniha(jmeno, cena)
{
this.jmeno = jmeno;
this.cena = cena;
}
knihal = new Kniha (,Konfederace hlupaku“, 19.95);
kniha2 = new Kniha (,,The Floating Opera"“,10.95);

Viz také
[1 (array access operator)

{} (object initializer)

Cast konstrukéni metody uvniti Givodu objektu.
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newline

Syntaxe
newline;

Argumety
Z4dné.

Popis

Konstanta; vklada novy fadek znak ( { ) vloZenim prazdného rfadku do kdédu
ActionScript. Pouzijte newline pro vytvoreni prostoru pro informaci, ktera je ziskavana
funkci nebo akci ve vasem kddu.

Pfehravac¢
Flash 4 nebo nové;si.

nextFrame

Syntaxe
nextFrame () ;

Argumenty
Z4dné.

Popis
Akce; posild hraci hlavu na dalsi snimek a zastavuije ji.

Pfehravac
Flash 2 nebo novéjsi.

Priklad
Kdyz uzivatel klikne na tlacitko, ke kterému je pfipojena akce nextFrame, je hraci
hlava poslana na dalsi snimek.
on (release) {
nextFrame (5) ;
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nextScene

not

Syntaxe
nextScene () ;

Argumenty
Z4dné.

Popis
Akce; posild hraci hlavu na snimek 1 dalsi scény a zastavuje ji.

Pfehravac
Flash 2 nebo novéjsi.

Priklad
Tato akce je pfipojena k tlacitku, které kdyz je stisknuto a uvolnéno posila hraci hlavu
na snimek 1 dalsi scény.
on(release) {
nextScene () ;

Syntaxe
not vyraz

Argumenty

vyraz Jakakoliv proménna nebo jiny vyraz, ktery se konvertuje na
Booleovskou hodnotu.

Popis

Operator; vykonava logickou operaci NOT ve Flash 4 Prehravaci.

Pfehravac¢
Flash 4 nebo novéjsi. Tento operator byl ve Flash 5 zavrzen; je doporu¢eno pouzivat
novy operator ! (logical NOT).

Viz také
! (logical NOT)
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Syntaxe
null

Argumenty
Z4dné.

Popis

Klicové slovo; speciadlni hodnota, ktera mlzZe byt pfipojena k proménnym nebo
ziskana funkci, jestlize nebyly poskytnuty Zzadna data. MiZete pouzit null pro
reprezentaci hodnot, které chybi nebo nemaji definovany typ dat.

Pfehravac
Flash 5 nebo novéjsi.

Priklad
V numerickém kontextu se null ohodnocuje na 0. S null mohou byt provedeny
testy rovnosti. V této zpraveé nema binaricky node strom zadné dité, takze pole pro
jeho levé dité mlze byt nastaveno na null.
if (strom.levy == null) {

strom.levy = new StromNode() ;

Number (function)

Syntaxe
Number (vyraz) ;

Argumenty

vyraz Retézec, Booleovska nebo jiny vyraz, ktery se ma konvertovat
na Cislo.

Popis

Funkce; konvertuje argument x na €islo a udava hodnotu nasledovné:
Jestlize je x Cislo, udand hodnota je x.

Jestlize je x Booleovskd, udand hodnota je 1, jestlize je x true, 0 jestlize je x false.

Jestlize je x fetézec, funkce pfistupuje k analyze x jako decimalnimu Cislu s volitelnym
stopovacim exponentem, to je 1.57505e-3.

Jestlize neni x definovano, udand hodnota je 0.

Tato funkce je pouZita pro konverzi Flash 4 soubor(i obsahuijicich zavrZzené operatory,
které jsou importovany do Flash 5 autorského prostredi. Pro vice informaci se
podivejte na operator &.

Pfehravac¢
Flash 4 nebo noveéjsi.

Viz také
Number (object)

Number (object)

Objekt Number je jednoduchy obalovy objekt pro Ciselny typ dat, to znamena, ze mizZete
manipulovat s plvodnimi numerickymi hodnotami pomoci pouZiti metod a viastnosti spojenych
s objektem Number. Funkénost poskytnuta timto objektem je stejnd jako u JavaScript
objektu Number.

Konstruktor Number musite pouzit kdyz volate metody objektu Number, konstruktor
ale nemusite pouzit, kdyz voldte vlastnosti objektu Number. Nasleduijici pfiklady specifikuji
syntaxi pro volani metod a vlastnosti objektu Number:

Toto je pfiklad volani metody toString objektu Number:

myNumber = new Number (1234);

myNumber. toString() ;

Udava fetézec obsahujici binarickou reprezentaci Cisla 1234.

Toto je pfiklad volani vlastnosti MIN_VALUE (také nazvana konstanta) objektu Number:
nejmensi = Number.MIN VALUE

Pfehled metod objektu Number
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Metoda Popis
toString Uddva retézcovou reprezentaci objektu Number.
valueOf Udé&va pavodni hodnotu objektu Number.
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Pfehled viastnosti objektu Number

Metoda Popis

Konstanta reprezentujici nejvetsi reprezentovatelne cislo (Avojita-presnost
MAX VALUE IEEE-754). Toto &islo je pfiblizng 1.7976931348623158e+308.

Konstanta reprezentujici nejmensi reprezentovatelné ¢islo (dvojita-presnost
MIN_VALUE IEEE-754). Toto ¢&islo je priblizné 5e-324.
NaN Konstanta reprezentujici hodnotu pro Not Number (NaN).

NEGATIVE_INFINITY | Konstanta reprezentujici hodnotu pro negativni nekone¢no.

Konstanta reprezentujici hodnotu pozitivniho nekoneé¢na. Tato hodnota

POSITIVE_INFINITY | o sieing jako véeobecnd proménné Nekonesno.

Konstruktor pro objekt Number

Syntaxe
myNumber = new Number (hodnota) ;

Argumenty

hodnota Numerickd hodnota objektu Number, ktery je vytvaren nebo
hodnota, kterd ma byt konvertovéna na cislo.

Popis

Konstruktor; vytvari novy objekt Number. Musite pouzit konstruktor Number, kdyz
pouzivate metody objektu Number toString a valueOf. Nepouzivejte konstruktor,
kdyz pouzivate vlastnosti objektu Number. Konstruktor new Number je pouzivan
pfedevsim jako drzitel mista. Instance objektu Number neni stejna jako funkce
Number, ktera konvertuje argument na plvodni hodnotu.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici kdd konstruuje nové objekty Number:
nl = new Number (3.4);

n2 = new Number (-10);

Viz také
Number (function)

Number.MAX_VALUE

Syntaxe
Number .MAX VALUE

Argumenty
Z4dné.

Popis
Vlastnost; nejvétsi reprezentovatelné Cislo (dvojita-pfesnost IEEE-754). Toto Cislo
je pfiblizné 1.79E+308.

Pfehravac
Flash 5 nebo noveéjsi.

Number.MIN_VALUE

Syntaxe
Number .MIN_ VALUE

Argumenty
Z4dné.

Popis
Vlastnost; nejmensi reprezentovatelné Cislo (dvojita-presnost IEEE-754). Toto Cislo
je priblizné 5e-324.

Pfehravac
Flash 5 nebo noveéjsi.
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Number.NaN

Syntaxe
Number .NaN

Argumenty

Zadné.

Popis

Vlastnost; hodnota IEEE-754 reprezentujici Not Number ().

Pfehravac
Flash 5 nebo novéjsi.

Number.NEGATIVE_INFINITY

Syntaxe
Number .NEGATIVE INFINITY

Argumenty
Z4dné.

Popis
Vlastnost; udava IEEE-754 hodnotu reprezentujici negativni nekonec¢no. Tato hodnota
je stejna jako vSeobecna proménna Infinity (Nekonecno).

Negativni nekonecno je specidlni numericka hodnota, ktera je obdrzena, kdyz
matematickd operace nebo funkce, uda zdpornou hodnotu vetsi nez miize byt
reprezentovana.

Pfehravac
Flash 5 nebo novéjsi.
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Number.POSITIVE_INFINITY

Syntaxe
Number . POZITIVE INFINITY

Argumenty

Zadné.

Popis
Vlastnost; udava IEEE-754 hodnotu reprezentujici kladné nekonecno. Tato hodnota
je stejna jako vSeobecna proménné Infinity (Nekonecno).

Pozitivni nekonecno je specialni numerickda hodnota, ktera je obdrzena, kdyz
matematicka operace nebo funkce, uda hodnotu vétsi nez mize byt reprezentovana.

Pfehravac
Flash 5 nebo noveéjsi.

Number.toString

Syntaxe
mojeCislo.toString(radix) ;

Argumenty

radix Specifikuje numericky zaklad (od 2 do 36) pro pouziti pro konverzi
Cislo-na-fetézec. Jestlize nespecifikujete argument radix, nastavena
hodnota je 10.

Popis

Metoda; udava fetézcovou reprezentaci specifikovaného objektu Number (myNumber).

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici priklad pouzivd metodu Number.toString, uréujici 2 za argument radix:
myNumber = new Number (1000) ;

(1000) . toString(2) ;

Udava fetézec obsahujici binarickou reprezentaci Cisla 1000.
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Number.valueOf

Syntaxe
myNumber .valueOf () ;

Argumenty
Z4dné.

Popis
Metoda; udava plvodni typ hodnoty specifikovaného objektu Number a konvertuje
obalovy objekt Number na pdvodni typ hodnoty.

Pfehravac
Flash 5 nebo novéjsi.

Object (object)

Genericky objekt Object je v kofenu ActionScript hierarchie tfid. Funkénost
generického objektu Object je malou podmnozinou toho, co poskytuje objekt
JavaScript Object.

Genericky objekt Object pozaduje Flash 5 Prehravac.

PFehled metod objektu Object

Konstruktor pro objekt Object

Syntaxe
new Object() ;
new Object (hodnota) ;

Argumenty

hodnota Cislo, Booleovska nebo fetézec, ktery ma byt konvertovan na
objekt. Tento argument je volitelny. Jestlize nespecifikujete
hodnotu, konstruktor vytvori novy objekt bez definovanych viastnosti.

Popis

Konstruktor; vytvafi novy objekt Object.

Pfehravac
Flash 5 nebo novéjsi.

Viz také
Sound.setTransform
Color.setTransform
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Object.toString

Syntaxe
myObject. toString() ;

Argumenty
Z4dné.
Popis

Metoda; konvertuje specifikovany objekt na fetézec a uddva ho.

Pfehravac
Flash 5 nebo noveéjsi.

Object.valueOf

Syntaxe
myObject.valueOf () ;

Argumenty
Z4dné.

Popis
Metoda; udava plvodni hodnotu specifikovaného objektu. Jestlize objekt nema
plvodni hodnotu, je obdrzen sam objekt.

Pfehravac
Flash 5 nebo noveéjsi.
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onClipEvent

Syntaxe

onClipEvent (movieUdalost) ; {

Argumenty
movieUdalost

load

unload

enterFrame

mouseMove

mouseDown
mouseUp
keyDown

keyUp

data

je spoustéci udalost, kterd vykona akce pfipojeny k movie klip
instanci. Jakékoliv nasledujici hodnoty mohou byt specifikovany
pro argument movieUdalost:

Akce je inicializovana, jakmile je movie klip konkretizovan a objevi
se na Casové ose.

Akce je inicializovana na prvnim snimku poté co je movie klip
odstranén z Casové osy. Akce spojené s movie klip udalosti
Unload jsou provedeny pred jakymikoliv akcemi pfipojenymi
k ovlivnénému snimku.

Akce je inicializovdna, kdyZ hraje kazdy snimek, podobné jako
akce pripojené k movie klipu. Akce spojené s movie klip udalosti
OnEnterFrame jsou vykonany po jakychkoliv akcich, které
jsou pfipojeny k ovlivnénym snimkdm.

Akce je inicializovana pokazdé, kdyz se hne mysi. PouZijte viastnosti
_xmouse a _ymouse pro urceni aktualni pozice mysi.

Akce je inicializovana, kdyz je stisknuto levé tlacitko mysi.
Akce je inicializovédna, kdyz je uvolnéno levé tlacitko mysi.

Akce je inicializovana, kdyz je stisknuta kldvesa. Pouzijte metodu
Key.getCode, pro ziskani informace o naposledy stisknuté
klavese.

Akce je inicializovana, kdyz je kldvesa uvolnéna. Pouzijte metodu
Key.getCode, pro ziskdni informace o naposledy stisknuté
klavese.

Akce je inicializovana, kdyz je obdrZen udaj a akci loadVariables
nebo loadMovie. Pokud je specifikovdna akce pomoci
loadVariables, uddlost data se objevi pouze jednou, kdyz je
natazena posledni proménna. Kdyz je specifikovdna akce pomoci
loadMovie, udalost data se objevi opakované pokazdé, kdyz je
ziskdna kazdd ¢ast dat.

Popis
Ovladac; spousti akce definované pro specifickou instanci movie klipu.

Pfehravac
Flash 5 nebo noveéjsi.

Priklad
Nasledujici zprava zahrnuje skript z externiho souboru, kdyz je instance movie klipu
nataZena a poprvé se objevi na Casové ose:
onClipEvent (load) {
#include ,majScénar.as"

}

Nasledujici pfiklad pouzivd onClipEvent s udalosti keyDown. Uddlost keyDown je
obvykle pouzivana ve spojeni s jednim nebo vice metodami a vlastnostmi spojenymi
s objektem Key. Ve scénafi dole je Key.getCode pouzit pro zjisténi, kterou
klavesu uzivatel stiskl; obdrzena hodnota je spojena s vlastnostmi objektu Klavesa
RIGHT nebo LEFT, a animace je fizena podle toho.
onClipEvent (keyDown) {
if (Key.getCode () == Key.RIGHT) {
}_parent.nextFrame() ;
else if (Key.getCode () == Key.LEFT) {
_parent.prevFrame() ;

}

Nasledujici priklad pouziva onClipEvent s uddlosti mouseMove. Vlastnosti xmouse
a ymouse sleduji pozici mysi.
onClipEvent (mouseMove) {

plochaX = _root.xmouse;
plochaY = _root.ymouse;
}

Viz take

on (mouseEvent)
Key (object)
_Xmouse

_ymouse
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on(mouseEvent)

Syntaxe

on (mouseEvent) {

ptikaz;

}

Argumenty

pfikaz Instrukce pro vykonani, kdyz se stane mouseEvent.

Akce mouseEvent m(ze mit jeden z nasledujicich argumentu:
press Tlacitko mysi je stisknuto, zatimco ukazatel je na tlacitku.

release Tlagitko mysi je uvolnéno, zatimco ukazatel je na tlacitku.

releaseOutside Tlacitko mySi je uvolnéno, zatimco ukazatel je mimo tlacitka.

rollOver Ukazatel mysi roluje na tlacitku.
rollOut Ukazatel mysi roluje mimo oblast tlacitka.
dragOver Zatimco je ukazatel na tlacitku, bylo stisknuto tlacitko mysi, kdyz

rolovalo mimo tlacitko a potom rolovalo zpét na tlacitko.

dragOut Zatimco je ukazatel na tlacitku, tlacitko mysSi je stisknuto a potom
roluje mimo oblast tlacitka.

keyPress

( ,klavesa“) Je stisknuta specifikovana kldvesa. Cast argumentu kldvesa je
specifikovana pouZitim klavesovych kédl zapsanych v Dodatku B,
,Klavesy Klavesnice a Hodnoty Kédd Klaves*®, nebo jakychkoliv
konstant kddi zapsanych v prehledu Vlastnosti pro objekt Kldvesa.

Popis

Ovladag; specifikuje udalost mysSi nebo stisknuti klavesy, které spousti akci.

Pfehravac
Flash 2 nebo novéjsi.
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Priklad
V nasledujicim skriptu se vykona akce startDrag kdyz je my$ stisknuta,
a podminkovy pfikaz je vykonan kdyz je mys$ uvolnéna a objekt je pustén:
on (press) {

startDrag ("kralik") ;
}

on (release) {

if (getproperty("", _droptarget) == target) {
setProperty ("kralik", _x, _root.kralik x);
setProperty ("kralik", _y, _root.kralik y);
lelse {
_root.kralik x = getProperty("kralik", _x);

_root.kralik y = getProperty("kralik", _y);
_root.target = "pastvina";

}

trace (_root.kralik y);

trace (_root.kralik x);

stopDrag() ;
}

Viz takeé
Key (objekt)
onClipEvent

Syntaxe
podminkal or podminka2

Argumenty
podminkai,2 Vyraz, ktery se ohodnocuje na true nebo false.
Popis

Operétor; odhodnocuje podminku1 a podminku?2 a jestlize je jeden vyraz true,
potom je cely vyraz true.

Pfehravac¢
Flash 4 nebo novéjsi. Tento operator byl ve Flash 5 zavrZen a je doporu¢eno pouzivat
novy operator | |.

Viz také
Il (OR)
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ord

Syntaxe
ord (znak) ;

Argumenty
znak Znak, ktery se ma konvertovat na Cislo ASCII kddu.

Popis
Retézcova funkce; konvertuje znaky na Cisla ASCII kddu.

Pfehravac¢
Flash 4 nebo novéjsi. Tato funkce byla ve Flash 5 zavrzena a je doporuceno
pouzivat metody a vlastnosti objektu String.

Viz také
String (object)

_parent

Syntaxe
_parent.vlastnost = x
_parent._parent.vlastnost = x

Argumenty

vlastnost Vlastnost, ktera je specifikovana pro aktualni a rodiCovsky
movie klip.

X Hodnota nastavena pro vlastnost. Toto je volitelny argument nemusi
byt nastaven, zavisi na vlastnosti.

Popis

Vlastnost; specifikuje nebo udava odkaz na movie klip, ktery obsahuje aktualni
movie klip. Aktualni movie klip je movie klip obsahuijici aktualné vykonavany skript.
Pouzijte _parent pro specifikaci relativni cesty.

Pfehravac¢
Flash 4 nebo nové;si.
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Priklad

V nasledujicim pfikladé je movie klip tabule ditétem movie klipu trida. Kdyz se skript
dole vykond uvnit movie klipu tabule, hraci hlava sko&i na snimek 10 v Casové
ose movie klipu trida.

_parent.gotoAndStop (10) ;

Viz také
_root
targetPath

parseFloat

Syntaxe
parseFloat (fetézec) ;

Argumenty
fetézec Retézec, ktery se ma analyzovat a konvertovat na plynouci Cislo.

Popis

Funkce; konvertuje fetézec na plynouci Cislo. Funkce analyzuje a udava Cisla v fetézci,
dokud analyzator nedosahne znaku, ktery neni ¢asti plvodniho Cisla. Jestlize fetézec
nezacina cGislem, které mize byt analyzovdno, parseFloat uda NaN nebo 0. Bily
prostor pred platnymi celymi Cisly je ignorovan, stejné jako nenumerické znaky.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasleduijici jsou pfiklady pouziti parseFloat pro ohodnoceni riéiznych typt Gisel:
parseFloat(,-2%) uda -2

parseFloat(,2.5%) uda 2.5

parseFloat(,3.5e6") uda 3.5e6 nebo 3500000

parseFloat (,,foosloupec") uda NaN
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parseint

Syntaxe
parselnt(vyraz,radix) ;

Argumenty

vyraz Retézec, plynouci &islo nebo jiny vyraz, ktery se ma analyzovat
a konvertovat na celé Cislo.

radix Celé Cislo reprezentuijici radix (zaklad) Cisla pro analyzovani. Legalni
hodnoty jsou od 2 do 36. Tento argument je volitelny.

Popis

Funkce; konvertuje fetézec na celé Gislo. Jestlize nemUize byt specifikovany fetézec
v argumentech konvertovany na Cislo, funkce uda NaN nebo 0. Cela Cisla zacinajici
s 0 nebo specifikujici radix 8 jsou interpretovany jako oktal Cisla. Cela Cisla zacinajici
0x jsou interpretovana jako hexadecimalni Cisla. Bily prostor pred platnymi celymi
Cisly je ignorovan, stejné jako nenumerické znaky.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasleduijici jsou pfiklady pouziti parselnt pro ohodnoceni réiznych typt cisel:
parselInt(,3.5%) uda 3.5

parselInt (,sloupec") uda NaN

parselInt (,4foo“) uda 4

Hexadecimalni konverze:
parseInt (“0x3F8"“) uda 1016
parseInt (,3E8%, 16) uda 1000

Binaricka konverze:
parselnt (,1010%, 2) uda 10 (decimalni reprezentace binarického 1010)

Analyzovani oktal &isla (v tomto pfipadé je oktalni ¢islo identifikovano pomoci radix,8):
parselnt (,777“, 8) uda 511 (decimalni reprezentace oktalniho 777)
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play

Syntaxe
play();

Argumenty
Z4dné.

Popis
Akce; posunuije hraci hlavu dopfedu na Casoveé ose.

Pfehravac
Flash 2 nebo noveéjsi.

Priklad
Nasledujici kdd pouziva pfikaz if pro kontrolu hodnoty jména, které uzivatel viozi.
Jestlize uzivatel vlozi Steve, je voldna akce play a hraci hlava se posune dopfedu
na Casové ose. Jestlize uZivatel vloZi cokoliv jiného neZ Steve, movie nehraje
a je zobrazeno textové pole s proménnou jménem varovani.
stop () ;
if (jmeno = “Steve") {

play();
lelse{

varovani = ,Ty nejsi Steve!"“;

prevFrame

Syntaxe
prevFrame () ;

Argumenty
Z4dné.
Popis

Akce; posila hraci hlavu na prfedchozi snimek a zastavuje ji.

Pfehravac
Flash 2 nebo noveéjsi.

KAPITOLA 7-3 319



Priklad

Kdyz uzivatel klikne na tlacitko, ke kterému je pfipojena akce prevFrame, je hraci hlava

poslana na predchozi snimek.
on (release) {
prevFrame (5) ;

}

Viz takeé
MovieClip.prevFrame

prevScene

Syntaxe
prevScene () ;

Argumenty
Z4dné.
Popis

Akce; posild hraci hlavu na snimek 1 pfedchozi scény a zastavuje ji.

Pfehravac
Flash 2 nebo novéjsi.

Viz také
nextScene

Syntaxe

print (cil,“bmovie") ;
print (cil,“bmax"“) ;
print (cil,“bframe") ;

Argumenty

bmovie

bmax

bframe

Popis

Oznacuije hrani¢ni box specifického snimku v animaci jako oblast
tisku pro vSechny tisknutelné snimky. Pfipojte popisek #b
(v autorském prostredi) pro oznaceni snimku, jehoz hrani¢ni box
chcete pouzit jako oblast tisku.

Oznaduje slozeninu v8ech hrani¢nich boxd, vSech tisknutelnych
snimka, jako oblast tisku. Specifikujte argument bmax, pokud
se tisknutelné snimky ve vasi animaci li$i velikosti.

Oznacuje hraniéni box pro kazdy tisknutelny snimek, ktery ma
byt pouzity jako oblast tisku pro tento snimek. Toto zméni oblast
tisku pro kazdy snimek a méfi objekty, aby padly oblasti tisku.
Pouzijte bframe, jestlize mate objekty rlznych velikosti v kazdém
snimku a chcete, aby kazdy objekt vyplnil tisknutou stranku.

Akce; tiskne movie klip cil v souladu s modifikdtorem tiskdrny specifikovanym
v argumentu. Jestlize chcete tisknout pouze ur€ité snimky v cilové animaci, pfipojte
popisek snimku #P ke snimkdm, které chcete tisknout. Ackoliv se akce print odrazi
ve vyssi kvalité tiskl, nez akce printAsBitmap, nemuZe byt pouzita pro tisk animaci,
které pouzivaji alfa prihlednosti nebo specialni barevné efekty.

Jestlize nespecifikujete argument oblast tisku, je oblast tisku v nastaveni uréena
velikosti Scény nataZzené animace. Animace nedédi velikost hlavni Scény. Oblast
tisku mlzete ovladat uréenim argumentd bmovie, bmax nebo bframe.

VSechny tisknutelné prvky v animaci musi byt zcela nataZzeny dfive nez zacne tisk.

Flash Prehravac tisk podporuje tiskdrny PostScript a non-PostScript.
Non-PostScript tiskdrny konvertuji vektory na bitmapy.

Prehravac

Flash 5 nebo novéjsi.

Priklad

Nasleduijici pfiklad bude tisknout vSechny tisknutelné snimky v mojeMovie s oblasti

tisku definovanou

hranié¢nim boxem snimku s pfipojenym popiskem snimku #b:

cil

Jméno instance movie klipu, ktery se ma tisknout. V nastaveni
jsou tisknuty vSechny snimky v animaci. Jestlize chcete tisknout
pouze urcité snimky, oznacte snimky pro tisk pfipojenim popisku
snimku #P k témto snimk{m v autorském prostredi.

print (,mojeMovie", “bmovie“) ;

Nasleduijici pfiklad bude tisknout vSechny tisknutelné snimky v mojeMovie s oblasti

tisku definovanou hrani¢nim boxem kazdého snimku:

ASURRNY

print (,mojeMovie"“, “bframe") ;

Viz také
printAsBitmap
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printAsBitmap

Syntaxe

printAsBitmap (cil,“bmovie“) ;
printAsBitmap (cil, “bmax"“) ;
printAsBitmap (cil,“bframe"“) ;

Argumenty

cil Jméno instance movie klipu, kterd se ma tisknout. V nastaveni
jsou tisknuty vSechny snimky. Jestlize chcete tisknout pouze urcité
snimky, oznacte snimky pro tisk pfipojenim popisku snimku #P.

bmovie Oznacuje hrani¢ni box specifického snimku v animaci jako oblast
tisku pro vSechny tisknutelné snimky. Pfipojte popisek #b
(v autorském prostredi) pro oznaceni snimku, jehoz hraniéni box
chcete pouzit jako oblast tisku.

bmax Oznacuje slozeninu vS§ech hranic¢nich boxd, vSech tisknutelnych
snimkd, jako oblast tisku. UrGete argument bmax, kdyz se tisknutelné
snimky ve vasi animaci lisi velikosti.

bframe Oznacuje hrani¢ni box pro kazdy tisknutelny snimek, ktery ma
byt pouzity jako oblast tisku pro tento snimek. Toto zméni oblast
tisku pro kazdy snimek a méfi objekty, aby padly oblasti tisku.
Pouzijte bframe, jestlize méate objekty rlznych velikosti v kazdém
snimku a chcete, aby kazdy objekt vyplnil tisknutou stranku.

Popis

Akce; tiskne movie klip cil jako bitmapu. Pouzijte printAsBitmap pro tisk animaci,
které obsahuji snimky s objekty, které pouzivaji prihlednost nebo barevné efekty.
Akce printAsBitmap tiskne v nejvy§Sim dostupném rozliSeni tiskarny, aby zvladla
tolik ostrosti a kvality, kolik je mozné. Pro kalkulaci tisknutelné velikosti souboru snimku
oznaceného pro tisk jako bitmapa nasobte Sifku v pixelech vySkou v pixelech
a rozlisenim tiskarny.

Jestlize vase animace neobsahuje alfa prihlednosti nebo barevné efekty, je
doporucovano, abyste pouzivali akci print pro kvalitnéjsi vysledky.

ACTION SCRIPT - FLASH 5

V nastaveni je oblast tisku urCena velikosti Scény natazené animace. Animace
nedédi velikost hlavni Scény. Oblast tisku miZete ovladat ur¢enim argumentd bmovie,
bmax nebo bframe.

Vsechny tisknutelné prvky v animaci musi byt zcela natazeny dfive nez zacne tisk.
Flash Prehravac tisk podporuje tiskdrny PostScript a non-PostScript. Non-
PostScript tiskarny konvertuji vektory na bitmapy.

Pfehravac
Flash 5 nebo noveéjsi.

Viz take
print

_quality

Syntaxe

_quality
_quality = x;

Argumenty

X Retézec specifikujici jednu z nésleduijicich hodnot:

LOW Predlozeni nizké kvality. Grafiky nejsou antialiazed(vyrovnany),
bitmapy nejsou vyhlazené.

MEDIUM PredloZeni stfedni kvality. Grafiky jsou antialiased pouzitim mfizky
2x2, ale bitmapy nejsou vyhlazeny. Vhodné pro movies, které
neobsahuiji text.

HIGH Predlozeni vysoké kvality. Grafiky jsou antialiased pouzitim mfizky
4x4 a bitmapy jsou vyhlazeny, jestlize je movie statické. Toto je
nastavené predlozeni nastaveni kvality pouzité Flashem.

BEST Predlozeni velmi vysoké kvality. Grafiky jsou antialiased
pouzitim mfizky 4x4 a bitmapy jsou vzdy vyhlazené.
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Popis
Vlastnost (vSeobecnad); nastavuje nebo ziskdva predloZzenou kvalitu pouzitou pro
animaci.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici pfiklad nastavuje kvalitu zobrazeni staraKvalita na HIGH:
staraKvalita = quality

_quality = ,HIGH“;

Viz take
_highquality

random

Syntaxe
random () ;

Argumenty
hodnota Nejvyssi celé &islo pro které nahodné uda hodnotu.

Popis
Funkce; udava nahodné celé Cislo mezi 0 a celym Cislem uréenym v argumentu
hodnota.

Pfehravac¢
Flash 4. Tato funkce je zavrZzena ve Flash 5; je doporu¢eno pouzivat metodu
Math.random.

Priklad
Nasledujici pouziti random udava hodnotu 0,1,2,3 nebo 4:
random(5) ;

Viz také
Math.random

removeMovieClip

Syntaxe
removeMovieClip (cil) ;

Argumenty

cil Cilova cesta movie klip instance vytvorené pomoci
duplicateMovieClip nebo jméno instance movie klipu vytvorené
pomoci metod objektu MovieClip attachMovie
nebo duplicateMovie

Popis

Akce; rusi movie klip instanci, ktera byla vytvorena pomoci metod objektu Movie klip
attachMovie nebo duplicateMovieClip nebo pomoci akce duplicateMovieClip.

Pfehravac
Flash 4 nebo novéjsi.

Viz takeé

duplicateMovieClip
MovieClip.duplicateMovieClip
MovieClip.attachMovie
MovieClip.removeMovieClip

return

Syntaxe
return [vyraz];
return;

Argumenty
vyraz Typ, fetézec, Cislo, pole nebo objekt, ktery se ma ohodnotit a obdrzet
jako hodnota funkce. Tento argument je volitelny.

Popis

Akce; specifikuje hodnotu obdrzenou funkci. Kdyz je obdrzena akce vykonana,
vyraz je ohodnocen a obdrZen jako hodnota funkce. Obdrzena akce zpUlsobi,
Ze se zastavi vykonavani akce. Jestlize pfikaz return je pouzit samostatné nebo
jestlize Flash nenarazi na pfikaz return béhem akce smyckovani, uda null.

Pfehravac
Flash 5 nebo noveéjsi.
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_root

Priklad

Nasleduijici je prikladem pouziti return:
function sum(a,b,c){

return a + b + c;

}

Viz také
function

Syntaxe

_root;
_root.movieKlip;
_root.akce;

Argumenty

movieKlip Jméno instance movie klipu.

akce Hodnota nastavena pro vlastnost. Toto je volitelny argument
a nemusi byt tfeba ho nastavovat - zavisi na vlastnosti.

Popis

Vlastnost; specifikuje nebo udévé odkaz na kofenovou Casovou osu animace.
Jestlize ma animace nékolik trovni, kofenova Casové osa je na trovni obsahuijici
aktudlné vykondvany skript. Napiiklad, jestlize skript na drovni 1 ohodnocuje root,
je obdrzena uroven 1.

Specifikovani _root je stejné jako pouZiti slash (zpétné lomitko) oznaceni ( /)
pro urceni absolutni cesty uvnitf aktualni drovné.

Pfehravac¢
Flash 4 nebo nové;si.
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Priklad

Nasleduijici priklad zastavuje Casovou osu lrovné obsahuiici aktuding vykondvany
skript:

_rootl.stop() ;

Nasledujici priklad posila Casovou osu v aktudlni Grovni na snimek 3:
_root.gotoAndStop (3) ;

Viz také
_parent
targetPath

_rotation

Syntaxe
instancejméno._rotation
instancejméno._rotation = celééislo

Argumenty
celé cislo Pocet stupnd, o které se ma movie klip otocit.

instancejméno  Movie klip, ktery ma rotovat.

Popis
Vlastnost; urCuje rotaci movie klipu ve stupnich.

Pfehravacé
Flash 4 nebo novejsi.

Syntaxe
proménna_jméno.scroll = x

Argumenty

proménna_jméno Jméno proménné spojené s textovym polem.

X Cislo nejvyse viditelného radku v textovém poli. MdiZete specifikovat
tuto hodnotu nebo pouzit nastavenou hodnotu 1. Flash Prehravac
updatuje tuto hodnotu, jakmile uzivatel roluje nahoru a doll textové
pole.
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Popis Selection (object)

Vlastnost; kontroluje zobrazeni informace v textovém poli spojeném s proménnou. Objekt Selection (Vybér) umoziiuje nastavit a kontrolovat aktudlné zamérené editovatelné
Vlastnost scroll definuje, kde v poli zacing zobrazeni obsahu; poté co je nastavena, textové pole. Aktudlngé zaméfené editovateiné textové pole je pole, kde je aktualng umistény
Flash Pfehravac ji updatuje s tim, jak uzivatel roluje skrz textové pole. Vlastnost uzivatelGv kurzor mysi. Indexy vybér-rozsah maji zaklad nula (kde je prvni pozice 0, druhd
scroll je uZziteCnd pro fizeni uzivateld na urcity odstavec v dlouhé pasazi textu, pozice je 1 atd.).
nebo vytvareni rolujicich textovych poli. Tato vlastnost mlZe byt ziskana Pro objekt Selection neni zadna konstrukéni metoda, protoze miizZe byt aktudlné zaméreno
a modifikovana. pouze jedno pole.
Pfehravac¢ Pfehled metod objektu Selection
Flash 4 nebo nové;si. -

Metoda Popis

. Udava index na zacatku rozsahu vybéru - 1, jestlize neni zadny index

Viz takeé getBeginIndex nebo vybrané pole.
maxscroll getCaretIndex Uddva aktudlni pozici caret (Sipka nahoru, vynechdvka) v aktualné zaméreném

rozsahu vybéru -1, jestlize neni Zddna pozice caret nebo aktudiné zaméreny
rozsah vybéru.

Udava index na konci rozsahu vybéru -1, jestlize neni Zédny index nebo aktudiné

getEndIndex vybrané pole.

tF Udava jméno proménné pro aktualné zamérené editovatelné textové pole.
getktocus Udavé nula, jestlize zde neni aktudlné zamérené editovatelné textové pole.
setFocus Zaméruje editovatelny text spojeny s proménnou specifikovanou v argumentu.
setSelection Nastavuje pocatecni a konec¢né indexy rozsahu vybéru.

Selection.getbeginindex
Syntaxe
Selection.getBeginIndex() ;

Argumenty
Z4dné.

Popis

Metoda; udava index na zacatku rozsahu vybeéru. Jestlize Zadny index neexistuje,
nebo zadné pole nema aktualné stfed, metoda uda -1. Indexy rozsahu vybéru maji
zdaklad nula (kde prvni pozice je 0, druha pozice je 1, atd.).

Pfehravac
Flash 5 nebo novéjsi.
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Selection.getCaretindex
Syntaxe
Selection.getCaretIndex() ;

Argumenty
Z4dné.

Popis
Metoda; udava index pozice blikajiciho kurzoru. Jestlize neni zadny blikajici ukazatel mysi
zobrazen, metoda uda -1. Indexy rozsahu vybéru maji zdklad nula (kde prvni pozice je 0,
druha pozice je 1, atd.).

Pfehravac
Flash 5 nebo novéjsi.

Selection.getEndindex
Syntaxe
Selection.getEndIndex () ;

Argumenty
Z4dné.

Popis
Metoda; udava konecny index aktudlné zaméreného rozsahu vybéru. Jestlize neexistuje
zadny index nebo jestlize zde neni Zzadny aktudlné zaméreny rozsah vybéru, metoda uda -
1. Indexy rozsahu vybéru maiji zaklad nula (kde prvni pozice je 0, druha pozice je 1, atd.).

Pfehravac
Flash 5 nebo novéjsi.
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Selection.getFocus
Syntaxe
Selection.getFocus() ;

Argumenty
Z4dné.

Popis
Metoda; udava jméno proménné aktudlné zaméreného editovatelného textového
pole. Jestlize neni zadné textové pole aktualné zaméreno, metoda uda null.

Pfehravac
Flash 5 nebo noveéjsi.

Priklad
Nasledujici kdd udava jméno proménné:
_root. jakykolivMovieKlip.mojeTextovePole.

Selection.setFocus
Syntaxe
Selection.setFocus (proménnad) ;

Argumenty

proménna Retézec udavajici jméno proménné spojené s textovym polem
pouzivajicim dot (teCkovou) nebo slash (lomitkovou) notaci.

Popis

Metoda; zaméruje editovatelné textové pole spojené s urcitou proménnou.

Pfehravac
Flash 5 nebo noveéjsi.
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Selection.setSelection

set

Syntaxe
Selection.setSelection(start,end) ;

Argumenty

start Pocatecni index rozsahu vybéru.
end Konec¢ny index rozsahu vybéru.
Popis

Metoda; nastavuje rozsah vybéru aktudlné zaméreného textového pole. Novy rozsah
vybéru bude zacinat na indexu ur¢eném v argumentu start a koncit na indexu
uréeném v argumentu end. Indexy rozsahu vybéru maji zaklad nula (kde prvni pozice
je 0, druha pozice je 1, atd.). Tato metoda nema zadny efekt, jestlize neni aktualné
zamereno zadné textoveé pole.

Pfehravac
Flash 5 nebo novéjsi.

Syntaxe
proménna = vyraz;
set(proménna, vyraz);

Argumenty

proménna Jméno schranky, ktera obsahuje hodnotu argumentu vyraz.

vyraz Hodnota (nebo fraze, ktera mdze byt ohodnocena na hodnotu),
ktera je pfipojena k proménné.

Popis

Akce; pfipojuje hodnotu proménné. Proménna je schranka, ktera obsahuje néjakou
informaci. Schranka samotna je vzdy stejna, ale jeji obsah se mize ménit. P¥i
prehrdvani animaci, mizete zménou hodnoty proménné nahrat a ulozit informaci
o tom, co uzivatel udélal, nahrat hodnoty, které se méni, nebo ohodnotit, zda
je podminka true, nebo false.

Proménné mohou obsahovat jak Cisla, tak retézce znak(. Kazda animace a movie klip
ma své vlastni nastaveni proménnych a kazda proménna ma svoiji vlastni hodnotu
nezavislou na proménnych v jinych animacich nebo movie klipech.

ActionScript je netypizovany jazyk. To znamena, ze u proménné nemusi byt explicitné
definovano, zda obsahuje €islo nebo retézec. Flash zasadné interpretuje typ dat jako
celé Cislo nebo fetézec.

Pro zadavani nebo ziskani hodnot pouzijte pfikaz set ve spojeni s akci call.

Pfehravac¢
Flash 4 nebo novejsi.

Priklad
Tento priklad nastavuje proménnou nazvanou orig_x_pos, kterd uklddd pdvodni
pozici souradnice x movie klipu ship, aby déle v animaci resetoval ship do startovniho
umisteni:
on (release) {

set(orig_x pos, getProperty(,ship“, _x));

Toto je ekvivalentni nasledujiciho:
on (release) {
orig x pos = getProperty (,ship™, _x);

Viz také
var
call
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setProperty
Syntaxe
setProperty(cil,vlastnost,vyraz);

Argumenty

cil Cesta ke jménu instance movie klipu, jehoz viastnost je nastavovana.
vlastnost Vlastnost, ktera ma byt nastavena.

vyraz Hodnota, ke které je vlastnost nastavena.

Popis

Akce; méni béhem pfehravani animce vlastnost movie klipu.

Pfehravac¢
Flash 4 nebo novéjsi.

Priklad
Tato zpréva nastavuje vlastnost _alpha movie klipu jménem star na 30 procent,
kdyz je stisknuto tlacitko:
on (release) {
setProperty(,star™, _alpha = 30);

}
Viz také
getProperty
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Sound (object)

Objekt Sound (Zvuk) umozfiuje nastavit a kontrolovat zvuky v konkrétni instanci movie
klipu, nebo na globalni Casové ose, jestlize pfi vytvareni nového objektu Sound nespeci-
fikujete cil. Pro vytvoreni instance objektu Sound pred tim, nez volate metody objektu
Sound, musite pouzit konstruktor new Sound.

Objekt Sound je podporovan pouze pro Flash 5 Prehravac.

Pfehled metod objektu Sound

Metoda Popis

attachSound Pripojuje zvuk specifikovany v argumentu.

getPan Udava hodnotu predchoziho volani setPan.

getTransform Uddva hodnotu predchoziho voldni setTransform.

getVolume Uddva hodnotu predchoziho volani setVolume.

setPan Nastavuje pravé/levé vyrovnani zvuku.

setTransform Nastavuje transformaci pro zvuk.

setVolume Nastavuje Uroveni hlasitosti pro zvuk.

start Zacind hrét zvuk od zacatku, nebo volitelné z vyrovnavaciho bodu nastaveného
v argumentu.

stop Zastavuje specifikovany hlas nebo vSechny zvuky, které aktudlné hraji.

Konstruktor pro objekt Sound
Syntaxe
new Sound() ;
new Sound(cil);

Argumenty

cil Instance movie klipu, ke které se pfipojuje objekt Sound. Tento
argument je volitelny.

Popis

metoda; vytvari novy objekt Sound pro specifikovany movie klip. Jestlize nespecifikujete
cil, objekt Sound kontroluje véechny zvuky v globaini Casové ose.

Pfehravac
Flash 5 nebo novéjsi.

Priklad
GlobalniZvuk = new Sound();
MovieZvuk = new Sound(mojemovie) ;

KAPITOLA 74 345



Sound.attachSound Sound.getTransform

Syntaxe Syntaxe
mujZvuk.attachSound(,idJméno); mujZvuk.getTransform() ;
Argumenty Argumenty
iddméno Jméno pro novou instanci zvuku. Toto jméno je stejné jako Z&dné.
jméno vlozené pro identifikdtor v dialog boxu Symbol Linkage
Properties. Tento argument musi byt vloZen do cita¢nich Popis
znamének “ . Metoda; udava informaci o transformaci zvuku pro specifikovany objekt Sound
nastavenou v poslednim voldni setTransform.
Popis
Metoda; pfipojuje zvuk specifikovany v argumentu iddméno ke specifikovanému Pfehravac
objektu Sound. Zvuk musi byt v knihovné aktudlni animace a také musi byt Flash 5 nebo novéjsi.
specifikovany pro export v dialog boxu Symbol Linkage Properties. Pro spusténi
zvuku volejte Sound. start. Viz také
Sound.setTransform
Pfehravac
Flash 5 nebo novéjsi.
Sound.getVolume
Viz také Syntaxe
Sound.start mujZvuk.getVolume () ;
Argumenty
Sound.getPan Z&dné.
Syntaxe
mujZvuk.getPan () ; Popis
Metoda; udava uroven hlasitosti zvuku jako celé &islo od 0 do 100, kde nula je vypnuty
Argumenty zvuk a 100 je pIna hlasitost. Dané nastaveni je 100.
Z&dné.
Pfehravac
Popis Flash 5 nebo noveéjsi.
Metoda; udava uroven pan nastavenou v poslednim volani setPan jako celé Cislo
od -100 do 100. Nastaveni pan kontroluje levo-pravou rovnovahu aktudlnich a budoucich Viz také
zvukU v animaci. Sound. setVolume

Tato metoda je kumulativni s metodami setVolume nebo setTransform.

Pfehravac
Flash 5 nebo novéjsi.

Viz také
Sound. setPan
Sound.setTransform

346 ACTION SCRIPT - FLASH 5 KAPITOLA 7-4 347



Sound.setPan

Syntaxe
mujZvuk.setPan (pan) ;

Argumenty

pan Celé cislo urcujici pravo-levou rovnovahu pro zvuk. Rozsah
platnych hodnot je od -100 do 100, kde -100 pouziva pouze
levy kanal, 100 pouziva pouze pravy kandl a 0 vyrovnava zvuk
shodné mezi dvéma kanaly.

Popis

Metoda; ur€uje, jak ma zvuk hrat v pravém a levém kanalu (mluvitkach). Pro mono
zvuky, ovliviiuje pan, pres které mluvitko (levé nebo prave) bude zvuk hran.

Tato metoda je kumulativni s metodami setVolume a setTransform a volani
této metody rusi a updatuje pfedchozi nastaveni setPan a setTransformovat.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici pfiklad pouziva setVolume a setPan pro kontrolu objektu zvuk
se specifikovanym cilem ,u2:

onClipEvent (mouseDown) {

//vytvofit objekt zvuk

s = new Sound(this);

//pEipojit zvuk v knihovné

s.attachSound (,u2“) ;

//nastavit Hlasitost na 50%

s.setVolume (50) ;

//vypnout zvuk v pravém kanalu

s.setPan (-100) ;

//zaé&it 30 sekund ve zvuku a hrat ho 5 krat
s.start (30, 5);

Viz také
Sound.setTransform
Sound. setVolume
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Sound.setTransform

Syntaxe
mujZvuk.setTransform(soundTransformObject);

Argumenty

soundTransformObject Objekt vytvoreny konstruktorem pro genericky objekt
Object.

Popis

Metoda; nastavuje informaci o transformaci zvuku pro objekt Sound. Tato metoda
je kumulativni s metodami setVolume a setPan a volani této metody rusi a updatuje
jakakoliv pfedchozi nastaveni setPan a setVolume. Toto volani je pro expert uzivatele,
ktefi chtéji ke zvukim pridat zajimavé efekty.

Zvuky pouzivaji znacnou ¢ast prostoru disku a pameéti. Protoze stereo zvuky pouzivaji
dvakrat vice dat nez mono zvuky, je vSeobecné nejlepsi pouzit 22-Khz 6-bit mono
zvuky. Metodu setTransform mizete pouZit, pro hrani mono zvuk( jako stereo,
hrani stereo zvuk( jako mono a pro pfipojeni zajimavych efektd ke zvukdm.

Argument soundTransformObject je objekt, ktery vytvarite pomoci pouziti konstrukéni
metody generického objektu Object s parametry urcujicimi, jak je zvuk rozdélovan
do pravého a levého kanalu (mluvitek).

Parametry pro soundTransformObject jsou nasledujici:
| Procentualni hodnota urcujici, kolik levého vstupu se ma hrat v levém

mluvitku (-100 az 100).

Ir Procentualni hodnota urcujici, kolik pravého vstupu se ma hrat v levém
mluvitku (-100 az 100).

rr Procentuadini hodnota urcuijici, kolik pravého vstupu se ma hrat v pravém
mluvitku (-100 az 100).

rl Procentualni hodnota urcujici, kolik levého vstupu se ma hrat v pravém
mluvitku (-100 az 100).

Vysledek parametrd je reprezentovan nasledujicim vzorcem:
levyVystup = levy vstup * 11 + pravy vstup * 1r

pravyVystup = pravy vstup * rr + levy vstup * rl
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Hodnoty pro levy nebo pravy vstup jsou uréeny typem (stereo nebo mono) zvuku
v animaci.

Stereo zvuky rozdéluji zvukovy vstup shodné mezi levé a pravé mluvitko a maji nasleduijici
dané nastaveni transformace:

11 = 100
lr = 0
rr = 100
rl =0

Mono zvuky hraji vSechny zvukoveé inputy v levém mluvitku a maji nasledujici dané
nastaveni transformace:

11 = 100
1lr = 100
rr = 0

rl =0
Prehravac

Flash 5 nebo novéjsi.

Priklad

Nasledujici priklad vytvari objekt zvukove transformace, ktery hraje levy i pravy kanal
v levém kanalu:

mySoundTransformObject = new Object
mySoundTransformObject.1l1l = 100

mySoundTransformObject.lr = 100

mySoundTransformObject.rr = 0

mySoundTransformObject.rl = 0

Abyste aplikovali objektové zvukoveé transformace na objekt Sound, musite vlozit
objekt do objektu Sound pouzitim setTransform:
mujZvuk. setTransform(mySoundTransformObject) ;

Nasledujici jsou pfiklady nastaveni, které mohou byt nastaveny pouzitim
setTransform, ale nemohou byt nastaveny pouzitim setVolume nebo setPan,
i kdyby byly kombinovany.

Tento kdd hraje levy i pravy kanal skrz levy kanal:
mujZvuk.setTransform (soundTransformObjectLeft);

V kddu nahofe ma soundTransformObjectLeft nasledujici parametry:
11 = 100

1lr = 100
rr = 0
rl =0

Tento kdd hraje stereo zvuk jako mono:
setTransform (soundTransformObjectMono);

V kddu nahofe ma soundTransformObjectMono nasledujici parametry:
11 = 50

1lr = 50
rr = 50
rl = 50

Tento kdd hraje levy kanal s polovi¢ni kapacitou a pfidava zbytek levého kanalu
do pravého kanalu:
setTransform (soundTransformObjectHalf);

V kddu nahofe ma soundTransformObjectHalf nasledujici parametry:
11 = 50

lr = 0

rr = 100
rl = 50
Viz také

Konstruktor pro objekt Object
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Sound.setVolume

Syntaxe
mujZvuk.setVolume(hlasitost);

Argumenty

hlasitost Cislo od 0 do 100 reprezentujici tirover hlasitosti. 100 je pInd hlasitost
a 0 je zadna hlasitost. Dané nastaveni je 100.

Popis

Metoda; nastavuje hlasitost pro objekt Sound.
Tato metoda je kumulativni s metodami setPan a setTransform.

Pfehravac
Flash 5 nebo novéjsi.

Priklad
Nasledujici priklad nastavuje hlasitost na 50% a transferuje zvuk pres Cas z levého
mluvitka do pravého:
onClipEvent (load) {
i = -100;
s = new Sound();
s.setVolume (50) ;
}
onClipEvent (enterFrame) {
S.setPan (i++) ;
}

Viz také
Sound. setPan
Sound.setTransform
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Sound.start

Syntaxe
mujZvuk.start() ;
mujZvuk.start ([secondOffset, loop]) ;

secondOffset  \olitelny argument, ktery umozriuje zacit hrat zvuk na urcitém bodeé.
Napfiklad, jestlize mate 30sekundovy zvuk a chcete, aby zvuk
zacal hrat uprostred, urCete 15 sekund pro argument secondOffset.
Zvuk neni opozdén o 15 sekund, ale zacina hrat na znacce
15 sekund.

loop Volitelny argument, ktery umoznuje urcit, kolikrat by mél zvuk
smyckovat (pocet opakovani-smycek).

Popis

Metoda; zacina hrat posledni pfipojeny zvuk od zacatku, jestlize neni specifikovan
zadny argument, nebo zacina na bodé ve zvuku, ktery je ur€en argumentem
secondOffset.

Pfehravac
Flash 5 nebo noveéjsi.

Viz také
Sound. setPan
Sound. stop
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Sound.stop startDrag

Syntaxe Syntaxe
mujZvuk.stop() ; startDrag(target) ;
mujZvuk.stop ([,idJIJméno™]) ; startDrag(target, [lock])
startDrag(target [, lock [, left, top, right, bottom ]]);

Argumenty
iddméno Volitelny argument urcujici, aby prestal hrat urcity zvuk. Argument Argumenty

iddméno musi byt v citaCnich znaménkach (™ ). target Cilové cesta movie klipu, ktery se ma tdhnout.
Popis lock Boolednska hodnota uréuijici, zda je tazitelny movie klip zamknuty
Metoda; zastavuje vSechny zvuky aktudlné hrajici, jestlize neni specifikovan zadny na stfed pozice mysi (true) nebo zamknuty na bod, kam uZivatel
argument, nebo pouze zvuk uréeny v argumentu idJméno. poprvé v movie klipu kliknul(false). Tento argument je volitelny.
Pfehravac¢

left, top, right, bottom  Hodnoty relativni k souradnicim rodi¢e movie klipu, které

Flash 5 nebo novejsi. urcuji konstrukci obdélniku pro movie klip. Tyto argumenty jsou

Viz také volitelné.
Sound.start -
Popis
Akce; €ini movie klip cil tazitelny béhem hrani animace. V jednom
soundbuftime ¢ase mlze byt Eaii?elf\y pogze jgden vr.novieE klip. Pri vykot\u op.erfe\cevz
- Syntaxe startDrag zustava movie klip tazitelny, dokud neni explicitné
. Cus zastaven akci stopDrag, nebo dokud neni volana akce startDrag
_soundbuftime = celé Cislo; oro jiny movie Kip.
Argumenty Priklad i C . 5 . . o . sax
celé &islo Podet sekund pred tim, nez animace zaéne téct. Pro vytvoreni movie klipu, ktery mohou uzivatelé umistit do jakéhokoliv umisténi,
’ pfipojte uvnitf animace akce startDrag a stopDrag k tlacitku nasledovné:
Popis on (press) {

. [ (i x . , tartD "ot ;
Vlastnost (vSeobecnd); udava pocet sekund, o které se tekouci zvuk prebuffer startDrag ( rue)

(zadrzi pfenasena data ve vyrovnavaci pameéti). Nastavena hodnota je 5 sekund. !

on (release) {
stopDrag() ;

Pfehravac }

Flash 4 nebo nové;si.
Viz také
stopDrag
_droptarget
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stop

Syntaxe
stop;

Argumenty
Z4dné.

Popis
Akce; zastavuje aktualné hrajici animaci. Nejbézné;jsi poucziti této akce je pro ovladani
movie klipu tlacitky.

Pfehravac
Flash 3 nebo novéjsi.

stopAllSounds

Syntaxe
stopAllSounds () ;

Argumenty
Z4dné.

Popis

Akce; zastavuje vSechny zvuky aktudlné hrajici v animaci, bez zastaveni hraci hlavy.
Zvuky nastavené pro tok, budou pokraCovat v hrani pfi pohybu hraci hlavy pfes
snimky, ve kterych jsou umistény.

Pfehravac
Flash 3 nebo novéjsi.

Priklad
Nasledujici kéd by byl pouzit na tlacitko, na které kdyz se klikne, zastavi vSechny
zvuky v animaci:
on (release) {
stopAllSounds () ;
}

Viz také
Sound
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stopDrag

Syntaxe
stopDrag() ;

Argumenty
Z4dné.

Popis
Akce; zastavuje aktudlni operaci tazeni.

Pfehravac¢
Flash 4 nebo novejsi.

Priklad
Tato zprava zastavuje akci taZzeni na instanci mc, kde uzivatel uvolni tlacitko mysi:
on (press) {
startDrag("mec") ;
}
on (release) {
stopDrag() ;
}

Viz takeé
startDrag
_droptarget
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String (function)

Syntaxe

String(vyraz);

Argumenty

vyraz Cislo, Booleanska, proménna nebo objekt, ktery se ma konvertovat
na retézec.

Popis

Funkce; udava retézcovou reprezentaci specifikovaného argumentu nasledovné:
Jestlize je x Booleovskad, obdrzeny retézec je true nebo false.

Jestlize je x Cislo, obdrzeny retézec je decimalni reprezentace Cisla.

Jestlize je x retézec, obdrzeny retézec je x.

Jestlize je x objekt, obdrzena hodnota je retézcova reprezentace objektu generovaného
volanim retézcové vlastnosti pro objekt nebo volanim object. toString, pokud
ale zadna takova vlastnost neexistuje.

Jestlize je x movie klip, obdrzend hodnota je cilova cesta movie klipu v zavorkdch (/).

Jestlize x neni definovdno, obdrZzena hodnota je prazdny retézec.

Pfehravac
Flash 3 nebo novéjsi.

Viz také
Object.toString
Number. toString
String (object)

"" (string delimiter)

“ « (string delimiter)

Syntaxe
~text™

Argumenty
text Jakykoliv text.

Popis

Retézcovy delimitdtor (string delimiter); kdyz je pouzity pred a za fetézcem, citaéni
znaménka indikuji, Ze je fetézec pismenny --- ne proménna, numerickd hodnota
nebo jiny ActionScript prvek.

Pfehravac
Flash 4 nebo novéjsi.

Priklad

Tato zprdva pouziva citani znaménka pro indikaci, ze fetézec ,Ostrov Prince Edwarda“
je pismenny fetézec a ne hodnota proménné:

provincie = ,Ostrov Prince Edwarda"“

Viz také
String (object)
String (function)
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String (object) Prehled viastnosti pro objekt String

Objekt String (Retézec) je obal pro fetézec pdvodniho typu dat, ktery umoZfiuje pouzivat
metody a vlastnosti objektu String k manipulaci s ptvodnimi typy fetézcovych hodnot. Metoda Popis

Pouzitim funkce String() muZete konvertovat hodnotu jakéhokoliv objektu na retézec. length Udavé délku fetézce.

VSechny metody objektu String, kromé concat, fromCharCode, slice a substr, jsou
generické. To znamend, e metody samotné volaji this.toString pred tim, neZ provedou Konstruktor pro objekt String
své operace a tyto metody miZete pouzivat s dal$imi ne-Retézcovymi objekty. Syntaxe
new String (hodnota) ;
Metody objektu String, mizZete volat pouzitim konstrukéni metody new String, nebo pouZitim

fetézcové pismenné hodnoty. Jestlize specifikujete pismenny fetézec, ActionScript interpreter Argumenty
ho automaticky konvertuje na dogasny objekt String, vold metodu a potom dogasny objekt hodnota Pdvodni hodnota nového objektu String.
String odlozi. S pismennym retézcem mdiizete pouzit také vlastnost String. length.
Popis
Je dilezité, abyste si nepletli pismenny Fetézec s instanci objektu String. V nasledujicim Konstruktor; vytvaii novy objekt String.
pfikladé prvni fadek kddu vytvari pismenny fetézec s1 a druhy radek kédu vytvafi instanci
objektu String s2. Pfehravac
sl = “foo“ Flash 5 nebo novéjsi.
s2 = new String(“foo")
Viz také
Je doporucovéno, abyste pouzivali pismenné retézce, pokud specificky nepotrebujete String (function)
pouzit objekt String, protoZe objekty String mohou mit kontraintuitivni chovani. * % (string delimiter)
Pfehled metod objektu String
String.charAt
Metoda Popis Sytltaxe .
mujRetezec.charAt (index) ;
charAt Udava &islo korespondujici s umisténim znaku v retézci.
charCodeAt Udéava hodnotu znaku na daném indexu jako 16-bitové celé ¢islo mezi 0 a 65535. Argumenty
concat Kombinuie text dvou fetézcil a uddva novy fetézec. index Cislo znaku v fetézci, ktery ma byt udan.
fromCharCode Udava fetézec vytvoreny ze znakl specifikovanych v argumentech.
indexOf Hledd Fetézec a udavd index hodnoty specifikované v argumentech. Popis
Jestlize se hodnota objevi vice nez jednou, je udan index prvniho vyskytu. Metoda; udava znak specifikovany argumentem index. Index prvniho znaku v fetézci

Jestlize neni hodnota nalezena, je udéno -1.
Udava posledni vyskyt podretézce uvnitf fetézce, kiery se objevi pred pocatecni

je 0. Jestlize index neni Cislo od 0 do string.length -1, je uddn prazdny fetézec.

lastIndexOf pozici specifikovanou v argumentu nebo uda -1, jestlize neni nalezen.
slice Vytahuje Cast fetézce a udava novy retézec. Piehravaé
split Rozdéluje objekt String na pole fetézcl oddélenim fetézcl na subfetézce. Flash 5 nebo novéjél'.
substr Udava specifikovany pocet znaku v retézci, za¢inajici na umisténi
specifikovaném v argumentu.
substring Uddva znaky mezi dvéma indexy specifikovanymi v argumentech do retézce.
toLowerCase Konvertuje fetézec na mald pismena a uddva vysledek.
toUpperCase Konvertuje retézec na velkd pismena a udava vysledek.
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String.charCodeAt

Syntaxe
mujRetezec.charCodeAt(index);

Argumenty
index Cislo znaku, pro ktery je ziskdna hodnota.

Popis
Metoda; udava hodnotu znaku specifikovaného indexem. ObdrZzena hodnota
je 16-bitove celé Cislo od 0 do 65535.

Tato metoda je podobna string.charAt az na to, Ze obdrzena hodnota je pro
znak na specifickém umisténi, namisto retézce obsahujiciho znak.

Pfehravac
Flash 5 nebo novéjsi.

String.concat

Syntaxe
mujRetezec.concat(hodnotai,...hodnotaN) ;

Argumenty
hodnota1,...hodnotaN  Nula nebo vice hodnot, které maji byt spojeny.

Popis

Metoda; kombinuje specifikované hodnoty a udava novy fetézec. Jestlize je to nezbytné,
kazdy argument hodnota je konvertovan na fetézec a pfipojen, podle poradi na konec
fetézce.

Pfehravac
Flash 5 nebo novéjsi.
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String.fromCharCode

Syntaxe
mujRetezec.fromCharCode(c1,c2,...cN) ;

Argumenty
c1,c2,..cN Znaky, které maji byt pfedélany na fetézce.

Popis
Metoda; udava fetézec vytvoreny ze znak(l specifikovanych v argumentech.

Pfehravac
Flash 5 nebo noveéjsi.

String.indexOf

Syntaxe
mujRetezec. indexOf (hodnota) ;
mujRetezec. indexOf (hodnota, start);

Argumenty

hodnota Celé Cislo nebo rfetézec urcujici podretézec, ktery ma byt nalezen
uvniti mujRetezec.

start Celé ¢islo specifikujici po¢atecni bod podretézce. Tento argument
je volitelny.

Popis

Metoda; hleda fetézec a udava pozici prvniho vyskytu specifikované hodnoty.
Jestlize hodnota neni nalezena, metoda uda -1.

Piehravac
Flash 5 nebo novéjsi.
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String.lastindexOf

Syntaxe

mujRetezec.lastIndex0Of(substring);
mujRetezec.lastIndexOf(substring, start) ;

Argumenty

substring (podretézec) Celé Cislo nebo retézec specifikujici retézec, ktery ma
byt nalezen.

start Celé ¢islo urcujici pocatecni bod uvnitf podretézce. Tento
argument je volitelny.

Popis

Metoda; hleda retézec a udava index posledniho vyskytu podietézce nalezeného
uvnitr volaného retézce. Jestlize podietézec neni nalezen, metoda uda -1.

Pfehravac
Flash 5 nebo novéjsi.

String.length

Syntaxe
string.length

Argumenty
Z4dné.

Popis
Vlastnost; udava pocet znak( ve specifikovaném objektu String. Index posledniho
znaku pro jakykoliv fetézec je x.délka-1.

Pfehravac
Flash 5 nebo novéjsi.
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String.slice

Syntaxe
mujRetezec.slice(start, end);

Argumenty

start Cislo ur€ujici index poc¢atecniho bodu pro vyrez. Jestlize je start
zaporné Cislo, pocatecni bod je uréen od konce fetézce, kde -1
je posledni znak.

end Cislo uréujici index posledniho bodu pro vyiez. Jestlize neni end
specifikovan, vyrez zahrnuje vSechny znaky od startu do konce
fetézce. Jestlize je end zaporné Cislo, konecny bod je uren od konce
fetézce, kde -1 je posledni znak.

Popis

Metoda; vytahuje vyfez nebo subfetézec specifikovaného objektu String; potom
ho udava jako novy fetézec bez modifikace plvodniho objektu String. Obdrzeny
fetézec zahrnuje znak start a vSechny znaky aZ do (ne véetné) znaku end.

Pfehravac
Flash 5 nebo noveéjsi.

String.split

Syntaxe
mujRetezec . split(delimiter);

Argumenty
delimiter Znak pouzity pro delimitaci retézce.

Popis

Metoda; rozdéluje objekt String rozdélenim fetézce tam, kde se objevi argument
delimiter a udava subfetézce v poli. Jestlize neni specifikovan zadny delimitator,
obdrzené pole obsahuje pouze jeden prvek - samotny retézec. Jestlize je delimitator
prazdny fetézec, kazdy znak v objektu String se stava prvkem v poli.

Pfehravac
Flash 5 nebo noveéjsi.
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String.substr

Syntaxe
mujRetezec.substr(start, length) ;

Argumenty

start Celé cislo, které indikuje pozici prvniho znaku v subfetézci, ktery
je vytvaren. Jestlize je start zaporné cislo, po¢ate€ni pozice
je ur€ena od konce fetézce, kde -1 je posledni znak.

length Pocet znak( v subfetézci, ktery je vytvaren. Jestlize délka nenfi
specifikovana, subfetézec zahrnuje vSechny znaky od startu do
konce fetézce.

Popis

Metoda; udava znaky v fetézci od indexu specifikovaného v argumentu start
az s poctem znakl ur¢enym v argumentu length.

Pfehravac
Flash 5 nebo novéjsi.

Sring.substring

Syntaxe
mujRetezec.substring(from, to) ;

Argumenty

from (od) Celé cislo, které indikuje pozici prvniho znaku v subfetézci, ktery
je vytvaren. Platné hodnoty jsou od 0 do string.length -1.

to (do) Celé Cislo, které ja 1+index posledniho znaku v subretézci, ktery
je vytvaren. Platné hodnoty jsou od 1 do string.length.
Jestlize neni specifikovan argument do, konec subretézce je konec
fetézce. Jestlize se od rovna do, metoda uda prazdny fetézec.
Jestlize je od vetsi nez do, argumenty jsou automaticky vymeénény
pfed tim, nez se vykona funkce.

Popis

Metoda; udava retézec sestavaji ze znakd mezi body specifikovanymi argumenty
od a do.

Pfehravac
Flash 5 nebo novéjsi.

266

ACTION SCRIPT - FLASH 5

String.toLowerCase

Syntaxe
mujRetezec. toLowerCase () ;

Argumenty
Z4dné.

Popis
Metoda; udava kopii pro objekt String, se vSemi velkymi znaky konvertovanymi na
pismena mala.

Pfehravac
Flash 5 nebo novéjsi.

String.toUpperCase

Syntaxe
mujRetezec . toUpperCase () ;

Argumenty
Z4dné.

Popis
Metoda; udava kopii objektu String, se vSemi malymi znaky konvertovanymi na
velka pismena.

Pfehravac
Flash 5 nebo noveéjsi.
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substring

Syntaxe
substring(fetézec, index, pocet) ;

Argumenty

retézec Retézec, ze kterého se ma vytahnout novy retézec.

index Cislo prvniho znaku, ktery se ma vytahnout.

pocet Pocet znakd, které se maji zahrnout do vytazeného retézce,
nezahrnuje znak index.

Popis

Retézcova funkce; vytahuje &ast fetézce.

Prfehravac¢
Flash 4 nebo novéjsi. Tato funkce byla zavrzena ve Flash 5.

Viz takeé
String.substring

_target

Syntaxe
instancejméno._target

Argumenty

instancejméno Jméno movie klip instance.

Popis
Vlastnost (pouze pro ¢teni); uddva cilovou cestu instance movie klipu specifikované
v argumentu instancejméno.

Pfehravac¢
Flash 4 nebo novéjsi.

targetPath

Syntaxe
targetPath(movieClipObject) ;

Argumenty
movieClipObject Odkaz (napfiklad _root nebo _parent) na movie klip,

pro ktery je ziskavdna cilova cesta.

Popis

Funkce; udava fetézec obsahuijici cilovou cestu movieClipObject. Cilova cesta je
obdrzena v dot (teCkové) notaci. Pro ziskani cilové cesty ve slash (lomitkové)
notaci pouzijte vlastnost _target.

Piehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici priklady jsou ekvivalentni. Prvni priklad pouziva te¢kovou notaci a druhy
pfiklad pouzivd slash notaci.

targetPath (Tabule.Blok[index*2+1]) {

play();

}

Je ekvivalentni k:

tellTarget (,Tabule/Blok:“+ (index*2+1)) {
play() ;

}

Viz také
eval
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tellTarget

Syntaxe
tellTarget(cil) {
ptikaz;

}

Argumenty
cil Cilova cesta fetézce urcujici Casovou osu, ktera bude kontrolovana.

pfikaz Instrukce aplikované k cilované Casové ose.

Popis

Akce; aplikuje instrukce specifikované v argumentu pfikaz, na Casovou osu uréenou
v argumentu cil. Akce tellTarget je uziteCnd pro navigaéni kontroly. Pfipojte
tellTarget k tlacitkdm, které zastavuji nebo startuji movie klipy kdekoliv na Scéné.
Také mUzete udélat to, aby movie klipy Sly na urcity snimek v tomto klipu. Napfiklad
mUzete pfipojit tellTarget k tlacitklim, které zastavuiji nebo startuji movie klipy
na Scéné nebo pobidnout movie Klipy, aby skocily na urcity snimek. Akce tellTarget
je velmi podobna akci with, s tim rozdilem, Ze with ma jako cil movie klip nebo
jiny objekt, a tellTarget vyZaduje cilovou cestu k movie klipu a nem(Ze kontrolovat
objekty.

Pfehravac¢
Flash 3 nebo novéjsi. Tato akce je ve Flash 5 zavrzena; je doporu¢eno pouzivat
akci with.

Priklad
Tento piikaz tellTarget kontroluje instanci movie klipu mic na hlavni Casové ose.
Snimek 1 movie klipu je prazdny a ma akci stop, aby nebyl viditelny na Scéné.
Kdyz je kliknuto na tlacitko s nasledujici akci, tellTarget urci, aby hraci hlava
v movie klipu mic Sla na snimek 2 a hrala animaci, kterd zde zacina.
on (release) {

telltarget (,mic") {

gotoAndPlay (2) ;

}
}
Viz také
with

this

Syntaxe
this

Argumenty
Z4dné.

Popis

Klicové slovo; odkazuje na objekt nebo instanci movie klipu. Klicové slovo this ma
stejny ucel a funkci v ActionScript jako v JavaScript, s dodate¢nou funkCnosti.
V ActionScript, kdyz se skript vykond, this odkazuje na instanci movie klipu, ktera
sskript obsahuje. This obsahuje odkaz na objekt, ktery obsahuje vykonanou
metodu pokud je pouzito s vyvolanim metody,.

Pfehravac
Flash 5 nebo novéjsi.

Priklad
V nasledujicim prikladé kliCové slovo this odkazuje na objekt Circle:
function Circle(radius) {

this.radius = radius;

this.area = math.PI * radius * radius;

}

V nasledujicim pfikazu pfipojenému ke snimku, kli¢ové slovo this odkazuje
na aktualni movie klip:

//nastaveni vlastnosti alfa aktudlniho movie klipu na 20.
this._alpha=20;

V nasledujicim pfikazu uvnitf ovladace onClipEvent, kliCové slovo this odkazuje
na aktualni movie klip:

//kdyz se movie klip natahne, je inicializovana funkce startDrag pro aktualni
movie klip.
onClipEvent (load) {
startDrag (this, true);
}

Viz také

new
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toggleHighQuality

Syntaxe
toggleHighQuality () ;

Argumenty
Z4dné.

Popis

Akce; zapina a vypind antialiasing ve Flash Prehravaci. Antialiasing vyhlazuje okraje
objektl a zpomaluje playback. Akce toggleHighQuality ovliviiuje vSechny
animace ve Flash Prehravaci.

Pfehravac
Flash 2 nebo novéjsi.

Priklad
Nasledujici kdd by mohl byt aplikovan na tlacitko, které, kdyz se na néj klikne, zapne
nebo vypne antialiasing:
on (release) {
toggleHighQuality () ;

Viz také

_quality
_highquality

_totalframes

Syntaxe
instancejméno._totalframes

Argumenty
instancejméno Jméno movie klipu, ktery ma byt ohodnocen.

Popis

Vlastnost (pouze pro ¢teni); chodnocuje movie klip specifikovany v argumentu
instancejméno a udava celkovy pocet snimkl v animaci.

Pfehravac¢
Flash 4 nebo nové;si.

trace

Syntaxe

trace(vyraz);

Argumenty

vyraz Vyraz pro ohodnoceni. Kdyz pouzivate v animaci texty, vysledky
argumentu vyraz jsou zobrazeny v okné Output.

Popis

Akce; ohodnocuije vyraz a zobrazuje vysledky do okna Output, v rezimu test animace.

Akci trace pouzijte pro nahrdni programovacich poznamek, nebo pro zobrazeni
zprav k okné Output, pokud testujete animaci. PouZijte parametr vyraz pro kontrolu,
zda podminka existuje nebo pro zobrazeni hodnot v okné Output. Akce trace
ja podobnad funkci alert v JavaScript.

Pfehravac¢
Flash 4 nebo novéjsi.

Priklad

Tento priklad je ze hry, ve které musi byt taZitelnd instance movie klipu pojmenovana
zajic uvolnéna na specificky cil. Podminkovy vyraz ohodnoti viastnost _droptarget
a vykona rGzné akce v zavislosti na tom, zda zajic je uvolnén. Akce trace
je pouzita na konci skriptu pro ohodnoceni umisténi movie klipu zajic a zobrazi
vysledky v okné Output. Jestlize se zajic nechova, tak, jak se oCekavalo (napriklad,
jestlize se chyti na Spatny cil), hodnoty poslané do okna Output pomoci akce trace
vdm pomohou urcit problém ve skriptu.

on (press) {

zajic.startDrag();

}

on (release) {
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if (eval (_droptarget) !'= target) {
zajic._x = zajic_x;
zajic._y = zajic_y;

lelse {

zajic_x = zajic._x;

zajic_y = zajic._y;

target = "_root.pastvina";

}

trace("zajic_y = " + zajic_y);

trace("zajic_x = " + zajic_x);

stopDrag() ;

}
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typeof

Syntaxe
typeof(vyraz);

Argumenty
vyraz Retézec, movie klip, objekt nebo funkce.

Popis

Operator; unarni (jednoclenny) operator umistény pred samostatnym argumentem.
ZpUsobuije, Ze Flash ohodnoti vyraz; vysledkem je fetézec specifikujici, zda je vyraz
fetézec, movie klip, objekt nebo funkce.

Pfehravac
Flash 5 nebo novéjsi.

unescape

Syntaxe
unescape (x) ;

Argumenty
X Retézec s hexadecimalnimi sekvencemi pro uniknuti.

Popis

Funkce nejvy$si Urovné; ohodnocuje argument x jako fetézec, dekdduje retézec
z URL-zakddovaného formatu (konvertuje vS§echny hexadecimalni sekvence do ASCII
znakUl), a udava fetézec.

Prehravaé
Flash 5 nebo novéjsi.

Priklad
Nasledujici pfiklad ilustruje proces konverze escape -na- unescape.
escape (,Hello{ [World]}") ;

Vysledek je nasledujici:
(,Hello%$7B%$5BWorld%5D%$7D"Y) ;

Pouzijte unescape pro vraceni do pivodniho formatu:
unescape (,Hello%$7B%5BWorld%5D%7D")

Vysledek je nasleduijici:
Hello {[World]}
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unloadMovie

Syntaxe
unloadMovie (umisténi) ;

Argumenty

umisténi Uroveri hloubky nebo cilovy movie klip, ze kterého se md animace
stahnout.

Popis

Akce; odstraruje animaci z Flash Prehravace, ktera bylo predtim natazena pouzitim
akce loadMovie.

Pfehravac
Flash 3 nebo noveéjsi.

Priklad
Nasledujici pfiklad stahuje hlavni animaci a zanechava Scénu prazdnou:
unloadMovie (_root);

Nasledujici pfiklad stahuje animaci na Urovni 15, kdyz uZivatel klikne na mys:
on (press) {
unloadMovie (_levell5);

}

Viz také
loadMovie
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updateAfterEvent

Syntaxe
updateAfterEvent(movie klip udalost);

Argumenty
movie klip udalost Mdzete specifikovat jednu z nasledujicich hodnot jako

movie klip udalost:

mouseMove Akce je inicializovana pfi kazdém pohybu mysi. Pouzijte
vlastnosti _xmouse a _ymouse k uréeni aktudlni pozice
mysi.

mouseDown Akce je inicializovana, jestlize je stisknuto levé tlacitko mysi.

mouseUp Akce je inicializovana, jestlize je levé tlacitko mysi uvolnéno.

keyDown Akce je inicializovana, jestlize je stisknuta klavesa. Pouzijte
metodu Key . getCode pro ziskani informace o naposledy
stisknuté klavese.

keyUp Akce je inicializovana, jestlize je klavesa uvolnéna. Pouzijte
metodu Key . getCode pro ziskani informace o naposledy
stisknuté klavese.

Popis

Akce; updatuje display (nezavisle na nastaveni snimk{ za sekundu v animaci) po
dokonceni klip udalosti specifikované v argumentech. Tato akce neni v seznamu
panelu Flash Akce. Pouziti updateAfterEvent s akcemi taZeni (drag), které
specifikuji vlastnosti _x a _y béhem pohybu mysi, vdam umoznuje pretahovat
objekty hladce, bez efektu tfepotani obrazovky.

Pfehravac
Flash 5 nebo novéjsi.

Viz take
onClipEvent
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_url
Syntaxe
instancejméno._url
Argumenty
instancejméno Cilovy movie Klip.
Popis
Vlastnost (pouze pro ¢teni); ziskava URL SWF souboru, ze kterého byl stazen
movie klip.
Pfehravac
Flash 4 nebo novejsi.

var
Syntaxe
var proménnaJménoi [ = hodnota1 ] [...,proménnaJménoN [ = hodnotaN ]];
Argumenty
proménnaJméno Jméno proménné, kterd se ma deklarovat.
hodnota Hodnota prifazena k proménné.
Popis
Akce; pouziva se pro deklaraci lokalnich proménnych. Jestlize deklarujete lokalni
proménné uvnitf funkce, proménné jsou definovany pro funkci a zanikaji na konci
volani funkce. Jestlize proménné nejsou deklarovany uvnitf bloku, ale seznam akce
byl vykonan pomoci akce call, proménné jsou lokalni a zanikaji na konci aktualniho
seznamu. Jestlize proménné nejsou deklarovany uvnitf bloku a aktudlni seznam
akce nebyl vykondan pomoci akce call, proménné nejsou lokalni.
Pfehravac
Flash 5 nebo novéjsi.
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_visible

void

Syntaxe
instancejméno._visible
instancejméno._visible = Booleovska;

Argumenty

Booleovska Vlozte hodnotu true nebo false, abyste urcili, zda je
movie klip viditelny.

Popis

Vlastnost; uréuje, zda je nebo neni animace specifikovana argumentem instancejméno
viditelné. Movie klipy, které nejsou viditelné (vlastnost nastavena na false) jsou
nedosaZitelné. Napfiklad na tlaCitko v movie klipu s vlastnosti _visible nastavenou
na false, nemiZe byt kliknuto.

Pfehravac
Flash 4 nebo novéjsi.

Syntaxe
void(vyraz);

Argumenty
vyraz Vyraz jakékoliv hodnoty.

Popis

Operator; undrni operdtor, ktery vyrazuje hodnotu vyrazu a udava nedefinovanou
hodnotu. Operdtor void je asto pouzivan pro ohodnoceni URL, aby se testovaly
efekty stran bez zobrazeni ohodnoceného vyrazu v okné browseru. Operator void
je také pouzivdn ve srovnanich za pouZiti operdtoru == pro testovani nedefinovanych
hodnot.

Pfehravac
Flash 5 nebo novéjsi.

Syntaxe

while (podminka) {
pEtikaz(y);

}
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Argumenty

podminka Ptikaz, ktery je ohodnocen pokazdé, kdyz je vykondna akce while.
Jestlize se piikaz ohodnoti na true, béZi vyraz v prikazu.

pfikaz(y) Vyraz, ktery ma béZet, jestlize je podminka ohodnocena na true.

Popis

Akce; bézi pfikaz nebo série prikazd opakovanych ve smycéce, pokud je argument
podminka true. Na konci kazdé akce while Flash restartuje smyc¢ku opakovanym
testovanim podminky. Jestlize je podminka false nebo rovna 0, Flash sko¢i na prvni
pfikaz za akci while.

Smyckovani je bézné pouzivano pro vykonani akce, zatimco je pocitadlo proménné
mensi nez ur¢ena hodnota. Na konci kazdé smycky je pocitadlo zvySeno, dokud
neni dosazeno prahové hodnoty, podminka uz neni true a smycka konci.

Pfehravacé
Flash 4 nebo novéjsi.

Priklad
Tento priklad duplikuje pét movie klipl na Scéné, kazdy s nahodné generovanou
X ay pozici, xscale ayscale a vlastnosti _alpha pro dosazeni efektu rozptyleni.
Proménna foo je inicializovana s hodnotou 0. Argument podminka je nastaven
tak, Zze smyCka while pobézi pétkrat nebo dokud je hodnota proménné foo mensi
nez 5. Uvnitf smycky while je duplikovdn movie klip a setProperty je pouzito
pro Upravu riznych vlastnosti duplikovaného movie klipu. Posledni piikaz smycky
zvySuje foo tak, Ze kdyz hodnota dosdhne 5, argument podminka se ohodnoti na
false a smycka nebude vykondna.
on (release) {
foo = 0;
while (foo < 5){
duplicateMovieClip("/flower", "mc"+foo, foo);
setProperty ("mc"+foo, _x, random(275));
setProperty ("mc"+foo, _y, random(275));
setProperty ("mc"+foo, _alpha, random(275)) ;
setProperty ("mc"+foo, _xscale, random(200));
setProperty ("mc"+foo, _yscale, random(200));
foo = foo + 1;
}
}

Viz také

do..while
continue
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_width

Syntaxe
instancejméno._width
instancejméno._width = hodnota;

Argumenty

hodnota Sitka movie v pixelech.

instancejméno Jméno instance movie klipu, pro ktery ma byt nastavena nebo
ziskana vlastnost _width.

Popis

Vlastnost; nastavuje Sifku animaci. V prfedchozich verzich Flash byly vlastnosti
height a_width pouze pro ¢teni; ve Flash 5 mohou byt nastaveny, stejné tak
jako ziskany.

Pfehravac¢
Flash 4 jako vlastnost pouze pro ¢teni. Ve Flash 5 nebo novéjsim, mlze byt tato
vlastnost nastavena stejné tak jako ziskana.

Priklad
Nasledujici pfiklad kddu nastavuje viastnosti vyska a Sitka movie klipu, kdyz uzivatel
klikne na mys:
onClipEvent (mouseDown) {
_width=200;
_height=200;
}

Viz take
_height
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with
Syntaxe
with (objekt){
prikaz(y) ;
}
Argumenty
objekt Instance ActionScript objektu nebo movie klip.
pfikaz(y) Akce nebo skupina akci vioZzenych do slozenych zavorek.
Popis
Akce; docasné meéni rozsah (nebo dilovou cestu) pouzity pro ohodnoceni vyraz(
a akci v pfikazu(ech). Poté, co se akce with vykond, rozsah fetézce je obnoven do
plvodniho stavu.
Objekt se stava kontextem, ve kterém jsou Cteny vlastnosti, proménné a funkce.
Napriklad, jestlize objektem je myArray a dvé z urCenych vlastnosti jsou 1length
a concat, jsou tyto vlastnosti automaticky Cteny jako myArray.length
amyArray.concat. V jiném pfikladé, jestlize je objekt stat.california, je to jako
by byly volany jakékoliv akce nebo pfikazy uvnitf akce with, zevnitf instance
california.
Pro nalezeni hodnoty identifikdtoru v pfikazu(ech) zacina ActionScript na zacatku
rozsahu fetézce specifikovaného objektem a hleda identifikator na kazdé urovni
rozsahu fetézce v urcitém poradi.
Rozsah retézce je pouzit akci with pro vyreSeni toho, aby identifikatory zacinali
prvni polozkou v nasledujicim seznamu a pokracovali k posledni nasledovneé:
objekt odkazovany nejvice vnitfni akci with
objekt odkazovany nejvice vnéjsi akci with
Aktivaéni objekt (DoCasny objekt, ktery je automaticky vytvoren pfi volani funkce,
ktera obsahuje lokalni proménné volané ve funkci.)
Movie klip obsahuijici aktualné vykonavany scénar
Globalni objekt (pfeddefinované objekty jako Math, String)
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Ve Flash 5 akce with nahrazuje zavrzenou akci tellTarget. Je doporu¢eno
pouzivat with namisto tellTarget, protozZe je to standardni rozsifeni ActionScriptu
na ECMA-262 standard. Principialni rozdil mezi akcemi with a tellTarget je ten,
Ze with bere odkaz na movie klip nebo jiny objekt jako svij argument, zatimco
tellTarget ma fetézec cilova cesta identifikujici movie klip a nemdize byt pouzita
pro cilovani objektd. Pro nastaveni proménné uvniti' akce with musi byt proménna
deklarovana mimo akci with nebo musite vioZit celou cestu do Casové osy na
které ma proménna byt. Jestlize nastavite proménnou v akci with bez jejiho
deklarovani, akce with bude hledat hodnotu vzhledem k rozsahu retézce. Jestlize
proménnd jesté neexistuje, nova hodnota bude nastavena na Casové ose, ze které
je akce with voldna.

Priklad

Nasledujici pfiklad nastavuje vlastnosti x a y instance nejakyJinyMovieKlip
a potom instruuje nejakyJinyMovieKlip, aby Sel na snimek 3 a zastavil se:
with (nejakyJinyMovieKlip) {

_x = 50;
_y = 100;
gotoAndStop (3) ;

Nasledujici kousek kddu ukazuje, jak byste napsali predchozi kdd bez pouziti akce
with:

nejakyJinyMovieKlip. x = 50;

nejakyJinyMovieKlip. y = 100;

nejakyJinyMovieKlip. gotoAndStop (3);

Tento kdd by také mohl byt napsan pomoci pouziti akce tellTarget:
tellTarget (,nejakyJinyMovieKlip"“) {

_x = 50;

_y = 100;

gotoAndStop (3);
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Akce with je uzite€na pro simultanni dosazeni nékolika polozek v seznamu rozsahu
fetézce. V nasleduijici prikladu je zabudovany objektu Math umistén pfed rozsah
fetézce. Nastaveni Math jako dany objekt vyresi identifikatory cos, sin a PI na
Math.cos,Math.sin aMath.PI. Identifikdtory a, x, y a r nejsou metody
nebo vlastnosti objektu Math, ale protoZe existuji v aktivaénim rozsahu objektu
funkce polar, vyresi se ke korespondujicim lokalnim proménnych.
function polar(r) {

var a,x,y

with (Math) {

a=PI *r *r

X = r * cos(PI)
y = r * sin(PI/2)
}
trace(“oblast = “ + a)

trace(“x = “ + x)
trace('y = “ + y)
}

Uhnizdéné akce with miZete pouzit pro dosazeni informace v nékolika prostorech.
V nasledujicim pfikladu instance £resno a instance salinas jsou déti instance
california. Zpréva nastavuje hodnoty _alpha instanci fresno a salinas bez
zmény hodnoty _alpha instance california.
with (california) {
with (fresno) {
_alfa = 20;
}
with (salinas){
_alfa = 40;

Viz také
tellTarget
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Syntaxe
instancejméno._x
instancejméno._x = celé ¢islo

Argumenty

celé cislo Lokalni souradnice x movie.
instancejméno Jméno movie klip instance.
Popis

Vlastnost; nastavuje souradnici x movie relativné k lokalnim souradnicim rodi€ovského
movie klipu. Jestlize je movie Klip na hlavni Casové ose, potom jeho systém souradnic
odpovida hornimu levému rohu Scény jako (0,0). Jestlize je movie klip uvnitf jiného
movie klipu, ktery ma transformace, movie klip je v lokalnim systému souradnic
vlozeného movie klipu. Tedy, pro movie klip oto¢eny 90° proti sméru hodinovych
ruciCek, zdédi dité movie klipu systém souradnic, ktery je otoCen o 90° proti sméru
hodinovych ruci¢ek. Souradnice movie klipu odpovidaji pozici registracniho bodu.

Pfehravac
Flash 3 nebo novéjsi.

Viz také
Y

_xscale

XML (object)
Metody a vlastnosti XML objektu pouzijte pro natazeni, analyzu, poslani, vytvofeni a manip-
ulaci se stromy XML dokumentu.

XML je podporovan Flash 5 a pozdéjSimi verzemi Flash Prehravace.

Pfehled metod objektu XML

Musite pouzit konstruktor new XML () pro vytvofeni instance XML objektu pred tim, nez
volate jakékoliv metody XML objektu.

Metoda Popis

appendChild Pripojuje node na konec specifikovaného seznamu ditéte objektu.

cloneNode Klonuje specifikovany node a volitelné, rekurzivné klonuje vS§echny déti.

createElement Vytvari novy XML prvek.

createTextNode| Vytvaii novy XML textovy node.

hasChildNodes Udava true, jestlize specifikovany node ma détské nody; jinak udava false.

insertBefore Vkladd node pred existujici node ve specifikovaném seznamu ditéte node.

load Natahuje dokument (specifikovany XML objektem) z URL.

onLoad Funkce zpétného volani pro load a sendAndLoad.

parseXML Analyzuje XML dokument ve specifikovaném stromu XML objektu.

removeNode Odstrani specifikovany node z jeho rodice.

send Posila specifikovany XML objekt do URL.

sendAndLoad Posild specifikovany XML objekt do URL a natahuje odpovéd serveru do jiného
XML objektu.

toString Konvertuje specifikovany node a jakékoliv dité na XML text.
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PfFehled viastnosti pro XML objekt

Vybrany prehled pro XML objekt

Metoda Popis

docTypeDecl Nastavuje a udéva informaci o DOCTYPE deklaraci XML dokumentu.

firstChild Odkazuje prvni dité v seznamu na specifikovany node.

lastChild Odakzuje posledni dite v seznamu na specifikovany node.

loaded Kontroluje, zda byl specifikovany XML objekt natazen.

nextSibling Odkazuje na dal$iho sourozence v rodi¢ovském seznamu ditéte node.

nodeName Uddva jméno tagu XML prvku.

nodeType Udava typ specifikovaného node (XML prvek nebo textovy node).

nodeValue Uddva text specifikovaného node, jestlize je node textovy node.

parentNode Udava rodi¢ovsky node specifikovaného node.

previousSibling| Ud&va pfedchoziho sourozence v rodiovském seznamu ditéte node.
Udava numericky stav kodu udavajici Uspeéch nebo neuspéch operace

status analyzovani XML dokumentu.

xmlDecl Nastavuje a udava informaci o dokument deklaraci XML dokumentu.

Metoda Popis
attributes Uddva asocia¢ni pole obsahuijici vSechny atributy specifikovaného node.
childNodes Udava pole obsahujici odkazy na détské nody specifikovaného node.

Konstruktor pro XML objekt

Syntaxe
new XML() ;
new XML (source) ;

Argumenty
source XML dokument analyzovany pro vytvoreni nového XML objektu.

Popis
Konstruktor; vytvari novy XML objekt. Pro vytvoreni instance XML objektu pred tim,
nez volate jakoukoliv metodu XML objektu, musite pouzit konstrukéni metodu.

Prvni syntaxe konstruuje novy, prazdny XML objekt.
Druha syntaxe konstruuje novy XML objekt analyzou XML dokumentu specifikovaného

v argumentu source a osidluje nové vytvoreny XML objekt s vyslednym stromem
XML dokumentu.

Poznamka: Metody createTextNode a createTextNode jsou konstrukéni metody pro
vytvoreni prvk( a textovych nodd ve stromu XML dokumentu.

Pfehravac
Flash 5 nebo novéjsi.

Priklad
Nasledujici pfiklad vytvafi novy prazdny XML objekt:
myXML = new XML();

Viz také
XML . createTextNode
XML . createTextNode

XML.appendChild

Syntaxe
myXML.appendChild(childNode) ;

Argumenty

childNode Détsky node, ktery ma byt pfidan ke specifikovanému XML
seznamu ditéte objektu.

Popis

Metoda; pfipojuje specifikovany détsky node k XML seznamu ditéte objektu.
Pfipojeny détsky node je umistén ve stromoveé strukture, kdyz je odstranén ze svého
existujiciho rodi¢ovského node.

Pfehravac
Flash 5 nebo novéjsi.

Priklad
Nasledujici pfiklad klonuje posledni node z doc1 a pfipojuje ho k doc2:

docl = new XML (srcl);
doc2 = new XML();
node = docl.lastChild.cloneNode (true) ;

doc2.appendChild (node) ;
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XML.attributes

Syntaxe
myXML.attributes;

Argumenty

Zadné.

Popis
Vybér (Cist-psat); udava asociativni pole obsahuijici vSechny atributy specifikovaného
XML objektu.

Pfehravac
Flash 5 nebo novéjsi.

Priklad
Nasledujici priklad piSe jména XML atributl do okna Output:
str = "<mytag name=\"Val\"> polozka </mytag>";

doc = new XML (str);
y = doc.fristChild.attributes.name;

trace (y):
doc.firstChild.attributes.order = "first";
z = doc.firstChild.attributes.order

trace(z);

Do okna Output je psano ndsledujici:
Val
First
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XML.childNodes

Syntaxe
myXML . childNodes;

Argumenty
Z4dné.

Popis

Vybeér (pouze pro ¢teni); udava pole specifikovaného XML ditéte objektu. Kazdy prvek
v poli je odkaz na XML objekt, ktery reprezentuje détsky node. Toto je vlastnost
pouze pro ¢teni a nemUizZe byt pouzity pro manipulaci s détskymi nodes.

Pouzijte metody appendChild, insertBefore a removeNode pro manipulaci
s détskymi nodes.

Tento vybér neni definovan pro textové nodes (nodeTyp==3).

Pfehravac
Flash 5 nebo noveéjsi.

XML.cloneNode

Syntaxe
myXML.cloneNode(deep);

Argumenty

deep Booleovska hodnota specifikujici, zda jsou déti specifikovaného
XML objektu rekurzivné klonovany.

Popis

Metoda; konstruuje a udava novy XML node se stejnym typem, jménem, hodnotou
a atributy jako ma specifikovany XML objekt. Jestlize je deep nastaveno na true,
vSechny détskeé nody jsou rekurzivné klonovany, vysledkem je presna kopie plvodniho
stromu dokumentu objektu.

Pfehravac
Flash 5 nebo novéjsi.
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XML.createElement

Syntaxe
myXML.createElement(jméno);

Argumenty
jméno Jméno tagu XML prvku, ktery je vytvaren.

Popis

Metoda; vytvari novy XML prvek se jménem specifikovanym v argumentu. Novy prvek
nema plvodné Zadného rodice ani Zadné déti. Metoda udava odkaz na nove vytvoreny
XML objekt reprezentuijici prvek. Tato metoda a createTextNode jsou konstrukéni
metody pro vytvareni nodd pro XML objekt.

Pfehravac
Flash 5 nebo novéjsi.

XML.createTextNode

Syntaxe
myXML.createTextNode (text) ;

Argumenty
text Text pouzity pro vytvorfeni nového textového node.

Popis

Metoda; vytvarni novy XML textovy node se specifikovanym textem. Novy node
nema plvodné zadného rodiCe a textové nody nemohou mit déti. Tato metoda
udava odkaz na XML objekt reprezentujici novy textovy node. Tato metoda
a createElement jsou konstrukéni metody pro vytvareni nodd pro XML objekt.

Pfehravac
Flash 5 nebo novéjsi.
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XML.docTypeDecl

Syntaxe
myXML.docTypeDecl ;

Argumenty
Z4dné.

Popis

Vlastnost; nastavuje a udava informaci o XML DOCTYPE deklaraci dokumentu.
Poté, co byl XML text analyzovdn na XML objekt, je vlastnost XML objektu
XML .docTypeDecl nastavena na text XML DOCTYPE deklarace dokumentu.
Napfiklad <'DOCTYPE zdravi SYSTEM ,ahoj.dtd"“>. Tato vlastnost je sada
pouziti fetézcové reprezentace DOCTYPE deklarace, ne XML node objektu.

XML analyzator ActionScript neni analyzator potvrzujici platnost. DOCTYPE deklarace
je C¢tena analyzatorem a uloZena ve vlastnosti docTypeDecl, ale neni provedena
DTD validace.

Jestlize nedoslo k setkani se zadnou DOCTYPE deklaraci béhem operace analyzovani,
je XML . docTypeDecl nastaven na nedefinovany. XML. toString vyddva obsahy
XML . docTypeDecl okamzité poté, co je XML deklarace uloZena v XML . xm1Decl
a pred jakymkoliv dal§im textem v XML objetu. Jestlize je XML . docTypeDecl
nedefinovany, vystupem je zadna DOCTYPE deklarace.

Pfehravac
Flash 5 nebo noveéjsi.

Priklad

Nasledujici pfiklad pouzivd XML.docTypeDecl pro nastaveni DOCTYPE deklarace
pro XML objekt.

mujXML.docTypeDecl = “ <!DOCTYPE zdravi SYSTEM \ “ahoj.dtd \“> “;

Viz také
XML. toString
XML .xmlDecl
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XML.firstChild

Syntaxe
myXML. firstChild;

Argumenty
Z4dné.

Popis

Vlastnost (pouze pro ¢teni); ohodnocuje specifikovany XML objekt a odkazuje na
prvni dité v rodiCovském seznamu ditéte node. Tato vlastnost je null, jestlize
node nema déti. Tato vlastnost je nedefinovana, jestlize je node textovy node. Toto
je vlastnost pouze pro ¢teni a nemdze byt pouzita pro manipulaci s détskymi nody;
pro manipulaci s détskymi nody, pouzijte metody appendChild,
insertBefore a removeNode.

Pfehravac
Flash 5 nebo novéjsi.

Viz také

XML . appendChild
XM1.insertBefore
XML . removeNode

XML.hasChildNodes

Syntaxe
myXML . hasChildNodes () ;

Argumenty
Z&dné.

Popis
Metoda; ohodnocuje specifikovany XML objekt a udava true, jestlize tam jsou détské
nody; jinak udava false.

Pfehravac
Flash 5 nebo novéjsi.

Priklad
Nasleduijici priklad pouziva informaci z XML objektu ve funkci definované uZivatelem:
if (rootNode.hasChildNodes()) {

myfunc (rootNode.firstChild) ;
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XML.insertBefore

Syntaxe
myXML . insertBefore(childNode, beforeNode) ;

Argumenty

childNode Node, ktery ma byt viozen.

beforeNode Node pred bodem vlozeni pro childNode.
Popis

Metoda; vklada novy détsky node do XML seznamu ditéte objektu, pfed beforeNode.

Pfehravac
Flash 5 nebo novéjsi.

XML.lastChild

Syntaxe
myXML.lastChild;

Argumenty
Z4dné.

Popis

Vlastnost (pouze pro ¢teni); ohodnocuje XML objekt a odkazuje na posledni dité
v rodi¢ovském seznamu ditéte node. Tento zplsob udava null, jestlize node nema
déti. Toto je vlastnost pouze pro ¢teni a nemUize byt pouZita pro manipulaci s détskymi
nody; pro manipulaci s détskymi nody, pouzijte metody appendChild,
insertBefore a removeNode.

Pfehravac
Flash 5 nebo noveéjsi.

Viz také

XML . appendChild
XM1l.insertBefore
XML . removeNode
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XML.load

Syntaxe
myXML. load (url) ;

Argumenty

url Url, kde je umistén XML dokument, ktery se ma natdhnout. URL
musi byt ve stejné subdomeéneé jako URL, kde movie aktudiné sidli.

Popis

Metoda; natahuje XML dokument ze specifikovaného URL a nahrazuje obsahy
specifikovaného XML objektu daty natazeného XML. Proces natahovani je asynchronni;
nekonc¢i okamzité poté, co je vykonana metoda load. Kdyz je load vykonano,
vlastnost objektu loaded je nastavena na false. Kdyz XML data dokon¢i natahovani,
vlastnost loaded je nastavena na true a je vyvolana metoda onLoad. XML data
nejsou analyzovana, dokud nejsou kompletné natazena. Jestlize XML objekt predtim
obsahoval jakékoliv XML stromy, jsou vyrazeny.

Mdzete specifikovat svou vlastni funkci zpétného volani misto metody onLoad.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici je jednoduchym pfikladem pouziti XML . load:
doc = new XML();

doc.load(,theFile.xml") ;

Viz také
XML .onLoad
XML . loaded
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XML.loaded

Syntaxe
myXML. loaded;

Argumenty
Z4dné.

Popis

Vlastnost (pouze pro ¢teni); urCuje, zda proces natahovani dokumentu inicializovany
pomoci XML. load je dokoncen. Jestlize se proces Uspésné dokonc¢i, metoda
udava true; jinak udava false.

Pfehravac
Flash 5 nebo novéjsi.

Priklad
Nasledujici pfiklad pouziva XML . loaded v jednoduchém skriptu.
if (doc.loaded) {

gotoAndPlay (4)

XML.nextSibling

Syntaxe
myXML.nextSibling;

Argumenty
Z&dné.

Popis

Vlastnost (pouze pro ¢teni); ohodnocuje XML objekt a odkazuje na dalSiho sourozence
v rodiCovském seznamu ditéte node. Tato metoda uddva null, jestlize node
nema dals$i sourozenecky node. Toto je vlastnost pouze pro éteni a nemdize byt
pouzita pro manipulaci s détskymi nody. Pro manipulaci s détskymi nody, pouzijte
metody appendChild, insertBefore a removeNode.

Pfehravacé
Flash 5 nebo novéjsi.

Viz také

XML . appendChild
XML. insertBefore
XML . removeNode
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XML.nodeName

Zadné.

Syntaxe
myXML.nodeName ;

Argumenty

Popis

Vlastnost; bere nebo udava jméno node XML objektu. Jestlize je XML objekt XML
prvek (nodeType==1), je nodeName jméno tagu reprezentujiciho node v XML
souboru. Napfiklad TITLE je nodeName HTML tagu TITLE. Jestlize je XML objekt
textovy node (nodeType==3), nodeName je null.

Pfehravac
Flash 5 nebo novéjsi.

Viz také
XML .nodeType

XML.nodeType

Syntaxe
myXML.nodeType ;

Argumenty

Zadné.

Popis
Vlastnost (pouze pro ¢teni); bere nebo udava hodnotu nodeType, kde 1 je XML
prvek a 3 je textovy node.

Pfehravac
Flash 5 nebo novéjsi.

Viz také
XML .nodeValue
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XML.nodeValue

Syntaxe
myXML.nodeValue;

Argumenty
Z4dné.

Popis

Vlastnost; udava hodnotu node XML objektu. Jestlize je XML objekt textovy node,
nodeType je 3 a nodeValue je text node. Jestlize je XML objekt XML prvek, ma
nodeValue null a je pouze pro cteni.

Pfehravac
Flash 5 nebo novéjsi.

Viz také
XML .nodeType

XML.onLoad

Syntaxe
myXML . onLoad (success) ;

Argumenty
success Booleanska hodnota indikujici, zda byl XML objekt uspésné
natazen pomoci operace XML.load nebo XML.sendAndLoad.

Popis

Metoda; vyvolan Flash Prehravacem, kdyz je XML dokument obdrzen ze serveru.
Jestlize je XML dokument obdrzen uspésné, argument success je true. Jestlize
dokument nebyl obdrzen nebo jestlize se v odkazu obdrzeni ze serveru objevila
chyba, argument success je false. Nastavena implementace této metody neni
aktivni. Pro prepsani nastavené implementace musite pfipojit funkci obsahuijici vase
vlastni akce.

Pfehravac
Flash 5 nebo novéjsi.
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Priklad
Nasledujici pfiklad vytvari animaci - jednoduchou aplikaci vylohy e-obchodu.
Pouzivdame metodu sendAndLoad pro prenos XML prvku obsahujiciho jméno a heslo
uzivatele a instalujeme ovlada¢ onLoad pro ovladani odpovédi ze serveru.
var myLoginReply = new XML();
myLoginReply.onLoad = myOnLoad;
myXML . sendAndLoad ("http://www.samplestore.com/login.cgi",
myLoginReply) ;
function myOnLoad (success) {

if (success) {

if (e.firstChild.nodeName =="LOGINREPLY"&&
e.firstChild.attributes.status =="O0K") {
gotoAndPlay ("loggedIn")
lelse {

gotoAndStop ("loginFailed")
}
lelse {
gotoAndStop ("connectionFailed")

}

Viz také
function
XML. load
XML . sendAndLoad

XML.parentNode

Syntaxe
myXML .parentNode;

Argumenty
Z4dné.

Popis

Vlastnost (pouze pro ¢teni); odkazuje na rodi¢ovsky node specifikovaného XML
objektu nebo udava null, jestlize node nema zadného rodice. Toto je vlastnost
pouze pro ¢teni a nemUize byt pouzita pro manipulaci s détskymi nody; pro manipulaci
s détskymi nody, pouzijte metody appendChild, insertBefore a removeNode.

Pfehravac
Flash 5 nebo novéjsi.

XML.parseXML

Syntaxe
myXML.parseXML(source) ;

Argumenty

source XML text, ktery ma byt analyzovan a propustén do specifikovaného
XML objektu.

Popis

Metoda; analyzuje XML text specifikovany v argumentu source a osidluje specifikovany
XML objekt s vyslednym stromem XML. Jakékoliv existujici stromy v XML objektu
jsou vyrazeny.

Pfehravac
Flash 5 nebo noveéjsi.

XML.previousSibling

Syntaxe
myXML.previousSibling;

Popis

Vlastnost (pouze pro ¢teni); ohodnocuje XML objekt a odkazuje na pfedchoziho
sourozence v rodiCovském seznamu ditéte node. Udava null, jestlize node nema
predchozi sourozenecky Node. Toto je vlastnost pouze pro ¢teni a nemdze byt
pouzita pro manipulaci s détskymi nody; pro manipulaci s détskymi nody, pouzijte
metody appendChild, insertBefore a removeNode.

Pfehravac
Flash 5 nebo noveéjsi.
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XML.removeNode

Syntaxe
myXML . removeNode () ;

Argumenty
Z4dné.
Popis

Metoda; odstrariuje specifikovany XML objekt z jeho rodice.

Pfehravac
Flash 5 nebo novéjsi.

XML.send

Syntaxe
myXML. send (url) ;
myXML. send (url, window) ;

Argumenty
url Ur¢ena URL pro specifikovany XML objekt.
window Okno browseru, ve kterém se maji zobrazit data ziskana serverem:

_self - specifikuje aktudlni rdm v aktualnim okné
_blank - specifikuje nové okno

_parent - specifikuje rodiCe aktudlniho ramu

_top - specifikuje rdm nejvy$si irovné v aktudinim okné.

Popis
Metoda; kéduje specifikovany XML objekt do XML dokumentu a posila ho do
specifikovaného URL pomoci pouziti zplsobu POST.

Pfehravac
Flash 5 nebo novéjsi.
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XML.sendAndLoad

Syntaxe
myXML.sendAndLoad(url, targetXMLobject) ;

Argumenty
url Ur¢ena URL pro specifikovany XML objekt. URL musi byt ve stejné
subdoméné jako URL, ze kterého je animace stahovana.

targetXMLobject XML objekt vytvoreny pomoci XML konstrukéni metody, ktery obdrzi
informaci ze serveru.

Popis

Metoda; kdduje specifikovany XML objekt do XML dokumentu, posila ho do
specifikovaného URL pomoci pouZiti zplisobu POST, stahuje odpovéd serveru a potom
ji natahuje do cilXMLobjekt specifikovaného v argumentech. Odpovéd serveru je
natazena stejnym zpUsobem pomoci pouziti metody load.

Pfehravac
Flash 5 nebo novéjsi.

Viz také
XML.1load
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XML.status

Syntaxe
myXML.status;

Argumenty
Z&dné.

Popis

Vlastnost; automaticky nastavuje a udava numerickou hodnotu indikujici, zda byl
XML dokument Uspésné analyzovan do XML objektu. Nasledujici je seznam
numerickych kddd stavd a jejich popis:

0 Z4dnd chyba; analyza je Uspésné dokondena.

-2 Cést CDATA nebyla f4dné ukondena.

-3 XML deklarace nebyla radné ukoncena.

-4 Deklarace DOCTYPE nebyla radné dokoncena.

-5 Komentar nebyl radné dokoncen.

-6 XML prvek byl malformed.

-7 Nedostatek paméti.

-8 Hodnota atributu nebyla radné dokoncena.

-9 Start-tag neodpovida koncovému stitku.

-10 Doslo na setkdni k koncovym tagem, bez toho, Ze by odpovidal start-tagu.

Pfehravac
Flash 5 nebo novéjsi.
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XML.toString

Syntaxe
myXML.toString() ;

Argumenty
Z4dné.

Popis
Metoda; ohodnocuje specifikovany XML objekt, konstruuje textovou reprezentaci
XML struktury véetné node, déti a atributl a udava vysledek jako retézec.

Pro XML objekty nejvysSsi urovné (to jsou ty, které byly vytvofené konstruktorem)
udava XML . toString deklaraci dokumentu XML (uloZzenou v XML . xm1Decl),
nasledovanou DOCTYPE deklaraci dokumentu (ulozenou v XML . docTypeDecl),
nasledovanou textovou reprezentaci véech XML nod( v objektu. XML deklarace
neni vystupem, jestlize XML.xmlDecl je nedefinovany. Deklarace DOCTYPE neni
vystupem, jestlize neni XML . docTypeDecl definovany.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici kdd je prikladem metody XML. toString:
node = new XML (,<hl>text</hl>,);

trace (node. toString()) ;

posila

<Hl>test</H1>

do okna vystup

Viz také
XML . xmlDecl
XML .docTypeDecl
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XML.xmlIDecl

Syntaxe
myXML . xmlDecl ;

Argumenty
Z4dné.

Popis

Vlastnost; nastavuje a udava informaci o deklaraci XML dokumentu. Poté, co je XML
dokument analyzovan na XML objekt, jeho vlastnost je nastavena pomoci pouziti
textu deklarace XML dokumentu. Tato vlastnost je nastavena pomoci pouziti fetézcove
reprezentace XML deklarace, ne XML node objektu. Jestlize nedoslo k setkani se
zadnou XML deklaraci béhem operace analyzy, vlastnost je nastavena ne nedefinovana.
XML. toString uddvd obsah XML.xmlDecl pred jakymkoliv jinym textem v XML
objektu. Jestlize XML . xm1Decl obsahuje typ undefined (nedefinovano), neni
vystupem Zadna XML deklarace.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici priklad pouzivéd XML . xm1Decl pro nastaveni deklarace XML dokumentu
pro XML objekt:

mujXML.xmlDecl="<?xml verze=\“1.0\“?>“;

Viz takeé
XML. toString
XML .docTypeDecl

XMLSocket (object)

XMLSocket objekt implementuje klientské zasuvky, které umoznuji pocitaclm,
na kterych bézi Flash Prfehravac¢, komunikovat se serverovym pocitatem
identifikovanym IP adresou nebo jménem domény.

Pouziti XMLSocket objektu

Pro pouziti XMLSocket objektu musi serverovy pocita¢ bézet daemon (program),
ktery chape protokol pouzivany XMLSocket objektem. Protokol je nasledujici:

XML zpravy jsou posilany pfes plné-duplexni TCP/IP tekouci zasuvkové spojeni.
Kazda XML zprava je kompletni XML dokument, ukon¢eny nulovym bytem.

Pres jedno XMLSocket spojeni, mlze byt posléan a obdrzen neomezeny pocet XML
Zprav.

XMLSocket objekt je uziteCny pro aplikace klient-server, které pozaduji nizkou
latentnost, jako jsou napfiklad chat systémy v redlném Case. Tradicni HTTP-zaloZzené
chat reSeni ¢asto odesila server a stahuje nové zpravy pouzitim HTTP poZadavku.
Naproti tomu, XMLSocket chat feSeni ovlada otevrené spojeni se serverem, které
serveru umoznuje okamzité poslat prichazejici zpravy bez pozadavku od klienta.

Nastaveni serveru pro komunikaci s XMLSocket objektem miiZe byt problematicke.
Jestlize vase aplikace nepozaduje interaktivitu v redlném ¢Case, pouzijte namisto
XMLSocket objektu akci loadvVariables nebo Flash HTTP-zaloZzené XML server
spojeni (XML .load, XML.sendAndLoad, XML.send),.

Pro pouziti metod XMLSocket objektu musite pro vytvoreni nového XMLSocket
objektu nejprve pouzit konstruktor new XMLSocket,.
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XMLSocket a bezpec¢nost

Protoze XMLSocket objekt zavadi a podporuje oteviené spojeni se serverem, byly
z bezpecnostnich dlvodd zavedeny ndsledujici restrikce na XMLSocket objekt:

Metoda XMLSocket.connect miZe spojovat pouze s TCP port Cisly vy$Simi
nebo rovnymi 1024. Jeden vyznam této restrikce je, Ze serverové daemons (programy),
které komunikuji s XMLSocket objektem musi byt také pripojené k port ¢isldm
vySSim nebo rovnym 1024. Port Cisla nizsi nez 1024 jsou Casto pouzivany systémovymi
sluzbami jako FTPR, Telnet a HTTP, tedy zatarasujicimi XMLSocket objekt z téchto
portl. Restrikce na ¢isla portl limituje moznost, Ze tyto zdroje budou nepatficné
dosazeny a zneuzity.

Metoda XMLSocket . connect miiZe spojovat pouze s pocitaci ve stejné subdomeéng,
kde sidli SWF soubor. Tato restrikce se neaplikuje na animaci bézici mimo lokalni disk.
(Tato restrikce je stejna jako bezpecnostni pravidla pro loadvariables,
XML . sendAndLoad a XML.load.)

Pfehled metod objektu XMLSocket

Metoda Popis

close Zavird oteviené zasuvkové spojenti.

connect Zavadi spojeni se specifikovanym serverem.

onClose Funkce zpétného volani, kterd je vyvoldna, kdyz je zavieno XMLSocket spojeni.
onConnect Funkce zpétného volani, kterd je vyvolana, kdyZ je zavedeno XMLSocket spojeni.
onXML Funkce zpétného volani, kterd je vyvoldna, kdyz prijde XML objekt ze serveru.
send Posila XML objekt do serveru.

Konstruktor pro XMLSocket objekt
Syntaxe
new XMLSocket() ;

Argumenty
Z4dné.

Popis

Konstruktor; vytvari novy XMLSocket objekt. XMLSocket objekt neni pdvodné spojen
se zadnym serverem. Pro spojeni objektu se serverem musite volat metodu
XMLSocket. connect.

Pfehravac
Flash 5 nebo noveéjsi.

Priklad
myXMLSocket = new XMLSocket() ;

Viz také
XMLSocket.connect

XMLSocket.close

Syntaxe
myXMLSocket.close() ;

Argumenty
Z4dné.
Popis

Metoda; zavird spojeni specifikované XMLSocket objektem.

Pfehravac
Flash 5 nebo noveéjsi.

Viz také
XMLSocket.connect
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XMLSocket.connect

Syntaxe
myXMLSocket. connect(host, port) ;

Argumenty

host PIné kvalifikované jméno DNS domény nebo IP adresa ve formé
aaa.bbb.ccc.ddd. Také mizZete specifikovat null pro spojeni
s hostitelskym serverem, na kterém sidli movie.

port TCP port Cislo na hostiteli, pouzité pro zavedeni spojeni. Port
¢islo musi byt 1024 nebo vyssi.

Popis

Metoda; zavadi spojeni se specifikovanym Internet hostitelem pomoci pouziti
specifikovaného TCP portu (musi byt 1024 nebo vyssi) a uddva true nebo false
v zavislosti na UspéSném zavedeni spojeni. Jestlize neznate Cislo portu vaseho
Internet hostitelského stroje, kontaktujte vaseho sitového administratora. Jestlize
je pouzivan Flash Netscape plug-in nebo ActiveX control, hostitel specifikovany
argumentu musi mit stejnou subdoménu jako hostitel, ze kterého byla stazena
animace.

Pokud pro argument host specifikujete nul1l, kontaktovany hostitel bude ten hostitel,
kde sidli animace volajici XMLSocket . connect. Napfiklad, jestlize animace byla
stazena z http://www.yoursite.com, specifikujici null pro argument hostitel je stejné
jako vlozeni IP adresy pro xxx.yoursite.com.

Jestlize XMLSocket . connect udava hodnotu true, pocatecni faze procesu spojeni
je uspésna; pozdéji je vyvoldana metoda XMLSocket.onLoad pro uréeni,
zda je konecné spojeni Uspesné nebo neuspésné. Jestlize XMLSocket . connect
udava false, spojeni nemohlo byt zavedeno.

Pfehravac
Flash 5 nebo novéjsi.
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Priklad
Nasledujici pfiklad pouzivd XMLSocket . connect pro spojeni s hostitelem, kde
sidli animace a pouziva trace pro zobrazeni udané hodnoty indikujici uspéch nebo
neuspéch spojent:
function myOnConnect (success) {
if (success) {
trace ("Connection succeeded!")
lelse {
trace ("Connection failed!'")

}

socket = new XMLSocket ()

socket.onConnect =myOnConnect

if ('socket.connect(null,2000)) {
trace ("Connection failed!'")

}

Viz také
function
XMLSocket.onLoad

XMLSocket.onClose

Syntaxe
myXMLSocket.onClose() ;

Argumenty
Z4dné.

Popis

Metoda; funkce zpétného volani, kterd je vyvoldna, kdyz je serverem zavieno
otevfené spojeni. Dand implementace této metody neprovadi zadné akce. Pro
pfepsani dané implementace musite pfipojit funkci obsahujici vase vlastni akce.

Pfehravac
Flash 5 nebo noveéjsi.

Viz také
function
XMLSocket.onLoad

KAPITOLA 74 309



XMLSocket.onConnect

Syntaxe
myXMLSocket. onConnect (success) ;

Argumenty

success Boolednska hodnota indikujici, zda bylo zasuvkoveé spojeni Uspeésnée
zavedeno (true nebo false).

Popis

Metoda; funkce zpétného volani vyvoldna Flash Pfehravacem, kdyz pozadavek na
spojeni iniciovany pomoci metody XMLSocket.connect byl UspésSny nebo
neuspésny. Jestlize bylo spojeni Uspésné, argument success je true; jinak je
argument success false.

Dana implementace této metody neprovadi zadné akce. Pro pfepsani dané
implementace musite urcit funkci obsahujici vase vlastni akce.

Pfehravac
Flash 5 nebo novéjsi.

Priklad
Nasledujici pfiklad ilustruje proces specifikace nahrazeni funkce pro metodu
onConnect Vv jednoduché chat aplikaci.

Funkce kontroluje, ke které obrazovce se uzivatelé dostanou v zavislosti na tom,
zda je Uspésné zavedeno spojeni. Jestlize je spojeni Uspésné zavedeno, uzivatelé
se dostanou k hlavni chat obrazovce na snimku popsaném startChat. Jestlize
spojeni neni Uspésné, uzivatelé jdou na obrazovku, kde je informace na popisku
connectionFailed.
function myOnConnect (success) {
if (success) {
gotoAndPlay ("startChat")
lelse {
gotoAndStop ("connectionFailed")

Po vytvoreni XMLsocket objektu pomoci pouziti konstrukéni metody, scénar
instaluje metodu onConnect pouzitim operatoru ur€eni (assignment):

socket = new XMLSocket ()

socket.onConnect = mujOnConnect
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Nakonec je inicializovano spojeni. Jesltize connect udava false, animace je
poslana pfimo do snimku popsaného connectionFailed a onConnect UZ neni
vice vyvolan. Jestlize connect udava true, animace skoci na snimek popsany
waitForConnect, coZ je obrazovka ,Prosim cekejte”. Animace zlstdva na snimku
waitForConnect, dokud neni vyvolan ovlada¢ onConnect, coz se stane na stejném
bodé v budoucnosti v zavislosti na sifové latentnosti.
if ('socket.connect(null,2000)) {

gotoAndStop ("connectionFailed")
lelse {

gotoAndStop ("waitForConnection")

Viz také
XMLSocket.connect
function

XMLSocket.onXML

Syntaxe
myXMLSocket . onXML(objekt) ;

Argumenty

objekt Instance XML objektu obsahujici analyzovany XML dokument
obdrzeny ze serveru.

Popis

Metoda; funkce zpétného volani vyvolana Flash Pfehravacem, kdyz specifikovany
XML objekt obsahujici XML dokument prejde pres oteviené XMLSocket spojeni.
XMLSocket spojeni mlze byt pouzito pro transfer neomezeného poctu XML
dokument( mezi klientem a serverem. Kazdy dokument je ukon¢en nulovym bytem.
Kdyz Flash Prehrdva¢ obdrzi nulovy byte, analyzuje vSechny XML obdrZzené od
predchoziho nulového bytu nebo od zavedeni spojeni, pokud je toto prvni obdrzena
zprava. S kazdou sérii analyzovanych XML se zachazi jako s jednim XML dokumentem
a je propusténa do metody onXML.

Dana implementace této metody neprovadi Zzadné akce. Pro pfepsani dané
implementace musite urcit funkci obsahuijici akce, které definujete.

Pfehravac
Flash 5 nebo novéjsi.
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Priklad

Nasledujici funkce prepisuje danou implementaci metody onXML v jednoduché
chat aplikaci. Funkce myOnXML instruuje chat aplikaci, aby rozpoznala jednotlivy
XML prvek, MESSAGE, v nasledujicim formatu:

<MESSAGE USER = “John“ TEXT = “AHOJ, jmenuji se John!“/>.

Ovlada¢ naXML musi byt nejprve instalovan v XMLSocket objektu nasledovné:
socket.onXML = myOnXML;

Predpoklada se, ze funkce displayMessage je funkce definovana uzivatelem,
ktera uzivateli zobrazi obdrZzenou zpravu.
function myOnXML (doc) {
var e = doc.firstChild;
if (e !'= null && e.nodeName == "MESSAGE") {
displayMessage (e.attributes.user, e.attributes.text);

Viz také
function

XMLSocket.send

Syntaxe
myXMLSocket. send (objekt) ;

Argumenty
objekt XML objekt nebo jind data, kterd se maiji pfenést na server.

Popis

Metoda; konvertuje XML objekt nebo data specifikovana v argumentu objekt na fetézec
a prenasi je na server, nasledované nulovym bytem. Jestlize je objekt XML objekt,
fetézec je XML textova reprezentace XML objektu. Operace posilani je asynchronni;
vraci se okamzite, ale data mohou byt prenesena pozdéji. Metoda XMLSocket . send
neudava hodnotu indikujici, zda byla data Uspésné prenesena.

Jestlize myXMLSocket objekt neni spojen se serverem
(pouzitim XMLSocket . connect), operace XMLSocket . send bude nelspésna.

Pfehravac
Flash 5 nebo novéjsi.

Priklad

Nasledujici pfiklad ilustruje, jak byste mohli specifikovat jméno uzivatele a heslo
pro poslani XML objektu myXML do serveru:

var myXML = new XML() ;

var myLogin = myXML.createElement("login") ;
myLogin.attributes.username = usernameTextField;
myLogin.attributes.password = passwordTextField;

myXML . appendChild (myLogin) ;

myXMLSocket. send (myXML) ;

Viz také
XMLSocket.connect

_Xmouse

Syntaxe
instancejméno._xmouse

Argumenty

instancejméno Jméno movie klip instance.

Popis
Vlastnost (pouze pro ¢teni); uddva souradnici x pozice mysi.

Pfehravac
Flash 5 nebo noveéjsi.

Viz také
Mouse (object)

_ymouse
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_xscale

Syntaxe

instancejméno._xscale

instancejméno._xscale = procento;

Argumenty

procento Procentni hodnota specifikujici procento pro horizontalni méfitko

animace. Dand hodnota je 100.
instancejméno Jméno movie klip instance.

Popis
Vlastnost; udava horizontalni méfitko (procento) movie klipu jako aplikované
z registracniho bodu movie klipu. Dany registra¢ni bod je (0,0).

Méfitko lokalniho systému souradnic ovliviiuje nastaveni viastnosti_x a_y, které jsou
definovdny v celych pixelech. Napfiklad, jestlize je movie klip zmen§en na 50%,
nastaveni viastnosti _x posune objekt v movie klipu o polovinu poctu pixeld, na rozdil
od toho, kdyby bylo movie na 100%.

Pfehravac¢
Flash 4 nebo novéjsi.

Viz takeé
_yscale
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-y
Syntaxe
instancejméno._y
instancejméno._y = celé &islo;
Argumenty
celé cislo Lokalni souradnice y movie klipu.
instancejméno Jméno movie klip instance.
Popis
Vlastnost; nastavuje soufadnici y movie relativné k lokdlnim souradnicim rodi¢ovského
movie klipu. Jestlize je movie klip na hlavni Casové ose, potom jeho systém souradnic
odpovida levému hornimu rohu Scény jako (0,0). Jestlize je movie klip uvnitf jiného
movie Klipu, ktery je transformovan, movie klip je v lokalnim systému souradnic viozeného
movie klipu. Tedy, pro movie klip oto¢eny o 90° proti sméru hodinovych rucicek,
zdedi déti movie klipu systém souradnic, ktery je otoCen o 90° proti sméru hodinovych
ruciCek. Souradnice movie klipu odpovidaji pozici registracniho bodu.
Pfehravac
Flash 3 nebo noveéjsi.
Viz také
_yscale

_ymouse
Syntaxe

instancejméno._ymouse

Argumenty
instancejméno Jméno movie klip instance.

Popis

Vlastnost (pouze pro ¢teni); indikuje soufadnici y pozice mysi.

Pifehravaé
Flash 5 nebo noveéjsi.

Viz také

Mouse (object)
_Xmouse
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_yscale
Syntaxe
instancejméno._yscale
instancejméno._yscale = procento;

Argumenty
procento Procentni hodnota specifikujici procento pro vertikalni méfitko
animace. Dana hodnota je 100.

instancejméno Jméno movie klip instance.

Popis

Vlastnost; nastavuje vertikalni méfitko (procento) movie klipu, jako aplikované
z registracniho bodu movie klipu. Dany registracni bod je (0,0).

Méfitko lokalniho systému soufadnic ovliviiuje nastaveni vlastnosti _x a _y, které
jsou definovany v celych pixelech. Napriklad, jestlize je movie klip zmensen na 50%,
nastaven vlastnosti _x posune objekt v movie klipu o polovinu poctu pixeld, na

rozdil od toho, kdyby byla animace na 100%.

Pfehravac¢
Flash 4 nebo nové;si.

Viz také

_x
v
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DODATEK A

Nadrazenost a asociativita operatoru

Seznam Operatora
Toto je seznam vSech ActionScript operdtord a jejich asociativity, podle nadfazenosti
od nejvys$si po nejnizsi.

Operator Popis Asociativita
+ Unary plus Right to left
- Unary minus Right to left
~ Bitwise one s complement Right to left
! Logical NOT Right to left
not Logical NOT (Flash 4 style) Right to left
++ Post-increment Left to right
- Post-decrement Left to right
() Function call Left to right
[1 Array element Left to right
Structure member Right to left
++ Pre-increment Right to left
- Pre-decrement Right to left
new Allocate object Right to left
delete Deallocate object Right to left
typeof Type of object Right to left
void Returns undefined value Left to right
* Multiply Left to right
/ Divide Left to right
% Modulo Left to right
+ Add Left to right
add String concatenation (formely &) Left to right
- Subtract Left to right
<< Bitwise Left Shift Left to right
>> Bitwise Right Shift Left to right
>>> Bitwise Right Shift (Unsigned) Left to right
< Less than Left to right
<= Less than or equal to Left to right
> Greater than Left to right
>= Greater than or equal to Left to right
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Operator Popis Asociativita
>= Greater than or equal to Left to right
1t Less than (string version) Left to right
le Less than or equal to (string version)| Left to right
gt Greater than (string version) Left to right
ge Greater than (string version) Left to right
== Equal Left to right
1= Not equal Left to right
eq Equal (string version) Left to right
ne Not equal (string version) Left to right
& Bitwise AND Left to right
~ Bitwise XOR Left to right
| Bitwise OR Left to right
&& Logical AND Left to right
and Logical AND (Flash 4) Left to right
N Logical OR Left to right
or Logical OR (Flash 4) Left to right
?: Conditional Right to left
= Assignment Right to left
W=, /=, %=, 4= Compound assignment Right to left
-=, &=, |=, "=,

<<=, >>=, >>>="

, Multiple evaluation Left to right
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DODATEK B Klavesa pismeno, nebo cislice Kod klavesy
Klavesy Klavesnice a Hodnoty Kodu Klaves 3 51
Ndsledujici tabulky ukazuji seznam vSech standartnich kldves kldavesnice a jim odpovidajici 4 52
hodnoty kdd(, které jsou pouzivany v ActionScriptu. Pro vice informaci se podivejte
na objekt Key v kapitole 7, "ActionScript Slovniku". 5 %
Pismena od A do Z a standartni ¢islice 0 az 9 6 o4
Klavesa pismeno, nebo cislice Kod klavesy ; ZZ
A % 9 57
B 66
(¢} 67
D 68
E 69
F 70
G A Klavesy na numerické klavesnici
H 72
| 73 Numericka klavesa Kdd klavesy
J 74 Numklavesa 0 96
K 75 Numklévesa 1 97
L 76 Numkldvesa 2 98
M 77 Numkldvesa 3 99
N 78 Numkldvesa 4 100
0 79 Numklévesa 5 101
P 80 Numklavesa 6 102
Q 81 Numkldvesa 7 103
R 82 Numkldvesa 8 104
S 83 Numkldvesa 9 105
T 84 Nasobeni 106
U 85 Plus 107
\Y; 86 Enter 108
W P Odegiténi 109
X 88 Desetina 110
Y 89 Déleni 111
z 90
0 48
1 49
2 50
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Klavesy funkci

Numericka klavesa Kod klavesy
F1 112
F2 113
F3 114
F4 115
F5 116
F6 117
F7 118
F8 119
F9 120
F10 121
F11 122
F12 123
Ostatni klavesy
Klavesa Kod klavesy
Backspace 8
Tab 9
Clear 12
Enter 13
Shift 16
Control 17
Alt 18
Caps Lock 20
Esc 27
Spacebar 32
Page Up 33
Page Down 34
End 35
Home 36
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Klavesa Kod klavesy
Left Arrow 37

Up Arrow 38

Right Arrow 39

Down Arrow 40

Insert 45

Delete 46

Help 47

Num Lock 144

i 186

=+ 187

- 189

/? 191

~ 192

[{ 219

\| 220

{[ 221

- 222
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DODATEK C

Chybova hlaseni
Nasleduijici tabulka obsahuje seznam hlaseni o chybach udanych Flash kompildatorem. U kazdé
zpravy je poskytnuto vysvétleni, které vam ma pomoci pfi odstrariovani problémd ve vasich
movie souborech.

Chybové hlaseni

Kdd klavesy

Chybové hlaseni

Kdd klavesy

Illegal function

Byla pouzita deklarace jmenované funkce jako vyraz.
Deklarace jmenované funkce musi byt prikaz.Platné:
function sqr (x){
return x * x;
}
Neplatné: var v = function sqr (x)({
return x * x;

}

Property <property>does not exist

Doslo k setkani s vlastnosti, kterd neexistuje.
Napriklad x = zelena je neplatnd, protoze
_zelena neniz&dna vlastnost.

Function name expected

Jméno specifikované pro tuto funkci neni platné
jméno funkce.

Operator <operator>must
be followed by an operand

Doslo k setkdni s operdtorem bez operandu.
Napfiklad x = 1 + vyZaduje operand

za operatorem +.

Operétor je nasledovan neplatnym operandem.
Napriklad trace (1+) je syntakticky nespravné.

Parameter name expected

V deklaraci funkce bylo oéekdvano jméno
parametru (argumentu), ale doslo k setkani s
neo¢ekavanym symbolem.

else'encountered without matching'if'

Doslo k setkdni s pfikazem else, ale pred
ni se neobjevilo zadné if. MlZete pouZit else
pouze ve spojeni s piikazem if.

Syntax error

Tato zprava je vydana, kdykoliv dojde k setkani
s nespecifikovanou chybou syntaxe.

Expected a field
name after '.' operator

Kdyz pouzivéte syntaxi objekt.pole,
Musite specifikovat platné jméno pole.

Scene type error

Argument scény akce gotoAndPlay, gotoAndStop
nebo ifFrameLoaded byl §patného typu. Argument
scény musi byt fetézcovd konstanta.

Expected <token>

Doslo na neplatny nebo neogekdvany symbol.
Napriklad v syntaxi dole, symbol £oo neni platny.
Ocekavany symbol je while.
do {

trace (i)

} foo (i < 100)

Internal error

V ActionScript kompildtoru se objevila vnitini chyba.
Prosim poslete FLA soubor, ktery generoval tuto chybu
do Macromedia s detailnimi instrukcemi,

jak reprodukovat zpravu.

Hexadecimal digits expected after O0x

Doslo k setkdni se sekvenci 0x, ale sekvence
nebyla nasledovéna platnymi hexadecimalnimi ¢islicemi

Initializer list must
be terminated by <terminator>

V inicializaénim seznamu objektu nebo pole chybi
ukonCovaci zdvorka ] nebo }.

Error opening #include file

Byla zde chyba otevirajici zahrnuty soubor s prikazem
include. Chyba se mohla objevit proto, Ze soubor
nebyl pfitomny nebo v disledku chyby disku.

Identifier expected

Doslo k setkdni s neocekdvanym symbolem
na misté identifikdtoru. V pfikladu dole neni 3 platny
identifikdtor. var 3 = 4;

Malformed #include directive

Pfikaz include nebyl napsan spravné.
Pfikaz include musi pouzivat ndsledujici syntaxi:
#include ,néjakysoubor.as™

The JavaScript '<construct>
'construct is not supported

Doslo k setkani s JavaScript konstrukci,

kterd neni podporovano ActionScript. Tato zpréva
se objevi, jestlize jsou pouZity jakékoliv

z nasledujicich JavaScript konstrukci:

void, switch, try, catch nebo throw.

Multi-line comment was not terminated

Nékolika radkovy komentdr zacal s /* a chybfi
zaviraci */ tag.

String literal was not properly
terminated

U pismenného fetézce zacinajiciho otevirajicim citacnim
znaménkem (jednoduchym nebo dvojitym) chybi zavirajici
citaéni znameénko.

Left side of assignment operator
must be variable or property

Byl pouZit operator uréeni, ale na levé strané
uréeni nebyla legaini proménna nebo vlastnost.

Function <function>takes <count>
parameters

Byla voléna funkce, ale doslo k setkdni
s neo&ekdvanym poctem parametrd.

Statement block must
be terminated by '}'

Skupina vyrazl byla deklarovéna ve slozenych
zévorkach, ale chybi ukonCovaci zdvorka.

Property name expected in
GetProperty

Byla voléna funkce getProperty, ale druhy argument
nebylo jméno movie klip vlastnosti.

Event expected

Byl deklarovén ovlada¢ On (MouseEvent)

nebo onClipEvent, ale nebyla specifikovana udalost
nebo doslo k setkani s neocekavanym

symbolem tam, kde se méla objevit uddlost.

Parameter <parameter>cannot
be declared multiple times

Jméno parametru se objevilo nékolikrat v parametru
deklarace funkce. Véechna jména parametr(
musi byt jedine¢na.

Invalid event

Scénar obsahuje neplatnou udalost mysi nebo
klipu. Seznam platnych udalosti mysi a klipu
viz polozky On(MouseEvent) a onClipEvent

v kapitole slovniku ActionScript.

Variable <variable>cannot be
declared multiple times

Jméno proménné se objevilo nékolikrat v piikazu var.
V8echna jména proménnych v jednom piikazu var
musi byt jedinec¢na.

Key code expected

Musite specifikovat kéd kldvesy. Seznam kédU
klaves viz Dodatek B.

‘on’ handlers may not be nested
within other ‘on’ handlers

Ovladac on byl deklarovan uvnitf jiného ovladace on.
V8echny ovladage se musi objevovat v nejvyssi Urovni
seznamu akce.

Invalid key code

Specifikovany kdd kldvesy neexistuje.

Statement must appear within on
handler

V akcich pro instanci tlaéitka byl deklarovan prikaz bez
obklopujiciho bloku on. V8echny akce pro instanci tlaéit
ka se musi objevit uvnitf bloku on.

Trailing garbage found

Scénar nebo vyraz byl analyzovén spravné,
ale obsahoval dodate¢né stopovaci znaky,
které nemohly byt analyzovany.

Statement must appear within
onClipEvent handler

V akcich pro movie klip instanci byl deklarovén piikaz
bez obklopujiciho bloku onClipEvent.

V8echny akce pro movie klip instanci se musi objevit
uvnit bloku onClipEvent.
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Chybové hlaseni Kdd klavesy

Mouse events are permitted only Ovladac uddlosti tlacitka byl deklarovan v seznamu
for button instances akei snimku nebo v seznamu akci movie klip instance.
Udalosti tla¢itek jsou povoleny pouze v seznamech
akcf instanci tlacitek.

Clip events are permitted only Ovladac uddlosti klipu byl deklarovén v seznamu akci

for movie clip instances snimku nebo v seznamu akci instance tlacitka. Udalosti
klipu jsou povoleny pouze v seznamech akci movie klip
instanci.

415 ACTION SCRIPT - FLASH 5



	FLASH 5 - ACTION SCRIPT
	Obsah
	Úvod
	Kapitola 1
	Kapitola 2
	Kapitola 3
	Kapitola 4
	Kapitola 5
	Kapitola 6
	Kapitola 7
	Dodatek A
	Dodatek B
	Dodatek C

